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Chapter 1. Workbench

About the CIMPLICITY Workbench

Your CIMPLICITY Workbench, which is at the center of your CIMPLICITY project, provides you
with the power you need to view, configure, organize, and manage every component of your project
through one easy to use window.

Among the many capabilities that are packed into the Workbench's familiar Windows interface is the
capability for you to:

• Open the Workbench (page 21)
• Workbench at a Glance (page 22)
• Multiple Workbench Windows (page 26)
• Workbench Display Options (page 27)
• Workbench Procedures for CIMPLICITY Projects (page 38)
• Record and File Configuration (page 51)

Open the Workbench

You open the Workbench the same way you open any supported Windows versions application.

1. Click Start on the Windows task bar.

2. Select (All) Programs>Proficy HMI SCADA - CIMPLICITY version.

Note:  Proficy HMI SCADA - CIMPLICITY version is the default Startup menu location.
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3. Click the Workbench icon . A Workbench opens with installed computer

and runtime options listed in the left pane.

Note:  CIMPLICITY provides several methods for opening projects in the Workbench.

Workbench at a Glance

Within the supported Windows versions familiar environment, the CIMPLICITY Workbench
provides you with all the unique CIMPLICITY Power Tools you need to create and manage your
project with maximum efficiency.

Also, you will recognize some of the Workbench's tools from your supported Windows versions
toolbars and file menus.

Note:  Click a button on the Workbench graphic to view details about the selection.
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rect -3, 15, 23, 37  (page 23)
rect -4, 37, 22, 56  (page 23)
rect 27, 128, 53, 150  (page 25)
rect 42, 152, 68, 174  (page 25)
rect 28, 189, 54, 211  (page 25)
rect 12, 325, 38, 361  (page 25)
rect -8, 360, 18, 382  (page 25)
rect 266, 58, 292, 80  (page 25)
rect 266, 179, 292, 201  (page 25)
rect 336, 272, 362, 294  (page 25)
rect 393, 67, 419, 89  (page 23)
rect 13, 56, 39, 78  (page 25)

A Menu bar

B Toolbar Buttons

General

1 New project

2 Open project

3 Print file details

4 Dynamic configuration

5 Stop project
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6 Run project

7 Configuration update

8 Compare main and data

9 Status log

10 Computer properties

11 Project properties

12 Project wizard

13 List in the right pane

14 Details in the right pane

15 Large icons in the right pane

16 Tree view in the right pane

17 Thumbnails in the right pane

18 Help contents

Edit

1 New object

2 Duplicate object

3 Delete object

4 Object properties

5 Search

6 Field chooser

7 Cancel

Manage

1 Project checkout

2 Project check in

3 Computer checkout

4 Computer check in
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C Top-level
folders

CIMPLICITY configuration and usage is grouped into three overall categories.

1 Project Project level configuration. Applications and files in this section apply to the open CIMPLICITY
project only.

2 Computer Computer level configuration. User configured components in this section are common to all
projects and typically found under the CIMPLICITY root directory. The same computer project is
referenced by all Workbenches on the same computer.

3 Runtime Set of utility applications that can be used when a project is running locally or remotely.

D Application
icon

Expand to display subordinate applications.

E Subordinate applications

F Application
folder

Open or close the folders, to view or hide applications.

G Status bar Provides information that includes how many records are retrieved, if the project is running, and if a
specified task has been completed.

H Fields Chosen in the Field Chooser for display.

I Files/
Records

Associated with selected object.

J Keystrokes Perform commonly used functions.

Ctrl+N Creates a new object.

Ctrl+O Opens another project in this window.

Ctrl+R Runs the stopped project.

Ctrl+W Runs the Project Wizard.

Ctrl+L Displays the Status Log for the project.

Alt+Spacebar Displays the Control Menu.

Alt+F4 Closes the project window.

Ctrl+Esc Displays the system Task List window.

Note:  The following work on a single selected node in the Workbench left or right-pane.

Numpad + Expands currently selected node.

Numpad * Expands currently selected node and all its child nodes.

Numpad - Collapses currently selected node.

Tip:  Place the cursor over any object in the Workbench to display a brief description of what it
does.
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Multiple Workbench Windows

The Workbench enables you to:

• Open several Workbench windows at the same time.
• Refresh the view in the Workbench in which you are working.

Open Additional Workbench Windows on the Same Computer

You can open as many Workbench windows on one computer as its resources allow. You can also
open them on connected servers or development viewers.

The multiple Workbench windows can contain the same or different CIMPLICITY projects.

Click File>New>Window on the Workbench menu bar to open additional windows.

A new Workbench opens with the same project that displayed in the first Workbench. You can easily
open another project.

Refresh a Project Display in an open Workbench

CIMPLICITY makes changes that are made to a project in any Workbench window in every open
version of that project. Refresh your view to insure that what you are looking at is the current
configuration.

Do one of the following.

• Press F5.
• Click View>Refresh on the Workbench menu bar.
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The Workbench window displays the most current version of the displayed CIMPLICITY project.

Workbench Display Options

Workbench Display Options

The Workbench display can be as sparse or as detailed as you need.

You can:

• Expand / collapse the left pane view.
• Change the right pane view to display.
• Select Records or Files to display in the right pane.
• Select fields to display in the right pane.

Expand / Collapse the Left Pane View

You can expand or collapse folders or icons that have subordinate icons the same way you do in
Windows Explorer for supported Windows versions.

1 Click the – to collapse the tree.
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2 Click the + to expand the tree.

Change the Right Pane View

Change the Right Pane View

Right pane view options emulate the Windows XP Explorer options, including:

• Detailed lists with field information.
• Lists of records or files.
• Large icons.
• Tree view.

Do one of the following.

Method 1

1. Click Edit>View on the Workbench menu bar.

2. Select one of the view options: Large Icons, List, Details, Tree or Thumbnails.

Method 2

Click the appropriate button on the Workbench toolbar.

1 List

2 Detail

3 Large icons

4 Tree

5 Thumbnails
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The right pane view changes to reflect your choice.

Important:  Thumbnails will display in Windows Explorer and in the Open dialog when you
display a screens directory.

Configure the Thumbnail View

You can change the size of the thumbnails in the Workbench right pane. This feature enables you
to increase or decrease the number of thumbnails that you can view at one time. It also enables you
review the detail in a single thumbnail without opening the CimEdit or CimView screen.

1. Click View on the Workbench toolbar.

2. Select Thumbnail size.

The Thumbnail Size dialog box opens.

3. Do either of the following to change the thumbnail size.
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• Grab the lower right corner of the Thumbnail sizing box to enlarge or reduce its size.

Note:  If the size is out of range the OK button is disabled.

• Enter the number of pixels to specify the thumbnail size in the Width and Height fields.

4. Click OK.

The thumbnails display in the size you specify.

A Thumbnail 200x200

B Thumbnails 100x100

Select Records or Files to Display in the Right Pane

Select Records or Files to Display in the Right Pane

CIMPLICITY offers you an efficient way to view:

• Display all records or files for an icon.
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• Display selected records or files.

• Find the names of records or files to list.

• Use CIMPLICITY browsers.

Display All Records or Files for an Icon

The procedures for selecting to view all records or files for a selected icon are as follows.

Note:  Whether you view a list of records or of files depends on the icon you select in the left
pane. For example, if you select Points in the left pane, you will view a list of records in the right. If
you select Screens in the left, you will view a list of files in the right.

1. Select an icon in the left pane.

2. Tell CIMPLICITY to automatically display all the records by either of the following methods:

Method 1

a. Click View on the Workbench menu bar.
b. Select Auto Fill to display a check on its left side.

Method 2

a. Place the cursor in the Workbench right pane.
b. Click the right-mouse button.
c. Select Auto Fill on the Popup menu to display a check on its left side.
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CIMPLICITY displays a list of all the existing records or files for the selected icon when you use
either method.

Display Selected Records or Files

Note:  Whether you select a list of records or files depends on the icon you select in the left pane.

Example

• If you select:
◦ Points in the left pane, you will select a list of records in the right.
◦ Screens in the left-pane, you will select a list of files in the right.

• The Search feature is not available for the system short point IDs that are created and associated
with user created long point IDs.

1. Select an icon in the left pane.

2. Display a Search dialog box using any of the following methods.

Method 1

Click View>Search on the Workbench menu bar.
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Method 2

a. Right-click the mouse in the Workbench right pane.

b. Select Search on the Popup menu. 

Method 3

Click the Search button on the Workbench toolbar.

The Search dialog box associated with the selected icon appears.

A Search criteria. Enter one or more.

B Opens related browser window.

3. Enter the name or associated information for the record(s) or file that you want to display. What
format the information (records, files…) is in depends on what you select in the left pane.



Project Setup | 1 - Workbench | 34

The records or files you specify will display in the right pane until you change your specifications.

Find the Names of Records or Files to List

CIMPLICITY provides you with the appropriate search tool each time you need help qualifying what
records or files you want to list.

These tools include:

• Browse windows
• Workbench Explore tool

Browsers

Browse (page 548) windows are available for:

• Alarms
• Devices
• Points
• Ports
• Roles
• Resources
• Users

Workbench Explore Tool

The Workbench has an Explore tool for all search windows that request a file name.

1. Close the Search dialog box, if it is open.

2. Click Project>Explore on the Workbench menu bar.

A Windows Explorer window opens and displays the open project's directory.

3. Use the Windows Explorer to find the type of files you are looking for.
a. Open the folder that has the file you are looking for. For example, open the Screens folder

for CimEdit files.
b. Select the file to include in the Workbench's list.
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4. Place the Windows Explorer window next to the Workbench.

5. Open the Search (page 32) dialog box.

6. Type the name of the file in the Filename field.

The appropriate entry appears in the Workbench right pane.

Select Fields to Display in the Right Pane

Select Fields to Display in the Right Pane

There are one or more fields for any icon that, when displayed, help you determine exactly what an
icon represents. You can display as few or as many of these fields as you want in the Workbench's
right pane list.

The procedures for two steps to configure the Workbench right pane fields are:

Step 1
(page
35)

Open the Field Chooser dialog box using any one of several methods.

Step 2
(page
36)

Use the Field Chooser dialog box.

Step 1. Open the Field Chooser Dialog Box

1. Select an icon in the left pane.

2. Do any of the following to open the Field Chooser dialog box.

• Click View>Field Chooser on the Workbench menu bar.
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• Click the right mouse button in the right pane; select Field Chooser on the Popup

menu.

• Click the Field Chooser button  on the Workbench toolbar.

The appropriate Field Chooser dialog box opens when you use any of these methods.

Step 2. Use the Field Chooser Dialog Box

The Field Chooser:

• Enables you to select what fields will display in what order in the Workbench right-pane.
• Affects the Detail and Tree View.

• Field Chooser options
• Example: Workbench Right-Pane columns

Field Chooser Options

Field Chooser options are as follows.

Option Action/Features
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1 Available
Field

Select a field.

Note:  Fields listed in the Available Field column do not display in the Workbench right-pane.

The following button is available.

Add Moves the selected field to the Display Fields list.

2 Display
Fields

Select a field.

Note:  Fields listed in the Display Fields column display in the Workbench right-pane.

Example

A list of Display Fields for points might be:

• Point ID
• Short ID
• Resource
• Device ID
• Point Type
• Descriptions

The following buttons are available.

Move Up Moves the field with each click:

• Up one level in the list
• Left one column in the Workbench right-pane.

Note:  Disabled if the field:

• Is the first field on the list.

Move
Down

Moves the field with each click:

• Down one level in the list
• Right one column in the Workbench right-pane.

Note:  Disabled if the field:

• Must be the furthest left column.
• Is the last field on the list.

Remove Moves the selected field back to the Available Field list

Note:  Disabled if the field is required.

Example

The Point ID must display in the Workbench right-pane when Points is
selected in the left-pane.

3 OK/Cancel OK Closes the Field Chooser: saves the changes.

Cancel Closes the Field Chooser; does not save the changes.
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Example: Workbench Right-Pane Columns

The Workbench right-pane displays the Points fields, from left to right, in the order they are listed in
the Field Chooser (page 36) dialog box.

1 Point ID

2 Short ID

3 Resource

4 Device ID

5 Point Type

6 Description

Workbench Procedures for CIMPLICITY Projects

Workbench Procedures for CIMPLICITY Projects

The Workbench provides you with a powerful tool for handling projects.

Through the Workbench you can:

• Create a new project.

• Open a project.

• Start/stop a CIMPLICITY project.

• Switch to another running project using the same Workbench.

• Copy an existing project into a new project.
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• Rename a CIMPLICITY project.

• Drag and drop items from one project to another.

• Update a project (either when it is not running or dynamically).

• Insert a project shortcut in the Windows Start menu

Switch from One Project to another using the same Workbench

1. Click File>Running Projects List on the Workbench menu bar.

2. Select the project you want from the extended menu.

Note:  Only projects that are running display on this list. If no project is running, the
running Projects List option does not display on the File menu.

Rename a CIMPLICITY Project

1. Do one of the following to open the Project Properties dialog box.
• Click Project>Properties on the Workbench menu bar.
• Press Alt+P on the keyboard.

The Project Properties dialog box opens when you use either method.

2. Select the General tab.

3. Enter the new project name in the Project Name field.
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4. Click OK.

The project's name is changed. The new name displays on the Workbench title bar.

Drag Items from One CIMPLICITY Project into Another

Drag Items from One CIMPLICITY Project into Another

When you have two projects (and two Workbenches) open, you can select certain core items in one
Workbench and drag them into the other.

• Overview: Drag Items from one project to another.
• Example: Drag Device Points from a SOURCE to TARGET Project
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Overview: Drag Items from one Project to Another

The items you can drag from one open project to another are as follows.

Note:  The order in which these items are listed is the recommended order for dragging them
from one project to another.

• Security
◦ Resource
◦ Roles
◦ Users

guide:  Guidelines

1. The User Properties dialog box has a Resources tab so the appropriate resources can be
assigned directly to that user. Assigned resources are in the Configured box.

2. The Resource Definition dialog box lists all the users and categorizes them as Available
users or Users for this resource.

3. If the user does not yet exist in the target project when a resource is dragged over, the name
is not listed in the Resources dialog box.

4. When a user who is configured for a resource is dragged to the target, the resource in the
target project automatically lists him/her as Users for this resource.

Note:  If a resource is assigned to a user in the Users dialog box>Resources tab, but the
resource does not exist in the target project, dragging the user will fail.

• Equipment
◦ Ports cannot be dragged;  they must be configured in the target project; they cannot be

dragged over.
◦ Devices (except for the OPC Client and Proficy Driver Server devices)

Note:  Make sure the:
◦ Port in the target project has the same name (and device communication) as the port in the

source project.
◦ Device communication has been made available in the second project (Project Properties

dialog box>General tab>Protocols).

Even though devices can be dragged from one project to the other only part of the configuration
will be ported.

For example, some entries on the Device dialog box>General tab will be ported over; entries on
tabs that are specific to a device (e.g. the PrivPage tab for the S90 Triplex) will not be ported.

• Alarms
◦ Alarm classes
◦ Alarm strings cannot be dragged; they must be configured in the target project exactly as

they are configured in the source project.
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• Points

Points that are successfully dragged from one project to the next bring along associated alarms.

guide:  Guidelines

1. Create any associated items that cannot be dragged (e.g. alarm strings, devices) in the
second project before dragging the points.

2. Drag points  associated with the select point (e.g. safety points, point attributes, availability
triggers, points in a derived point's expression) before the selected point.

Note:  If a point's alarm class is not recognized, the point will be copied over if the
applications engineer confirms an error message; however, the alarm will not be configured
or listed. If the point is deleted and dragged again after the alarm class has been dragged
over, the alarm will be configured and listed as well as the point.

• Screens

Screens cannot be dragged from one project to another. However, they can be pasted into the
project's Screens folder in Windows Explorer and will display in the Workbench.

Note:  If the Workbench is open, press F5 on the keyboard to refresh the view.

Important:  Make sure the project includes all points, alarms and other features that the
screens require.

• Other features that can be dragged and dropped are:
◦ Classes
◦ Class objects

Example: Drag Device Points from a SOURCE to TARGET Project

An applications engineer needs to add S90 Triplex points to a TARGET project.

SOURCE TARGET
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A The points are already in a SOURCE project.

B The points are not in the TARGET project.

The applications engineer does the following.

1
(page

)

Enables
S90TRIPLEX
in
the
TARGET
project's
Project
Properties
dialog
box.

2
(page

)

Creates
an
S90
TRIPLEX
port
in
the
TARGET
project.

3
(page

)

Drags
the
Factory
resource
from
the
SOURCE
to
the
TARGET
project.

4
(page

)

Drags
the
Alarm
classes
from
the
SOURCE
to
the
TARGET
that
are
associated
with
the
TRIPLEX01
device
points.

unique_25_Connect_42_i1Enables
unique_25_Connect_42_i1Enables
unique_25_Connect_42_i1Enables
unique_25_Connect_42_i1Enables
unique_25_Connect_42_i2port
unique_25_Connect_42_i2port
unique_25_Connect_42_i2port
unique_25_Connect_42_i2port
unique_25_Connect_42_i3resource
unique_25_Connect_42_i3resource
unique_25_Connect_42_i3resource
unique_25_Connect_42_i3resource
unique_25_Connect_42_i4Alarmclasses
unique_25_Connect_42_i4Alarmclasses
unique_25_Connect_42_i4Alarmclasses
unique_25_Connect_42_i4Alarmclasses
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5
(page

)

Creates
Alarm
Strings
that
are
associated
with
the
TRIPLEX01
device
points.

6
(page

)

Drags
the
device
assigned
to
the
points
(TRIPLEX01)
from
the
SOURCE
to
the
TARGET
project.

7
(page

)

Clicks
OK
(to
copy
points
assigned
to
the
device).

Result
(page

)

1. Enables S90TRIPLEX in the TARGET project's Project Properties dialog

box.

unique_25_Connect_42_i5AlarmStrings
unique_25_Connect_42_i5AlarmStrings
unique_25_Connect_42_i5AlarmStrings
unique_25_Connect_42_i5AlarmStrings
unique_25_Connect_42_i6device
unique_25_Connect_42_i6device
unique_25_Connect_42_i6device
unique_25_Connect_42_i6device
unique_25_Connect_42_i7OK
unique_25_Connect_42_i7OK
unique_25_Connect_42_i7OK
unique_25_Connect_42_i7OK
unique_25_Connect_42_Result_
unique_25_Connect_42_Result_
unique_25_Connect_42_Result_
unique_25_Connect_42_Result_
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2. Creates an S90 TRIPLEX port in the TARGET project.

A port cannot be dragged from a SOURCE to a TARGET project; it has to be created in the
TARGET project.

3. Drags the Factory resource from the SOURCE to the TARGET project.

The selected device (TRIPLEX01) uses a resource named Factory. The TARGET project
requires this resource before the device can be dragged over.

SOURCE TARGET

Also drags required roles and users after the resources are in the target project.

4. Drags the alarm classes from the SOURCE to the TARGET that are associated with the
TRIPLEX01 device points.

Some of the Triplex device points have associated alarms, which include alarm classes; the
alarm classes can be dragged from the SOURCE to TARGET project.

SOURCE TARGET
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Hold down the Ctrl key to select more than one object.

5. Creates alarm strings that are associated with the TRIPLEX01 device points.

Alarm Strings cannot be dragged from a SOURCE to a TARGET project; the alarms strings
assigned to the point alarms need to be created in the TARGET project.

6. Drags the device assigned to the points (TRIPLEX01) from the SOURCE to the TARGET
project.

When all of the necessary features are dragged from the SOURCE project or created in
the TARGET project, the applications engineer drags the device from the SOURCE to the
TARGET.

A message opens reporting how many points are attached to the device and asking if the
attached points should be copied to the TARGET project.

7. Clicks OK (to copy points assigned to the device.)

When the applications engineer clicks OK, if the TARGET project has been set up correctly, the
device and points are copied to the TARGET project.
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Note:  If Cancel is clicked, the points can be copied over at a later time.

• The device is copied to the TARGET project.

SOURCE TARGET

• Points assigned to the device are copied to the TARGET project.

SOURCE TARGET

Message Examples: Dragging Objects from one Project to Another

CIMPLICITY has several built-in safeguards to insure that the dragged items will operate correctly
in the second project.

Messages for these safeguards include the following.

• If other points are associated with a dragged device, a message will ask if you want to copy
those items over also.

Example
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• If you accidentally drag the items to the wrong location, the items will not be copied. An error
message may report that the items cannot be copied.

Example

• If you drag an item that has associated items that you have not configured in the second project,
the items will not be copied and a message will explain why.

Example

• If points you are dragging already exist in the second project, a message will ask you if you
want to overwrite them.

Example

Drag Points into the Point Control Panel

Selecting several points to monitor during runtime has never been easier. You simply open a Point
Control Panel and drag your selections into it.

1 Open the Point Control Panel.

Important:  The project must be running to open the Point Control Panel.
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2 Select Points in the Workbench.

3 Select the points in the Workbench right pane that you want to monitor.

4 Drag the selected points into the Point Control Panel.

5 Release the right-mouse button.

CIMPLICITY displays runtime information for the selected points.
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Note:  CIMPLICITY does not duplicate any of the dragged points that already exist in the open
Point Control Panel

Monitor a Selected Point's Runtime Values

The Workbench gives you access to several CIMPLICITY features that keep track of a selected
point's runtime status and values.

Each of these features can be opened for a selected point in the Workbench.

1. Select Points in the Workbench's left pane.

2. Select the point in the right pane that you want to track.

3. Click the right mouse button.

4. Select one of the following:

Feature Displays

Point
Control
Panel

Point Control panel display the selected point (if you have user access).

Note:  Once opened, you can deal with the point  the same as you would any open Point
Control Panel.

Quick
Trends

Quick Trend chart that trends the selected point

Note:  You can then manipulate the chart, including changing the axis limits, line color and
add other lines.

*.cim
screens

Open a CimView screen that is associated with the point (Point Properties dialog box>View tab).
The screen name is listed on the Popup menu.

The object you select opens displaying at least the selected point's values.
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Record and File Configuration

Record and File Configuration

The CIMPLICITY Workbench provides you with an efficient environment in which to create or add
new components to your project.

You can also open any application that is associated with an icon in the left pane. For example, if you
use Microsoft Access as a database logger, you can open it directly through the Workbench.

You can open the associated New configuration application for any selected icon.

For You can open

Screens A new CimEdit screen

The following:

• Points
• Devices
• Ports
• Users
• Roles
• Resources
• Remote projects
• Clients

A related New dialog box

Project status log Notepad

System status log Microsoft Excel

Scripts Blank script window

Database Logger Database Logger Configuration window

Options Option window, e.g. Action Calendar

Create a New Record or File

You can add a new component to any icon in the left pane of your project through the Workbench.
When you do, you will see it listed as a record or file in the right pane when the icon is selected.

1. Select the appropriate icon in the Workbench left pane.
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2. Do any of the following:
• Double click the icon.
• Click File>New>Object on the Workbench menu bar.
• Press ALT+F+N+O on the keyboard.
• Press Ctrl+N on the keyboard.

A new screen or appropriate new dialog box opens when you use any of these methods.

Tip:  If you want to use only the keyboard, you can also press the Arrow Up and/or Arrow Down
key to select the icon in the left pane of the Workbench.

Open Records and Files

• Open a record or file for modification
• Popup menu items to open records and files

Open a record or file for modification

You can access any file, Properties dialog box or application in your project through the Workbench.

1. Select the associated application in the Workbench right pane.

2. Do one of the following to select the object to be changed or edited in the right pane.
• Click Edit>Properties on the Workbench menu bar.
• Select Properties.
• Right-click an object.
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A Popup menu displays with menu items that reflect the selected object.

Popup menu items to open records and files

Choose the menu item   For   To Open

Edit Screens CimEdit screen

Properties Points Properties – Point dialog box

Devices Device dialog box

Ports Port Properties dialog box

Users User properties dialog box

Roles Roles dialog box

Resources Resource Definition dialog box

Measurement Units Measurement Unit Configuration window

Event Editor Event Editor window

Alarm Sound Manager Alarm Sound Manager dialog box

Open Script Script window

Project status log Notepad

System status log Microsoft Excel

Database Logger Microsoft Access

Action Calendar Action Calendar

Print Feature Details

You can print the details that are listed in the Workbench right-pane for any selected features.

1. Select a feature (e.g. Alarms) in the Workbench left-pane.
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2. Optional:   (Optional) Click File>Print Preview on the Workbench menu bar.

A Print Preview window opens.

3. Do one of the following.
• When the Print Preview window is open:

◦ Click Print on the Print Preview window toolbar.
• When the Print Preview window is not open:

◦ Click File>Print on the Workbench menu bar.
◦ Press Ctrl+P on the keyboard.

A Print dialog box opens.

4. Select the options available for your printer.

5. Select the number of pages to print.

6. Click OK.
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CIMPLICITY prints the Workbench right-pane details for the selected feature.

Note:  You can also select File>Print Setup on the Workbench menu bar to open a Print Setup

dialog box and select default printer settings.



Chapter 2. New Project Creation

About New Project Creation

The following procedures are available to create a new project.

• Create a New Project
• Copy to a New Project

Create a New Project

Create a New Project

Steps to create an entirely new project include:

Step 1
(page
56)

Open a Create as dialog box to create a new project.

Step 2
(page
57)

Use the Create as dialog box for a new project.

Step 3
(page
59)

Begin entering project properties.

Step 1. Open a Create as Dialog Box to Create a New Project

Choose either:

• Click the New Project button  on the Workbench toolbar.
• Click File>New>Project on the Workbench menu bar.

The following window opens.
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1. Enter a user name. This user will have SYSMGR privileges.
2. Enter and confirm a password for the user. Beginning with CIMPLICITY 9.5 password

complexity is turned on by default for all new projects. See About CIMPLICITY passwords for
more details.

The Create as dialog box opens displaying the options for a completely new project.

Step 2. Use the Create as Dialog Box to Create a New Project

The New Project dialog box provides you with the tool to

• Enter the name and location of a new project and
• Select product options and protocols that will be included in the project.
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rect 351, 236, 377, 265  (page 58)
rect 170, 305, 196, 334  (page 58)
rect -1, 306, 25, 335  (page 58)
rect 69, 235, 95, 264  (page 58)
rect 25, 23, 51, 52  (page 58)

1 Use the Create in navigation field to select a directory in which CIMPLICITY will create the project.

2 Enter a unique project name in the Project field.

Important:

• The project name can contain up to 20 characters.
• The characters can be alphanumeric only.

Errors will be returned when this limitation is violated.

3 Check the Options and Protocols that will be enabled when the project is created.

You can change your selections whenever the project is not running.

4 Click Create.

A Project Properties dialog box opens.
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Step 3. Begin Entering Project Properties

1. Make as many entries in the Project Properties dialog box as you need to initially make.

Note:  Entries can be added or changed later (page 84).

2. Click OK.

The project is ready for additional configuration.
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Copy to a New Project

1. Click File>Copy to Project on the Workbench menu bar.
A Create as browser opens displaying the options to copy one project into another.

2. Do the following.

A Create
as

Select the location for the project copy.

B Project Name the project copy.

When you copy an existing project into a new project you only need to enter the name and
location of the new project. Be aware that:

• The project name can contain up to 20 characters.
• The characters can be alphanumeric only.

Errors will be returned when this limitation is violated.

C Create
button

Click Create.

The Workbench copies the existing project's entire configuration to the new project. You can now
open (page 61) the new project and work with it.



Chapter 3. Basic Project Management

Project Management

1
(page
61)

Open a CIMPLICITY project.

2
(page
64)

Update a CIMPLICITY project.

3
(page
72)

Log into a CIMPLICITY project.

4
(page
73)

Start/stop a CIMPLICITY project.

5
(page
76)

Select a running CIMPLICITY project.

1. Open a Project

1. Open a CIMPLICITY Project

1.1
(page
61)

Open a project through the Workbench

1.2
(page
63)

Open a project through the Start menu.

1.1 Open a Project through the Workbench

1. Do any of the following.
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A Click File>Open on the Workbench menu bar.

B Click the Open button on the Workbench toolbar.

C Press CTRL+O on the keyboard.

The Open dialog box opens for you to select the project you want to open.

2. Find and select the project you want to open.

3. Select the <project name>.gef file.

Example: Windows 7

The selected project opens in the Workbench.
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1.2. Open a Project through the Start Menu

• Start menu
• Project shortcut on the Start menu

Start menu

1. Click Start on a supported Windows version task bar.

2. Select (All) Programs>Proficy HMI SCADA - CIMPLICITY version.

3. Click the project you want to open.

Important:  You can add a shortcut for any of your projects to the Start Menu.

Result: The  selected project opens in the Workbench.
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Project shortcut on the Start Menu

The CIMPLICITY Workbench provides you with an easy way to place your project in the
CIMPLICITY Start menu. Once you do, a user can use the Start menu to open the project's
Workbench.

1. Click File>Install on the Workbench menu bar.
A Create Shortcut dialog box opens.

2. Select the folder (or create a new folder) in which you want the CIMPLICITY project to
display.

3. Click OK.

The project will display on the Start menu in the folder you selected.

2. Update a Project

2. Update a CIMPLICITY Project
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CIMPLICITY software configuration information is stored in files in the project's:

Master directory New configuration  is normally available for configuration functions, but not runtime functions.

Data directory New configuration is immediately available for runtime functions.

When you configure a feature in the project data is written to files in one or both directories as
follows.

Project state
Data is

written to the:
How written to

the Data Directory

2.1
(page
161)

Not running Master directory. Configuration update.

Running - Dynamic Configuration is
turned off.

Master directory. Configuration update.

2.2
(page
177)

Running - Dynamic Configuration is
enabled.

Master and Data
directories.

Dynamic configuration.

2.1 Configuration Update

2.1 Configuration Update

When you make a change in a project that is not running or is running with dynamic configuration
turned off, effected files in the Master and Data directory will be different. A configuration update
will copy the configuration from the Master directory to the Data directory so they are both the same
and the changes are applied to runtime.

2.1.1
(page
65)

Compare Master and Data configuration.

2.1.2
(page
70)

Update configuration.

2.1.1. Compare Master and Data Configuration

2.1.1. Compare Master and Data Configuration

Before doing a configuration update, starting with CIMPLICITY 7.0, you can review the differences
between the Master and data directory and undo unwanted changes.

Comparisons of the Master and Data configuration files can be reviewed whenever necessary.
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For example, if you:

• Have made several configuration changes and want to review those changes to make sure that
continuing configuration will be compatible. Based on the comparison you can set changes back
to the original state.

• Want to review the changes before you do a configuration update, which will overwrite the
original configuration.

Steps to compare data are as follows.

Step 2.1.1.1
(page
66)

Open a Directory Comparison report.

Step 2.1.1.2
(page
67)

Review the Directory Comparison report.

Step 2.1.1.3
(page
68)

Review a Comparison Report for a selected file.

Step 2.1.1.1. Open a Directory Comparison Report

• Open a Directory Comparison report at any time
• Open a Directory Comparison report  before a configuration update.
• Open a Directory Comparison report before starting a project.

Open a Directory Comparison Report at any Time

Do any of the following.

A Click Project>Compare Master and Data on the Workbench menu bar.

B Click the Compare Master and Data button.

C Press Alt+P+D on the keyboard.
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CIMPLICITY compares the project's Master and Data directories and opens the Directory
Comparison Report with details.

Open a Directory Comparison Report  before a Configuration Update

If Master and Data files are not identical when you start to do a configuration update (page 70) a
Configuration Update message box will open with a Compare button.

Click Compare.

CIMPLICITY compares the project's Master and Data directories and opens the Directory
Comparison Report with details.

Open a Directory Comparison Report before Starting a Project

If a project needs to be updated when you attempt to start (page ) it, a CIMPLICITY
Configuration message will warn you that the project is out of date.

The message is:

The master and runtime project configuration are out-of-date. Would you like to perform a
configuration update prior to starting the project?

Click Compare.

CIMPLICITY compares the project's Master and Data directories and opens the Directory
Comparison Report with details.

Step 2.1.1.2. Review the Directory Comparison Report

The Directory Comparison Report reports whether or not the project's Master directory files match
the Data directory files, as follows.

unique_47_Connect_42_Start
unique_47_Connect_42_Start
unique_47_Connect_42_Start
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1 The left column lists the files in the Data directory.

2 The right column reports the result of comparing each Master file with its Data file counterpart.

3 Files Differ reports differences in binary files. A configuration update is required to make them match.

4 Differences Exist alerts you that there are differences in the files. Double-click Differences Exist to open a detailed
comparison report for the selected file.

Step 2.1.1.3. Review a Comparison Report for a Selected File

• File report overview.
• Differences in selected rows.

File Report Overview

The comparison report for a selected file displays the contents of the Data and Master files side by
side.

The report includes the following.
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1 Difference X of N. Where

X = Identifies the sequential order of the selected line from the first Master and Data file lines that are different.

N = The total number of lines that are different when the Master file is compared to the Data file.

2 Navigation buttons are:

Prev Click to go to the previous line that is different.

Note:  If you click Prev when  the selected line is the first different line in the files, the Directory
Comparison Report list will display.

Next Click to go to the next line that is different.

3 Left column Rows in the Data directory file.

Right colum Rows in the Master directory file.

4 A row highlighted in red is the selected line.

5 Rows highlighted in yellow lines are different.

6 Rows with a white background are the same.

Differences in Selected Rows

The comparison between the Master and Data files is a line by line comparison, e.g. line 1 vs. line 1,
line 2 vs. line 2, etc.

The lines that display are the lines in the respective files.

Note:
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• Definition of the elements in a line are listed at the beginning of each section in the

file.
• If you decide that you do not want to keep any of the changes that you see in the report (where

a feature in the data file is different from the same feature in the Master file) go into the
Workbench and change the configuration back.

2.1.2. Update a Configuration

Do one of the following.

A Click Project>Configuration Update on the Workbench menu bar.

B Click the Configuration Update button  on the Workbench menu bar.

C Press Alt+P+C on the keyboard.

If the Master and Data files are identical, the Workbench will do a configuration update. Be aware
that Configuration Update is not available if the project is running.

2.2. Dynamic Configuration
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If your user role has been assigned the option, dynamic update option is an efficient way to make
certain changes in a project and have the project automatically updated.

Note:  When Dynamic mode is unavailable, or disabled, CIMPLICITY makes all configuration
updates to files in the project's Master directory. When configuration data is updated, the new entries
are immediately available to other configuration functions, but they are not normally available to
runtime functions.

The Workbench provides you with the option to enable Dynamic configuration.

Dynamic Configuration Functionality

CIMPLICITY supports the following dynamic changes:

Ports In Dynamic Update Mode you can modify the following fields:

• Description
• Scan rate
• Scan Units
• Retry Count
• Enable
• Enable Stale Data

Devices In Dynamic Update Mode you can modify the following fields:

• Description
• Resource
• Enable/Disable

Points In Dynamic Update Mode you can modify all fields except Delay load.

Classes Beginning with CIMPLICITY v10.0 , you can modify a class dynamically. You can also delete a class
dynamically if there are no references to the class or there are no object instances of that class with
composite references to the class.  

Remote
Projects

You cannot create or modify remote projects in Dynamic Update mode.

Dynamic Configuration Procedures

Do one of the following.

• Click the Dynamic Configuration button on the Workbench toolbar.
• Click Tools>Dynamic on the Workbench menu bar.
• Press Alt+T+D on the keyboard.

If a password is required a password dialog box will open when you use any of these methods. If
a password is not required or if you enter the correct password, you will be able to dynamically
configure the project.
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When you activate Dynamic Configuration, CIMPLICITY updates your project's configuration
automatically. You don't have to return to the Workbench and do a project update in order for your
changes to take affect.

3. Log into a CIMPLICITY Project

You have a great deal of flexibility in determining when and how users will log in to CIMPLICITY
software.

Note:  The CIMPLICITY Configuration Security (page 88) feature changes how the login
behaves. Briefly, if configuration security is activated, users are presented with a CIMPLICITY User
Login dialog box when they attempt to open a CIMPLICITY project.

In addition, they will only be allowed access to the CIMPLICITY applications for which their role is
assigned privileges.

 Guidelines for CIMPLICITY login include:

On a server, if you Then Users

A Define a CIMPLICITY user name and password that
match the user name and password users enter when
they log into supported Windows versions.

If the user is on:

• The same node as the project and the user name
matches a configured CIMPLICITY user

Then

the user will be automatically logged in.

• A different node

Then

automatic login will not occur.

B Define a CIMPLICITY user name and password that are
different from the user name and password users enter
when they log into supported Windows version systems.

Are presented with a CIMPLICITY User Login dialog
box when they attempt to open a CIMPLICITY project
or select a CIMPLICITY application (Alarm Viewer,
CimEdit, CimView, or CWSERV).

A Define common user names across all projects or Are automatically logged in to all projects when they
display a CimView screen that has points from remote
projects.
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On a server, if you Then Users

B Define different user names across projects. Have to log in to each of those projects when they
display a CimView screen that has points from remote
projects.

A Specify that remote projects are for resident processes
only or

Have to log in at the application level.

B Specify that remote projects are not for resident
processes only.

Are automatically be logged in and given the same
privileges as the CIMPLICITY User ID for the remote
login. See the "Remote Projects" section in the "System
Management" chapter in this manual for details.

If a User Then the User

Checks the Save Username + Password check box
when selecting any applications in the project

Will automatically be logged in to the project with the
saved user name and password.

A Opens a CIMPLICITY application while the login is
active, (The login remains active for a period after the
user exits all open CIMPLICITY applications. The length
of time is specified by the system manager or

Does not need to log in when an application is opened.

B Opens a CIMPLICITY application after the login period
has expired.

Needs to log in again.

On a Viewer, if a User: Then the:

Checks Reconnect at Startup. Viewer is automatically connected to the project used
by the application whenever CIMPLICITY software is
started on the viewer.

Checks Save Username + Password in the Login
dialog box.

User will be automatically logged into the project.

4. Start/Stop a CIMPLICITY Project

• Start a CIMPLICITY project.
• Stop a CIMPLICITY project.

Start a CIMPLICITY project

You can start a project using either of the following.

• Workbench
• Select a CIMPLICITY® Project dialog box

Important:  A maximum of 5 CIMPLICITY projects can be running concurrently on a
CIMPLICITY server.
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1. Do one of the following.

A Click Project>Run on the Workbench menu bar.

B Click the Run button on the Workbench toolbar.

C Press Alt+P+R on the keyboard.

A message box opens to confirm starting  the project, when you use any method.

2. Click OK.

The project starts running when you use any of these methods

Select a CIMPLICITY® Project dialog box

1. Open a runtime window, e.g. CimView, Point Control Panel.
If no project is running, a Select a CIMPLICITY® Project dialog box opens.

2. Do one of the following.
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Action Option Description

A Select a project. List Recently used or selected objects are listed.

Browse Click Browse to find and select a project that is not listed.

B Start the project. Start The project will run with  Server functionality.

Start as Viewer The project will run with Viewer functionality.

Note:  Click Cancel to cancel starting a project. If the window opens there will be no
runtime values. For example, a CimView window will open, but the screen will display black
instead of values.

Stop a CIMPLICITY project

1. Do one of the following.

A Click Project>Stop on the Workbench menu bar.

B Click the Stop button on the Workbench toolbar.

C Press Alt+P+S on the keyboard.

A message box opens to confirm that the project should be stopped, when you use any method.

2. Click OK.

The project stops.
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5. Select a Running CIMPLICITY Project

If you open a CIMPLICITY runtime tool, e.g. Point Control Panel, when more than one project is
running on the local server a Select project to connect dialog box opens with a list of the running
projects.

1. Select the project to connect.

2. Click Connect.

The runtime tool uses the selected project's runtime data.

In many tools you will be able to change or add selected running projects.

Example

The Select a Point browser is opened in the Point Control Panel.

• The Project field has a drop-down list of running projects that are both on the local server and
being broadcast on the network.

• Points for any project can be selected by an authorized user and added to the Point Control
Panel display.
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Technical Notes

Technical Notes

1
(page
77)

CIMPLICITY program layers.

2
(page
78)

CIMPLICITY project backup.

3
(page
79)

CIMPLICITY command line options.

1. CIMPLICITY Program Layers

A CIMPLICITY project has two layers of programs:

• User Application
• Resident Process

The User Application layer consists of the following programs:

• Alarm Viewer,
• CimView,
• CimEdit, and
• CWSERV.

These programs are started by user request and remain running until the user exits them.

The Resident Process layer consists of a set of programs that are started when you start your
CIMPLICITY project, and that remain running until your CIMPLICITY project is shut down.

If you are on a Server, the Resident Process layer includes such programs as the:

• Router,
• Device drivers,
• Point Management,
• Point Data Logger and,
• Alarm Management Resident Process.
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If you are on a Viewer, the only process running in the Resident Process layer is the Router.

2. CIMPLICITY Project Backup

Each CIMPLICITY project has several sub-directories associated with it.

The standard project sub-directories are:

Subdirectory Hold

alarm_help Operator Help files for alarms (that you created and put them in this directory).

arc Database Logger archive files.

data All the runtime configuration files.

lock The project lock file.

log All status log files, and program error files.

master All the master copies of configuration files.

screens All CimView screens (default directory).

scripts All Basic Control Engine scripts for a project.

 To make a backup copy of your project:

1. Open the Windows Explorer.

2. Locate the project directory for the project you want to back up.

3. Copy the project's directory to a CD or DVD.

Important:  If the project is running, some files in this directory may be locked and will not
be deleted.

If you try to back up a running project, an error message opens telling you there is a sharing
violation.
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3. CIMPLICITY Command Line Options

You can use the STARTUP.EXE command to start and stop local and remote projects from a
command prompt or through batch files.

• Display a startup Help message box.
• Require user authorization to start/stop CIMPLICITY projects.
• Auto-start/stop CIMPLICITY projects without user intervention.
• STARTUP.EXE and redundancy
• START.EXE [/STOP or -STOP] with no project named.

Display a startup Help message box

Use one of the arguments for STARTUP.EXE.

STARTUP.EXE [/HELP | /? | -HELP]

Example

STARTUP.EXE /HELP

A startup message opens displaying the STARTUP.EXE command line options.

Note:  If you type STARTUP.EXE with no qualifier at a command prompt and press Enter, a
CIMPLICITY Options dialog box opens.

Require user authorization to start/stop CIMPLICITY projects

CIMPLICITY provides start/stop project security to insure that only authorized users can start or stop
a project.

If one of the following STARTUP.EXE command line options is used when Start Stop (page 90)
security is enabled, a Log in dialog box opens to require a user name and password before the
specified project will start or stop.
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• For projects on the local server.

Type one of the following.

◦ STARTUP.EXE [/START|-START <project>]
◦ STARTUP.EXE [/STOP|-STOP <project>

Where

/START or -START starts the project.

/STOP or -STOP stops the project.

<project> is the path and project name.

Example

STARTUP.EXE /START E:\Projects\ECimp\ECIMP.gef.

• For projects on a remote server.

Type one of the following.

◦ STARTUP.EXE [/RSTART|-RSTART <project> <computer>]
◦ STARTUP.EXE [/RSTOP|-RSTOP <project> <computer>]

Where

/RSTART or -RSTART starts the project on a remote server.

/RSTOP or -RSTOP stops the project on a remote server.

<project> is the path and project name.

<computer> is the computer the project is on.

Example

STARTUP.EXE /RSTOP E:\Projects\ECimp\ECIMP.gef SERVER2

Auto-start CIMPLICITY projects without user intervention

The STARTUP.EXE command line option can allow plants that have batch files to auto-start
CIMPLICITY projects without user intervention, even when Start Stop (page 90) security is
enabled.

• For projects on the local server.
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Type one of the following.

◦ STARTUP.EXE [/START|-START <project>] [/USERID <user ID> /PASSWORD
<password>]

◦ STARTUP.EXE [/STOP|-STOP <project>] [/USERID <user ID> /PASSWORD
<password>]

Where

/START or -START starts the project.

/STOP or -STOP stops the project.

<project> is the path and project name.

/USERID calls the user ID.

<user ID> is the authorized user ID.

/PASSWORD calls the password.

<password> is a valid password for the user ID.

Example

STARTUP.EXE /START E:\Projects\ECimp\ECIMP.gef. /USERID ADMINISTRATOR /
PASSWORD enter

• For projects on a remote server.

Type one of the following.

◦ STARTUP.EXE [/RSTART|-RSTART <project> <computer>] [/USERID <user ID> /
PASSWORD <password>]

◦ STARTUP.EXE [/RSTOP|-RSTOP <project> <computer>] [/USERID <user ID> /
PASSWORD <password>]

Where

/RSTART or -RSTART starts the project on a remote server.

/RSTOP or -RSTOP stops the project on a remote server.

<project> is the path and project name.

<computer> is the computer the project is on.

/USERID calls the user ID.

<user ID> is the authorized user ID.
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/PASSWORD calls the password.

<password> is a valid password for the user ID.

Example

STARTUP.EXE /RSTOP E:\Projects\ECimp\ECIMP.gef SERVER2 /USERID
ADMINISTRATOR /PASSWORD enter

STARTUP.EXE and redundancy

If you are working with a redundant project use the:

• /START  and  /STOP  options for the active server.
• /  RSTART and  /  RSTOP options for the standby.

START.EXE [/STOP or -STOP] with No Project Named

STARTUP.EXE [/STOP or -STOP ] accepts a missing project file name.

If there is no file given then all projects running will be checked to see if the user can stop them as
follows.

Condition Startup.exe /stop will:

The Viewer only (i.e. Router) is running, Stop the Viewer (i.e. Router).

Two projects without Start/Stop Security
are running

Stop both projects and the Router.

Two projects are running:

• One with Start/Stop (page 90)
security.

• One without Start/Stop security.

Open a CIMPLICITY Login dialog box for the first project.

• Cancelling the log in results in no stops.
• Entering a valid log in will stop the first project, then the second and

finally the Router.



Chapter 4. Project Properties

About Project Properties

You can set several project wide properties in the Project Properties dialog box.

Step 1
(page
83)

Access the Project Properties dialog box.

Step 2
(page
84)

Set Project Properties.

Step 1. Open the Project Properties Dialog Box

Do one of the following to open the Project Properties dialog box.

A In Workbench, select Project, and then select Properties.

B
In Workbench, select the Project Properties button  on the Workbench toolbar.

C On the keyboard, enter Alt+P+P on the keyboard.

The Project Properties dialog box opens when you use any method.
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Step 2. Set Project Properties

Step 2. Set Project Properties

Option
2.1 (page
84)

Set project general properties.

Option
2.2 (page
85)

Set project options.

Option
2.3 (page
95)

Set project settings.

Option 2.1. Set Project General Properties
This topic describes the General tab on the Project Properties dialog box.

The General section of the Project Properties dialog box has the following options:



Project Setup | 4 - Project Properties | 85

rect 14, 45, 140, 80  (page 85)
rect 13, 104, 161, 244  (page 85)
rect 162, 104, 301, 248  (page 85)

Option Description

Project Name Enter the name of the project.

Important:  The project name should be different from the node name.

Options Displays both CIMPLICITY features and special options that are available for the project.

Protocols Displays the available device communication protocols.

Option 2.2. Set Project Options

Option 2.2. Set Project Options

This topic describe project options. It also includes security and priority expanded definitions.

Project Options Defined

The Options section of the Project Properties dialog box has the following options:
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Option Description

Description Brief description of option setup.

Enable
project
broadcast

If Enable project broadcast is checked, a project description will be sent out in a project broadcast.
Enables broadcast of the project name to all computers on the network. When you broadcast the project
name, users on other nodes that request point data can use the project name in fully qualified points.
Otherwise, they can only use the node name in fully qualified points.

Important:  Do not enable broadcasting for two projects with the same name.
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Option Description

Enable
project
multicast

Allows traffic sent once to be received and processed by multiple interested IP hosts, regardless of
their location on an IP Inter-network. A host listens for a specific IP multicast address and receives all
packets sent to that IP address. IP multicast is more efficient than IP unicast or project broadcast for
one-to-many delivery of data.

• Unlike unicast, only one copy of the data is sent.
• Unlike broadcast, multicast traffic:

◦ Is only received and processed by computers that are listening for it.
◦ Can potentially go through routers, bridges, bridge routers across the LAN to some other

network.

CIMPLICITY viewers will listen for both project Broadcast and Multicast. The default Multicast address
is 224.0.0.29.

CAUTION:  When multicasting is checked to operate across a LAN, several network factors that
are outside of CIMPLICITY must be configured correctly, e.g. the network router needs to be capable
of and configured to allow multicast. Therefore, it is strongly recommended that you consult the network
administrator before selecting this option.

Note:  If this is a redundant project then the Broadcast option will be selected and the user will not
be able to select the Multicast option.

Use this IP
address

(Enabled if either Enable project broadcast or multicast is checked)

The IP address that will be used in project broadcast/multicast can be entered in the Use this IP
address field; this is used if you want to restrict the project announcements to only one IP address.

Note:  The drop-down list contains IP addresses that are selected for use on the Network tab in the
CIMPLICITY Options dialog box. The field is writable; an IP address that is not in the list can be entered
manually.

Computer
name

Name of the computer that is to run on when the project is started. Available computers are listed in the
Computer name field's drop-down list. For all installations, you may run the project on your computer.

Startup
timeout

Number of minutes in the Startup timeout field that CIMPLICITY should wait for the project to start
before it times out. The default is 10 minutes.

Configuration
security

Restricts user configuration access to any or all of CIMPLICITY's applications.

Run at high
priority

CIMPLICITY project processes can run at a high priority. This prevents CIMPLICITY processes from
being interrupted by lower priority user processes or configuration processes. As a result, CIMPLICITY
processes can focus on gathering data from the devices and processing it.

Enable
concurrent
equipment
port process
startup

During full project starts, all device communication processes start, instead of waiting for any initiated
device communication processes to complete their startup.

Allow
configuration
auto login for
trusted client
users

(Enabled if Configuration security is selected) Allows user configuration access to any or all of
CIMPLICITY's applications for trusted client users.
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Option Description

Allow web
configuration
for this
project

Registers this project for web configuration.

Security and priority expanded definitions

Option
2.2.1 (page
88)

Configuration security for  a project.

Option
2.2.2 (page
90)

Start, stop project security.

Option
2.2.3 (page
93)

Run a project at high priority.

Option 2.2.1. Configuration Security for a Project

• Configuration security configuration.
• Configuration security runtime.

Configuration security configuration

1. In the Project Properties dialog box, in the Options tab, select Configuration security.
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A Configuration tab is added to the Role Properties dialog box. Users with roles configuration
privileges can specify what applications users assigned to each role can configure after they log
in to the project.

Important:  In order to ensure that configuration is only performed by users who have the
privilege, configuration security requires a manual login even if Windows Authentication is
used and Allow Auto Login is selected.

2. Check the privileges a role can have when configuration security is enabled.
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Configuration security runtime

1. When you try to access Workbench, a Configuration Login dialog box is

displayed.

2. If your role has not been granted Workbench privileges, you will be denied access.

Option 2.2.2. Start, Stop Project Security

• Start, stop security configuration.
• Start, stop security enabled.

Start, Stop Security Configuration

Starting and stopping a project can be limited to users who have the authority to make those
decisions for the selected project. This includes users who access the project both locally and
remotely.

1. In the Project Properties dialog box, in the Options section, select Start stop security.
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2. Close the Project Properties dialog box.

3. In Workbench, in the left pane, expand the Security folder.

4. Select Roles.

5. Double-click a role that will be able to start and/or stop the project.
The Role properties dialog box opens for the selected role.

6. Select either the Start Project or Stop Project check box or both.
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A Start Project Users who are assigned this role can start this project.

B Stop Project Users who are assigned this role can stop this project.

Note:  Make sure that at least one user is assigned a role that has Stop Project privileges.

Note:  When the Start, stop security check box is clear in the Project Properties dialog box,

the Start project and Stop Project check boxes are disabled.

Start, Stop Security Enabled

A user may do any of the following to start a project:

• Use Workbench functionality
◦ Toolbar Run button
◦ Project>Run menu item
◦ Ctrl+R keyboard

• Access a CimView screen.
• Log in to a project through the Alarm Viewer
• Start a project on the Projects tab in the CIMPLICITY® Options dialog box.
• Open any or the following

◦ Point Control Panel
◦ Process Control
◦ DGR
◦ Recipes

When Start, stop security is enabled a Start project dialog box opens.

Fill in both fields.
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User ID User ID for a user who is authorized to start the project.

Password User's password.

Option 2.2.3. Run a Project at High Priority

• Run all processes at high priority.
• Run a single process at high priority.

Run all processses at high priority

Running CIMPLICITY project processes at high priority prevents CIMPLICITY processes from
being interrupted by lower priority user processes or configuration processes.

In the Project Properties dialog box, in the Options section, select Run at high priority.

CIMPLICITY processes can focus on gathering data from the devices and processing it.
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For CIMPLICITY v.5.5 and greater:

Checking Run at high priority will

• Make the project processes run at a high priority, which can be verified in the task manager.
• Configures a project global parameter called HIGH_PRIORITY which should be set to Y to

enable the project to run at high priority.

For CIMPLICITY v. 5.0x:

• If you are still using CIMPLICITY 5.0x, you can change the processes behavior by setting the
HIGH_PRIORITY global parameter.

Run a single process at high priority

A priority for a single process can be changed from Normal to High.

1. Open a Command Prompt window through the Workbench.

2. Type  CD master

3. Press Enter on the keyboard.

4. Type  idtpop node_logproc

5. Press Enter.

6. Type  notepad node_logproc.idt

7. Press Enter on the keyboard.
The  node_logproc.idt  file opens in Notepad.

8. Change a process priority from 20 to 128.



Project Setup | 4 - Project Properties | 95

9. Close Notepad.

10. Type  scpop node_logproc  at the command prompt.

11. Restart the project.

If the global parameter is not set, only that process will run at a higher priority.

Option 2.3. Set Project Settings
This topic describes the Settings tab on the Project Properties dialog box.

This section enables you to enter general settings for each application on the displayed list of
applications.

1. Select the application whose settings you want to modify.

2. Click Settings.
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A dialog box that applies to your selection opens.

Setting Function

Alarms Alarm Properties

Database Logger Logging Properties

Event Editor (Event Editor) Setup

Measurement Units Activate Measurement System

Points Point Setup

Users User Setup

Option 2.4. Set Project Change Management Properties
This topic describes the Change Management tab on the Project Properties dialog box.

Change Management Tab

The Change Management section of the Project Properties dialog box has the following options:
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Enable Change Management

Select the Enable Change Management check box to enable Change Management for the active
CIMPLICITY project.

Clear the check box to disable Change Management for the active CIMPLICITY project. This does
not affect enabling Change Management for the computer project.

Note:  When Change Management is enabled for a CIMPLICITY project, the project’s
Configuration Security option on the Options section is automatically selected and made read-only.
Change Management can be enabled for both a running and a stopped project.

Enter the Server Name

Enter the name of the Change Management server that the user will be using to authenticate/log in to
Change Management.

Test the Connection
Select Test connection to confirm that the selected Change Management server is available and can
connect to the project.

A Change Management Logon dialog box opens. Enter an authorized user name and password.

One of the following will occur depending on the project/Change Management Server status:
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• The connection is successful. A message opens and reports: The change management server
connection test succeeded.

• The connection fails. A message opens and reports: Unable to connect to change management
server <Change Management server> with user <User Name>. Server unreachable or not found.

If the connection failed, check with the Change Management system administrator to correct the
problem.

Requirement for logging into the Change Management server depends on the following.

Change Management Logon

Logon at Workbench startup/Prompt for user name and password. If Change Management is enabled
for the CIMPLICITY project, configuration security is enabled.

Other factors that determine if and when a user needs to log in to PCM include whether the following
values are set to Yes or No.

• Allow Configuration Auto Logon in the Windows Authentication dialog box.

Note:  If Allow Configuration Auto Logon is not selected, logging in options/requirements are
the same as if the Windows Authentication login is invalid.

• Prompt Username/password.

• PCM Workbench Start.

If Allow Configuration Auto Logon is selected in the Windows Authentication window options and
requirements for Change Management logon are as follows.

Windows Logon for CIMPLICITY Windows Logon for PCM

Valid Valid

THEN IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Auto Workbench Start

PCM Logon

Prompt Username/Password Yes / No Manual / Auto

PCM Workbench Start Yes / No Workbench Start / PCM Open
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Windows Logon for CIMPLICITY Windows Logon for PCM

Valid Invalid

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Auto Workbench Start

PCM Logon

Prompt Username/Password Yes / No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM Open

Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Valid

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Manual Workbench Start

PCM Logon

CIMPLICITY Login is Valid PCM Login

Prompt Username/Password Yes / No Manual / Auto

PCM Workbench Start Yes / No Workbench Start / PCM Open

CIMPLICITY Login is Invalid PCM Login

Prompt Username/Password Yes / No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM Open

Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Invalid

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Manual Workbench Start

PCM Logon

CIMPLICITY Login is Valid PCM Login

Prompt Username/Password Yes / No Manual /Auto

PCM Workbench Start Yes / No Workbench Start / PCM Open

CIMPLICITY Login is Invalid PCM Login
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Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Invalid

Prompt Username/Password Yes /No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM Open

Change Management Project Name
It is strongly recommended that the Name of the project in Change Management be the same as the
CIMPLICITY project name.

The default name is the name of the local project.

When you first log in, if the project does not exist in Change Management, the project is created.

No files are added to the project except when specifically requested by you.

Require Checkout Before Changes

Do one of the following.

Option Description

Select
Requires that an entity be checked out of Change Management before it can be edited.

A message reminds you that:

You are required to check out the project before you can modify it.

Important: If a project is being managed, you must add the entity and check out the entity before making
any changes.

Enabling this feature provides the highest level of integration with Change Management.

If the project is not checked out, you cannot perform a configuration update when trying to start the project.

Certain managed files, e.g. CimEdit screens (*.cim) and scripts (*.bcl), may be edited even when Require
checkout before changes is checked and the files are not checked out. However, the edited file can only be
saved using the File>Save as option either:

• to an unmanaged folder.
• with a different name than the managed entity in the managed folder.

(File>Save as the managed entity name to a managed folder is not allowed.)

The new saved as version will not be managed. The managed version will be the original version before it
was edited.

Note: When a new file is created, it is not managed until it is added. The unmanaged file can be edited no
matter where it it located until it is added.

Clear An entity does not have to be checked out of Change Management to be edited and saved.
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Allow changes when the server is not available

Do one of the following.

Option Description

Select Allows changes when the Change Management server is not available.

Clear
Does not allow changes when the Change Management server is not available.

Important: If Require Checkout before changes is selected, configuration changes will not be possible if
the Change Management Server is not available.

Important:  If this feature is selected, make sure a Project Compare is performed when the
Change Management server is available. The report will aid you to check modified entities into the
Change Management server so they will not be lost.

Example

1. Allow changes when the server is not available is selected.
2. A CimEdit screen, TANK750, is not checked out.
3. TANK750 is enhanced with new graphic and text objects reporting additional point values.
4. The following is done so these changes will be preserved:

• TANK750 is checked out. Don't overwrite local files with managed copy is checked.
• TANK750 is checked in.

The TANK750 screen modifications are now preserved in the PCM server.

Preserve runtime configuration data on fetch (passwords and alarm setups)

The Preserve runtime configuration data on Fetch options dictate how the runtime data will be
handled.

Alarm (filter setup) and passwords.
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Option

Result
when

the base
configuration

is
fetched

Prompt
1. A Save

Configuration
Data
dialog
box
opens
with
check
box
entries
for
each
of the
configuration
data
that
has
changed.
The
dialog
box
opens
before
any
of the
following
processes
are
completed:
Fetch,
Check
out,
and
Get
latest
version.
Note:
Currently
the
configuration
data
includes
passwords
and
alarm
setups.

2. Select
the
configuration
data
that
you
want to
preserve.
Passwords
that
were
specified
as
valid
after
the
checkout
continue
to be
valid.
If you
are
logged
in with
a new
password,
you
can
continue
the
configuration
with no
interruptions.
New or
modified
alarm
setups
are
preserved.

3. Select
one or
more
of the
following.



Project Setup | 4 - Project Properties | 103

Option

Result
when

the base
configuration

is
fetched

OK

Cancel

Select All

Clear All

Yes
Passwords
that were
specified
as valid
after the
checkout
continue
to be valid.
If you are
logged in
with a new
password,
you can
continue
configuration
with no
interruptions.

New or
modified
alarm
setups are
preserved.

When
the base
configuration
is checked
into
Change
Management,
the file will
be checked
in with the
current
valid
passwords.
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Option

Result
when

the base
configuration

is
fetched

No
The file
with the old
passwords
is fetched
from
Change
Management
and
overwrites
the file with
the new
passwords.

The new
passwords
are no
longer
valid.

You will
have to
re-enter
the old
password
and, in
instances
where
a new
password
is required,
you will
have to
enter
the new
password
in order to
continue
configuration.

When
the base
configuration
is checked
into
Change
Management,
the file will
be checked
in with the
passwords
that were
specified
as valid
after the
checkout..
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Select OK to continue. If the project has already been added to the Change Management server, a
message opens and reports: Change Management project <project name> already exists on the Server
<Change Management server>. Do you want to replace the project?

Select one of the following.

Button Description

Yes
Change Management maps your CIMPLICITY project to the existing Change Management project.

The local project is now managed.

Note: The project (version) that was replaced is still on the Change Management server and can be
retrieved, if necessary.

No
The local project is

Not added to the Change Management server.

Not managed.

If the project is new on the Change Management server:

• The Change Management server maps a place for the Change Management project.
• The project is now managed.

Note:  The project or entities in the project that should be managed still need to be added to the
Change Management server.

Enable Enhanced Auditing

When the enhanced auditing check box is selected, CIMPLICITY will put entries in the Change
Management audit log when a point is added, modified or deleted.

The audit entries include the:

• Point.
• Action.
• User who performed the action.

Important:  This feature will have a performance impact when bulk operations are performed on
large numbers of points so it is best to enable it after the main provisioning stage of the project and
more in the maintenance stage

A global parameter, PCM_ENH_AUDIT, is added when you select Enable Enhanced Auditing.

Perform a Workbench configuration update after you select/clear the check box
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Option 2.5. Set Project OPC UA Server Properties
This topic describes the OPC UA Server tab on the Project Properties dialog box.

OPC UA Server Tab

Select or clear the Enable Server check box to enable or disable the OPC UA Server.

Note:  Enabling the OPC UA server uses more system resources and has an impact on
CIMPLICITY's performance. This option is disabled by default.

UA Endpoints Configuration

1. Under Endpoint, enter or confirm your information in the Port, Network Address, and Logical
Host Name fields.
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2. Once the data is entered, you can view how these fields affect the data in the Endpoint URL,
Server URL, and Server Name fields. The port field is configurable from 1025-49151 and
is reflected in the Endpoint URL as the value changes. The Network Address accepts the
machine name, an IPv4 address, or an IPv6 address. If you enter "[NodeName]," then the
field will be replaced with the machine name at server runtime. This field only affects the
corresponding place holder in the Endpoint URL. The Logical Host Name must be of valid
DNS hostname syntax but doesn't need to be a machine that is actually online. This field
affects the corresponding place holders in the Server URLI and Server Name. If any of the
fields have incorrect values, a message box will appear and explain the syntax error. Any
subsequent changes made to the project name will be reflected in the three fields without
manual modification.

3. Select OK to save the data to the ServerConfig.xml file.

Security Configuration
Select one or more security configurations from which you can choose when you configure your
endpoints.

From the OPC UA Server section of the Project Properties dialog box, select Security Configuration
to open the Security Configuration dialog box.

Select the check boxes for the security policies and modes you want the server to support. If you do
not select any of the check boxes, a message box will appear indicating that at least one of the check
boxes must be selected.
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Select OK to save the data to the ServerConfig.xml file.

Logging Configuration
The logging UI enables you to modify the following nodes in ServerConfig.xml:

• UaAppTraceMaxEntries: The number of lines per log file (range is from 1-500000)

• UaAppTraceMaxBackup: The number of files for log backups (range is from 1-255)

• UaAppTraceFile: Location of the log file to be used

• UaStackTraceLevel: Possible values are NONE, ERROR, WARNING, SYSTEM, INFO,
DEBUG, CONTENT, and ALL

• UaAppTraceLevel: Possible values are NoTrace, Errors, Warning, Info, InterfaceCall, CtorDtor,
ProgramFlow, and Data

NOTES:

• You can enter a path to a log file manually. In this case, the file will be generated by the
OPC UA SDK automatically, given the proper permissions, and the path to the file will be
created. If the file cannot be created, no log file will be used during runtime. You can also enter
"%SITE_ROOT%\log" as a directory prior to the file if you would like the log file to be placed
in the project's "log" directory.

• Select Reset to set the path of the log file to the last saved path.
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• The trace levels (log levels) are ranked in the list by ascending log level; in other words,
ERROR will create fewer log entries than ALL for the Stack Trace Level.

• These changes are made visible in ServerConfig.xml when you select OK on the Project
Properties dialog box (not when you select OK on the current dialog box).

Refer to the Troubleshooting section of the CIMPLICITY OPC UA Server for more information
about Trace Levels.

Option 2.6. Set Project Web HMI Properties
This topic describes the Web HMI tab on the Project Properties dialog box.

You can configure the Web HMI server for data communication between
CIMPLICITY and Web HMI. The Web HMI options are as follows:

Option Description

Server name The machine name on which Web HMI is running or the URL of the Web HMI Server.

Port The port on which Web HMI is running.

User name The Web HMI user name used to establish the connection.
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Option Description

Test Connection Select to ensure connectivity between CIMPLICITY and the Web HMI server.

Require trusted connection Select to use a trusted connection.

View Certificate Select to view the certificate used for the connection.

Option 2.7. Set Project Historian Properties
This topic describes the Historian tab on the Project Properties dialog box.

If you added Historian as part of your project setup, the Historian tab is visible. If not, you can select
one or both of the Historian check boxes that appear in the list on the General tab.

• If you select the Historian OPC Interface check box, the Historian Data Server is enabled.

• If you select the Historian OPC A & E Interface check box, the Historian Alarm Server is
enabled.

Select the Historian tab and complete the fields as described below.
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For the Historian data and alarm connections:

1. In the top section, enter the name of your Historian Data Server and in the bottom section, enter
the name of your Historian Alarm Server.

2. In each section, enter the Historian username and Historian password used to access your
Historian Data Server and Historian Alarm Server, respectively. If these are not entered
correctly, the logging will fail. These entries are not always required. Instances where an entry
should be made include the following: the Historian Server and users who log into that server
are different from the CIMPLICITY Server and user, or a user who is logged into the Historian
Server may not have all of the privileges required to manage logging CIMPLICITY data. An
entry in this field can specify a user with administrator privileges.

3. The CIMPLICITY user name is automatically populated from your project.
4. Enter the corresponding CIMPLICITY password. Note that privileges may differ between the

Historian user and the CIMPLICITY user.
5. Retain the default Tag name convention or identify a new one. For information, see the Tag

naming convention section.
6. Select Test to test your connection to the Historian server. One of the following messages

appear:

Test Result Message

The Historian server is incorrect or not available. Failed to connect to the Historian server.

Historian does not recognize the user name or
password.

The configured user does not have permission to write to
Historian.

Connection succeeds. Connected to the Historian server.

When the Test button is clicked, global parameters related to Historian Server information (e.g.
HISTDATASERVER, HISTDATAUSER, HISTALMSERVER) are created with appropriate values.

(Optional) SelectMigrate Datato open the Historian Migration Utility and migrate data in SQL
databases to Historian. The Historian Migration Utility is also available through the CIMPLICITY
Database Logger. For the Historian Data Server only, select or clear the Overwrite check box to do
the following.

• Select the check box to overwrite tag descriptions that already exist in Historian.

• Clear the check box to keep the tag descriptions that already exist in Historian.

Important:  You can revise tag definitions, e.g. data type, in Historian. However, if Overwrite
is selected, the changes will be overwritten when the Historian log is updated. However, collection
criteria are not overwritten.

Dlcfgui.chm::/dlcfg_ui/ProficyHistorianMigration.htm
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Tag Naming Convention

An example of the current Historian tag name displays the Tag Name field. This naming convention
can be changed.

CAUTION:  If tags have previously been imported into Historian, changing the tag naming
convention will result in duplicate tags, tags with the old naming convention and tags with the new
naming convention.

Example
The Historian tag name convention was changed for CIMPLICITY points that had been previously
imported into Historian. The same CIMPLICITY points are listed as two separate tags in Historian.

 Select the Open button to the right of the Tag Name

field to change the displayed naming convention. 
The Historian Tag Naming Configuration dialog box opens and displays the following options:
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Item Description

Default Native
Collector Format

The default Native Collector format is available to help Historian users who used the Native
Collector, which is not supported by CIMPLICITY v7.5 and higher.

When Default Native Collector Format is selected, Historian will use the Native Collector naming
convention, which was

<PROJECTNAME>.<POINTNAME>.VALUE

Where:

<PROJECTNAME> is the name of the CIMPLICITY project that the point is in.

<POINTNAME> is the CIMPLICITY point name.

A read-only naming convention preview displays for a sample point in the Tag Name field.
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Item Description

Default OPC
Collector Format

When Default OPC Collector Format is selected, Historian will use the OPC Collector format as the
naming convention for migrating CIMPLICITY points.

The OPC Collector format is:

<MACHINENAME>.\\<PROJECT NAME>\<POINTNAME>.VALUE

where:

<MACHINENAME> is the Historian server.

<PROJECTNAME> is the name of the CIMPLICITY project that the point is in.

<POINTNAME> is the CIMPLICITY point name.

A read-only naming convention preview displays for a sample point in the Tag Name field.

Custom Format
(Default)

When Custom Format is selected, the entire naming convention can be customized and applied as
the official Historian tag naming convention.

The convention is divided into a prefix and suffix, as follows.
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Item Description

Prefix
The default Prefix text for a Historian tag name is <MACHINENAME>.\\<PROJECTNAME>

where:

<MACHINENAME> is the Historian server.

<PROJECTNAME> is the name of the CIMPLICITY project that the point is in.

Text can be entered instead of or in addition to the <MACHINENAME> and <PROJECTNAME>
parameters.

Note: Select the Popup Menu button to the right of the Prefix field to select and automatically enter
either parameter.

The following should not be included in the prefix: * ? Spaces

If the text in the Prefix field is empty then the prefix for the tag name will be the CIMPLICITY point
name only.

Example

The following example describes how a Historian tag name is constructed when the Prefix field is
blank.

• Prefix: Blank
• Suffix: .<PROJECTNAME>.<MACHINENAME>.VALUE. Important: Include the . character

where it should be included in the Historian tag name.
• Point: SAMPLEPOINT
• Tag Name: SAMPLEPOINT.PROFCIMP.HISTSERV.VALUE. Where the sample tag name

parts are as follows: SAMPLEPOINT, PROFCIMP, HISTSERV, VALUE
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Item Description

Suffix The default Suffix text for a Historian tag name is .VALUE.

The parameters <MACHINENAME> and <PROJECTNAME> can be used in the suffix instead of or
in addition to being used in the prefix.

Note: Select the Popup Menu button to the right of the Prefix field to select and automatically enter
either parameter.

The following should not be included in the suffix.

* ? Spaces

If the text in the Suffix field is empty, then the suffix for the tag name will be the CIMPLICITY point
name only.

Example

The following example describes how a Historian tag name is constructed when the Suffix field is
blank.

• Prefix: VALUE. Important: Include the . character where it should be included in the Historian
tag name.

• Suffix: Blank.
• Point: SAMPLEPOINT
• Tag Name: VALUE.SAMPLEPOINT

Option 2.8. Set Project Redundancy Properties
This topic describe project options. It also includes security and priority expanded definitions.

In this section, you can communicate to the primary server where files and screens can be sent, and
collect data (after a failure) from the secondary server.

Note:  To view the Redundancy section, in the Project Properties dialog box, in the General tab,
select the Server Redundancy option.
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Option Description

Computer name Enter the name of the secondary server.

Project path
Enter the directory on the secondary server where the CIMPLICITY project will be stored.

• (Recommended) A UNC path, e.g. \\SERVER2\Redund.
• A mapped drive on the primary server.

NOTE: UNC file names are supported.

NOTE: A mapped drive may not be a valid configuration in some situations.



Chapter 5. CIMPLICITY Options

About CIMPLICITY Options

CIMPLICITY software supports running multiple projects on a single computer.

Step 1 (page 118) Open the CIMPLICITY� Options dialog box.

Step 2 (page 120) (Optional)  Set projects options.

Step 3 (page 123) (Optional) Select Startup options.

Step 4 (page 128) (Optional) Configure automatic log out.

Step 5 (page 135) (Available with more than one IP address) Configure Network IPs.

Step 6 (page 138) Identify host nodes and IP addresses.

Step 7 (page 138) Configure Broadcast Sessions.

Step 8 (page 146) Integrate with Windows Firewall.

Administrator privileges required. (page 147)

Note:  If you have a web server installed, you can use the Broadcast Sessions tab to allow
CIMPLICITY to serve up broadcast sessions that generate PNG files on a periodic basis containing
the contents of specified CIMPLICITY screens. More information

Step 1. Access the CIMPLICITY Options Dialog Box

CIMPLICITY provides several methods to open the CIMPLICITY® Options dialog box.

• Workbench
• Startup Menu

Workbench

Do one of the following.
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A Click Edit>Properties  on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C Right-click Options in the Workbench right-pane; select Properties on the Popup menu.

D Press Alt+Enter on the keyboard.

Start Menu

1. Click Start on the Windows Task bar..

2. Select (All) Programs>Proficy HMI SCADA - CIMPLICITY version>CIMPLICITY Options.

The CIMPLICITY® Options dialog box opens when you use any method.
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Step 2. Set Projects Options

Select the Projects tab in the CIMPLICITY® Options dialog box.

Options are as follows.
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Connect to another computer as a Server.

2
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Connect to CIMPLICITY Projects as a Viewer.
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Stop a running project.

4
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Add a project to the projects list.

5
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Start a project in the projects list.
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6
(page

)

Delete a project from the list.

1. Connect to another Computer as a Server

Select a computer in the Computer name drop-down list to which your computer has access and is
currently running CIMPLICITY software.

Note:  If the computer name does not appear in the list, type it in the Computer Name field and
click Connect.

The projects that are currently running on the selected computer display in the Running Projects
field.

2. Connect to CIMPLICITY Projects as a Viewer

1. In the CIMPLICITY Options window, select the Projects tab.

The tab displays the local computer in the Computer name field.

2. Click Start Viewer.

The router starts and VIEWER appears in the Running projects box.

The Computer name field now has computer names to which the local computer has Viewer
access.

3. Select another computer from the new Computer name drop down menu.

Note:  If you type in the computer name click Connect to connect to the computer.

unique_90_Connect_42_i6Delete
unique_90_Connect_42_i6Delete
unique_90_Connect_42_i6Delete
unique_90_Connect_42_i6Delete
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Projects that are running on the selected computer appear in the Running projects box. You can now
view them through CimView.

3. Stop a running project

You may stop any project that is currently running on the computer to which you are currently
connected as a server.

1. Select the project in the Running projects list.

2. Click Stop.
If you are connected as a server, a confirmation message opens.

3. Click Yes to confirm that you want to proceed with the shutdown.

After the project is stopped, CIMPLICITY removes the name from the Running projects list.

4. Add a Project to the Projects List

1. Click Add.
The Open dialog box opens.

2. Use the Open dialog box to search for the project (.gef) file you want.

3. Click OK.

The project you select is added to the Projects list.

5. Start a Project in the Projects List

1. Select the project.
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2. Click Start.
3. Verify that you want to start the project.

The project you select is started. When startup is complete, CIMPLICITY adds the project name to
the Running projects list.

6. Delete a project from the Projects List

You can delete any project from the list and disconnect it from your computer.

1. Select the project in the Projects list.

2. Click Delete.
A confirmation message opens.

3. Click Yes to confirm that you want to proceed with the deletion.

After the project is deleted from the list, CIMPLICITY removes the name from the Projects list.

Step 3. Set Startup Options

Step 3. Set Startup Options

In CIMPLICITY you can select:
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Option
3.1 (page
124)

Select network options.

Option
3.2 (page
125)

Configure system boot options.

Option 3.1. Select Network Options

1. In the CIMPLICITY Options window, select the Startup Options tab.

2. Do one of the following:

• Check Accept connections.

The local computer can connect to all other projects in the enterprise. Other computers can
connect to running projects on the local computer.

Important:  Accept connections is disabled when the license configuration for your
current CIMPLICITY version is invalid. Check your license configuration to correct this; if
you are upgrading this includes making sure that you added the upgrade license number to
your configuration.

If Accept connections is disabled the Allow Compression check boxes do not save their
information.

• Select Accept connections and Use secure sockets.

The local computer can connect to only other secure projects in the enterprise. Only secure
computers can connect to running projects on the local computer.

• Clear both Accept connections and Use secure sockets.

The local computer will not connect to other projects in the enterprise. Other computers in
cannot connect to projects running on the local computer.

3. Do one of the following.
• Select Allow compressed connections.

Compressed connections reduce the bytes that travel from one server to another. This can
help speed up communication for some types of networks.
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However, compression also increases CPU usage both for the sender and receiver. See the
Compression value explanation below.

• Select Allow uncompressed connections.

Communication occurs over the network according to its normal configuration.

• Select Allow uncompressed connections and Prefer compressed connections.

Communication will attempt to form a compressed transmission before an uncompressed
transmission.

If you are considering compression you can balance speed vs. CPU use by setting the
Compression value.

0 No compression

1 Least compression and least CPU usage 

9 The highest compression and highest CPU usage. 

The default is 6.

Option 3.2. Configure System Boot Options

• Automatically start a project.
• Automatically launch a CimView screen.
• Completely automatic startup.

Automatically start a project

1. In the CIMPLICITY Options window, display the Startup Options tab.

2. Check one of the following:

When
Checked

At boot Up

None CIMPLICITY does not start running on the local computer. Boot up configuration is done.

Viewer The CIMPLICITY router starts running and the local computer can act as a Viewer. However, no
local CIMPLICITY projects start running. Boot up configuration is done.
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When
Checked

At boot Up

Start
projects

Selected projects start running. Go to 3 in this procedure.

3. Click Add.

The CIMPLICITY Default Project dialog box opens.

4. Select a project from the project list.

Note:  Select Browse to find projects that are not in the drop down list.

5. Click OK.

The project displays in the Start projects box.

6. Add all the projects you want to start at boot up.

Note:  If there are no projects in the list, only the Router starts.

CIMPLICITY follows your specifications when the local computer boots up.
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Note:  To delete a project from the list, select the project, and click Delete. The project is
removed from the list.

Automatically launch a CimView screen

To automatically launch a CimView screen on project startup, use one of the following methods.

If you start a:

• Viewer

Creating a shortcut  to CimView in the Startup group using the command line argument /wait.  

cimview /wait [time] <pathname>

Where:

time is an optional parameter that specifies the number of seconds to wait for the router to start,
and

<pathname> is the fully qualified path of your Cimview .CIM screen file.

Tip:  If the project is installed on a local node, assign a specific time, e.g. 60 seconds.

Example

CimView.exe /wait 60

C:\Program Files\Proficy\Proficy CIMPLICITY\Projects\Cimpdemo\Screens

\TicTacToe.cim

• Start projects

For local projects only:

Creating a shortcut  to CimView in the Startup group using the command line argument /
waitforproject.  

cimview /waitforproject <projectname> <pathname>

Where:

<projectname> is the name of the project associated with this screen, and

<pathname> is the fully qualified path of your Cimview .CIM screen file,

Example
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CimView.exe /waitforproject cimpdemo

C:\Program Files\Proficy\Proficy CIMPLICITY\Projects\Cimpdemo\Screens

\TicTacToe.cim

Note:  Other alternatives exist for launching Cimview when screens when your project
starts:

◦ Add the project associated with that screen to the list of projects (see step 6 above). In that
project, configure an action to run a script that launches the screen. Configure the an event
to trigger that action (Run Once) on project startup. Or,

◦ Do not add the CimView screen's project to the list above, but instead create a shortcut  to
CimView on the Windows Desktop using the command line argument /Autostart.

cimview /Autostart <pathname>

You can then double-click the desktop shortcut to launch the screen with it's associated
project.

Completely automatic startup

It is possible to start Windows with an automatic user log in. This configuration requires a change
to Windows registry settings which should only be done with great caution and after making a
complete backup  (system, database and project files). See Microsoft's online resources (http://
msdn.microsoft.com) for more information on this subject. Use the Search feature on their web page,
specifying the exact phrase "Automatic Logon" to find the relevant topics quickly.

Step 4. Configure Security Options

Step 4. Configure Security Options

You can help CIMPLICITY runtime users save resources by enabling automatic log out for a:

• CIMPLICITY Viewer.
• Terminal Services session.

Automatic logout will log the user out if there is no mouse or keyboard activity for a specified
number of minutes. Based on the configuration selection, the user can be only logged out, prompted
to log back in, or logged in as another user.

Automatic logout works the same as manually using the login panel to log out and in again.
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Auto logout

1. In the CIMPLICITY Options window, select the Security tab.

2. Fill in the following details:

Check
Box/Field

Description

Enable Auto
logout

Select to enable auto log out.

Wait Number of minutes there is no activity (e.g. no mouse or keyboard movement) before the
select auto log out option takes effect.

3. Select an auto log out option.

Option
4.1 (page
130)

Log Out of CIMPLICITY

Option
4.2 (page
132)

After Logging out prompt for login

Option
4.3 (page
133)

After logging out log in this user

Webspace Directory Whitelist

The Webspace Directory Whitelist allows you to configure specific UNC network directories. In
a Webspace session, CimView can use these network directories to load screens. For example, to
maintain all the screens for the dependent servers on a common file server, you must add a UNC path
to each Webspace server.
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Use the following buttons to update the Webspace Directory Whitelist:

Button Description

Add Select to specify the network directories whose CimView screens can be opened remotely by
CimWebServer.

Edit Select to edit a specific network directory.

Remove Select to remove a specific network directory from the Webspace Directory Whitelist.

Data Execution Prevention

Be aware of the following:

All of CIMPLICITY's DLLs and executables are marked to prevent code execution on data pages.
This is a security measure to prevent buffer overruns.

By default, the Enable DEP check box is selected and the CimEdit and CimView binaries are
secured.

A few ActiveX controls developed with VB 6.0 do not work with versions of CimEdit and CimView
that are enabled with DEP. To use these ActiveX controls, clear the Enable DEP check box.

Note:  You require administrator privileges to enable or disable DEP.

Option 4.1. Log Out of CIMPLICITY

Check Log out of CIMPLICITY

Runtime behavior is as follows.



Project Setup | 5 - CIMPLICITY Options | 131

1. A user:
• Opens a runtime application, e.g. Alarm Viewer
• Logs into CIMPLICITY.

2. The application is enabled.

3. If the user allows the machine to sit idle for the specified Logout idle time.
• The runtime application stops running.
• The user is automatically logged out of CIMPLICITY.
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Option 4.2. After Logging out Prompt for Login

Check After logging out prompt for login.

Runtime behavior is as follows.

1. A user:
• Opens a runtime application, e.g. Alarm Viewer
• Logs into CIMPLICITY.

2. The application is enabled.
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3. If the user allows the machine to sit idle for the specified Logout idle time.
• The runtime application stops running.
• The user is automatically logged out of CIMPLICITY.

4. A CIMPLICITY Login dialog box opens for the user to log back in.

Option 4.3. After Logging out Log in this User

1. Check After logging out log in this user.
2. Enter a Username and Password.
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The entered user will be logged in automatically, when it is necessary, during runtime

Runtime behavior is as follows.

1. A first user:
• Opens a runtime application, e.g. Alarm Viewer
• Logs into CIMPLICITY.

2. The first user allows the machine to sit idle for the specified period of Wait time.
a. The first user is automatically logged out of the runtime application.
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b. The second (entered (page 134)) user is automatically logged in.

Note:  The application will enable only the features for which each user has privileges.
Therefore, if the first and second user are assigned to different roles, the application may
provide different functionality when the second user is automatically logged in.

Step 5. Select Network IP Addresses

The Network tab:

• Displays if you have more than one IP address on your computer.
• Lists the currently used IP addresses.
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• Supports listening to multiple IP addresses for incoming connections to form an outgoing
connection.

Configuration includes the following.

rect 2, 64, 140, 191  (page 136)
rect -1, 191, 176, 218  (page 137)
rect 212, 62, 245, 89  (page 136)
rect 244, 69, 368, 185  (page 136)
rect 152, 126, 238, 153  (page 136)
rect 152, 101, 238, 128  (page 136)

1
(page
136)

Available IP addresses

2
(page
136)

Used IP addresses

3
(page
137)

Enable cabling redundancy

1 Available IP addresses

IP addresses that are available but are not selected to be listened to for incoming connections.

Adds selected IP addresses to the Used IP addresses box.

2 Used IP addresses

Listed IP addresses are listened to for incoming connections. If an IP address has an incoming
connection it may be used to form the outgoing connection.

Moves selected IP addresses back to the Available IP addresses box. The removed addresses will no
longer be listened to for incoming connections.
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3 Enable cabling redundancy

Cabling redundancy is very specific.

Two paths only are available between computers. These two paths are used continuously. Therefore,
if one cable is pulled communication continues to go over the other path.

Checked Cabling redundancy is enabled.

Default Cabling redundancy is clear.

Important:

• If you check Enable cabling redundancy 2 IP addresses (and only 2) are required in the
Available IP addresses box.

If there are more than two addresses, a message will display when you attempt to leave the tab
telling you that:

You need to select two IP addresses in order to use cabling redundancy.

This message may also display the first time you select the Network tab if your computer has
more than two available IP addresses.

1. Click OK.
2. Either clear Enable cabling redundancy or select two IP addresses for use.

• When using cabling redundancy, enter the remote host IP addresses and names in the
CimHosts.txt file.

CimHosts.txt is located in .the.[CIMPLICITY install path]\etc directory.

A sample file is located in that directory as follows.
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Step 6. Identify Host Nodes and IP Addresses

1. Enter a Host name in the name field.

2. Click OK.

3. Edit the Host name.

4. Click OK.

5. Enter an IP address in the address field.

6. Click OK.

7. Edit the address.

8. Click OK.

The IP address displays in the Address list when the associated Host is selected.

Step 7. Configure Broadcast Sessions

Step 7. Configure Broadcast Sessions

A broadcast session provides you with the means to broadcast a CIMPLICITY screen to an unlimited
number of users who can view it from remote locations. The screen that users view is a pre-
designated read-only screen. They cannot select any buttons or perform screen transfers or any other
interactive operations. However, if, for example, 1000 remote operation persons need to review the
performance of a system's processes, they can by using a broadcast session to view the CIMPLICITY
screen that reports the processes. In terms of the CIMPLICITY license, only one session is running.
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The Session Properties window provides you with the tools to specify what CIMPLICITY screen
will display during each broadcast session and configure display details.

Steps to configure the broadcast session include:

• Step 7.1. Display the CIMPLICITY Options Broadcast Sessions Section (page 139)
• Step 7.2. Open a Session Properties Window (page 139)
• Step 7.3. Define the Files for the Broadcast Session (page 141)
• Step 7.4. Define Broadcast Session Display and Accessibility (page 142)
• Step 7.5. Define Broadcast Session Update and Refresh Rates (page 143)
• Step 7.6. Specify if the Broadcast Session should start automatically (page 145)
• Step 7.7. Enter CimView Options (page 146)

Step 7.1. Display the CIMPLICITY Options Broadcast Sessions Section

1. Access the CIMPLICITY Options window: from the Windows menu bar select Start, or select
(All) Programs > HMI SCADA - CIMPLICITY, and then select CIMPLICITY Options.

2. In the Workbench left-pane, select Computer>Options.
3. Double-click Options. The CIMPLICITY Options window appears.

4. Select the Broadcast Sessions tab. 

Step 7.2. Open a Session Properties Window
Use these steps to create a new session or open an existing one.

Create a new session

In the CIMPLICITY Options window, in the Broadcast Sessions section, select Add.
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Result: A blank Session Properties window appears

Edit an existing session

From the list of Broadcast sessions, select a session. Select Properties.

Result: The Session Properties window for the selected session appears.
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Note:  You can add as many non-running broadcast sessions to the list as you want. A session
is included in licensed sessions when the broadcast session is running. When the purchased license
quota has been filled, the next broadcast session that you attempt to run will not start.

Step 7.3. Define the Files for the Broadcast Session

When a selected CimView screen is viewed during a broadcast session, it is a read-only file.
The .cim file is converted into graphics output, which is stored in a .png file that you name. An
HTML file then displays the graphics output through a web browser.

Item
Number

Field Description

1 CimView
screen Name and location of the .cim screen that generates the graphics file during the broadcast

session.

Browse opens a Find CimView screen window to find and select the screen.
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Item
Number

Field Description

2 Output
file Name and location of the .png file that will hold the graphic output and display the graphics

through a Web Browser.

Browse opens a Find PNG window to find and select the screen.

Default: The selected .cim screen name.

If you do not specify a location, WebView Standard places the file in the ...\Program Files
\Proficy\Proficy CIMPLICITY\WebPages\WebView directory.

If you do not enter a file name, a user can view the .png file through the Web browser.
However, the screen will not refresh itself since the refresh rate is specified in the HTML
template. The user will need to enter the .png extension when entering the URL.

3 HTML
file

Automatically created file that displays the graphics through the browser.

4 HTML
template Used to create the HTML file.

Default: refresh-IE5-template.html

This template specifies the rate at which the Web browser will collect and display a new copy
of the graphic file. Whether the new copy is different from the previous depends on the update
rate specified in the Session Properties window (see Step 2) and, if the CimView screen has
changed.

You can use this template, modify it, or create your own.

Refresh-template.html is located in the

C:\Program Files\Proficy\Proficy CIMPLICITY\WebPages\WebView\template\Broadcast folder.

Step 7.4. Define Broadcast Session Display and Accessibility
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Field Description

1 Width and
Height Width and height resolution

Tip: Use resolutions that correspond to screen resolutions, for example, 800 x 600 or 1024
x 768.

You can leave either the Width or Height box blank to assign only one size constraint to the
user's session. You cannot leave both boxes blank.

Default: 640 x 480.

2 Color palette
The number of total possible colors that should be displayed.

Choices include:

256 colors (default)

65536 colors

True color

Caution: The higher the resolution you choose, the larger the file will be.

Default: 256

3 Username and
Password If the CIMPLICITY project requests a user name and password.

CimView requires the entries to work.

If a user name and password are not entered, broadcast will not work.

Step 7.5. Define Broadcast Session Update and Refresh Rates

The frequency with which a broadcast session updates and refreshes a view depends on how often
the:

• Broadcast copy of CimView updates the image
• Browser (the HTML page) requests a refresh. The HTML page is generated from the following

template files: Refresh-IE5-template.html, Refresh-template.html
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Item Field Description

1 Update rate Number of seconds WebView should wait between screen rewrites in the field.

2 HTML template
Name of the HTML template that Broadcast uses to request the refresh rate.

The Update rate is specified in the template.

Refresh Rate in the HTML template

1. Open the templates in the ...\Program Files\Proficy\Proficy CIMPLICITY\WebPages\WebView
\template\Broadcast folder.

2. Edit either refresh-template.html or refresh=IIES-template.html.

Item Description

A Refresh rate line in Refresh-template.html (seconds).
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Item Description

Example

<META HTTP-EQUIV="Refresh" CONTENT="10; URL=$CIMHTMLFILE">

10=Seconds

Example

10 could be changed in the line to 20.

<META HTTP-EQUIV="Refresh" CONTENT="20; URL=$CIMHTMLFILE">

B Refresh rate line in Refresh-IE5-template.html (milliseconds)

Example

Refresh-IIES-template.html

window.setTimeout("reloadIt()", 10000);

10000=Milliseconds

Example

10000 could be changed in the line to 100000.

window.setTimeout("reloadIt()", 100000).

Step 7.6. Specify if the Broadcast Session should start automatically

You can start the broadcast session manually or specify that it should start when the WebView server
starts.

Field Description

Start automatically Starts the broadcast session when the WebView server starts.
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Note:  If the total number of running user and broadcast sessions equal the number of purchased
licenses, the broadcast session will not start. Instead, the Running column on the Broadcast Sessions
tab will be blank even if the WebView server is running.

Step 7.7. Enter CimView Options

Field Description

CimView options
Additional command line options can be passed to CimView.

Supported command line options include:

/project

/offline

/loadScript

/loadCache

/TouchDyn

/TouchStat

/TouchActive

Step 8. Integrate with Windows Firewall

The Firewall section in the CIMPLICITY Options window has been introduced to integrate
applications with Windows Firewall.
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CIMPLICITY Options obtains the list of applications that needs to be integrated with Windows
Firewall from the firewall_cim.ini file.

Administrator Privileges Required

One or more tabs in the CIMPLICITY® Options dialog box require you to run the Workbench
as administrator. Exactly what tabs require this depends on the operating system and your system
configuration.

Messages include the following.
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You need administrator privilege to configure the items on this
page

Unable to open SC Manager.

The following two options are available to access these features.

Run as Administrator

1. Right-click the Workbench in the Windows Start menu>Proficy HMI SCADA - CIMPLICITY
9.5 section (or Start Page).

2. Select Run as administrator on the Popup menu.
The CIMPLICITY Workbench opens.

3. Open the CIMPLICITY project through the Workbench.

Windows administrators will have access to the CIMPLICITY Options dialog box for the session
that the project is opened using Run as administrator.

Note:  If you use this method frequently, create a Workbench shortcut on your desktop.

Set Local Security

1. Open the Local Security Policy window.

2. Do the following.
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a. Expand Local Policies in the Local Security Policy window left-pane.
b. Select Security Options.
c. Right-click User Account Control: Run all administrators in Admin Approval Mode.

3. Check Disabled on the Local Security Setting tab.

4. Click OK.

Windows administrators will have access to the CIMPLICITY Options dialog box tabs whenever it is
opened.



Chapter 6. Workbench Point Display

About the Workbench Point Display

The Workbench provides you with a central location in which you can:

• Customize the point list display in your project.
• Display selected fields associated with the points.

Note:  You can also use the Workbench to monitor runtime behavior, to include:

• Opening the Point Control Panel to monitor and control runtime point behavior.
• Displaying a Quick Trend chart for a selected point.

Customize the Point List in the Workbench

Customize the Point List in the Workbench

You can display, in the Workbench right pane, a list of:

• All of the points in your project
• Selected points.

Display all Points in the Workbench

1. Select Points in the Workbench left pane.

2. Automatically display all the points in the Workbench right-pane using either of the following
methods.
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A Click View on the Workbench menu bar; select Auto-Fill if there is no check mark on its left side.

B Click the right mouse in the Workbench right-pane; make sure Auto-Fill is checked.

CIMPLICITY displays a list of all the existing points when you use either method.

Note:  Points with a  $  as the first character in the name are system points and cannot be changed
or removed.

Display Selected Points in the Workbench

1. Select Points in the left pane.

2. Display a Search dialog box using any of the following methods.
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A Click the Search button on the Workbench toolbar.

B Click View on the Workbench menu bar; select Auto-Fill if there is no check mark on its left side.

C Click the right mouse in the Workbench right-pane; make sure Auto-Fill is checked.

The Point search dialog box opens when you use any method.

3. Enter one or more of the following

• An existing Point ID
• Device ID, Resource and/or Point Type
• Description in a point's Properties dialog box>General tab>Description field.

Wild Card Characters to Find Points in the Workbench

Wild cards can help you filter your display even if you do not know the exact name for the criteria
you are using. Use either a * or a ?.

Enter a * in the following positions: when you enter any search criteria:

*Position static to Entered Characters Display Any Points that:

After Begin with the entered characters, e.g. F_ Tank*

Before End with the entered characters, e.g. *Tank

Between Begin and end with the entered characters, e.g. F*1 Enter
a ? to display any points that contain the characters you
enter, in addition to one character per ?, in the position
that the ? is entered, e.g. ?_Tank?

The point or points you specify will display in the right pane until you change your specifications.

Display Selected Fields in the Workbench

• Select fields to display in the Workbench.
• Field selection.
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Select Fields to Display in the Workbench

There are one or more fields for points that, when displayed, help you determine exactly what a point
represents. You can display as few or as many of these fields as you want in the Workbench's right
pane list.

Note:  Two useful fields that display the point status are:

Needs Update… Displays a one (1) if a point configuration has changed and the project needs a configuration update.

Modified Displays the date when the point was last modified

Field Selection

Use the Field Chooser dialog box to select the point fields that will display in the right pane of the
Workbench.

1. Select Points in the left pane.

2. Use any of the following methods to open the Field Chooser dialog box.

Method 1

a. Click the right mouse button in the right pane.
b. Select Field Chooser… from the popup menu.

Method 2

a. Click View on the Workbench menu bar.
b. Select Field Chooser.

Method 3

Click Field Chooser on the Workbench toolbar.

The Field Chooser dialog box for points opens when you use any of these methods.

A Fields that will not display.
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B Fields that will display.

C Add/Remove Fields to and from the display list.

D Moves a selected field further left in the pane.

E Moves a selected field further right in the pane.

F Accept/cancel changes in the display list.

Point Field Definitions in the Workbench

Most of the field names state exactly what the field is. However, for reference, following is a brief
explanation of all the fields available for display.

Field To Display

Access
Filter

"E" if the point is an Enterprise point.

Address Actual starting address of the point within a device (for device points)

See the CIMPLICITY Device Communications documentation for details on the addressing supported for
your particular device and protocol.

Address
Offset

Offset in memory from the first bit of the point

Address that marks the start of the point data (for device points).

Alarm High High alarm value for the point

Alarm Low Low alarm value for the point

Data
Length

Data length associated with the data type chosen.

Data Type
ID

Point type used for the point from one of the following values:

0 Boolean type point

1 Integer type point

2 APPL type point

3 Text type point

4 Unsigned 8-bit integer type point

5 Unsigned 16-bit integer type point

6 Unsigned 32-bit integer type point

7 Signed 8-bit integer type point

8 Signed 16-bit integer type point
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Field To Display

9 Signed 32-bit integer type point

10 Floating point type point

Description Brief information about the point.

Device ID Source of the point data with one of the following values: <device name>–The name of the device that is
supplying the point data.

$GLOBAL Indicates that the point is a Global derived point.

$DERIVED Indicates that the point is a Calculated derived point.

Display
Format

Format used for the point in CimView.

Display Limits Options If no limits are set for an expression when there is horizontal/vertical movement,
rotation/fill or horizontal/vertical scaling in CimView and a point is the single point used in the expression:

Display Limits Upper and lower limits

Display Limits High Upper limit

Display Limits Low Lower limit

Elements Number of elements that make up a point. A number greater than one (1) means the point is an array
point.

Has EU Identifies whether or not Engineering Units (EU) conversion is being done for the point

Displaying either:

0 No EU conversion.

1 Linear or custom conversion is enabled.

Log to DB 1 Point will be logged to the default CIMPLICITY DATA_LOG database.

0 Point will not be logged to the default CIMPLICITY DATA_LOG database

Log to
Historian

1 Point will be logged to Historian.

0 Point will not be logged to Historian.

Modified Displays the date when the point was last modified.

Need
Update

Displays either:

0 The project is up to date.

1 The point has been modified and the project needs a configuration update.

Point
Class

Class selected for the point; displays one of the following:

0 Analog class

1 Digital class
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Field To Display

3 Text class

4 Application class

Point
Origin

Origin of the point, displays one of the following:

0 Calculated derived point

1 Device point

2 Global derived point

Point Type Type of point (e.g. UINT, INT).

Resource Resource associated with the point.

Warning
High

High warning value for the point.

Warning
Low

Low warning value for the point.

Note:  The Remove button will be disabled if the field is required. The Move Down or Move Up
button will be disabled if a field that will be affected by the move has to appear in the furthest left
position.



Chapter 7. Points

About Points

Point configuration can be divided in the following categories

• Device point only configuration.
• Virtual point only configuration.
• Device and virtual point configuration (Alarms, View, limits, enumeration, conversion).
• Point and alarm change approval.
• Point technical reference.

CIMPLICITY collects or calculates point data that it distributes to:

• CimView screens that are configured in CimEdit.
• Alarm Viewer screens.
• Alarm printers.
• Logging tables.

• Other CIMPLICITY software options

The Workbench provides the following icons to access Point configuration components in addition to
the Point Properties dialog box.

Note:  Click a Point icon to display related documentation.
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rect 28, 115, 52, 134 Open a Point Properties Dialog Box (page 158)
rect 47, 132, 70, 150 About Point Attributes (page 359)
rect 48, 147, 70, 167 Step 3. Select Point Conversions and Enumeration (page 259)
rect 48, 165, 70, 183 About Point Cross Reference (page 431)

The collection and distribution of point data is handled by the Point Management subsystem. Point
Management's primary functions are to:

• Update the point database as point values change.
• Generate point alarms when limits are exceeded.
• Make point data available to CIMPLICITY software applications.
• Synthesize new point values by arithmetically combining other points.

New Points

Review details about creating a new:

• Device point
• Virtual point

Open a Point Properties Dialog Box

Open a Point Properties Dialog Box
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Option
1 (page
159)

Open a New Point Dialog Box

Option
2 (page
160)

Open an existing Point Properties dialog box.

Option 1. Open a New Point Dialog Box

CIMPLICITY provides several methods to create a new point.

1. Select Project>Points in the Workbench left pane.

2. Do one of the following.

A Click File>New>Object on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Points. a. Right-click Points.
b. Select New on the Popup menu.

D a. In the Workbench right pane:
a. Right-click any point.
b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

A New Point dialog box opens when you use any method.

Fill in the New Point dialog box to create one of the following.
• Device point (page 161)
• Virtual point (page 195)
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Important:  A point may be added only if the current point count is less than the licensed
point count. Contact your CIMPLICITY representative if you need to increase your licensed
point count.

Option 2. Open an Existing Point Properties Dialog Box

CIMPLICITY provides several methods to open an existing Point Properties dialog box.

1. Select Project>Points in the Workbench left pane.

2. Select a point in the Workbench right pane.

3. Do one of the following.

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:
a. Right-click Points.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click a point. a. Right-click a point.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

The Point Properties dialog box for the selected point opens.
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Point Properties Dialog Box General Tab

Review the general configuration for:

• Device points. (page 164)
• Virtual points. (page 177)
• Data item basic configuration.

Device Points

Device Point Only Configuration

Device points read from and/or write to devices.

Once you have attached a device to a server and you can create points to communicate back and forth
for monitoring and control purposes.

Following are steps that apply only to device point configuration.

Step 1
(page
161)

Create a new device point.

Step 2
(page
164)

Enter device point general properties.

Step 3
(page
177)

Enter device point device properties.

Continue
(page
250)

Device and virtual point configuration

Note:  CIMPLICITY provides you with a Manual Mode feature that enables a user to disconnect
a point's values from a device and set them manually.

Step 1. Enter Specifications for a new Device Point

1. Open (page 159) a New Point dialog box.

2. Enter the following specifications for a new device point.
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rect -3, 25, 26, 48  (page 162)
rect -3, 50, 23, 75  (page 162)
rect -4, 118, 21, 142  (page 163)

A
(page
162)

Point ID

B
(page
162)

Device type

C
(page
163)

Class

A Point ID

Unique name (page 338) that identifies the point.

Maximum Length: 256 characters

B Device type

Check the Device radio button to select device as the Type.

Options for selecting the device are as follows.

Option Description

Field Entered device will be associated with the point.
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Option Description

Opens a Select a Device browser. The selected
device is entered into the field.

Displays a device Popup menu.

• Browse: Opens the Select a Device
browser

• Edit: Opens a device's Properties dialog
box if a device is entered in the field.

• New: Opens a New Device dialog box to
create a new device.

• Devices: Previously selected devices can
be quickly selected for the new point.

C Class

Point classification dictates what the data type can be selected.

Options are:

• Analog
• Boolean
• Text

3. Click OK.

The new point's Point Properties dialog box opens.
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Step 2. Enter Device Point General Properties

Step 2. Enter Device Point General Properties

General Point Properties configuration is both basic and advanced.

Step 2.1
(page
165)

Enter device point basic general specifications

rect -3, 14, 22, 36 Step 2.1. Enter Device Point Basic General Properties (page 165)

Step 2.2
(page
170)

Enter device point advanced general specifications.

rect -4, 8, 23, 36 Step 2.2. Enter Device Point Advanced General Properties (page 170)
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Step 2.1. Enter Device Point Basic General Properties

The device point's data type choices are on the General tab of the Point Properties dialog box. The
data type choices available to you for a device point depend on the type you selected when you
created it.

Basic general specifications include the following:
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rect 288, 98, 312, 125  (page 170)
rect 169, 97, 193, 124  (page 168)
rect 30, 99, 54, 126  (page 166)
rect 0, 54, 24, 81  (page 166)

1
(page
166)

Description

2
(page
166)

Data type

3
(page
168)

Elements (in an array)

4
(page
170)

Read only

1 Description

(Optional) Enter a Description up to 80 characters.

This description:

• Displays when you position the cursor over the point in the Workbench
• Can be entered in the Point browser when you want to find and display or use the point

2 Data type

Select one Data Type from the drop down list that displays for the point type you selected:
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The Data Types are:

• Analog device points.
• Boolean device points.
• Text device points.

Analog device points

Data Type Description

3D_BCD 3-digit binary coded, 2 byte (16 bits) unsigned integer ranging from 0 to 999.

4D_BCD 4-digit binary coded, 2 byte (16 bits) unsigned integer ranging from 0 to 9999.

DINT 4 byte (32 bit) ranging from -2,147,483,648 to + 2,147,483,647.

INT Integers ranging from -32,768 to +32,767.

QINT 8-byte (64-bit) signed integer ranging from -9223372036854775808 to + -9223372036854775808.

REAL Floating-point numbers.

SINT Integers ranging from -128 to +127.

UDINT Unsigned integers ranging from 0 to 4,294,967,295.

UINT Unsigned integers ranging from 0 to 65,535.

UQINT 8-byte (64-bit) unsigned integer ranging from 0 to +18446744073709551615.

USINT Unsigned integers ranging from 0 to 255.

Note:  Values read from or written to a device point will be forced into the specified type.

Example

Reading an SINT point value, which is 8-bits, from a 16-bit register will truncate the high order byte,
and the sign will not be maintained.

Writing an INT point, which is 16-bits, to an 8-bit register will do the same.

Boolean device points
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Data Type Description

BOOL A one digit Boolean point with a value of 0 or 1.

BYTE 8-bits of data

WORD 16 bits of data

DWORD 32 bits of data

Text device points

Data Type Description

STRING  A one character alphanumeric

STRING_20 A 20 character alphanumeric string

STRING_8 An 8character alphanumeric string

STRING_80 An 80 character alphanumeric string

3 Elements (in an Array)

CIMPLICITY software treats all points as array points.

You can define single points and array points. Using array points is one way to provide more
efficient data collection. An array point can represent one instance of several process variables, or
several instances of one process variable.

Enter:
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A 1 The array is a single element array

B 2 or more The array is a multiple element array.

Important:  Array points are not supported by all CIMPLICITY software functions. Support for
array points is as follows:

CimEdit Objects can be configured to display array elements and use them for movement or animation

CimView Array elements can be displayed, and can control movement or animation.

Alarm Viewer Alarms cannot be generated for array points.

Database Logger Individual array elements can be logged.

The maximum size of an array point depends on the following.

1. Device type being used.
2. Memory type being addressed.
3. Point type.

The maximum size of an array point for each device type is:

Device Type Maximum Size (Bytes)

Virtual 1600

CCM2 250

Genius datagram 128

Series 90 Triplex 1000

SNP and SNPX 1000

Allen-Bradley Communications 1000

*DDE 1000

FloPro/FloNet 240

Johnson Controls N2 16

Mitsubishi A-Series Serial 1000

Mitsubishi TCP/IP 512

Modbus RTU 256

Modbus TCP/IP 512

OMRON Host Link 538-1000

OMRON TCP/IP 528-1000

Seriplex 480
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Device Type Maximum Size (Bytes)

Sharp TCP/IP 1000

Siemens TI 250

*Smarteye Electronic Assembly  40

Square D SY/MAX 250

*The DDE Client and Smarteye protocols do not support array points.

Values read from or written to a device point are forced into the correct type of the point. This may
affect the array size.

Example

An analog point is an INT data type on a CCM2 device.

The maximum array size in Register memory is 125 elements because each point in the array is put
into a separate 16-bit register.

Check the appropriate Device Communications documentation for further information.

4 Read only

Option Description

Clear The point can be used as a set point.

Checked The point cannot be used as a set point.

Note:  When a read-only device point is put in manual mode (page 373) , the read-only feature
is ignored. As a result, if Allow set point for read only manual mode points is checked (enabled)
in the Point Setup (page 346) accessed through the Project Properties dialog box, administrators
who are performing system diagnostics can change its value for testing purposes.

Step 2.2. Enter Device Point Advanced General Properties

The available selections on the General tab depend on what point type you are configuring. The
following procedure begins with entries for any point type and continues through entries for the
analog/Boolean point types only.
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General choices you can make to add to your device point's configuration are as follows.

rect 181, 312, 208, 337  (page 176)
rect -3, 313, 24, 338  (page 176)
rect -5, 282, 22, 307  (page 176)
rect 340, 263, 367, 288  (page 175)
rect -5, 256, 22, 281  (page 175)
rect -4, 227, 23, 252  (page 175)
rect 353, 147, 380, 172  (page 174)
rect 353, 126, 380, 151  (page 174)
rect 6, 140, 33, 165  (page 173)
rect 353, 96, 380, 121  (page 173)
rect -2, 108, 25, 133  (page 173)
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1
(page
173)

Resource ID.

2
(page
173)

Enable point, Enable alarm, Enable Enterprise.

3
(page
173)

(Analog and Boolean points only) Trend history.

4
(page
174)

Log to database.

5
(page
174)

Log to Historian

6
(page
175)

Safety point

7
(page
175)

Availability trigger

8
(page
175)

Invert

9
(page
176)

Attribute set
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10
(page
176)

Extra info

11
(page
176)

Level

1 Resource ID

Users who have the selected Resource ID assigned to their Role ID will be able to see any alarms
generated for this point on their Alarm Viewer screens.

Opens the Select a Resource browser to select an available resource.

Displays a Popup menu to:

• Open
◦ The Select a Resource browser.
◦ A New Resource dialog box.
◦ The Resource dialog box for a selected resource

• Select a recently selected resource.

2 Enable point, Enable alarm, Enable Enterprise

Check boxes do the following.

Check Box Description

Enable Point Enables the point at runtime.

Enable Alarm Enables the point's alarm.

Enable
Enterprise

Allows data to be exported to the Enterprise server so it will be available to other projects.

Important:

• Point buffering is not supported for Enterprise Server points.
• To see the alarms in the local project when enterprise point alarms are being collected,

configure the:
◦ Same resources in the local project that are configured for the point's source project.
◦ Local resources to be visible to the local project's authorized users.

3 (Analog and Boolean points only) Trend History
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Options Description

Max
Duration

(Checked box activates fields.) The amount of most recent time to be saved.

Select one of the following:

Seconds

Minutes

Hours

Days

Max
samples

(Checked box activates field.)

• The number of n values to be saved.
• Takes precedence over Max Duration in determining the number of values saved in the buffer.

Point buffering lets you allocate a buffer for a point and save a number of the most recent values. This
feature is currently being supported only for the Trending option. 

Example

Max Duration 1 minute. The buffer contains the 12 most recent values for ABC at any given
time.

Max Count 10. The buffer contains the 10 most recent values (that is, the values for the
last 50 seconds).

Max Duration and    Max
Count

The buffer contains the 10 most recent values.

Note:  A global parameter MAX_TREND_BUF is available to specify the maximum number of
point values a point buffers for Trending.

The lesser of MAX_TREND_BUF and the Trend History of the point determine the ceiling of
buffered values.

When MAX_TREND_BUF is not configured it uses the default value of 200.

4 Log to database

Note:  The Log to database checkbox displays only if Database Logger is enabled on the
General tab (page 84) in the Project Properties dialog box.

When checked, logs data to the default CIMPLICITY DATA_LOG. You can apply more
specifications in the Database Logger.

Setting a point value can require authorization (page 313) that produces an audit trail.

5 Log to Historian

Note:
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The Log to Historian checkbox displays only if Historian is installed/licensed and is enabled on the
General tab (page 84) in the Project Properties dialog box.

When checked, logs data to Historian.

6 Safety Point

Digital or analog (not REAL)

The safety point status controls whether or not a setpoint is permitted.

Buttons for the field do the following.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
◦ The Select a Point browser.
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.

• Select a recently selected point.

7 Availability Trigger

Digital or analog

Determines the validity of the point you are configuring and provides a "device healthy" signal for
points that are tied to intermediate devices during runtime.

Buttons for the field do the following.

Opens the Select a Point browser to select an available point.

Displays a Point Popup menu (page 175).

8 Invert

Check or leave blank based on the desired behavior, as described below.

At runtime if: Invert is Not Checked Invert is Checked

Availability Trigger Configured Point is Configured Point is
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At runtime if: Invert is Not Checked Invert is Checked

Evaluates to a non-zero
value:

Available Unavailable

Evaluates to zero: Unavailable Available

Is Unavailable: Unavailable

Max Count 10  the buffer contains the 10 most recent values (that is, the values for the last 50
seconds).

Max Duration and    Max
Count

The buffer contains the 10 most recent values.

9 Attribute Set

Sets of point attributes that use up to 32 bits each out of 64 (page 365) available bits and can be
applied to one or more points in a project.

All of the attribute fields in the selected attribute set will be available to associate with the point in
any expression that takes a Point ID.

Opens the Select Attribute Sets browser to select an available attribute set.

Displays a Popup menu to:

• Open:
◦ The Select Attribute Sets browser.
◦ A New Attribute Set dialog box.
◦ The Attribute Set dialog box for a selected attribute set.

• Select a recently selected attribute set.

10 Extra info

Any 32 bit number you want to enter.

You can access it as a point attribute and do with it what you want.

11 Level

A positive or negative number.

• Specifies a security level for the point to restrict setpoint access; the higher the number, the
more restricted the setpoint access.

• Level security affects all writable attributes of the point, e.g. alarm limits, quality attributes and
raw value.
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Step 3. Enter Device Point Device Properties

Step 3. Enter Device Point Device Properties

Device Point Properties configuration is both basic and advanced.

Step 3.1
(page
177)

Enter device point basic device properties.

rect 8, 10, 36, 35 Step 3.1. Enter Device Point Basic Device Properties (page 177)

Step 3.2
(page
184)

Enter device point advanced device properties.

rect 5, 9, 37, 35 Step 3.2. Enter Device Point Advanced Device Properties (page 184)

Step 3.1. Enter Device Point Basic Device Properties

Step 3.1. Enter Device Point Basic Device Properties

The main purpose of the basic Device tab is to define where the point is located in a device and how
the point is to be updated.
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Basic device specifications include:

rect 0, 115, 23, 137 Step 3.1.3. Select Update Criteria for a Device Point (page 182)
rect -1, 64, 22, 110 Step 3.1.2. Enter a Customized Address (page 179)
rect -1, 36, 22, 58 Step 3.1.1. Select a Device ID (page 178)

Step 3.1.1
(page
178)

Select a device ID.

Step 3.1.2
(page
179)

Enter a customized address.

Step 3.1.3
(page
182)

Select update criteria for a device point.

Note:  Addressing is used for most GE Intelligent Platforms device communications options and
for devices created via the Device Communications Toolkit API that uses custom addressing.

If you write a custom device communication interface using the device communications Toolkit API
and you design your interface to use standard addressing you will get a different display.

For further information on addressing for the protocol and device, see the CIMPLICITY Device
Communications documentation.

Step 3.1.1. Select a Device ID

The Device ID (page 162) that you selected in the New Point dialog box displays in the Device ID
field.

You can do any of the following to change the selection.
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Device ID

Any available Device ID can be entered in the Device ID field.

Options to help select or modify the device ID are as follows.

Opens a Select a Device browser. The selected device is entered into the field.

Displays a Popup menu to:

• Open:
◦ A New Device dialog box.
◦ The Device dialog box for a selected device.
◦ The Select a Device browser.

• Select a recently selected device.

Step 3.1.2. Enter a Customized Address

Addressing is used for most GE Intelligent Platforms device communications options and for devices
created via the Device Communications Toolkit API that use custom addressing.
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rect 229, 80, 250, 101  (page 180)
rect -2, 100, 19, 121  (page 180)
rect -1, 78, 20, 99  (page 180)

1
(page
180)

Address entry only.

2
(page
180)

Address offset (Boolean points only)

3
(page
180)

Address for diagnostic data

1 Address entry only

Enter an address that is appropriate for the selected device in the Address field.

See the documentation for a selected device for more information

2 Address offset (Boolean points only)

Enter an Address Offset (bit offset) if the first bit of the point's data is not the first bit of the address.
Address offsets start at 0, which is the least significant bit.

Example

A digital point is located in the third (3rd) bit of Register 5 on a Series 90-70

The Address is %R5.

The Address Offset is 2.

3 Address for diagnostic data
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Device communication enablers (devcoms) contain diagnostic data that you can use to detect,
diagnose and correct data communication problems.

To view diagnostic data, configure device points that correspond to the diagnostic locations
in the enabler. These diagnostic points are like device data points in all ways, except they are
always available when the enabler is running; points containing device data are unavailable if
communication with the device fails. Diagnostic points may be scanned at any appropriate multiple
of the port's base scan rate, displayed in CimView screens, trended, logged, alarmed, etc.

Note:  When you disable a device, the configured diagnostic points of the device become
unavailable.

Important:  You cannot write to diagnostic points. Always configure them for Read  access.

1. Check Diagnostic Data if the address is for a diagnostic point.
2. Enter one of the following values as the text address of the diagnostic data in the Address field.

  Address
Data
Type

  Description

$CURRENT_INIT_TIME DINT Should match the $FIRST_INIT_TIME value if the device was functioning
correctly on startup.

$CURRENT_INIT_TYPE SINT Possible values

0

1

2 Normal

$DEVICE_DOWN BOOL Device down status.

0

1 Device down state

$DEVICE_UP BOOL Device up status.

0

1 Device up state

$FAILURES UDINT Number of communication failures. Should increment when the enabler
has a failure.

$FIRST_INIT_TIME DINT Startup time for the device the point is attached to. Should be a positive
value.

$FIRST_PORT_INIT_TIME DINT Should be a positive value greater than the sum of the
$FIRST_INIT_TIME values for the devices attached to this port.

$FIRST_INIT_TYPE SINT Possible values

0
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  Address
Data
Type

  Description

1

2 Normal

$RESPONSES UDINT Number of messages received. Should be a value that:

• Increments when the device is up.
• May not increment when the device is down.

$RETRIES UDINT Number of retries. Should increment when enablers retry logic is
operating, such as when the device is unplugged.

$TRANSMISSIONS UDINT Number of messages. Should be a value that increments.

Standard diagnostic data, available for all enablers, includes:

Standard
Data

Description

Transmissions Number of all messages sent to the device.

Responses Number of all responses received from the device (successfully or not). This includes responses that
can be unsolicited with no data that can be mapped or that can contain protocol errors.

Retries Number of times a message had to be resent

Failures Number of periods of communication failure. A failure period includes retries that are back to back and
continues until a retry is successful. When a retry is successful and a failure occurs again, the next
retry begins a new failure period.

Device status Current device state

Each device communication enabler may also provide protocol-specific data.

Note:

• Diagnostic points are not available for the Point Bridge.
• Criteria described in this section are for customized addressing. There is another type of

addressing, standard addressing. However, it is rarely used.

Important:  You cannot write to diagnostic points. Always configure them for Read access. See
the documentation for a selected device for more information about addressing.

Step 3.1.3. Select Update Criteria for a Device Point

The update selection determines when the point value will be updated.

Selections in the drop down field are as follows.
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Criteria Point is updated

On Change (Default)

Data
Collected

At a regular interval. The interval equals the base scan rate for the port on which the device is located
multiplied by the scan rate for the point.

Value
Updated

Only when the value changes.

This is an efficient criterion.

On Scan

Data
Collected

At a regular interval. The interval equals the base scan rate for the port on which the device is located
multiplied by the scan rate for the point.

Value
Updated

The point's value is updated at the point's scan interval, whether or not the value changes. Because this
can increase system load, it is recommended that you use On Scan sparingly or not at all.

On Demand On Scan

Data
Collected

Whenever the point's value is needed by an application.

Value
Updated

At the point's scan interval, whether or not the value changes.

On Demand On Change

Data
Collected

Whenever the point's value is needed by an application.

Value
Updated

Only when the value changes.

Unsolicited

Value
Updated

Whenever the device communications receives data from the PLC, it immediately sends it to CIMPLICITY
Point Management whether or not the point's value has changed. This mode is only valid if the device
is capable of sending unsolicited updates of point values and the device communications protocol. See
the CIMPLICITY Device Communication documentation for your particular device and protocol to see if it
supports unsolicited communications.

Unsolicited On Change
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Criteria Point is updated

Value
Updated

Whenever the device communications receives data from the PLC, it evaluates the point and sends it
to CIMPLICITY Point Management only it the point's value has changed. This mode is only valid if the
device is capable of sending unsolicited updates of point values and the device communications protocol
supports it. See the CIMPLICITY Device Communication documentation for your particular device and
protocol to see if it supports unsolicited communications.

Poll Once

Data
Collected

Polled once when the device communications enabler starts up. Thereafter, it may be updated by
unsolicited data from the device. If you select Poll After Set, it will also be updated after a user performs a
Setpoint on the point.

Step 3.2. Enter Device Point Advanced Device Properties

Step 3.2. Enter Device Point Advanced Device Properties

Important:  Domains for programmable controllers in CIMPLICITY software are sized when
the project starts. If you dynamically re-configure domain sizes on the programmable controller, you
must restart the project to access points at the new domain offsets.

Advanced device configuration includes the following.

rect 3, 141, 31, 165 Option 3.2.1. Enter Device Point Trigger Settings (page 185)
rect 192, 140, 214, 168 Option 3.2.2. Specify a Device Point Scan Rate (page 190)
rect 0, 214, 23, 240 Option 3.2.3. Select Device Point Analog Deadband/Poll after Set/Delay Load
(page 191)

Option
3.2.1 (page
185)

Enter device point trigger settings.

Option
3.2.2 (page
190)

Specify a device point scan rate.
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Option
3.2.3 (page
191)

Select device point analog deadband/Poll after set/delay load

Option 3.2.1. Enter Device Point Trigger Settings

Option 3.2.1. Enter Device Point Trigger Settings

If you add a trigger setting, the point you are configuring is updated only when the trigger condition
evaluates to TRUE.

Example

You configure a point that requires an update for logging purposes.

• If the update needs to be hourly, but the device is being scanned every quarter hour for other
purposes:

Use a device Trigger Point that is configured with a one-hour scan rate (page 182) .

• If the update needs to occur when a particular condition changes:

Use a Device point that represents the condition and is configured to be updated On Change

Settings for the trigger point are as follows:

rect 0, 131, 24, 157  (page 186)
rect -2, 161, 21, 187  (page 188)
rect 168, 160, 192, 184  (page 188)

1
(page
186)

Trigger point.

2
(page
188)

Relation



Project Setup | 7 - Points | 186

3
(page
188)

Value

1 Trigger point

A Trigger Point is another device point that serves as the trigger for the point being configured.

The point being configured is updated only when the trigger is updated.

Trigger points can be used to:

• Coordinate or direct the sampling frequency of device points, (or the calculation frequency of
virtual points).

Example

Data needs to be collected from point PLC1 at an interval signaled by a ready bit on the PLC.

Trigger Settings and Scan Rate for PLC1 are as follows:

At runtime, PLC1 will only be updated while the point PLC1_READY is equal to 1.

• Make the system more efficient by reducing the amount of data that needs to be managed by the
data collection functions.

Example

For every contiguous sixteen bits of inputs or outputs on a Series 90-70 PLC, a single analog
point that overlaps them uses On Scan as the Update Criteria.
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The trigger settings and scan rate for each of the digital points has the following configuration.

Update Criteria On Change

Trigger point DEVICE_ANA;PG (with On Scan update criteria)

If the trigger point DEVICE_ANALOG does not change frequently there is a performance
benefit because the digital points will only be updated when the analog point changes.

The trigger point's Update Criteria determines when triggered reads take place.

The criteria can be either of the following.

• When the trigger point value changes.
• When the trigger point is scanned.

You make this selection when the trigger point is configured.

Example

You are configuring a point that requires an update for logging purposes.

If the update needs to: Use a:
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Be hourly Device Trigger Point that is configured with a one-hour scan rate.

Occur when a particular condition
changes

Device point that represents the condition and is configured to be updated On
Change

Important:  (For device points) triggers must be:

• A configured device point.
• On the same port as the points it is triggering. The points may be on different devices, but the

devices must be on the same port.

2 Relation

The Relation field specifies how the trigger point will be evaluated.

Options are:

Option Trigger is active when the trigger point's value:

None Triggering will not occur.

Equal Equals Value.

Greater Than Is greater than Value.

Greater Than Equal Is greater than or equal to Value.

Less Than Equal Is less than or equal to Value.

Less Than Is less than Value.

On Change Whenever the Trigger Point is changed.

3 Value

The value the trigger point will be compared with the entered Value to determine if the trigger
condition has been met.

Result: The trigger condition is evaluated each time the trigger point is polled, so effectively, this
point is polled at the trigger point's scan rate while the trigger condition is true.

Example: Scanned Values with and without Trigger Points

Two points are configured.

Point ID Type Scan Rate Point Relationship

A1 Analog 3 seconds Primary

D1 Digital 3 seconds Trigger
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Three options for A1 and D1 are:

1
(page
189)

Point A1 is set for On Scan; Point D1 has not been entered as a trigger point.

2
(page
189)

Point A1 is set to On Scan; Trigger point D1 is set to On Change.

3
(page
190)

Point A1 is set to On Scan; Trigger point D1 is set to Greater Than 0.

Point A1 is set for On Scan; Point D1 has not been entered as a trigger point.

• A1 is set for On Scan and
• D1 has not been entered as a trigger point.

CIMPLICITY reads A1 values during each scan.

Over a period of 30 seconds, A1 values are read as follows:

Point A1 is set to On Scan; Trigger point D1 is set to On Change.

• A1 is set to On Scan, and
• D1 is set to On Change.

CIMPLICITY reads A1 values when D1 has changed from 0 to 1 or from 1 to 0 between A1 scans.

Over a period of 30 seconds, A1 values are read as follows:
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In other words, CIMPLICITY reads A1 at the 3, 9, 15, 21, 24 and 27 second marks because the
value of D1 changed at those times. Note that any transitions that occur between scans (such as those
between the 15 and 18 second marks) do not count.

Point A1 is set to On Scan; Trigger point D1 is set to Greater Than 0.

• A1 is set for On Scan and
• D1 is set for Greater than 0.

CIMPLICITY reads A1 when D1 is greater than 0 (1) during an A1 scan.

Over a period of 30 seconds, A1 values are read as follows:

In other words, CIMPLICITY reads A1 at the 3, 15, and 24 second marks, because they are the only
places where the scanned value of D1 transitions from LOW to HIGH.

Note:  Because the trigger point in this example is Boolean, Greater than 0 behaves the same as
specifying Equal to 1.

Option 3.2.2. Specify a Device Point Scan Rate

The components for specifying the scan rate are:

Base Rate Minimum rate at which device points can be polled on the port.
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Scan Rate Is a multiple of the Base Rate.

rect 6, 97, 248, 132 Step 3.1.3. Select Update Criteria for a Device Point (page 182)

Enter the frequency at which the CIMPLICITY device communications option will read this point's
data, based on the port's Base Rate.

Example

The Base Rate is 5 seconds

The Scan Rate is set to 3.

The point is scanned every 15 seconds.

Note:  If you define Trigger Settings for a point, the Scan Rate field is disabled.

Option 3.2.3. Select Device Point Analog Deadband/Poll after Set/Delay Load

rect 2, 211, 29, 241  (page 192)
rect 167, 214, 196, 243  (page 192)
rect 246, 216, 274, 241  (page 193)
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1
(page
192)

Analog deadband

2
(page
192)

Poll after set

3
(page
193)

Delay load

1 Analog deadband

Analog Deadband filters out changes in the raw value of the configured point.

If a point value change is less than OR EQUAL TO the deadband, the value will be ignored. The
raw value must change more than the analog deadband value before the point value is updated in the
CIMPLICITY point database.

Therefore, the analog deadband can make CIMPLICITY software ignore small fluctuations in the
value of a point.

Example

A point ranges from 0 to 10,000.

Analog deadband = 5

Any point fluctuations of less than 5 are ignored.

Note:  An explicit deadband of 0 is the same as selecting an On Change update criteria.

2 Poll after set

Poll After Set determines when CIMPLICITY will read a setpoint value.

Options for the Poll After Set check box are:

Check box status CIMPLICITY will read the point's value

Check Immediately after a Setpoint is performed.

Clear On the next scan or when the trigger condition for the point is set to TRUE.

Important:

• Point Bridge does not support Poll After Set. If you are defining a Point Bridge point, clear this
check box.
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• If you use Poll After Set with the OPC client device communications, you may decrease
performance. Using Poll After Set with OPC device communications is not recommended.

3 Delay Load

When Delay Load is checked on the Device tab in the Point Properties dialog box, the point will
write to the point database, but is not loaded into memory until demanded by an application.

This option is not recommended for points that are accessed often because there may be a delay time
when the point is demanded and loading.

Important:  Manual mode is not supported on delay load points.

There are a number of benefits to using the delay-load option, along with some disadvantages and
non-supported functions. They are as follows:

Benefits Disadvantages Non-Supported Functions

• Loaded when
needed

• No memory usage
until point is loaded

• Written to point
database

• Available in point list

• Slower access
• Trigger settings

and
• Alarm options

are not
available

• Trend buffering
• Alarming
• Cannot be used within another point's configuration, e.g. Safety

point, Trigger, Availability Trigger point, etc.
• Cannot be used in a calculation point equation
• Manual Mode

Device Point Quality Support at Runtime

CIMPLICITY provides the capability for a user to take a device point that may or may not be
currently available and put it in manual mode. The user can then set the point's value. This is
particularly useful if a point is attached to equipment that is known to be malfunctioning and, as
a result, creates a problem in other areas of the system. This indicator enables a user to separate
the point from that equipment and set the point to a known good value that preserves the system's
integrity.

Example

A temperature sensor that reports temperatures, which are acted upon by CIMPLICITY applications
to initiate temperature control actions, fails.

To continue the high temperature setting, a user with Modify Manual Mode privilege places the point
that reflects the errant sensor in manual override mode.



Project Setup | 7 - Points | 194

The user then sets a value that causes the application to cease the unnecessary temperature
control procedures. This allows users who are knowledgeable of their CIMPLICITY application
implementation to make emergency, temporary adjustments to their system's operation.

Consequently the application does not have to anticipate and provide for handling of all possible
failures in its implementation.

Quality support for manual mode includes the storage of data values for points that are placed in
manual mode. This means that when you stop a project, then restart it CIMPLICITY takes all the
points that it finds in manual mode and restores them to their last known values. Retrieved point
value types can include any one of the following values:

• Set in manual mode
• That came from the PLC and was not reset in manual mode
• That is unavailable, if it was unavailable when the project stopped

CIMPLICITY allows access to manual mode wherever you can reference an attribute for a device
point. Access includes:

• Turning manual mode on and off in the CIMPLICITY Point Control Panel
• Using available point quality attributes in:

◦ Scripts
◦ Expressions in CimEdit or Custom PTMAPI applications

Note:  A point with manual mode enabled can be changed, regardless of the current value or state
of an associated availability trigger or safety point.

Important:  Manual mode is not supported on delay load points.

Virtual Points

Virtual Point Only Configuration

Virtual points do not directly originate from devices.

There are two types of virtual points:

Global
points

Have values that are generated by an application such as CimView. These values are shared by multiple
CIMPLICITY software applications.

Calculated
points

Are generated from arithmetic or logical expressions that modify or combine one or more numeric points.
These values may then be shared by multiple CIMPLICITY software applications.
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Virtual points provide you with the ability to calculate and report data that is independent of any one
device.

On a very basic level the virtual point can be available to receive a value from a variety of sources
across your projects, e.g. scripts or C++ programs. Once the point exists, you can use it wherever the
use is consistent with its formatting.

On a more advanced level, the value of the virtual point can be derived from a calculation that you
specify during configuration. This calculation can include the value of one or more virtual points. To
do this you:

Step 1
(page
195)

Create a new virtual point.

Step 2
(page
196)

Enter virtual point general properties.

Step 3
(page
206)

Enter virtual point virtual properties.

Continue
(page
250)

Device and virtual point configuration.

Step 1. Enter Specifications for a new Virtual Point

1. Open (page 159) a New Point dialog box.

2. Enter the following specifications for a new virtual point.

rect 0, 27, 23, 51  (page 195)
rect -3, 51, 23, 78  (page 196)
rect -2, 115, 20, 140  (page 196)

A Point ID
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Unique name (page 338) that identifies the point.

Maximum Length: 256 characters

B Virtual type

Check the Virtual radio button to select virtual as the Type.

C Class

Point classification dictates what the data type can be selected.

Options are:

• Analog
• Boolean
• Text

3. Click OK.

The new point's Point Properties dialog box opens.

Step 2. Enter Virtual Point General Properties

Step 2. Enter Virtual Point General Properties

General Point Properties configuration is both basic and advanced.

Step 2.1
(page
197)

Enter virtual point basic general specifications

rect -4, 12, 22, 37 Step 2.1. Enter Virtual Point Basic General Properties (page 197)
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Step 2.2
(page
201)

Enter virtual point advanced general specifications.

rect -2, 11, 22, 32 Step 2.2. Enter Virtual Point Advanced General Properties (page 201)

Step 2.1. Enter Virtual Point Basic General Properties

The virtual point's data type choices are on the General tab of the Point Properties dialog box. The
data type choices available to you for a virtual point depend on the type you selected when you
created it.

Basic general specifications include the following:
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rect 291, 96, 313, 122  (page 200)
rect 169, 97, 191, 123  (page 200)
rect 29, 96, 51, 122  (page 198)
rect 0, 52, 22, 78  (page 198)

• Description
• Data type
• Elements (in an array)
• Read only

1 Description

(Optional) Enter a Description up to 80 characters.

This description:

• Displays when you position the cursor over the point in the Workbench
• Can be entered in the Point browser when you want to find and display or use the point

2 Data type

Select one Data Type from the drop down list that appears for the point type you selected:

The Data Types are:

• Analog virtual points.
• Boolean virtual points.
• Text virtual points.
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Analog virtual points

Data Type Description

DINT 4 byte (32 bit) ranging from -2,147,483,648 to + 2,147,483,647.

INT Integers ranging from -32,768 to +32,767.

QINT 8-byte (64-bit) signed integer ranging from -9223372036854775808 to + -9223372036854775808.

REAL Floating-point numbers.

SINT Integers ranging from -128 to +127.

UDINT Unsigned integers ranging from 0 to 4,294,967,295.

UINT Unsigned integers ranging from 0 to 65,535.

UQINT 8-byte (64-bit) unsigned integer ranging from 0 to +18446744073709551615.

USINT Unsigned integers ranging from 0 to 255.

Boolean virtual points

Data Type Description

BOOL A one digit Boolean point with a value of 0 or 1.

BYTE 8-bits of data

WORD 16 bits of data

DWORD 32 bits of data

Text device points
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Data Type Description

STRING  A one character alphanumeric

STRING_20 A 20 character alphanumeric string

STRING_8 An 8character alphanumeric string

STRING_80 An 80 character alphanumeric string

3 Elements (in an Array)

CIMPLICITY software treats all points as array points.

You can define single points and array points. Using array points is one way to provide more
efficient data collection. An array point can represent one instance of several process variables, or
several instances of one process variable.

Enter:

A 1 The array is a single element array

B 2 or more The array is a multiple element array.

Important:  Array points are not supported by all CIMPLICITY software functions. Support for
array points is as follows:

CimEdit Objects can be configured to display array elements and use them for movement or animation

CimView Array elements can be displayed, and can control movement or animation.

Alarm Viewer Alarms cannot be generated for array points.

Database Logger Individual array elements can be logged.

4 Read only
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Option Description

Clear The point can be used as a set point.

Checked The point cannot be used as a set point.

Step 2.2. Enter Virtual Point Advanced General Properties

The available selections on the General tab depend on what point type you are configuring. The
following procedure begins with entries for any point type and continues through entries for the
analog/Boolean point types only.

There are several general choices you can make to add to your virtual point's configuration. They
include:

1
(page
202)

Resource ID

2
(page
202)

Enable point, Enable alarm, Enable Enterprise
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3
(page
203)

(Analog and Boolean points only) Trend history

4
(page
203)

Log to database

5
(page
204)

Log to Historian

6
(page
204)

Safety point

7
(page
205)

Availability trigger

8
(page
205)

Invert

9
(page
205)

Attribute set

10
(page
205)

Extra info

11
(page
206)

Level

1 Resource ID

Select an existing or create a new resource.

Users who have the selected Resource ID assigned to their  Role ID  will be able to see any alarms
generated for this point on their Alarm Viewer screens.

Opens the Select a Resource browser to select an available resource.

Displays a Popup menu to:

• Open
◦ A New Resource dialog box.
◦ The Resource dialog box for a selected resource
◦ The Select a Resource browser.

• Select a recently selected resource.

2 Enable point, enable alarm, Enterprise point

Check any of the following.
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Enable Point Enables the point at runtime

Enable Alarm Enables the point's alarm

Enable
Enterprise

Allows data to be exported to the Enterprise server so it will be available to other projects.

Important:  To see the alarms in the local project when enterprise point alarms are being
collected, configure the:

• Same resources in the local project that are configured for the point's source project.
• Local resources to be visible to the local project's authorized users.

3 (Analog and Boolean points only) Trend History

Check
box/Field

Description

Max
Duration

(Checked box activates fields.) The amount of most recent time to be saved. Select one of the following:

Seconds

Minutes

Hours

Days

Max
samples

(Checked box activates field.)

• The number of n values to be saved.
• Takes precedence over Max Duration in determining the number of values saved in the buffer.

Point buffering lets you allocate a buffer for a point and save a number of the most recent values. This
feature is currently being supported only for the Trending option.

Example

Point ABC is scanned every 5 seconds

If you define a:

Max Duration 1 minute.

The buffer contains the 12 most recent values for ABC at any given time.

Max Count 10.

The buffer contains the 10 most recent values (that is, the values for the last
50 seconds).

Max Duration and  Max
Count

The buffer contains the 10 most recent values.

4 Log to database

Note:  The Log to database checkbox displays only if Database Logger is enabled on the
General tab (page 84) in the Project Properties dialog box.
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When checked, logs data to the default CIMPLICITY DATA_LOG. You can apply more
specifications in the Database Logger.

Setting a point value can require authorization (page 313) that produces an audit trail.

5 Log to Historian

When you select the Log to Historian check box, data is logged to Historian.

Note:

• The Log to Historian check box is displayed only if Historian is installed/licensed and is enabled
on the General tab in the Project Properties window.

• When the project is not running, if you delete a point configured for Historian logging, data
continues to be logged to Historian.

6 Safety point

Status controls whether or not a setpoint is permitted.

The point can be:

1. Digital or analog (but not REAL)
2. Device or virtual

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.

• Select a recently selected point.

During runtime if the:

Safety Point is Setpoint on the Point is

Available and evaluates to a non-zero value Permitted

Available and evaluates to zero Not permitted

Unavailable Not permitted
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7 Availability trigger

Determines the validity of the point you are configuring and provides a "device healthy" signal for
points that are tied to intermediate devices during runtime.

Can be digital or analog.

Opens the Select a Point browser to select an available point.

Displays a Point Popup menu (page 204).

8 Invert

Check or leave blank based on the desired behavior, as described below.

At runtime if: Invert is Not Checked Invert is Checked

Availability Trigger: Configured Point is: Configured Point is:

Evaluates to a non-zero value Available Unavailable

Evaluates to zero Unavailable Available

Is Unavailable Unavailable

9 Attribute set

Sets of point attributes that use up to 32 bits each out of 64 (page 365) available bits and can be
applied to one or more points in a project.

All of the attribute fields in the selected attribute set will be available to associate with the point in
any expression that takes a Point ID.

Opens the Select Attribute Sets browser to select an available attribute set.

Displays a Popup menu to:

• Open:
◦ A New Attribute Set dialog box.
◦ The Attribute Set dialog box for a selected attribute set.
◦ The Select Attribute Sets browser.

• Select a recently selected attribute set.

10 Extra info

Any 32 bit number you want to enter.
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You can access it as a point attribute and do with it what you want.

10 Level

A positive or negative number.

• Specifies a security level for the point to restrict setpoint access; the higher the number, the
more restricted the setpoint access.

• Level security affects all writable attributes of the point, e.g. alarm limits, quality attributes and
raw value.

Result: When point level setpoint security is enabled (page 344) a project user can set the point
only if the user's assigned role has a corresponding level that is equal to or higher than the point
level.

Tip:  Enable point level setpoint security (page 344) in the Point Setup dialog box.

Step 3. Enter Virtual Point Virtual Properties

Step 3. Enter Virtual Point Virtual Properties

rect -1, 91, 30, 116 Step 3.2. Configure Virtual Calculations (page 211)
rect -4, 37, 27, 62 Step 3.1. Specify Initialization for Virtual Points (page 206)

Step 3.1
(page
206)

Specify initialization for virtual points.

Step 3.2
(page
211)

Configure virtual calculations.

Step 3.1. Specify Initialization for Virtual Points
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• Analog or BOOLEAN point initialization.
• Text point initialization.

Analog or Boolean point initialization

Options for analog or Boolean point initialization are as follows.

• None
• Initialized
• Saved
• Saved or Initialized

1 None

(Default) No reset/startup condition is defined.

2 Initialized

Requires an initial value.

An initial value is:

• An integer
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• A constant value.

Each element in an array is initialized to the initial value.

Example

A UINT point:

• Is an array with 4 elements.
• Has an initial value of 1000.
• Each element in the array is initialized to 1000.

3 Saved

The last saved value of the point when the project is stopped.

Note:  When points are saved is specified in the Project Properties dialog box, Settings tab.

Choices for when to save the point are:

• Every time a point changes.
• When the project shuts down normally.

4 Saved or Initialized

The last saved value of the point if there is one; otherwise the constant entered in the Initial Value
field.
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Text point initialization

Options for text point initialization are as follows.

• None
• Initialized
• Saved
• Saved or Initialized

1 None

No reset/startup condition is defined.

2 Initialized

A constant value entered in the Initial Value field (C) is initialized.
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Following are examples of an initial value based on the array type.

Array type Initial Value

Multi-character Each element in the array is initialized to the Initial Value .

Example

A String array:

• Is an array of 4.
• Has an Initial Value of ABCDEFGH.
• Each element in the array is initialized to ABCDEFGH.

Single character Each element in the array is initialized with the corresponding character in the Initial Value field.

Example

A String array:

• Is an array of 8.
• Has an Initial Value of ABCDEFGH.
• Sets  STRING [0] to A
• Sets  STRING [1] to B, etc.

3 Saved

The last saved value of the point when the project starts.
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Note:  When points are saved is specified in the Project Properties dialog box, Settings tab.

Choices are:

• Every time a point changes.
• When the project shuts down normally.

4 Saved or Initialized

The last saved value of the point if there is one; otherwise the constant entered in the Initial Value
field.

Important:  When working with initialization values for string arrays, if:

• Too many elements are given in Initial Value, the string truncates at the number of elements.
• The Initial Value does not specify enough elements; the remaining elements of the string are

initialized to the Null character.

Step 3.2. Configure Virtual Calculations

Step 3.2. Configure Virtual Calculations

In addition to defining an initialization value for a virtual point (basic configuration), you can select
one of several calculations types to have CIMPLICITY calculate a value for the point.

Each calculation type requires different information from you.

You can enter basic initialization criteria in basic or advanced configuration.

The Calculation types are:

Option 3.2.1
(page 212)

Equation (Analog and Boolean).
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Option 3.2.2
(page 215)

Delta Accum.

Option 3.2.3
(page 221)

Value Accum.

Option 3.2.4
(page 224)

Average.

Option 3.2.5
(page 227)

Max Capture.

Option 3.2.6
(page 230)

Min Capture.

Option 3.2.7
(page 233)

Trans-High Accum.

Option 3.2.8
(page 236)

Equation w/Override.

Option 3.2.9
(page 239)

Timer/Counter.

Option 3.2.10
(page 244)

Histogram.

Examples
(page 248)

Virtual Calculation and Trigger Points

Tip:  A Local check box displays on the advanced Virtual tab for every calculation choice except
none. Check the Local check box to tell CIMPLICITY not to report the value of the point to the
Point Management process. This is useful for points that are only used to hold intermediate values in
calculations. For such points, setting the Local flag eliminates the overhead of reporting to the Point
Management process. Local points cannot be shared with other applications.

Note:  Almost all of the calculations allow you to enter a trigger (page 248) point.

Note:  For calculation points, you only need Saved and Initial values for Delta Accum, Timer/
Counter and Value Accum points. This is because all other calculation points are validated at
startup and any saved or initial value is immediately overwritten.

Option 3.2.1. Equation

Select Equation in the Calculation field on the Virtual tab of the Point Properties dialog box.
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rect -1, 91, 23, 119  (page 213)
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rect -3, 145, 28, 173  (page 215)

• Expression
• Reset point
• Trigger point

1 Expression field

The expression may contain:

• One or more Point IDs along with
• Constant values, operations, and functions.

Rules for defining an expression are:

Rule Description

Avoid introducing loops
(circular references between
points) in your expressions.

Example of what to AVOID: VIRTUAL_PT1 = DEVICE_PT + VIRTUAL_PT2 VIRTUAL_PT2 =
DEVICE_PT + VIRTUAL_PT1

Although this will not cause CIMPLICITY software to fail, it will cause the Virtual Point
Processor to always have work to do. This causes all available computer time to be
consumed, which adversely impacts system performance.

Use proper formatting for
array points.

Example of the correct format: VIRTUAL_PT1 = DEVICE_PT[0] / 2.0

Use proper formatting for
Point IDs with reserved
words.

Point IDs that are reserved words, or contain spaces, arithmetic operators,
parentheses, or that begin with a non-alphabetic character must be placed in single
quotes when used in an expression.

Example

VIRTUAL_PT2 = 'DEVICE_PT:0' * 'WARNING_LOW'



Project Setup | 7 - Points | 214

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:

• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset Point

(Optional) When a Reset point is selected the Equation point is reset as follows during runtime.

When the trigger point is not defined:

If And Then

An Initial Equation Point value is The Current value of the Expression is The Equation point value is reset to the

Not defined Available Current value

Not defined Unavailable Zero

Defined Unavailable Initial value

Defined Available Current value

When the trigger point is defined:

If Then

An Initial Equation Point value is The Equation point value is reset to the

Not defined Zero

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger Point field

(Optional) When the value of the equation updates depends on whether or not you defined the trigger
point.

Trigger point The value of the Equation point is updated whenever Value of the:

Defined Trigger point is updated.

Not defined One of the source points in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Option 3.2.2. Delta Accum

Select Delta Accum in the Calculation field on the Virtual tab of the Point Properties dialog box.

A Delta Accum point is an increasing representation of a source expression. A decrement in the
source expression value is also considered to be an increase to the Delta Accum.

A Delta Accum point is particularly useful when used with a PLC to keep an incrementing tally as
the PLC count increments and rolls over.

Note:  You can also use a Delta Accum point with a global virtual point. However, in most cases,
the virtual point should be configured so that when it reaches the rollover level it emulates a PLC and
rolls over to the initial value.
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• Expression (page 216)
• Reset point (page 217)
• Trigger point (page 218)
• Variance (page 218)
• Rollover (page 218)
• Delta Accum array configuration (page 219)
• Guidelines for a Delta Accum point (page 220)

1 Expression field

Enter an expression that calculates the value of the Delta Accum point.

The expression will be monitored for transitions.

The expression may contain:

• One Point ID along with
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset Point

Based on whether there is an entry in the Reset Point field, at runtime the Delta Accum point is reset
as follows:

When the trigger point is not defined

If And Then

An Initial Delta Accum Point Value
is

The Current value of the Expression
is

The Delta Accum point value is reset to
the:

Not defined Unavailable Zero

Not defined Available Zero

Defined Unavailable Initial value

Defined Available Initial value

When the trigger point is defined

If Then

An Initial Delta Accum Point Value is The Delta Accum point value is reset
to the:

Not defined Zero

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

(Optional) When the value of the Delta Accum point updates depends on whether or not you defined
the Trigger point as follows:

Trigger point The value of the Delta Accum point is updated whenever the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

4 Variance

If incoming data suddenly, for example, overloads the computer to the degree that the variance
between the Delta Accum increment and the source becomes high enough that the Delta Accum
misses a source rollover, the Delta Accum value ceases to be an accurate representation of the source
activity.

The Variance field provides a way to alert the operator if this situation occurs.

When the difference between the new source value and the old source value exceeds the entry in the
Variance field, the Delta Accum value does not increment. Instead a message is logged to the status
log that this situation occurred.

Enter the maximum acceptable delta value in the Variance field that can be added to the Delta
Accum point value.

If the delta value is greater than the Variance value, the:

1. New delta value is not added.
2. System logs the following message to the Status Log with Success status:

Variance value exceeded for accumulator point : <point_id>

5 Rollover



Project Setup | 7 - Points | 219

(Optional)

Example

A Delta Accum point has a:

• Rollover value of 99.
• Current value of 98.

The previous source expression has a value of 97.

If a new value of +3 is received, the new delta accum is calculated as:

98+(100 - 97)+ 3= 104

If you do not specify a Rollover value, the size of the data type for the Delta Accum point determines
the default Rollover value.

Example

If the source point has an INT point type, the maximum acceptable value for the Delta Accum point
is 32767.

When the maximum value is exceeded the following message is logged to the Status Log with
Success status:

Rollover occurred for accumulator point : <point_id>

Note:  If the source expression is a floating or Boolean point, rollover is not applied.

6 Delta Accum Array Configuration

When you configure an array point as a Delta Accum point:

• The first element of the array adds the difference between the current and previous values of the
source Point ID that you specify in the Expression field to the current value of the element.

• Each additional element of the array is used to store the delta accumulator value for a different
subgroup of the array.

A selector point, which is defined in the Safety Point field, determines which subgroup element of
the array is updated. The selector point must have a value from 1 to N-1, where N is the number of
elements in the array.

Example

An array Delta Accum point tracks production counts for the
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• Total number of parts produced in a shift.
• Number of parts produced in each hour of the eight-hour shift.

The Delta Accum array point is called COUNTS with 9 Elements (one for the total shift count, and
one for each hour of the shift). The elements are defined as follows:

Element Description

COUNTS[0] Shift total production count

COUNTS[1] First hour production count

COUNTS[2] Second hour production count

COUNTS[3] Third hour production count

COUNTS[4] Fourth hour production count

COUNTS[5] Fifth hour production count

COUNTS[6] Sixth hour production count

COUNTS[7] Seventh hour production count

COUNTS[8] Eighth hour production count

A Safety Point called HOUR:

• Varies from 1 to 8, depending on the hour of the shift.
• Determines which subgroup element gets updated along with COUNTS[0]. For example, if

HOUR=4, COUNTS[0] and COUNTS[4] are updated.

If HOUR is less than 1 or greater than 8, no elements in the array are updated. 

7 Guidelines for a Delta Accum point

A Delta Accum point:

• Adds the difference between the current and previous values of the expression that you specify
in the Expression field to the current value of the Delta Accum point.

• Is first updated after the first two expression updates are received.
• Continues to have Delta values added until a Reset Condition is reached.
• Is writable, i.e. you can use the Point Control Panel or a script to set the value, overwriting the

accumulated value.
• Is always calculated as follows:

1. If the old source is less than the new source,

New Delta Accum = Old Delta Accum + (New source - old source)
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2. If the source has rolled over so the new source is less than the old source,

New Delta Accum = Old Delta Accum + (Source rollover value + 1) - old

source value + new source value

Example

Note:  A rollover value, which is used in this example, is the maximum acceptable value for a
source point. When the maximum value is incremented by 1 unit, the source point rolls over to 0.

A Delta Accum point has a value of 100 and a Rollover value of 1000.

1. The source changes from 100 to 999.

The new Delta Accum value=999.

999=100+(999-100)

2. The source next changes from 999 to 20. (The source point has rolled over.)

The new Delta Accum changes to 1022 based on the formula's calculation:

999+(1000 + 1) - 999 + 20 = 1022

Option 3.2.3. Value Accum

Select Value Accum in the Calculation field on the Virtual tab of the Point Properties dialog box.

A Value Accum point adds the current value of the source Point ID that you specify in the
Expression field to the current value of the Value Accum point.

Values continue to be added until a Reset Condition is reached.

Note:  A Value Accumulator point is writable, i.e. you can use the Point Control Panel or a script
to set the value, overwriting the accumulated value.
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• Expression
• Reset point
• Trigger point

1 Expression

Enter an Expression that calculates the value of the Value Accum point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs along with
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset Point

Based on whether there is an entry in the Reset Point field, at runtime the Value Accum point is
reset as follows:

When the trigger point is not defined

If And Then

An Initial Value Accum Point Value is The Current value of the Expression is The Value Accum point value is reset
to the:

Not defined Unavailable Zero

Not defined Available Zero

Defined Unavailable Initial value

Defined Available Initial value

When the trigger point is defined

If Then

An Initial Value Accum Point Value is The Value Accum point value is reset to the:

Not defined Zero

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

When the value of the Value Accum point updates depends on whether or not you defined the trigger
point as follows:

Trigger point The value of the Value Accum point is Updated whenever the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Option 3.2.4. Average

Select Average in the Calculation field on the Virtual tab of the Point Properties dialog box.

An Average point maintains the average value for the source Point ID that you specify in the
Expression field. This virtual point can be a signed or unsigned integer, or a floating-point number.

The average is calculated as the accumulation of the deviation from the average point data, divided
by the number of samples taken. The calculation is:

average = average + (source - average) / sample_count

Or simply as

average + (source - average) / sample_count

The average is calculated as an eight-byte floating-point data type, then the result is converted into
the data type you specify for the average point.
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• Expression
• Reset point
• Trigger point

1 Expression

Enter an expression that calculates the value of the Average point in the Expression field on the
Virtual tab of the Point Properties dialog box.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs as well as
• Constant values, operations and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset point field

Based on whether there is an entry in the Reset Point field, at runtime the Average point is reset as
follows:

When the trigger point is not defined

If And Then

If And Then

An Initial Average Point Value is The Current value of the Expression is The Average point value is reset to
the:

Not defined Unavailable Zero

Not defined Available Current value of the source point

Defined Unavailable Initial value

Defined Available Average of the source and initialized
value

When the trigger point is defined

If Then

An Initial Average Point Value is The Average point value is reset to the:

Not defined Unavailable*

Defined Initial value*

*    When the trigger point is defined, the result will either be the source value or the average of the
source and initialized value.

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

When the value of the Average point updates depends on whether or not you defined the trigger point
as follows:

  Trigger point The Value of the Average Point is updated When the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Note:  For integer type points, the resulting data is rounded. This may result in a loss of accuracy.
It is suggested that you use the Real point type for your Average point.

Important:  Average points are not supported in redundancy.

Option 3.2.5. Max Capture

Select Max Capture in the Calculation field on the Virtual tab of the Point Properties dialog box.

A Max Capture point maintains the maximum encountered point value for the source Point ID that
you specify in the Expression field.

The maximum value is determined by comparing the current source point value with the value stored
in the Max Capture point. If the current value is greater, it is stored as the new Max Capture point
value.

Important:  Max Capture points are not supported in redundancy.
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• Reset point
• Trigger point

1 Expression

Enter an expression that calculates the value of the Max Capture point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs along with
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset point

Based on whether there is an entry in the Reset Point field, at runtime the Max Capture point is reset
as follows:

When the trigger point is not defined

If And Then

An Initial Max Capture Point Value is The Current value of the Expression is The Max Capture point value is reset
to the

Not defined Unavailable Smallest possible value for the point
type. e.g. for INT the value is -32768

Not defined Available Current value

Defined Unavailable Initial value

Defined Available Whichever has the Max value

When the trigger point is defined

If Then

An Initial Max Capture Point Value is The Max Capture point value is reset to the

Not defined Smallest possible value for the point type. e.g. for INT the
value is -32768

Defined Initial value

Note:  When a

• Startup condition is Saved,
• Reset point is defined,
• Trigger point is defined,

Then the Max Capture point will only reset to the equation value after the reset point is activated,
followed by the trigger point being activated.
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Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point field

When the value of the Max Capture point updates depends on whether or not you defined the trigger
point as follows.

  Trigger point The Value of the Max Capture Point is Updated When the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Option 3.2.6. Min Capture

Select Min Capture in the Calculation field on the Virtual tab of the Point Properties dialog box.

A Min Capture point maintains the minimum encountered point value for the source Point ID that
you specify in the Expression field.

The minimum value is determined by comparing the current source point value with the value stored
in the Min Capture point. If the current value is smaller, it is stored as the new Min Capture point
value.

Important:  Min Capture points are not supported in redundancy.
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1 Expression

Enter an expression that calculates the value of the Min Capture point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs along with
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset point

Based on whether there is an entry in the Reset Point field, at runtime the Min Capture point is reset
as follows:

When the trigger point is not defined

If And Then

An Initial Min Capture Value is The Current value of the Expression is The Min Capture point value is reset
to the

Not defined Unavailable Initial value

Not defined Available Current value

Defined Unavailable Max possible value for the point type.
E.g. for INT the value is +32767

Defined Available Whichever has the Min value

When the trigger point is defined

If Then

An Initial Min Capture Value is The Min Capture point value is reset to the

Not defined Max possible value for the point type. E.g. for INT the
value is +32767 for INT the value

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

When the value of the Min Capture point updates depends on whether or not you defined the trigger
point as follows.

  Trigger point The Value of the Min Capture Point is Updated When the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Option 3.2.7. Trans-High Accum

Select Trans_High Accum in the Calculation Type field on the Virtual tab.

A Trans-High Accum point accumulates the number of times the Expression value transitions from
a zero to a non-zero value. While the CIMPLICITY project is running, the Trans_High Accum point
remembers its latest state, even if the points it depends on become unavailable.

Determining a transition takes into consideration the calculation type of the expression and the point
type of the Trans-High Accum point.

Important:  Transition points are not supported in redundancy.

Example

• If the Trans-High Accum point type is DINT and the Expression uses floating point arithmetic,
the result of the calculation is rounded to the nearest integer. For example, a value of 0.1 is
considered to be zero, and a value of 0.6 is considered to be non-zero.

• If the Trans-High Accum point type is FLOAT and the Expression uses floating point
arithmetic, then a transition from 0 to 0.1 is considered to be a transition from a zero to a non-
zero value.
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• Expression
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• Trigger point

1 Expression

Enter an expression in the Expression field on the Virtual tab of the Point Properties dialog box.

Enter an expression that calculates the value of the Trans-High Accum point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs as well as
• Constant values, operations and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset point

Based on whether there is an entry in the Reset Point field, at runtime the Trans-High Accum point
is reset as follows:

When the trigger point is not defined

If And Then

An Initial Trans High Accum Value is The Current value of the Expression is The Trans High Accum point value is
reset to the:

Not defined Unavailable Zero

Not defined Available Zero

Defined Unavailable Initial value

Defined Available Initial value

When the trigger point is defined

If Then

An Initial Trans High Accum Value is The Trans High Accum point value is reset to the:

Not defined Zero

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

When the value of the Trans-High Accum point updates depends on whether or not you defined the
trigger point as follows:

  Trigger
point

The Value of the Trans High Accum
Point is Updated When the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

Option 3.2.8. Equation w/Override

Select Equation w/Override in the Calculation field on the Virtual tab of the Point Properties
dialog box.

An Equation w/Override point is similar to an Equation point. It uses the expression you specify in
the Expression field to update the point's value.

In addition, applications may change the value of an Equation w/Override point. The changed value
remains in effect until one of the source points in the Expression changes and the Expression is
recalculated, or until an application supplies a new value for the point.
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• Trigger point

1 Expression

Enter an expression that calculates the value of the Equation w/Override point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs along with
• Constant values, operations and functions.

Rules for defining an expression are:

1. Avoid introducing loops (circular references between points) in your expressions.

Example of what to AVOID:

VIRTUAL_PT1 = DEVICE_PT + VIRTUAL_PT2

VIRTUAL_PT2 = DEVICE_PT + VIRTUAL_PT1

Although this will not cause CIMPLICITY software to fail, it will cause the Virtual Point
Processor to always have work to do. This causes all available computer time to be consumed,
which adversely impacts system performance.
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2. Use proper formatting for array points.

Example of the correct format

VIRTUAL_PT1 = DEVICE_PT[0] / 2.0

3. Use proper formatting for Point IDs with reserved words.

Point IDs that are reserved words, or contain spaces, arithmetic operators, parentheses, or
that begin with a non-alphabetic character must be placed in single quotes when used in an
expression.

Example

VIRTUAL_PT2 = 'DEVICE_PT:0' * 'WARNING_LOW'

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:

• Open:
◦ The Select a Point browser.
◦ The Point Properties dialog box for a selected point.
◦ A New Point dialog box.
◦ The Expression Editor.

• Display an extended menu with the associated operations.

2 Reset point

Based on whether there is an entry in the Reset Point field, at runtime the Equation /Override
point is reset as follows:

When the trigger point is not defined

If And Then

An Initial Equation w/Override Point
Value is

The Current value of the expression
is

The Equation w/Override point
value is reset to the:

Not defined Unavailable Zero

Not defined Available Current value

Defined Unavailable Current value
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If And Then

Defined Available Current value

When the trigger point is defined

If Then

An Initial Equation w/Override Point Value is The Equation w/Override point value is reset to the:

Not defined Zero

Defined Initial value

Note:  Buttons to the right of the Reset Point and Trigger Point fields help with
configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
◦ A New Point dialog box.
◦ The Point Properties dialog box for a selected point.
◦ The Select a Point browser.

• Select a recently selected point.

3 Trigger point

When the value of the Equation w/Override updates depends on whether or not you defined
the trigger point as follows:

  Trigger
point

The Value of the Equation w/Override
is Updated When the Value of the:

Defined Trigger point is updated.

Not defined Value of the source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of
the Reset Point field.

Option 3.2.9. Timer/Counter
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A Timer/Counter point records the following data in three array elements:

• A count of the number of times the Expression has transitioned from the LOW state to the
HIGH state since the project started or since the Timer/Counter point was reset.

The Expression is in its:

• LOW state if its value is less than or equal to zero
• HIGH state if its value is greater than zero
• The accumulated duration of all HIGH states, stored in seconds.
• 0 or the time of the last transition to HIGH.

While the Expression is in the:

• LOW state, this field contains zero
• HIGH state, this field contains the time the Expression transitioned to the HIGH state.

Time is stored in the number of seconds since 00:00:00 on January 1, 1970 GMT (Greenwich Mean
Time). If you computer's clock is set for another time zone, this value is translated accordingly. For
example, if your computer's clock is set for Eastern Standard Time, the base time is 19:00:00 31
December 1969.

• General Tab: Point Properties dialog box.
• Virtual Tab: Point Properties dialog box.

General Tab: Point Properties dialog box

Selections on the General tab are as follows.
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• Data type
• Elements

1 Data type field (General tab)

Select UDINT.
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2 Elements (General tab)

Select 3.

During runtime, the value of the Expression determines how information is stored in the array.

When the Expression transitions from its LOW state to its HIGH state:

• The first element of the array is incremented.
• The third element of the array is set to the current system time
• The Interval timer starts.
• While the Expression remains in its HIGH state, the duration time in its second element is

increased at every Interval.
• When the Expression transitions from its HIGH state to its LOW state, the third array element is

set to zero.
• While the Expression remains in its LOW state, no elements of the array are updated.

Virtual Tab: Point Properties dialog box

Selections on the Virtual tab are as follows.
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• Expression
• Reset point
• Start time
• Interval

1 Expression
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Enter an expression that will serve as the "edge trigger" for the Timer/Counter.

The expression may contain:

• One or more Point IDs as well as
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:

• Open:
• The Select a Point browser.
• The Point Properties dialog box for a selected point.
• A New Point dialog box.
• The Expression Editor.
• Display an extended menu with the associated operations.

2 Reset point

During runtime, when the reset point updates, the elements of the Timer/Counter point are reset to 0.

Example

Three Timer/Counter points are updating every 15 seconds

You can define their start times as follows to distribute system load:

Point ID Start Time

Point1 00:00:05

Point2 00:00:10

Point3 00:00:15

You want to update the Timer/Counter point every ten minutes while the expression is in the HIGH
State.

Enter 00:10:00 in the Interval field to update each Timer/Counter every ten minutes from the time it
started.

  Point ID While the expression remains high, will update every 10 minutes in the hour beginning at:
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Point1 00:00:05

Point2 00:00:10

Point3 00:00:15

When the Expression value goes HIGH, the values in the Timer/Counter point are updated. After
that, the updates are done every ten minutes.

Note: Buttons to the right of the Reset Point  field helps with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
• A New Point dialog box.
• The Point Properties dialog box for a selected point.
• The Select a Point browser.
• Select a recently selected point.

3 Start time

Enter a Start Time that is at least 00:00:01 to be a base start time for the Interval.

The format is hh:mm:ss

Where

hh is the hour,

mm is the minute, and

ss is the second value.

If you have a large number of Timer/Counter points being updated at a high frequency, system
performance can be adversely affected. You can use Start Time to distribute their updates to
different times and reduce the impact on system performance.

4 Interval

Enter the time Interval between the Timer/Counter point updates while the Expression value
remains HIGH.

The format is hh:mm:ss
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Where

hh is the number of hours,

mm is the number of minutes, and

ss is the number of seconds.

Option 3.2.10. Histogram

Select Histogram in the Calculation field on the Virtual tab.

A Histogram point records the frequency at which the value of the source point, identified in the
Expression field, updates within specified range intervals. This information is typically displayed
graphically as a histogram.

Each time the source point is updated, the counter whose range encompasses the source point value is
incremented.

You must configure a Histogram point as an array point. The number of elements in the array will be:

         the number of range intervals you desire + 6
      

The extra six elements are used to maintain the:

• Minimum of the point values received
• Maximum of the point values received
• Total number of samples received
• Sum of the values of all samples received
• Number of sample values that were less than the lower limit of the point range (underflow

bucket)
• Number of sample values that were greater than the upper limit of the point range (overflow

bucket)
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• Expression
• Reset point
• Trigger point
• Example

1 Expression

Enter an expression that calculates the value of the Histogram point.

The expression will be monitored for transitions.

The expression may contain:

• One or more Point IDs as well as
• Constant values, operations, and functions.

Buttons to help with the equation are as follows.

Opens the Expression Editor (page 347).

Displays a Popup menu to:
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• Open:
• The Select a Point browser.
• The Point Properties dialog box for a selected point.
• A New Point dialog box.
• The Expression Editor.
• Display an extended menu with the associated operations.

2 Reset point

Based on whether there is an entry in the Reset Point field, at runtime the Histogram point is reset as
follows:

When the trigger point is not defined

If And Then

An Initial Histogram Value is The Current value of the Expression is Each Array element of the Histogram is reset to:

Not defined Unavailable Zero

Not defined Available Zero

Defined Unavailable Initial value

Defined Available Initial value

When the trigger point is defined

If Then

An Initial Histogram Value is Each Array element of the Histogram is reset to:

Not defined Zero

Defined Initial value

Note: Buttons to the right of the Reset Point and Trigger Point fields help with configuration.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:
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• Open:
• A New Point dialog box.
• The Point Properties dialog box for a selected point.
• The Select a Point browser.
• Select a recently selected point.

3 Trigger point

When the value of the Histogram point updates depends on whether or not you defined the trigger
point as follows:

  Trigger point The Value of the Histogram is Updated When the Value of the:

Defined Trigger point is updated.

Not defined Source point in the Expression field is updated.

Buttons to help with the trigger point have the same functionality as the buttons to the right of the
Reset Point field.

4 Histogram Point Example

A point named CYCLE_TIME is expected to have a value between 50 and 100, and you want to
track the frequency at which values occur within five intervals.

Create a Histogram point called HIST_CYCLE_TIME with:

Display Low 50

Display High 100

Elements 11

Expression CYCLE_TIME

The eleven elements of this point contain the following information, where X is the number of point
value samples:

Element Contents

HIST_CYCLE_TIME[0] X<50 (underflow bucket)

HIST_CYCLE_TIME[1] 60<X³50

HIST_CYCLE_TIME[2] 70<X³60

HIST_CYCLE_TIME[3] 80<X³70

HIST_CYCLE_TIME[4] 90<X³80
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HIST_CYCLE_TIME[5] 100£X³90

HIST_CYCLE_TIME[6] 100<X (overflow bucket)

HIST_CYCLE_TIME[7] Number of samples

HIST_CYCLE_TIME[8] Sum of all sample values

HIST_CYCLE_TIME[9] Minimum of the point values received

HIST_CYCLE_TIME[10] Maximum of the point values received

Tip:  Use the Display Limits fields to specify the lower and upper range values within which
the point values are expected to occur. The range intervals are automatically calculated based on the
Display High and Display Low limits and the number of Elements you specify.

Examples: Virtual Calculation and Trigger Points

The trigger point function lets you configure virtual points so they are updated only when the trigger
point is updated. This minimizes the system resources that are required for calculating virtual points
when it is not necessary to keep virtual points current with the points used to calculate their values.

For virtual points, a trigger point may be either a device point or a virtual point.

If the trigger point is a:

Device
point

The Update Criteria for the trigger point determines when triggered reads take place. The criteria can either
be when the trigger point value changes or when it is scanned.

Virtual
point

There are no update criteria that can be changed.

• Example 1: Virtual Update Logging.
• Example 2: Virtual Point Interval Trigger.

Example 1: Virtual Update Logging

You are configuring a point that requires an update for logging purposes.

You can use the following based on when the update needs to occur.

If the update
needs to occur:

Use

Hourly A device trigger point that is configured with a one-hour scan rate.

When a particular condition
changes:

Use either a:

• Device trigger point that represents the condition and is configured to be updated
On Change or.

• Virtual trigger point that represents the condition.
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Example 2: Virtual Point Interval Trigger

Two device points accumulate the number of widgets and nuts made during a shift.

• WIDGET_ACCUM and
• NUT_ACCUM

Data needs to be captured from these points at the end of each shift.

A procedure to do this includes configuring three virtual points:

• SHIFT_NUMBER
• WIDGET_COUNT
• NUT_COUNT

1. Configure SHIFT_NUMBER.
a. Select the Virtual tab in the Point Properties dialog box.
b. Select None in the Calculation field.

2. Configure WIDGET_COUNT.

Select the Virtual tab in the Point Properties dialog box.

Entries are as follows.
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Field Description

A Calculation Equation

B Expression WIDGET_ACCUM

The device point that accumulates the number of widgets during the shift.

C Trigger point SHIFT_NUMBER

When SHIFT_NUMBER changes, WIDGET_COUNT will read the value of WIDGET_ACCUM.

3. Configure NUT_COUNT.

Select the Virtual tab in the Point Properties dialog box.

Entries are as follows.

Field Description

A Calculation Equation

B Expression NUT_ACCUM

The device point that accumulates the number of widgets during the shift.

C Trigger point SHIFT_NUMBER

When SHIFT_NUMBER changes, NUT_COUNT will read the value of NUT_ACCUM.

Device and Virtual Point Configuration

Device and Virtual Point Configuration

Step 1
(page
251)

Configure View for points.
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Step 2
(page
256)

Enter point limits.

Step 3
(page
259)

Select point conversions and enumeration.

Step 4
(page
278)

Configure point alarms.

Step 1. Configure View for Points

The View tab is available in the Point Properties (and Data Item) dialog box when the General tab is
in Advanced view.

Options are as follows.

rect -3, 53, 23, 81  (page 252)
rect -2, 82, 22, 106  (page 252)
rect 128, 103, 153, 127  (page 252)
rect -4, 165, 25, 192  (page 253)
rect -2, 200, 24, 224  (page 256)
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252)

Justification

2
(page
252)

Width

3
(page
252)

Precision specifications
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4
(page
253)

Display limits

5
(page
256)

Screen

1 Justification

An analog point's justification when it displays in CIMPLICITY software, such as CimView.

Check the left, right or zero radio button.

Radio Button Point display justification is:

Left Left

Right Right

Zero Right and zero filled

2 Width

Minimum number of spaces you want to use to display the point.

The width specification never causes a value to be truncated. If the number of characters in the
output value is greater than the specified width, or if a width is not given, all characters of the value
are printed (subject to the precision (page 252) specification).

If the number of characters in the output value is less than the specified width, blanks are added to
the left or right of the values, depending on whether the flag (for left alignment) is specified, until the
minimum width is reached.

If the width is prefixed with 0, zeros are added until the minimum width is reached.

3* Precision specifications

Precision specifications (displays for analog real points only) are as follows.

1. Enter the precision number of digits to be displayed to the right of the decimal point in field.

2. Select Fixed, Scientific or Compact for the format TYPE. The result of your choice is as
follows:

Format
Type

Description

Fixed Fixed format using the Width and Precision information you specify.

Default 6
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Format
Type

Description

   Example Width = 8 Precision =3 1500 displays as 1500.000.

Note: Select Configured for the text object in CimEdit to display the specifications on the View tab.

Scientific Scientific format using the Width and Precision information you specify.

Default 6

             
Up (page
252)

Example Width = 8 Precision = 3 1500 displays as 1.500e+003

Compact Fixed or Scientific format based on Precision information. Precision information determines the
exponent to start displaying in Scientific format.

Example Width = 8 Precision = 3 1500 displays as 1.5e+003 

The Compact type also truncates trailing zeros to the right of the decimal point. For example, 10.0
displays as 10 and 10.10 displays as 10.1.

Guide for enabling analog display configuration: When you configure an object that uses the
point in CimView, you have to enable the Justification and Width configuration in CimEdit.
You do this on the Text tab of the Object Properties dialog box in CimEdit, in the Display
Format field.

Up (page 252)

4 Display Limits
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Display low and Display high graphics limits are used by CimView and Trending.

CimEdit/CimView uses graphics limits as maximum/minimum limits for:

• Horizontal/Vertical movement.
• Rotation/Fill.
• Horizontal/Vertical scaling.

If you have a single point expression in any of the above expressions and you do not specify
a minimum or maximum limit for the expression, the point's display limits are used instead.
If these limits are not specified either, default values of 0 (minimum) and 100 (maximum) are
used.

Trending uses the graphics limits to determine the Y-axis limits for the point.

Note: The display limits must be within the range limits (page 256) you specify on the Limits
tab in the Point Properties dialog box..

Display
Limit

Description

Display High Upper bound for the display. If the point value is greater than this value, this Display High
value displays.

Display Low Lower bound for the display. If the point value is less than this value, this Display Low value
displays

Important:  Make sure the display limits are within range limits that you set.

Display Limits Example

Display limits configuration (example)

Display limits are specified in the Point Properties dialog box.

Display Low 0

Display High 5000

A car is placed on a CimEdit Screen.
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Horizontal movement is configured in the CimEdit Properties - Group dialog box Movement
tab.

Expression CAR_R

Expr. min/max Blank (Point Properties specifications are used.)

Move offset 115

Display limits runtime (example)

The point value is 0. The car is at the minimum display position.

The point value is 5000. The car is at the maximum display position.

The point value is 10000. The car position is the same as the maximum
display value, 5000.
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Up (page 253)

5 Screen

Options include CimView screens that are in the project directory.

• The name of the screen you select will appear on the point's Popup menu in the
Workbench. The screen will appear when it is selected.

• The screen will display when a user selects this point in the Alarm Viewer and clicks
Screen.

Step 2. Enter Point Limits

The Limits tab is available in the Point Properties (and Data Item ) dialog box:

For device or virtual analog points:

When the General tab is in Advanced view.

• Range limits configuration.
• Setpoint limits configuration.

Range Limits configuration

Values below a low range limit and above a high range limit will display as an unavailable point
value.

Range limits:

• Apply to only the first element of an array point.
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• Can be very useful if you want to exclude meaningless data from CIMPLICITY functions.

Enter the low and high limits in the Range limits box for the converted value of the point.

Example

• A PLC gives raw data in counts from 0 to 1000.
• The raw data represents temperatures between -500 °C and 500 °C.
• Values above 200 °C or below -200 °C are considered to be out of range.

• The point's value displays as follows.

Point value Value that displays

Below -200 °C Unavailable

Above 200°C Unavailable

Between -200 °C and +200 °C Current

guide:  Guidelines for Unavailable Range Values during Runtime

When the project is running, values exceeding the range limits are handled as follows:
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If the range limit is exceeded:

During runtime
• The point value on CimView screens

displays the default text until the point
comes back within raw limits.

• Point Control Panel displays asterisks
(******) for the point value until the point
comes back within raw limits.

At startup
• The point value on CimView screens

displays the default text until the point
comes back within raw limits.

• Point Control Panel displays asterisks
(******) for the point value until the point
comes back within raw limits.

If the RAW_LIMIT_ALARM global parameter is set to:

YES An alarm is generated when a point's value first exceeds its range limits. When the point value returns to within
its range limits, the Alarm State will be set to Normal.

NO No alarm will be generated.

Setpoint limits configuration

Setpoint entries during runtime must be within the limits entered in the Setpoint limits box.

If a user enters a value below the low setpoint limit or above the high setpoint limit, the value will
not be accepted.

Enter the Low and High limits in the Setpoint limits box.

Important:  The setpoint limits must be within the range limits.
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Step 3. Select Point Conversions and Enumeration

Step 3. Select Point Conversions and Enumeration

1. Click Advanced on the General tab the Point Properties (and Data Item) dialog box.

2. Select the Conversion tab.

3. Continue using the following methods.

rect 141, 85, 164, 107 Step 3.3. Select a Point as an Enumeration Point (page 265)
rect 0, 110, 23, 132 Step 3.2. Configure the Conversion Type for a Device Point (page 262)
rect 0, 53, 23, 75 Step 3.1. Configure Base Point Engineering Units for a Point (page 259)

Step 3.1
(page
259)

Configure base engineering units for a point.

Step 3.2
(page
262)

(For device points) Configure the conversion type.

Step 3.3
(page
265)

Select a point as an enumeration point.

Note:  If you select a unit of measurement on the Conversion tab, and the project has an
active measurement system at runtime, the base engineering units for the point are automatically
converted to the corresponding units in the active measurement system.

If there is no active measurement system, the base engineering units are used. If the project has
an active measurement system at runtime, no further point conversion takes place.

Step 3.1. Configure Base Point Engineering Units for a Point
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• Measurement unit configuration features.
• Create a new measurement unit.
• Label with no unit.

Note:

• During runtime, the base engineering units for the point are automatically converted to the
corresponding units in the active measurement system. No further point conversion takes place.

• Deadbands and analog deadbands are configured they will not be converted via measurement
units or otherwise.

• There is no active measurement system, the base engineering units are used.

Measurement unit configuration features

Unit Unit that is converted from the project's base measurement unit.

Opens the Select a Measurement Unit browser to select an available measurement unit.

Displays a Popup menu to:

• Open:
• A New Measurement Unit dialog box.
• The Measurement Unit Properties dialog box for a selected unit.
• The Select a Measurement Unit browser.
• Select a recently used unit.

Label Displays when the measurement unit is listed.

Create a new measurement unit
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1. Click the Popup Menu button  to the right of the Unit field.

2. Select New.

The New Measurement dialog box opens.

3. Enter a new measurement label in the Unit ID field.

4. Click OK.

A Measurement Unit Properties dialog box opens.

5. Enter the following.

Field Description

Description Provides more information about the new measurement unit label.

Display label Label that displays when the measurement unit is listed.

6. Click Apply.

The new unit and label display in Unit and Label fields and is added to the list of available units.

Note:  You can delete a measurement unit in the Measurement Units window.

Label with no unit

Leave the base units for the point blank and enter your own label in the Label field.
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You can configure point enumeration for either a virtual or device point.

Step 3.2. Configure the Conversion Type for a Device Point

CIMPLICITY supports the following types of Engineering Unit (EU) conversions for device analog
points:

rect 81, 131, 138, 148  (page 263)
rect 150, 131, 207, 148  (page 264)
rect 23, 131, 80, 148  (page 262)

• None
• Linear conversion.
• Custom conversion.

Important:  When you specify Linear or Custom conversion, you must enter the values for the
Raw and Converted Limits.

None (no conversion)

When None (no device conversion) is checked, the active measurement system is used.
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Example

A point's value represents degrees in Fahrenheit.

The Unit field is blank.

The active measurement system uses Metric units.

However, there is no conversion from degrees in Fahrenheit to degrees in Centigrade during runtime.

Linear Conversion

• Linear configuration
• Linear conversion formula

Linear configuration

When Linear is checked, fields are as follows.

Raw values Low Two valid raw values.

High

Converted values Low Engineering unit values that correspond to the low and high raw values.

High

Linear conversion formula

These four values calculate the linear conversion for the point.

The conversion formula is:
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Where

EU value = the Engineering Units value

RL = Low raw value

RH = High raw value

CL = Low conversion value

CH = High conversion value

Raw value = the value read from the device.

The inverse of this expression converts set point values that are entered by users to raw values. The
raw values can be downloaded to the device.

Custom Conversion

• Custom conversion configuration.
• Valid operations.
• Expression processor interpretation.

Custom Configuration

When Custom is checked conversion fields are as follows.

Forward Converts the raw data to engineering units.

Use the placeholder %P to indicate the point value in the expression. %P is the raw value of the point.

Reverse Converts set point values from engineering units to raw data.

Use the placeholder %P to indicate the point value in the expression. %P is the engineering units value of
the point.

Valid Operations

Forward and Reverse operations use the functions that are available in the Expression Editor (page
350) .

Example
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A conversion calls for the raw data to be divided by 10.0 then multiplied by 2.5.

The Forward expressions is (%P/10.0)*2.5

The Reverse expression is (%P/2.5)*10.0

Expression processor interpretation

Important:  When creating a custom conversion:

• The numeric operands you use in the Forward expression are assumed to be integers unless you
include decimal points in them. Once the expression processor sees an operand with a decimal
point, it will process the rest of the expression using floating-point arithmetic.

• A conversion that inverts the sign, (e.g. a FWD Conversion = %P(-1) and REV Conversion =
%P(-1)) will not work correctly if you configure a set point, range or alarm limits

Example

A conversion that calls for the raw data to be divided by 2, then multiplied by 10.

The raw value for the point is 3.

You could enter any one of the following expressions. However, the Expression Processor interprets
each expression differently, as follows:

Expression Result

Because integer arithmetic was used throughout, the result is an integer:

(%P/2)*10 (3/2)*10 = (1)*10 = 10

Because integer arithmetic was used in the first operation of these two expressions, the operation
(3/2) gives the result 1 instead of 1.5:

(%P/2)*10.0 (3/2)*10.0 = (1)*10.0 = 10.0

Because (3/2.0) is processed using floating point arithmetic, the rest of the expression will be
processed using floating point arithmetic, even thought 10 is entered as an integer:

(%P/2.0)*10 ( 3/2.0)*10 = (1.5)*10 = 15.0

Because (3/2.0) is processed using floating-point arithmetic, the rest of the expression will be
processed using floating-point arithmetic:

(%P/2.0)*10.0 (3/2.0)*10.0 = (1.5)*10.0 = 15.0

Step 3.3. Select a Point as an Enumeration Point

Step 3.3. Select a Point as an Enumeration Point



Project Setup | 7 - Points | 266

When a point is configured as an enumeration point, the value of the point will display as enumerated
text (a STRING point of 32 elements) in applications including:

• Point Control Panel,
• CimView,
• Database Logging and
• BCE.

Point enumeration is particularly useful for points where a value that is translated into text is more
easily understandable than the numeric value, e.g. ON/OFF vs. 0/1.

If the value of the point does not correspond to a configured enumeration, the point will be treated as
being out of range and will be displayed as unavailable.

Options to select an enumeration point include:

Option
3.3.1 (page
267)

Select an existing Enumeration Set for a point.

Option
3.3.2 (page
268)

Create a new Enumeration Set.

Option
3.3.3 (page
270)

Edit an existing Enumeration Set.

guide:   Guidelines for enumerated points include:

• Analog points, including derived points, of the following base data types may use enumeration
sets:

• SINT ,
• USINT ,
• INT,
• UINT,
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• DINT,
• UDINT and
• BOOL.

These data types will be referenced as discrete data types.

• Points that are not supported include:
• Array points.
• Points with EU conversion. The result of their evaluation is a REAL data type, which does not

have discrete values.
• Discrete points with 1 element only can use enumeration sets.
• A point can be configured so that the value can be set to any of the case-sensitive enumerated

text values.

If the point is set to a value that is not part of the case-sensitive enumeration, CIMPLICITY
generates an error.

Option 3.3.1. Select an Existing Enumeration Set for a Point

Click either of the following buttons to select an enumeration set.

Button Description

Opens the Select a Point Enumeration browser to select an available enumeration set.



Project Setup | 7 - Points | 268

Button Description

Displays a Popup menu to:

• Open:
• A New Enumeration Set dialog box.
• The Enumeration Set Properties dialog box for a selected set.
• The Select a Point Enumeration browser.
• Select a recently used set.

Result: The enumeration displays in the Point Enumeration field and provides the point conversion
during runtime.

Option 3.3.2. Create a new Enumeration Set

Option 3.3.2. Create a new Enumeration Set

Option 3.3.2.1
(page 268)

Open a new Point Enumerations dialog box.

Option 3.3.3.2
(page 268)

Configure a new Enumeration set.

Option 3.3.2.1. Open a new Point Enumeration Dialog Box

1. Right-click Point Enumerations.
2. Select New on the Popup menu.
3. Right-click any Enumeration ID.
4. Select New on the Popup menu.

Option 3.3.2.2. Configure a new Enumeration Set

1. Do the following.
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A Enter a description in the Description field in the Point Enumeration dialog box.

B Click New.

The New Value dialog box opens.

2. Create a new value as follows.
a. Enter a value in the Value field.

Note:  When the Enumeration set is associated with a point, its accompanying text will
display in applications, e.g. Point Control Panel, when this value is reached.

If the point is a setpoint, the value you enter will be set when its accompanying text is selected.

a. Click OK.

The Value properties dialog box opens.

Options are as follows.

Value (Read-only) Value that was entered in the New Value dialog box.
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Text Text that will be associated with the value.

Setpoint
Allowed

Check  to allow a point that is associated with the Enumeration set to be set to the selected
value.

a. Click OK.

The Point Enumeration dialog box displays the information you just entered.

3. Continue adding values until the Enumeration set is complete.

4. Click OK.

the Point Enumeration set is now available to be associated with one or more points. The values that
you enter in the text field are case sensitive. Anyone working with those values must enter them
exactly as configured.

Option 3.3.3. Edit an Existing Enumeration Set

CIMPLICITY provides several methods to open an existing Point Enumeration dialog box.

• Through the Workbench
• Through a Point Properties dialog box.

Through the Workbench:

1. Select Project>Points>Point Enumerations in the Workbench left pane.

2. Select an Enumeration ID in the Workbench right pane.

3. Do one of the following.
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A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:
a. Right-click Point Enumerations.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click an Enumeration ID. a. Right-click an Enumeration ID.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

Through a Point Properties dialog box

a. Enter an enumeration set in the Point Enumeration field.

b. Click the Popup Menu button  to the right of the Point Enumeration field.
c. Select Edit.
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4. Right-click Point Enumerations.

5. Select Properties on the Popup menu.

6. Right-click an Enumeration ID.

7. Select Properties on the Popup menu.

Enumeration Point Application Examples

Enumeration Point Application Examples

• A point is assigned an enumeration set.
• Enumeration applications include the Point Control Panel and CimEdit/CimView.

A Point is assigned an enumeration set

• A UDINT analog point named HEAT.SOUTH.REGION.01_MACHINE6501:
• Allows setpoints.

• Is associated with an Enumeration set named TEMPERATURE.
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• The TEMPERATURE values/text are as follows.

Value Text Setpoint Allowed

0 Too Cold True

1 Cold True

2 Normal True

3 Warm True

4 Hot True

5 Too hot True

Enumeration applications include the Point Control Panel and CimEdit/
CimView.

The Enumeration set is used in:

• The Point Control Panel.
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• CimEdit/CimView.

Enumeration Point Example in the Point Control Panel

During runtime in the Point Control Panel, the value reflects the enumeration text.

A Point Control Panel user:

1
(page
274)

Displays the point LNE1_CNTRL in the Point Control Panel.

2
(page
274)

Changes the point value in the Point Properties dialog box.

3
(page
275)

PARTLY CLOSED displays in the Point Control Panel.

Displays the point LNE1_CNTRL in the Point Control Panel.

The LNE1_CNTRL point value is OPEN.

OPEN is one of the text values for  the THROTTLE_VALE enumeration set.

Changes the point value in the Point Properties dialog box.

The new value is set PARTLY CLOSED.
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PARTLY CLOSED displays in the Point Control Panel.

Enumeration Point Example in CimEdit/CimView

The enumeration point LNE1_CNTRL  (page 272) is used in CimEdit/CimView.

A screen designer:

1
(page
276)

Configures a text object as an enumeration setpoint.

2
(page
276)

Inserts a valve group from the Object Explorer onto the CimEdit screen.

3
(page
276)

Configures expression animation for the valve indicator.

4
(page
277)

Performs a runtime enumeration test.
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Configures a text object as an enumeration setpoint.

A text object on the CimEdit screen will provide setpoint capability in CimView.

Configuration for the enumeration value is as follows.

Option Entries

A String (Default text) VALVE-POSITION

B Expression LNE1_CNTRL'

C Setpoint action Checked

Inserts a valve group from the Object Explorer onto the CimEdit screen.

Configures expression animation for the valve indicator.

Each of the enumeration point values is assigned an animation color in the Expression List Attribute
Animation dialog box.
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Expression values are as follows.

LNE1_CNTROL EQ Color Animation

LNE1_CNTRL EQ "OPEN" Solid green

LNE1_CNTRL EQ "PARTLY OPEN" Striped green/white

LNE1_CNTRL EQ "HALF OPEN" Striped blue/white

LNE1_CNTRL EQ "PARTLY CLOSED" Striped red/white

LNE1_CNTRL EQ "CLOSED" Solid red

LNE1_CNTRL EQ "UNAVAILABLE" Solid black

Performs a runtime enumeration test.

The text setpoint functionality enables the LNE1_CNTRL value to be changed in CimView .

A When CimView opens the:

• Value is OPEN.
• Indicator is green.
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B The text PARTLY CLOSED is entered.

C After PARTLY CLOSED is entered the:

• Value is PARTLY CLOSED.
• Indicator is striped red/white.

Step 4. Configure Point Alarms

Step 4. Configure Point Alarms

You can set alarms for analog and Boolean points. The alarms can be configured for both audio and
visual display.

Select the Alarm tab in the Point Properties dialog box.

Configuration in the Point Properties dialog box includes the following steps.
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rect 271, 20, 331, 39 Step 4.3. Set Alarm Options (page 305)
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Step 4.1
(page
279)

Configure the Alarm tab.

Step 4.2
(page
302)

Configure alarm routing.

Step 4.3
(page
305)

Set alarm options.

Step 4.1. Configure the Advanced Alarm Tab

Step 4.1. Configure the Advanced Alarm Tab

No matter what alarm criteria you select, the advanced Alarm tab provides you with the ability to do
the following.
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Step 4.1.1
(page
280)

Enter a detailed alarm definition.

Step 4.1.2
(page
287)

Select alarm criteria.

Step 4.1.3
(page
297)

Specify an alarm deadband.

Step 4.1.4
(page
298)

Provide an Alarm Viewer help file.

Step 4.1.5
(page
302)

Enter maximum alarm stacked.

Note:

• You create an event alarm in the Alarms folder. You can modify point alarms in both the Point
Properties dialog box and the Alarm Definition dialog box in the Alarms folder.

• A basic alarm tab is available to enter a basic alarm message and one or more absolute alarm
limits. If a different alarm criteria (page 287) or a deadband (page 297) is entered, the basic
view will no longer be available.

Step 4.1.1. Enter an Alarm Definition
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You can configure a basic I/O alarm message in the Alarm tab's basic view.

In the advanced view you can enter a definition that CIMPLICITY uses to trigger exactly the alarm
message you want based on calculated criteria.

A detailed alarm definition includes the following configuration.

rect -1, 45, 22, 68  (page 281)
rect -3, 72, 20, 95  (page 286)
rect 190, 68, 213, 91  (page 286)

1
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Alarm message

2
(page
286)

Alarm class

3
(page
286)

String index

1 Alarm message

CIMPLICITY alarm messages

• Display in the alarm in Alarm Viewer.
• Can be logged to SQL Server.
• Can include the following.

• Basic text alarm message.
• Standard variable information in an alarm message.
• Related point values embedded in alarm messages
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Basic Text Alarm Message

An alarm message can display a basic text message on the Alarm Viewer.

Example

The following basic message is entered in the Alarm message field,

Alarm State. Call the Station 1 supervisor.

During runtime, the message displays in the Alarm Viewer.

Standard Variable Information in an Alarm Message

This message may contain text plus variable information that is determined when the alarm is
generated.

Note: You can type the variable fields in the Alarm message field or click each that you want on the
Popup menu to the right of the field. Type them all as capital letters (CAPS).

Total display length 80 characters for all fixed text and variables.

Popup menu displays selections that, when clicked, insert a corresponding variable in the in the Alarm message
field.

Popup Selection Variable During runtime, displays:

Point ID %ID Point ID.

Point Value %VAL Point value (converted
to engineering units if
applicable).

EU Value %EU Engineering Units label.

Alarm State %STATE Alarm string for the String
Index.

Alarm Limit %LIMIT Alarm limit that was
exceeded.

Deviation Point %DEV_ID Point ID of the deviation
point.

Deviation Value %DEV_VAL Value of the deviation point.

Deviation Amount %DEV_AMT Difference between the
current point value and the
deviation point value.

Percent %% Actual percent sign in the
message.

Example
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An alarm string is configured so that the string for

• Warning High is WARNING.
• Alarm High is EMERGENCY.

The Alarm High and Warning High limits are 400 and 350 degrees.

The alarm message is:

CONDITION: %STATE - TEMP IS AT %VAL DEGREES

If the temperature is 353 degrees, an alarm will be generated with the message:

CONDITION: WARNING - TEMP IS AT 353 DEGREES

If the temperature goes to 402 degrees, the alarm will be updated and the message will read:

CONDITION: EMERGENCY - TEMP IS AT 402 DEGREES

Related Point Values Embedded in Alarm Messages

Alarm messages can report additional point values.

This feature provides the ability to quickly evaluate other factors that might be affecting the point's
alarm condition.

The following fields enable you to include additional point values in an alarm message.

%VAL1(<point ID>)

%VAL2(<point ID>)

%VAL3(<point ID>)

%VAL4(<point ID>)

%VAL5(<point ID>)

%VAL6(<point ID>)

%VAL7(<point ID>)

%VAL8(<point ID>)

%VAL9(<point ID>)

Important:
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• %VAL<n> must be in capital letters. The point ID can be in lower case; however it will be
transformed to all capital letters when it is written to the disk.

• A maximum of 6 fields can be included in an alarm message. This includes both the standard
variable fields and the fields to report related point values.

When entered in the Alarm message field, %VALn(<point ID>) values are:

• Included in the alarm message that displays in an Alarm Viewer
• (Optional) Logged in separate columns in SQL Server.
• The alarm messages enhancements do not support CIMPLICITY system points (many of which

are not generated by the Point Management Resident Process); they should not be included in
your alarm message configuration.

Example

A system includes features whose  performance is mutually dependant.

One feature may go into an alarm state, when the other features are in normal state. However, an
analysis of the values for the other features reveals that interaction contributes to the alarm state and
changes in settings may resolve the issue.

Including those values in a single alarm message and logging them facilitates the analysis.

The alarm message is:

%ID TEMPERATURE is %VAL! HTR1: %VAL1(HEAT101), COOLANT: %VAL2(COOL101),

Heater1 Level: %VAL5(LEVELR101), Heater2 Level: %VAL7(LEVELR201)

Where

Field Description Example

%ID = ID of a point being monitored Temperature

%VAL = Value of the point being monitored.

%VAL1 = Value of another point, which is identified in the parentheses. Heater temperature

%VAL2 = Value of another point, which is identified in the parentheses. Coolant status

%VAL5 = Value of another point, which is identified in the parentheses. Heater 1 level

%VAL7 = Value of another point, which is identified in the parentheses. Heater 2 level

When  the point is in alarm state, the message displays all values in the Alarm Viewer, as follows.
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HEAT01 is 162! HTR1: 100 COOLANT: 45, Heater1Level: 291, Heater2Level: 268

Where

Field Value

%ID = HEAT01

%VAL = 162

%VAL1 = 100

%VAL2 = 45

%VAL5 = 291

%VAL7 = 268

Note:  If the values of the point that is being monitored are logged to the ALARM_LOG, the
%VALn columns display in the SQL table, as follows.

Field Alarm ID Column Value Point Value Column Value

%ID = alarm_id HEAT01 alarm_id HEAT01

%VAL = point_val 162 point_val 162

%VAL1 = point_id_1 HEAT101 point_val_1 100

%VAL2 = point_id_2 COOL101 point_val_2 45

%VAL5 = point_id_5 LEVELR101 point_val_5 291

%VAL7 = point_id_7 LEVELR201 point_val_7 268

Tip:  Even though each alarm message can include only 6 fields, an entire system can make use
of all of the %VALn columns. One option is to use each column for a specific feature. Each time a
point ID for that feature is used its values will display in the designated column.

Example

The coolant value for a system is assigned to %VAL2 in any alarm message where it is included. An
engineer who needs to analyze its values directly in the SQL table can easily fine the values in the
point_val_2 column.

Note: Other CIMPLICITY features, such as Trend and Digital Graphic Replay, can also facilitate
tracking any issues.
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2 Alarm class

Groups alarms with similar characteristics.

An alarm's class determines the order in which it appears static to other alarms in Alarm Viewer. You
can prioritize classes in the Alarm Class Configuration dialog box.

Note:  If you specify an Alarm Class, you must specify an Alarm Message.

Opens the Select an Alarm Class browser to select an existing alarm class.

Popup menu displays the following selections.

• Open:
• A new Alarm Class Configuration dialog box.
• The Alarm Class Configuration dialog box for a class that is entered in the Alarm Class

field.
• The Select an Alarm Class browser.
• Select a recently selected class.

3 String index

Number to identify the alarm text, if you are using %STATE in your alarm message.

Opens the Select an Alarm String browser to select an existing alarm string set.
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Popup menu displays the following selections.

• Open:
• A new Alarm String Configuration dialog box.
• The Alarm String Configuration dialog box for a class that is entered in the Alarm String

field.
• The Select an Alarm String browser.
• Select a recently selected alarm string.

Step 4.1.2. Select Alarm Criteria

Step 4.1.2. Select Alarm Criteria

You can select one of the following methods for evaluating the alarm values:

Option 4.1.2.1
(page 288)

Absolute alarming

Option 4.1.2.2
(page 289)

Absolute equals alarming

Option 4.1.2.3
(page 291)

Deviation alarming

Option 4.1.2.4
(page 294)

On update alarming

Option 4.1.2.5
(page 295)

Rate of change alarming

Check Update Value to cause the %VAL (page 280) field in the alarm message to update

while the point is in alarm state.
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Option 4.1.2.1. Absolute Alarming

Analog and Boolean points

Absolute alarms are used to detect when the value of a point is too high or too low. An alarm is
generated when the: Point's value transitions from one Alarm State to another.

The following configuration applies to absolute alarms.

rect 42, 132, 69, 159  (page 288)
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Alarm type

2
(page
288)

Alarm limits

3
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289)

Update value

1 Alarm type

Select Absolute.

2 Alarm limits

Enter at least one alarm limit.

Entries can include 4 limits, e.g. very high, high, low and very low.
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Note:  Actual Alarm limits field names are determined by the selected string index.

Each time the point's value is updated, its current value is compared with the alarm values.

1. Analog Points

Limit (Default Label) Alarm is triggered when the:

Alarm High Analog point value ³ Alarm High value.

Warning High Alarm High value > Analog point value ³ Warning High value.

Warning Low Warning Low value ³ Analog point value > Alarm Low value.

Alarm Low Analog point value £ Alarm Low value.

The point is in a Normal state when the value is less than the Warning High value  and greater than
the Warning Low value.

1. Boolean Points

Limit (Default Label) Alarm is triggered when the:

Alarm on value of 1 Boolean point value is 1.

Alarm on value of 0 Boolean point value is 0.

3 Update value

(Optional) If %VAL is in the Alarm message:

Check Updates the value in the alarm message during runtime, when the value changes.

Clear Does not update the value in the alarm message during runtime, when the value changes.

Option 4.1.2.2. Absolute Equals Alarming

Analog points only

Absolute equals alarms are used to detect when one to four exact point values.

An alarm is generated when the: Point's value exactly equals a value entered in one of the Alarm
limits fields.

The following configuration applies to absolute equals alarms.
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3
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Update value

1 Alarm type

Select Absolute Equals.

2 Alarm limits

The alarm limits are exact point values.

Alarm limits values:

• Can be in any order, i.e. the value in the first field in the column does not have to be the highest
value.

• Triggers an alarm when the exact point value is detected. There is no value range.

Tip:  You can create a string index that reflects an Absolute Equals alarm state.

Example

Absolute equals alarm limits are entered as follows.
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String Index Value

STATE1 500

STATE 2 1000

STATE 3 1500

STATE 4 2000

During runtime, an alarm is triggered when the point value is 500, 1000, 1500 or 2000.

3 Update value

(Optional) If %VAL is in the Alarm message:

Check Updates the value in the alarm message during runtime, when the value changes.

Clear Does not update the value in the alarm message during runtime, when the value changes.

Option 4.1.2.3. Deviation Alarming

Analog points only

Deviation alarming is used to detect when the value of a point deviates too far from that of a second
point.

An alarm is generated when the: Difference between the current value of the point and the current
value of the Deviation Point exceeds an alarm limit.

The following configuration applies to deviation alarms.

rect 282, 116, 307, 143  (page 293)
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1
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Alarm type

2
(page
292)

Deviation Point

3
(page
292)

Alarm limits

4
(page
293)

Update value

1 Alarm type

Select Deviation for deviation alarming.

2 Deviation Point

Deviation point values are used to calculate a deviation from the norm.

An alarm is generated when the difference between the current value of the point and the current
value of the Deviation point exceeds an alarm limit.

This difference is calculated whenever the value of the point or the Deviation Point changes.

Opens the Select a Point browser to select an available point.

Displays a Popup menu to:

• Open:
• A New Point dialog box.
• The Point Properties dialog box for a selected point.
• The Select a Point browser.
• Select a recently selected point.

3 Alarm limits

Alarm limit values are based on the deviation from the norm, where the:

• High limit is larger than the Warning High limit.
• Low limit is larger than the Warning Low limit.

The difference between the current value of the point and the current value of the Deviation Point is
calculated whenever the value of the point or the Deviation Point changes.
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Note: Alarm limits field names are determined by the selected string index.

Limit Value Description

Hi-2 600 Furthest from the norm.

Hi-1 500 Lower than Hi-2.

Normal Limits are based on the deviation from the norm.

Lo-1 200 Lower than Lo-2.

Lo-2 300 Furthest from the norm

4 Update Value

(Optional) If %VAL is in the Alarm message:

Check Updates the value in the alarm message during runtime, when the value changes.

Clear Does not update the value in the alarm message during runtime, when the value changes.

5 Delay alarm

(Optional) Delays the display of the alarm on Alarm Viewers and other Alarm Management
Interested Processes unless the point remains in an alarm state for the configured interval.

The point is scanned at its normal Scan Rate (page 190) , but is evaluated for alarming at the
Alarm Delay rate (also known as the sample interval).

When
an alarm
condition is
Detected for a
point and if:

The Point Manager sends the information:

No Alarm
delay is
configured

Immediately to the Alarm Manager and all other Point Management Interested Processes such as
CimView and the Event Manager.

An Alarm
delay is
configured

After the delay time generates the Alarm Delay. This means that Alarm Delay applies to all the Point
Management Interested Processes such as CimView, Point Control Panel and the Event Manager, the
Alarm Viewer and other Alarm Management Interested Processes, such as the Alarm Printer, that are
serviced by the Alarm Manager.

Check box Check to display the length and interval fields.

Length Length of selected interval time to delay the display.

Interval Options are:

• Seconds
• Minutes
• Hours
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Note:  The minimum interval is 1 second.

Note:  If the point has:

• Engineering units (EU) and
• Deviation alarming,

an alarm is generated when the difference between the:

• Current converted value of the point and
• Converted value of the deviation point (if the deviation point also has EU)

exceeds an alarm limit.

Option 4.1.2.4. On Update Alarming

Analog and Boolean points

On Update alarming is used to generate an alarm whenever the point's value is updated.

An alarm is generated when the: Point's value is updated.

The following configuration applies to on update alarms.

Note:

• If you select the On Update alarm criteria, you cannot define Alarm Values. Each time the
point's value is updated, an alarm is generated.

• Variables that can be entered in the Alarm message field for On Update are limited to:
• %VAL
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• %ID
• %EU

Option 4.1.2.5. Rate of Change Alarming

Selected analog points only

Important:  The following analog point types cannot have rate of change alarms. If you try to
configure a rate of change alarm you will see an Invalid point type for rate of change alarm error
message.

• 3D_BCD
• 4D_BCD
• QINT
• UQINT
• UDINT
• UINT
• USINT

Rate of Change alarming detects either a faster or slower than expected change in the value of a
point.

An alarm is generated when the: Difference between the current value of the point and its value at the
last sample interval exceeds an alarm limit.

The following configuration applies to rate of change alarms.

rect 283, 113, 306, 135  (page 297)
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Update value

1 Alarm type

Select Rate of Change.

2 Interval

Length of the interval between sampling the point for Rate of Change alarming.

The interval is a number of:

• Seconds
• Minutes or
• Hours

Important: The minimum Rate of Change interval is 5 seconds.

If the difference between the current value of the point and the value at the last sample time exceeds
alarm limits, an alarm message will be generated.

3 Alarm limits

Specify positive alarm limits to check for increasing values and negative alarm limits to check for
decreasing values.

The current point is not evaluated for an alarm condition each time the value changes.

An alarm is generated under these conditions:

Alarm Generates alarms for:

Alarm High Faster than expected changes

Warning High Faster than expected changes

Alarm Low Slower than expected changes

Warning Low Slower than expected changes
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In the Alarm Limits, you can specify:

Values that are To check for:

Positive Increasing values

Negative Decreasing values.

Use the following table as a guide.

  Alarm Limit   Limit Value Rate of Change Value is ...   Point value is ....

Alarm High Positive ³ Alarm High Increasing too fast

Alarm High Negative £ Alarm High Decreasing too fast

Warning High Positive ³ Warning High Increasing too fast

Warning High Negative £ Warning High Decreasing too fast

Warning Low Positive £ Warning Low Increasing too slowly

Warning Low Negative ³ Warning Low Decreasing too slowly

Alarm Low Positive £ Alarm Low Increasing too slowly

Alarm Low Negative ³ Alarm Low Decreasing too slowly

4 Update value

Check to update the point value in runtime applications, e.g. Alarm Viewer, each time the value
changes.

Step 4.1.3. Specify an Alarm Deadband

When included in the alarm configuration, a deadband
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• Defines the tolerance for alarm conditions.
• Cushions the generation of alarms when a point value fluctuates at an alarm limit.
• When a point transitions from an alarm state into a warning state of the same type, the alarm

status switches from Alarm to Warning only if the point value is more than the deadband away
from the alarm limit.

Example

A point has the following values.

Field Value

VERY HIGH Alarm Limit 100

HIGH Alarm Limit 85

Deadband 5

The point

• Goes into the VERY HIGH alarm state when its value reaches 100.
• Stays in the VERY HIGH alarm state until its value drops below 95.
• Goes into HIGH alarm state when its value drops to 94.
• If the point has Engineering Units (page 259) (EU), the EU converted deadband is used for all

calculations.

Step 4.1.4. Provide an Alarm Viewer Help File

If a custom (ANSI) Help file is assigned to a point alarm it will display when a user clicks the Help
button in the Alarm Viewer.

• Help file configuration.
• Help file display.

Help file configuration

Enter the file name in the Help file field on the Alarm tab.
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Help file Description

Format ASCII (ANSI) text file with an .hlp extension (e.g. POINTALARM.hlp)

Rules
• Be up to 60 lines.
• Have a maximum of 70 bytes per line.

Note: A character can be 1 or 2 bytes, depending on the system you are using.

• Can have a file name of up to 67 characters.
• Can be used for several points.

Location %SITE_ROOT%\alarm_help directory.

Stored Underlying file is Alarm_HELP:\<up to 67 character name>.hlp for a total of 80 characters.

Example

• A text file, POINTALARM.txt, is created in Notepad.

• The file is:
• Renamed  POINTALARM.hlp.
• Placed in the project's Alarm_HELP directory.
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• POINTALARM is entered as the Help file on the Alarm tab in the Point Properties dialog box
for the point POINTALARM.

• POINTALARM goes into an alarm state and displays in the Alarm Viewer.

A user selects POINTALARM and clicks Help.

Result: The POINTALARM help file displays.
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Help file display

The Help file displays the following information.

A
(page
301)

Read-only fields

B
(page
301)

Help text written in the ASCII .txt file.

A Read-only fields

Read-only fields provide descriptive summary about the alarm.

These fields can be selected to display as columns in the Alarm Viewer.

Field Description

Alarm ID Alarm with which the help file is associated.

Resource ID Resource assigned to the alarm. The resource is assigned for point alarms and event alarms as
follows.

Point Alarm Selected on the General tab in the Point Properties dialog box.

Event Alarm System resource is automatically associated.

Class Selected on the Alarm tab.

Deletion
requirement

Selected on the Alarm Options tab.

Message Entered on the Alarm tab.

Date Date alarm was generated

State Categories are in the Alarm Class Configuration dialog box. Normal Unavailable Alarm
Acknowledged

Ack Runtime acknowledged: Y or N

Reset allowed Selected on the Alarm Options tab.

B Help text written in the ASCII .txt file.
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The text entered in the file that is identified on the Alarm tab in the Point Properties dialog box
displays in text box.

Step 4.1.5. Maximum Alarm Stacked

Maximum stacked enables the states an alarm passes through, once it is generated, to be kept or
stacked until the alarm is deleted.

Enter a number between 0 and 20 in the Maximum Stack field on the Alarm tab in the Point
Properties dialog box.

Stack Value Description

0 Alarm will not be stacked.

20 The maximum number of alarms that can be stacked will be stacked.

During runtime

• Alarm Viewer users can display the alarm stack.
• As occurrences are generated for the alarm, occurrences fill the stack. When the Maximum

Stack value is reached, the oldest alarm occurrence is deleted from the stack as each new
occurrence is generated.

• When the alarm is deleted, all occurrences of the stacked alarm are deleted.

Note:  You can also configure alarm options in the point alarm's Alarm Definition dialog box in
the Alarms folder. The configuration displays in both dialog boxes.

Step 4.2. Configure Alarm Routing

Alarm Routing properties let you select the roles that can view any alarms generated by this point.
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Note: Event alarms have the same tab in the Alarm Configuration dialog box. Adding roles for a
selected event alarm is the same as for a point alarm.

rect 125, 68, 150, 95  (page 303)
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Add/remove a role's privilege to view alarms.

2
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Open an existing role's properties dialog box.

3
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304)

Create a new role.

1 Add/remove a role's privilege  to view alarms.

Add or remove the alarm viewing privilege for a role, as follows.

Select in: Click Role is moved to: View alarms

Available roles Add Configured roles for alarms. Yes

Configured roles for alarms. Remove Available roles No

2 Open an existing role's Properties dialog box.

A Properties dialog box for any selected role can be opened through the Alarm Routing tab.

1. Select a role in either the Available roles or Configured roles for alarms box.

2. Click Properties .
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Result: The Role Properties dialog box for the selected role opens.

3 Create a new role.

New roles can be created through the Alarm Routing tab.

1. Select a role in either the Available roles or Configured roles for alarms box.

2. Click New .

A New Role dialog box opens.

1. Enter a unique name in the New Role ID field.

1. Click OK.

A Role Properties dialog box opens for the newly created role.

1. Continue configuration for these roles the same as you do for roles created through the
Workbench.

2. Click OK.

Result: role is listed in the Configured roles for alarms box on the Alarm Routing tab.
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Step 4.3. Set Alarm Options

You can determine how, when, and for what time period alarms will be displayed and reset on the
Alarm Options tab.
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1
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Use the same settings for all alarm levels.

2
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Deletion requirements.

3
(page
308)

Manual reset allowed.

4
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Alarm on delay.

5
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Alarm off delay.

6
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Printer repeat.

7
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Auto acknowledge.

8
(page
312)

Auto reset

9
(page
312)

Alarm logging.

10
(page
321)

Change approval.

1 Use the same settings for all alarm levels

Alarm options can be configured all alarm levels or separately for each level.

Clear or check Use the same settings for all alarm levels to apply options, as follows..

1. Clear

The Alarm state drop down list is enabled.

Entries in the list reflect the String index (page 280) selected on the Alarms tab before the last
project configuration update.
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When Use the same setting for all alarm levels is cleared the Alarm state list provides:

• Four states for analog points
• Alarm High (HiHi)
• Warning High (Hi)
• Warning Low (Lo)
• Alarm Low (LoLo)
• Two states for Boolean points.
• Alarm High (HiHi)
• Warning High (Hi)

Select alarm options for each alarm state.

Example

For an analog point:

• A High alarm state requires the alarm to be both acknowledged and reset before it can be
deleted.

• A Warning High alarm state only requires the alarm to be acknowledged.
• The Use the same settings for all alarm levels check box is clear.
• The alarm states for deletion requirements are checked or clear, as follows.

Alarm State Acknowledge Reset

High Checked Checked

Warning High Checked Clear

• The other two alarm states are configured according to their requirements.

1. Check

The Alarm state dropdown list is disabled.

Selected alarm options apply to all alarm levels.

Important:   

When you check Use the same settings for all alarm levels, the settings that display if you then clear
the checkbox become the settings for all of the alarm states.
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If you had entered custom settings for one or more states you must go back and re-select them.

2 Deletion requirements

Deletion Requirements are the conditions that must exist in order for an alarm to be deleted
 (removed from the system) as follows.

Check: The alarm:

Acknowledge Must be acknowledged to be deleted. Note: The alarm will be deleted as soon as it is acknowledged. If
it is not acknowledged it cannot be manually reset (page 308)..

Reset Must be reset to be deleted.

Both check
boxes

Must be acknowledged and reset to be deleted.

Neither
check box

Can be deleted without being acknowledged or reset.

Note:  CIMPLICITY v9.0 clients will not support acknowledging or resetting alarms from
a CIMPLICITY v6.1 or earlier server. (CIMPLICITY v6.1 and earlier versions are no longer
supported.)

3 Manual reset allowed

Manual reset allowed specifies if a user can reset an alarm.

Manual Reset Description

Check A user can manually reset the associated alarm.

Clear A user cannot manually reset the associated alarm.

Important:  The Manual reset allowed is relevant only if reset is required for the alarm to be
deleted. If an alarm must only be acknowledged (page 308) to be deleted it cannot be reset to
Normal and then deleted; it must be acknowledged. Once it is acknowledged the alarm will be
deleted automatically.

4 Alarm on delay
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(Optional) Delays the display of the alarm on Alarm Viewers and other Alarm Management
Interested Processes unless the point remains in an alarm state for the configured interval.

When
an
alarm
condition
is
Detected
for a
point
and
if:

The Point Manager sends the information:

No
Alarm
on
delay
is
configured

Immediately to the Alarm Manager and all other Point Management Interested Processes such as CimView and
the Event Manager.

An
Alarm
on
delay
is
configured

After the delay time generates the Alarm on delay. This means that Alarm on delay applies to:

• Point Management Interested Processes (e.g. CimView, Point Control Panel).
• Event Manager.
• Alarm Viewer.
• Other Alarm Management Interested Processes that are serviced by the Alarm Manager (e.g. Alarm

Printer).

Check
box

Check to display the length and interval fields.

LengthLength of selected interval time to delay the display

IntervalOptions are:

• Seconds
• Minutes
• Hours

Important: The minimum interval is 1 second.

Note:

• If the point is in normal state, the Point Manager resets alarms for the point.
• Alarm on delay was named Delay alarm in previous CIMPLICITY versions.

5 Alarm off delay
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(Optional) If a point goes from an Alarm state to a Normal state, CIMPLICITY waits for the
specified time interval before reporting that the point has changed to a Normal state.

When
a
return
to
normal
condition
is
Detected
for a
point
and
if:

The Point Manager sends the information:

No
Alarm
off
delay
is
configured

Immediately to the Alarm Manager and all other Point Management Interested Processes (e.g. CimView and the
Event Manager) that the point has returned to Normal state.

An
Alarm
off
delay
is
configured

Waits for the specified delay time to report the Normal state. This means that Alarm off delay applies to:

• Point Management Interested Processes (e.g. CimView, Point Control Panel).
• Event Manager.
• Alarm Viewer.
• Other Alarm Management Interested Processes that are serviced by the Alarm Manager (e.g. Alarm

Printer).

Check
box

Check to display the length and interval fields.

LengthLength of selected interval time to delay the display.

IntervalOptions are:

• Seconds
• Minutes
• Hours

Important: The minimum interval is 1 second.

Note:

• Alarm off delay can alleviate fleeting alarm conditions, for example, by allowing system
engineers to adjust the dead band time between the changes in state to clear an alarm.

• If an alarm can be deleted from the Alarm Viewer after deletion requirements have been
fulfilled, the alarm will be deleted. However, in other applications (e.g. the Point Control Panel),
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the point will remain in alarm state for the specified Alarm off delay time after the point has
transitioned to a normal state.

6 Printer repeat

Printer repeat is the time that the Alarm Manager waits before repeating the alarm to all Alarm Line
Printer (AMLP) processes. Setting a repeat time out will cause the point's alarm to be reprinted on
the Alarm Line Printer until it is acknowledged, reset or deleted.

Printer repeat options are:

Printer
Repeat

Description

None The alarm will not be repeated.

Timed Number of minutes that the Alarm Manager should wait before repeating the alarm to all AMLP processes.
Minutes are entered in a Minutes field that displays when Timed is selected.

Note:  The actual number of minutes that the Alarm Manager will wait before repeating the
alarm may be greater than this number. The maximum time will be the number you enter in this field
plus the number of minutes configured for the timer for processing automatic alarms in the Alarm
Manager configuration file (alarm_mgr.dat). The default for this timer is 5 minutes.

You have the ability in CIMPLICITY to enter your specifications for each stage in the sequence.

7 Auto acknowledge

Auto acknowledge specifies if and how an alarm can be automatically acknowledged.

Auto acknowledge options are:

Auto
Acknowledge

Description

None A user must manually acknowledge the alarm.
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Auto
Acknowledge

Description

Immediate The Alarm Manager immediately automatically acknowledges the alarm.

Timed Number of minutes that the Alarm Manager should wait before automatically acknowledging the
alarm. Minutes are entered in a Minutes field that displays when Timed is selected.

Note:    The actual number of minutes that the Alarm Manager will wait before acknowledging
the alarm may be greater than this number. The maximum time will be the number you enter in this
field plus the number of minutes configured for the timer for processing automatic alarms in the
Alarm Manager configuration file (alarm_mgr.dat). The default for this timer is 5 minutes.

8 Auto reset

Auto reset enables an alarm to be automatically reset.

An alarm can be reset:

• Manually.
• Automatically.

Because the condition causing the alarm no longer exists, and the process that detected the alarm
condition automatically reset the alarm.

Auto reset options are:

Auto
Reset

Description

None The Alarm Manager cannot automatically reset the alarm. However, the alarm can be:

• Manually reset (if manual reset is allowed) or
• Reset by the process that detected the condition that generated the alarm.

Immediate The Alarm Manager immediately resets the alarm. The alarm will not repeat.

Timed Number of minutes that the Alarm Manager should wait before automatically resetting the alarm. Minutes
are entered in a Minutes field that displays when Timed is selected.

9 Alarm logging
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Note:  Alarm Logging displays in the Point Properties dialog box if Database Logger is checked
in the Project Properties (page 83) dialog box.

Check if and when you want an alarm to be logged in the Alarm Logging box on the Alarm tab. You
can select any or all of the options:

• Generate
• Acknowledge
• Delete
• Reset

When the configuration is applied, CIMPLICITY will add the point to its default ALARM_LOG.
You can also apply these and more specifications in the Database Logger .

10
(page
321)

Change approval.

In the CIMPLICITY change approval system, you can select the point alarms that will require
change approval.

Point and Alarm Change Approval

Point and Alarm Change Approval

CIMPLICITY provides the functionality to  maintain an audit trail of:

• A point's change requests.
• User performed alarm operations.

Change Approval Overview

The change approval system can require electronic signatures from either of the following:

• A user who is allowed to perform one or both of the following:
◦ A setpoint action for a selected point.
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◦ A user performed alarm operation.

• Both a user who is allowed to perform:
◦ A setpoint action for a selected point and another user who has the privilege to verify the

setpoint action.
◦ A user performed alarm operation and another user who has the privilege to verify the

alarm operation.

The change approval system tracks setpoint attempts in the form of audit trail.

The Change Approval system is enabled during runtime wherever a setpoint or a user performed
alarm operation can be made.

Change Approval Components

1
(page
314)

Change approval: Configuration.

2
(page
325)

Change approval: Runtime Perform or Perform and Verify

3
(page
335)

Change approval: CA_LOG.

4
(page
337)

Change approval: Technical reference.

1. Change Approval: Configuration

1. Change Approval: Configuration

Change approval configuration is straightforward.

Step 1.1
(page
314)

Enable change approval.

Step 1.2
(page
316)

Configure change approval.

Step 1.1. Enable Change Approval

1. Open the Project Properties (page 83) dialog box.
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2. Select the General tab.

3. Check Database Logger: A&E & App.

CIMPLICITY creates a CA_LOG table that is listed in:

• The Database Logger window.

Note: The CA_LOG table cannot be opened.

• SQL Server (with other CIMPLICITY log tables).
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Note: Data (page 335) about setpoint successes and failures will be logged to this table for points
that require change approval.

Step 1.2. Configure Change Approval

Step 1.2. Configure Change Approval

The following configuration is required and/or available if one or more points require change
approval.

1.2.1
(page
316)

Change approval: Role privileges.

1.2.2
(page
317)

Change approval: Comments lists.

1.2.3
(page
319)

Change approval: Points.

1.2.4
(page
321)

Change approval: Alarms

1.2.5
(page
322)

Change approval: Scripts.

1.2.1. Change Approval: Role Privileges

Roles that are assigned setpoint and/or setpoint verification privileges will be required in order  to
successfully perform a setpoint that requires setpoint (page 326) or setpoint and verification (page
327) privileges.
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1. Open the Role Properties dialog box for the role that will be assigned one or both privileges.

2. Check either or both of the following privileges.

Privilege Users with privilege can

1 Setpoint Set point values, including points that require an electronic setpoint performer entry.

2 Disable/
modify
alarms

Disable or modify a point's alarms in the Point Control Panel.

3 Verify Verify setpoints for points that require change setpoint verification.

1/2/3 Verify Verify changing point values or alarm status.

Note:  During one setpoint or disable/modify alarm action a user who has both privileges
can enter an electronic signature only to set the point or to verify the setpoint. The same user
cannot sign for both during one instance.

Only users with roles that are assigned the required change approval privilege will be allowed to set
or verify setpoints during runtime.

1.2.2. Predefined Comments Lists

Point setpoints and user performed alarm operations that require one or more digital signatures
require comments to document the reason why the value was manually changed. Setpoint performers
and/or verifiers can enter their own comments when they enter their signature or select predefined
comments created for your system.

Create the predefined comments, as follows.

1. Create a text file for each operation.
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Filenames are as follows.

Operation Filename

Setpoint Ca_PreDefinedComments.txt

Alarm ALM_PREDEFINEDCOMMENTS.txt

2. Place both Ca_PreDefinedComments.txt and ALM_PREDEFINEDCOMMENTS.txt in the
\<Project Name>\Data folder.

3. Add comments to the file.

Place the | symbol at the end of:

• Each comment, so it separates comments.
• The last comment.

Important:  The maximum length of each comment is 80 characters.

Example:

A list of commonly needed comments are entered into a Ca_PredefinedComments.txt file for
setpoint operations, as follows.

Project start|Alarm high. Opened valve.|Alarm low. Opened valve.|Alarm
 high. Closed valve.|Alarm low. Closed value.|Maintenance shut down.|
Standard level increase.|Standard level decrease.|

During runtime, when a Change Approval dialog box opens, the predefined comments are available
for the selected operation, as follows.

CIMPLICITY checks for a CA_PREDEFINEDCOMMENTS.txt or
ALM_PREDEFINEDCOMMENTS.txt file in the project's Data  folder.

If there is a file, CIMPLICITY reads the comments and populates a Predefined Comments dropdown
list.
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The selected comment displays in the Predefined comments and Comment fields.

Note:  The selection is logged to the CA_LOG.

1.2.3. Change Approval Points

In the CIMPLICITY change approval system, you can select the points that will require change
approval.

Change approval options are on the General tab of the Point Properties dialog box for device and
virtual points.

Check one of the change approval options as follows.



Project Setup | 7 - Points | 320

Checkbox CIMPLICITY Change Approval

Perform Requires an electronic signature from the user who attempts to set the selected point's value.

Perform and
verify Requires an electronic signature from:

1. The user who attempts to set the selected point's value.
2. A user whose role has the verification privilege assigned.

Log only Does not require any electronic signature from users or services. The changes are logged into CA_LOG.

None (Default) Does not require any electronic signature from users or services.

Unsigned
writes Unsigned writes enables services to perform even if Perform or Perform and verify is checked.

Does not require valid signatures from services, such as Event Manager Resident Process (EMRP),
Tracker and other third party services without requiring valid credentials.

Requires the selected change approval (Perform only or Perform/Verify ) validation in CIMPLICITY
applications such as Point Control Panel and CimView.

The setpoint will only be completed if valid credentials are entered. If either Perform or Perform and
verify is checked for a point and unsigned writes is not checked, services, such as Event Manager
Resident Process (EMRP), Tracker and other third party services without requiring valid credentials will
fail for that point.

Note: An issue and resolution involving Unsigned Writes and the Event Manager (EMRP) are as follows.

Issue:
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In the following conditions:

1. A point is configured with Change approval Perform or Perform.
2. Verify. Unsigned writes is not selected.
3. An Event Manager event uses the point as in a setpoint action.
4. The project is started.
5. Dynamic configuration is enabled.
6. The Event Manager (EMRP) service will not set the point; the following error message is

entered in the Status Log. Point <point name> is configured with change approval. If you check
Unsigned writes for the point, the EMRP service still will not set the point.

Resolution

Note: You do not need to stop the project.

1. Open the Event Manager.
2. Make sure dynamic configuration is enabled in the Event Manager.
3. Delete the event and action that requires the change approval setpoint.
4. Recreate the event and action.

1.2.4. Change Approval: Alarms

In the CIMPLICITY change approval system, you can select the point alarms that will require
change approval.

Change approval options are on the Alarm Options tab of the Point Properties dialog box for device
and virtual points.

Important: Change approval support is only for user performed Alarm operations. Automatic
operations (e.g. Auto Acknowledge) do not log into the CA_LOG table.

Check one of the change approval options as follows.
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Checkbox CIMPLICITY Change Approval

Perform Requires an electronic signature from the user who attempts to perform an alarm operation on the
selected point alarm.

Perform and
verify Requires an electronic signature from:

1. The user who attempts to perform an alarm operation.
2. A user whose role has the verification privilege assigned.

Log only Does not require any electronic signature from users or services. The changes are logged into CA_LOG.

None (Default) Does not require any electronic signature from users or services.

Unsigned
actions Unsigned actions enables services to perform even if Perform or Perform and verify is checked.

Does not require valid signatures from services, such as Event Manager Resident Process (EMRP),
Tracker and other third party services without requiring valid credentials.

Requires the selected change approval (Perform only or Perform/Verify ) validation in CIMPLICITY
applications such as Point Control Panel and Alarm Viewer.

The alarm operation will only be completed if valid credentials are entered. If either Perform or Perform
and verify is checked for a point alarm and unsigned writes is not checked, services, such as Event
Manager Resident Process (EMRP), Tracker and other third party services without requiring valid
credentials will fail for that alarm.

1.2.5. Change Approval Scripts
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Change approval script objects that accept performer and verifier user names and passwords are
available.

Once information is set to an object the configured script object can be passed to a setpoint script
function.

• Change approval objects.
• Change Approval Basic Control Engine entries.
• Sample script: Point/object manipulation.
• Sample script: Object Model.
• Sample Script: Alarm update operations.

Change Approval Objects

The objects are:

• CimChangeapprovalEnum (enum)
•  CimRole.PrivVerify (property) of CimRole (Object)

Change Approval Basic Control Engine Entries

• AlarmUpdateCA (Method)
• CimChangeApprovalData (Object)
• Point.ChangeApproval (property, write)
• Point.ChangeApprovalInfo (property, read)

Sample Script: Point/Object Manipulation

The following sample script creates a point with Change Approval.

Sub main()
   Dim MyPoint As New Point
   Dim obj As New CimChangeApprovalData
'Init Point
 Set MyPoint.Id = "MYPOINT"
'Init CimChangeApprovalData with prompts
 Select Case MyPoint.ChangeApprovalInfo
 Case CP_CHANGEAPPROVALPERFORM   
   obj.PerformerUserid =  AskBox("Performer Userid")
   obj.PerformerPassword = AskPassword("Performer Password")
 Case CP_CHANGEAPPROVALPERFORMVERIFY
   obj.PerformerUserid =  AskBox("Performer Userid")
   obj.PerformerPassword = AskPassword("Performer Password")
   obj.VerifierUserid = AskBox("Verifier Userid")
   obj.VerifierPassword = AskPassword("Verifier Password")
 Case CP_CHANGEAPPROVALNONE
End Select
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'Copy our CimChangeApprovalData into the Point's ChangeApproval
   Set MyPoint.ChangeApproval = obj
'Set the point
   MyPoint.SetValue = InputBox("Setpoint")
 
End Sub

Sample Script; Object Model

Sub Main()
Dim project As CimProject
Dim points As CimPointList
Dim Point As CimPoint
Dim szProjectName As String
Dim bProjectOpen   As Boolean
Set project = CreateObject("CimProject")
szProjectName = ENVIRON$("SITE_ROOT") & ENVIRON$("PROJECT")
bProjectOpen = project.OpenLocalProject (szProjectName)
If bProjectOpen = true Then
Set Points = project.Points
Set point = CreateObject("CimPoint")
point.Pointid = "CA_TESTPOINT"
    point.ResourceID = "$SYSTEM"
    point.Type = CimGlobal
        point.PointTypeID = "INT"
    point.DerivedPoint.InitState = cimInitialized
    point.DerivedPoint.InitValue = "0"
    point.PointAlarm.AlarmConfigured = false

Sample Script: Alarm Update Operations

Const NUMPOINTS = 1
Sub Main()
Dim project As CimProject
Dim points as CimPointList
'Dim point As CimPoint
Dim obj As New CimAlmChangeApprovalData
Dim TestProjectName As Integer
Dim ResultValue As Integer
Dim ib As String
Dim int As Integer
Set project = CreateObject("CimProject")
project.OpenLocalProject "D:\CIMPLICITY\ESIGDEMO\ESIGDEMO.gef"
project.ProjectUserName = "ADMINISTRATOR"
project.ProjectPassword = ""
set points = project.points
Dim point as CimPoint
Set point = points.Item("CA_TESTPOINT")
br = point.PointAlarm.AlarmConfigured  
bh= point.PointAlarm.Alarm.changeapproval  
Select Case point.PointAlarm.Alarm.changeapproval
       Case AM_CHANGEAPPROVALPERFORM
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     obj.PerformerUserid = "administrator"
             obj.PerformerPassword = ""
             obj.PerformerComment= "bool=1 from BCE"
AlarmUpdateCA "ESIGDEMO","CA_TESTPOINT","$MAC_FR",AM_ACKNOWLEDGED,obj,
 "CA_TESTPOINT","CA_TESTPOINT","CA_TESTPOINT"
 
Case AM_CHANGEAPPROVALPERFORMVERIFY
             obj.PerformerUserid = "OPERATOR"
             obj.PerformerPassword = ""
             obj.PerformerComment= "bool=1 from BCE"
             obj.VerifierUserid = "BOSS"
             obj.VerifierPassword = ""
             obj.VerifierComment= "bool=1  from BCE"
AlarmUpdateCA "ESIGDEMO","CA_TESTPOINT","$MAC_FR",AM_ACKNOWLEDGED,obj,
 "CA_TESTPOINT","CA_TESTPOINT","CA_TESTPOINT"
     Case AM_CHANGEAPPROVALNONE
         MsgBox "Its NONE "
End Select
End Sub

2. Change Approval: Runtime Perform or Perform and Verify

During runtime, when a user CIMPLICITY provides dialog boxes when electronic signatures are
required to do either of the following.

• Set a point.
• Perform an alarm operation, e.g. acknowledge an alarm.

Set a Point Approval

The dialog box required entries depend on the point's change approval requirements.

rect 198, 112, 225, 135  (page 326)
rect 198, 134, 225, 153  (page 327)
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rect 198, 171, 225, 191  (page 329)
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1
(page
326)

Perform requirement

2
(page
327)

Perform and verify requirements

3
(page
329)

No requirements

4
(page
329)

Unsigned writes

1 Perform Requirement

When a setpoint is attempted, a:

1. The Change Approval Perform window appears.
2. A valid performer must review and enter the required information.

Field Description

PointID (Read only) The point whose value is being set.

Set value The new value of the point.

Current
Value

The existing value of the point.
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Field Description

Timestamp The time at which the latest value of the point was set.

Available Determines if the point already has a value assigned to it.

• If the value is True, the point has a value assigned to it, and is available.
• If the value is False, the point does not have a value assigned to it, and is not available.

Array
Details

Displays the array elements such as the set value, current value, and element index for an array point.

Note:  The Array Details button is disabled if the point is not an array point.

Performer The name and password of a user who has setpoint privileges.

Perform
Comments

Two methods to enter a comment are available.

Predefined
comments

If predefined, comments had been listed in a Ca_PreDefinedComments.txt file and are
available in a drop-down list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.

Result: One of the following happens if OK is clicked.

Result Description

Success When the user name and password are valid, the new value is set; the digital signature information is logged
in the CA_LOG table.

Failure If the user name and/or password are not valid: A message box reports the following: No perform change
approval privilege. Result: The point value is not changed.

Note:  The setpoint action can be cancelled by clicking the Cancel button in the Change
Approval Perform dialog box; nothing is entered in the log.

2 Perform and Verify Requirements

When a setpoint is attempted:

• The Change Approval Perform Verify window appears.
• A valid performer and a verifier must review and enter the required information.
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Field Description

PointID (Read only) The point whose value is being set.

Set value The new value of the point.

Current
Value

The existing value of the point.

Timestamp The time at which the latest value of the point was set.

Available Determines if the point already has a value assigned to it.

• If the value is True, the point has a value assigned to it, and is available.
• If the value is False, the point does not have a value assigned to it, and is not available.

Array
Details

Displays the array elements such as the set value, current value, and element index for an array point.

Note:  The Array Details button is disabled if the point is not an array point.

Performer The name and password of a user who has setpoint privileges.

Perform
Comments

Two methods to enter a comment are available.

Predefined
comments

If predefined comments had been listed in a Ca_PreDefinedComments.txt file they are
available in a dropdown list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.
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Field Description

Verifier The name and password of a user who has verifier privileges.

Verifier
comments

The same two methods that are available for the performer to enter a comment are available for the
verifier.

Predefined
comments

If predefined comments had been listed in a Ca_PreDefinedComments.txt file they are
available in a dropdown list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.

Result: One of the following happens if OK is clicked.

Result Description

Success When the user and verifier names and passwords are valid, the new value is set; the digital signature
information is logged in the CA_LOG table.

Failure If the user name and/or password are not valid, the following message appears: No perform change
approval privilege. Result: The point value is not changed.

If the verifier name and/or password are not valid, the following message appears: No verify change
approval privilege. Result: The point value is not changed.

If both the performer and verifier fail validation, the following message appears: A No perform change
approval privilege message displays. Result: The point value is not changed.

3 No Requirements

If a user has a role with setpoint privileges, the setpoint succeeds. No electronic signatures are
required.

4 Unsigned Writes

Unsigned points can be allowed either with a perform change approval or perform/verify change
approval point.

During runtime, the following occurs when Unsigned writes is checked.

• Will be accepted for services, such as Event Manager Resident Process (EMRP), Tracker and
other third party services without requiring valid credentials.

• The selected change approval (Perform only (page 326) or Perform/Verify (page 327) )
validation will continue to be required in CIMPLICITY applications such as Point Control Panel
and CimView.

The setpoint will only be completed if valid credentials are entered.
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Acknowledge an Alarm Approval

The Point Properties window requires entries depending on the change approval requirements of the
alarms.

rect 208, 170, 228, 189  (page 330)
rect 207, 189, 227, 208  (page 332)
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The change approval options are:

1
(page
330)

Perform requirement

2
(page
332)

Perform and verify requirements

3
(page
335)

No requirements

4
(page
335)

Unsigned writes

1 Perform Requirement
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When an alarm operation, for example, Alarm Acknowledge, is attempted for one or more alarms
that only require a Perform approval:

1. Change Approval Perform User window appears.
2. Valid performer must review and enter the required information.

Field Description

Alarm ID (Read only) One or more alarms on which the action will be performed. Important: The Change Approval
Perform window dialog box appears only if all of the alarms require Perform approval only.

Performer The name and password of a user who has alarm operation privileges.

Perform
Comments

Two methods to enter a comment are available.

Predefined
comments

If predefined comments had been listed in an ALM_PREDEFINEDCOMMENTS.txt file they
are available in a dropdown list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.

Result: If you select OK, one of the following actions occur.
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Result Description

Success When the user name and password are valid, the alarm operation is performed; the digital signature
information is logged in the CA_LOG table.

Failure If the user name and/or password are not valid, a Change Approval Alarms List window appears with the
following information:

1. The Alarm IDs that are selected  for the operation.
2. The reason the operation failed.

Result: The alarm operation is not performed.

Note:  The alarm operation can be cancelled by clicking the Cancel button in the Change
Approval Perform window; nothing is entered in the log.

2 Perform and Verify Requirements

When an alarm operation is attempted:

• A Change Approval Perform Verify window opens.
• The valid performer and a verifier must review and enter the following.
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Field Description

Alarm ID (Read only) The alarms on which the operation will be performed.

Performer The name and password of a user who has alarm operation privileges.

Perform
Comments

Two methods to enter a comment are available.

Predefined
comments

If predefined comments had been listed in an ALM_PREDEFINEDCOMMENTS.txt file they
are available in a drop-down list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.

Verifier The name and password of a user who has verifier privileges.

Verifier
comments

The same two methods that are available for the performer to enter a comment are available for the
verifier.

Predefined
comments

If predefined comments had been listed in an ALM_PREDEFINEDCOMMENTS.txt file they
are available in a drop-down list. When a comment is selected from the list, it displays in the
Comment field.

Comment An original comment can be entered. Note: The original comment overrides a previously
selected predefined comment.

Result: One of the following happens if OK is clicked.
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Result Description

Success When the user and verifier names and passwords are valid, the new value is set; the digital signature
information is logged in the CA_LOG table.

Failure If the performer  name and/or password are not valid, the following information is displayed:

A Alarm IDs that required either:

• Performer only approval.
• Performer and verifier approval.

B The reason the operation failed.

Result: The alarm operation is not performed for alarms that required either change approval.

If both the performer and verifier fail validation or the verifier name and/or password are not valid, the
following information is displayed:
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Result Description

A The alarm IDs that were both:

• Selected for the operation .
• Required the verifier approval.

B The reason the operation failed.

Results: The alarm operation:

• Was successful for Alarms that required only the performer approval.
• Failed for alarms that required both performer and verifier approval. .

3 No Requirements

If a user has a role with alarm operations privileges, the alarm operation succeeds. No electronic
signatures are required.

4 Unsigned actions

Unsigned alarm operations can be allowed either with a perform change approval or perform/verify
change approval alarm operation.

During runtime, the following occurs when Unsigned writes is checked.

• Event Manager Resident Process (EMRP), Tracker, and other third-party services will be
accepted without requiring valid credentials.

• The selected change approval (Perform only (page 326) or Perform/Verify (page 327))
validation will continue to be required in CIMPLICITY applications such as the Alarm Viewer
and Alarm Viewer control.

The operation will only be completed if valid credentials are entered.

3. Change Approval: CA_LOG

Details about all attempts to perform a setpoint on points that require validation are entered into a
CA_LOG table in SQL Server.

• Data: Entered in CA_LOG.
• Guidelines: CA_LOG review.

Data: Entered in CA_LOG

The following data is entered in the CA_LOG.
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  Field
Max.

Length
  Description

timestamp 7 Local time

timestamp_utc 7 UTC time

sequence_number - Sequence of setpoint action

project 20 Project in which the point was located.

logged_by 32 Logged in user

performby_userid 32 User who entered the setpoint.

performby_comment 80 Performer's comment.

verifyby_userid 32 User who verified the setpoint.

verifyby_comment 80 Verifier's comment.

location 32 Name of the computer from which the change was made.

action 32 Type of action performed, e.g. SETPOINT, ALARMACK, ALARMDEL,
DYNCFG.

result 10 SUCCESS, FAILURE

message 80 Result description, e.g. SETPOINT SUCCESS, INVALID PERFORM
USERID.

point_id 256 Point that was set.

point_attribute 26 Name of the attribute on which a setpoint was performed.

point_val 255 Value that point was set to.

point_prevval 255 Point value before it was changed.

alarm_id 256 Generated alarm ID.

alarmmessage 512 Generated alarm message.

Guidelines: CA_LOG Review

• If an array point requires change approval, even if a setpoint is performed on any index in the
array, the CA_LOG will log the first index information only.

• By default, the values in the CA_LOG are all raw values except enumeration values.
• To log EU converted values for point_val and point_prevval fields of CA_LOG,

1. Enable device conversion. For information refer, Step 3.2. Configure the Conversion Type
for a Device Point (page 262).

2. Add the parameter PTMRP_CALOG_EU_VALUES to project parameters and set its value
to Y.

• Enumerated points log their configured values, e.g. Closed not 0.
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4. Change Approval: Technical Reference

Enterprise And Point Bridge Points

When:

1. A source project that contains a point is:
• Configured with an Enterprise point and Change Approval
• Added as remote project in Enterprise server,

2. A setpoint is performed on Enterprise or Point Bridge points in the Enterprise server.

Then:

Change approval:

3. Validation is performed against the source project configuration (source project users, roles and
resources).

4. Audit trail is created in the Source project.

Important:  Unsigned writes option must not be selected for a point configured with
Enterprise points.

Download passwords

Important:  While doing a setpoint on the point in a project that is configured with
DownLoad password If a point is:

Configured with change approval Download password checking does not occur.

Not configured with change approval Download password checking occurs as usual

Change Approval License

A Change Approval license is a server based license; whenever setpoint is performed from
clients running either on a Viewer or the server, if change approval license is present:

• Change Approval dialog boxes will open.
• Change Approval will create an audit trail

If the CIMPLICITY server does not include a Change Approval license, Change Approval
configuration for points will be ignored. Runtime setpoints will succeed without the required
Change Approval credentials.
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Point Technical Reference

Point Technical Reference

1
(page
338)

Name points.

2
(page
342)

Point setup.

3
(page
347)

Virtual point expressions.

4
(page
351)

Long point IDs/Mixed case support.

1. Name Points

Each point you create in your project has a unique Point ID.

• Allowed entries when naming points.
• Reserved words when naming points.
• Reserved characters when naming points.
• Rename points.
• Duplicate points.
• Qualified points.

Allowed entries when naming points

A Point ID may contain:

• A maximum of 256 characters.
• Any combination of upper or lower case letters and numbers.
• Special characters, with some restrictions (page 339).

Reserved words when naming points

The following are reserved words in CIMPLICITY software. Avoid using these words for Point IDs.

A1 A2 AH1
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AH2 AL AL1

AL2 ALARM ALARM_HIGH

ALARM_LOW ALARM_NOT_ACKED ANA

AND BAND BNOT

BOR BXOR EQ

EU_CONV GE GT

LE LT NE

NOT OR SQR

WARNING WARNING_HIGH WARNING_LOW

XOR

If, however, you do use a reserved word for a Point ID and you include such a Point ID in a point
expression or equation, you must enclose the Point ID in single quotes.

Reserved characters when naming points

Important:  The following guidelines are intended for backward compatibility with previous
CIMPLICITY releases.

However, in order to prevent ambiguity with other character uses in CIMPLICITY (e.g. characters
in expressions and areas that include file system names) it is recommended that you construct point
names for new projects as follows.

1. Begin with an alphabetic character or underscore.

2. Continue with alphabetic characters, underscores and/or numbers.

Note:   Guidelines for reserved characters in Point IDs include:

Do not
use

| $ Brackets {  }  [  ]

Avoid
using

+  *  ?  \  /  [  ]  <  >  "  :  (  )  = The Expression Editor and other software can misinterpret these.

Use
carefully

Any other special character (such as #, %, etc.) on the keyboard. A Point ID that starts with a number
0-9. You must enclose the Point ID in single quotes when used in a point expression or equation. The
@ character is invalid if it is the first character in the Point ID.

Use
freely

The underscore character _ The period .

Rename points
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3. Right-click a point in the Workbench right pane.

4. Select Rename... on the Popup menu.

A Rename dialog box opens. The current point name is in the Rename field.

5. Enter a new name in the To field.

6. Click OK.

Result: CIMPLICITY renames the point and updates all references to the Point ID.

Note:  A point may be renamed only if the current point count is less than the licensed point
count. Contact your CIMPLICITY representative if you need to increase your licensed point
count.

Duplicate points

You can speed up point configuration by duplicating existing points, then making any necessary
changes.

7. Right-click a point in the Workbench right pane.

8. Select Duplicate on the popup menu.

A Duplicate dialog box opens.

9. Do one of the following:

For a: Enter a new:

Device point Point ID and select the Device ID.
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For a: Enter a new:

Virtual point Point ID.

10. Click OK.

The point's Properties dialog box opens. Configuration from the duplicated point is applied.

Qualified points

Qualified points, whose names include prefaces, enable you to identify precisely what point should
be used for a specific project.

Qualified point names can be:

• Prefaced as follows:

Preface type Example

\\<Project name>\ \\MYPROJ\MYPOINT

\\<Server name on which the project is running>\ \\SERVER1\MYPOINT

\\<IP address of the project's server>\ \\111.36.2.13\MYPOINT

• Used wherever you can enter a point ID, including:
◦ Alarm Viewer (OCX control))
◦ Alarm Viewer (Stand-alone)
◦ CimEdit/CimView
◦ Data logging
◦ Recipes
◦ SPC
◦ Trending

Note:  An unqualified point has the point name only.

Preface type Example

No preface type MYPOINT
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2. Point Setup

2. Point Setup

You can select the several point permission settings in the Point Setup dialog box.

Open the Point Setup dialog box.

Select point settings.

Step 2.1
(page
342)

Open the Point Setup dialog box.

Step 2.2
(page
343)

Select point settings.

Step 2.1. Open the Point Setup Dialog Box

1. Do one of the following to open the Project Properties dialog box.
• Click Project>Properties on the Workbench menu bar.
• Press Alt+P+P.

The Project Properties dialog box opens.

2. Open the Point Setup dialog box, as follows.

A Select the Settings tab.

B Select Points.

C Click Settings.

The Point Setup dialog box opens.
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Step 2.2. Select Point Settings

Step 2.2. Select Point Settings

The Point Setup dialog box provides three groups of setting options.

rect 2, 245, 262, 276 Option 2.2.3. Allow Set Points for Read-only Manual Mode Points (page
346)
rect -2, 152, 258, 243 Option 2.2.2. Virtual Value Storage (page 345)
rect -3, 20, 257, 148 Option 2.2.1. Set Point Security (page 344)

Option
2.2.1 (page
344)

Set point security.

Option
2.2.2 (page
345)

Virtual value storage.

Option
2.2.3 (page
346)

Allow set points for read-only manual mode points.
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Option 2.2.1. Set Point Security

• Set point security options.
• Guidelines for Enterprise server setpoint security.

Set point security options

(Optional) Check any of the following check boxes to enable set point security.

rect -1, 80, 23, 100  (page 345)
rect -1, 62, 23, 82  (page 344)
rect -1, 41, 23, 61  (page 344)

Check box Description

A Enable
resource set
point security

Restricts set point privileges to only the resources for which a project user has access.

Example POINT_A has been defined for RESOURCE_1

If: RESOURCE_1 is an authorized resource for USER_X. Enable resource set point
security is enabled.

Then: USER_X can perform setpoints on POINT_A.

If: RESOURCE_1 is not an authorized resource for USER_X. Enable resource set point
security is enabled.

Then: USER_X cannot perform setpoints on POINT_A.

Note: Resources are assigned to users in the User Properties dialog box.

B Enable level
setpoint security

Restricts a project user's point setpoint privilege to only points that are assigned levels equal to
or lower than the project user's role level.

Example A Discrete_Oper user is assigned the role Oper in the User Properties dialog box.
Oper is assigned a Level 10 in the Role Properties dialog box.
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Check box Description

The Discrete_Oper user can set only device points that have been assigned a level that is
smaller or equal to 10.

C Enable set point
password

Restricts access to the setpoint functions to users who know the password. The CIMPLICITY
default is unrestricted access.

Password Required to perform setpoint
actions.

Confirm Password Confirms the password.

Result: Project users who fulfill the criteria will be able to set points for a selected resource or device
point.

Guidelines for Enterprise server setpoint security.

If Then

• An Enterprise Server project contains the same
resources as the provider of a point,

Setpoint Security for the point is enforced against the
resource in the Enterprise Server project.

• The resource is not configured on the Enterprise
Server project,

Setpoint Security for the point is enforced against the remote
project's resource.

The DONT_VERIFY_ESPOINT_FRID global parameter is available to change this behavior.

Option 2.2.2. Virtual Value Storage

If you choose  Saved or Saved or Initialized  (page 206) for the point initialization value (on the
Virtual tab of the Point Properties dialog box) you have to specify how CIMPLICITY stores the last
known good value for all virtual points in your project.

Select how to store virtual values, as follows.
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A Check one of the following.

Checkbox Description

On point
update

Each saved virtual point in your project is saved, whenever its value updates. Caution: When the
saved virtual points in your project change at a rapid pace, this option causes the Point Manager to
consume more computer resources. This is because each point change is written to disk as it occurs.

On
project
shutdown

Values of the saved virtual points in your project are to disk when you shut down the project normally.
This option improves disk performance since the Point Manager no longer needs to access the disk
every time a saved point changes. However, if your project terminates abnormally, the last known good
values will not be saved.

B (Optional) Check Compact on project startup to compact the saved virtual point storage when the project starts up.

If you select this option, the Point Manager removes all points in the saved point storage that no longer exist
in the project's run-time configuration, and then compresses the storage to make optimum use of disk space.
Recommended: Use this option only while you are developing your project. Once you have a stable point
configuration, it is no longer necessary to compact the saved virtual point storage.

Option 2.2.3. Allow Set Points for Read-only Manual Mode Points

You can specify whether or not users can set read-only points when they are in manual mode (page
373) .

Do one of the following in the Allow set point for read-only manual mode points checkbox.
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Check An engineer can set a value for read-only points in manual mode.

Clear An engineer cannot set a value for read-only points in manual mode.

3. Virtual Point Expressions

3. Virtual Point Expressions

There are several places in Virtual Points where you enter an expression as part of your
configuration.

Whenever you are asked to enter an expression, you can use the:

• Point and Operation selections located to the right of an Expression box.
• Edit Builder.

Point and Operation selections located to the right of an Expression field
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In the Point Properties window, to the right of the Expression box, select  A menu opens with the
following tools that help build expressions.

Option Description

Browse Point ID Opens the Select a Point window.

Edit Point Opens the Point Properties window for a selected point.

New Point Opens a New Point window.

Build Expression Opens the Build Expression window.

Browse Historian
Tags

Opens the Select a Tag window.

Alarm Functions

Arithmetic

Bitwise
Operations

Format String

Format Value

General

Historian

Logical
Operations

Displays extended menus with the expression operations and functions that are associated with
the selected category.
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Option Description

Relational
Operations

Scientific

Shape Attribute

Point By Address Opens the Point By Address window.

System Sentry
Points

Opens the System Sentry Address Builder window.

Select an operation to place it at the current position of the cursor in the input box. If the operation
requires an argument, the cursor is positioned for you to type the argument.

Insert a point ID or variable either after the operator or between parentheses, if they appear with an
operator.

• A point based expression can be up to 300 characters long.
• When you use a device Point ID in the Expression Editor for virtual points, the raw value of the

point is used by default.
• If you want to use the engineering units value, enter  EU_CONV(< point_id >)  in the

expression.

Expression Builder

For points, when you select , the Build Expression window appears.

For data items, when you select , the Edit Expression window as seen below appears.
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For information on the expression building operations, see Use Expression Functions window.

Expression Editor Operations

1. Create an empty project

2. Create 2 BOOLEAN points: A, B.

3. Do a configuration update.

4. Start the project.

5. Create a new CimEdit screen.

6. Create a button.

7. Open the button's Properties - Object dialog box.

8. Create a Mouse Up event.

9. Create a new procedure.

10. Configure the new procedure as follows.

11. Click OK.
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The Properties - Object dialog box closes.

12. Save the screen.

13. Test the screen.

The button will do a setpoint action based on the B point value.

4. Long Point IDs/Mixed Case Support

4. Long Point IDs/Mixed Case Support

Long point IDs with mixed case support provide the means to create detailed descriptive names,
when necessary.

However long point IDs

• Require more considerations (e.g. where the point ID will display relative to monitor width)
than simple short point IDs (32 characters or fewer).

Note: There are best practices that are recommended when they apply to your system requirements.

• Are not universally supported.

Note: CIMPLICITY automatically generates a short internal point ID for each manually created long
point ID. When necessary any short point ID/long point ID combination can be reviewed.

4.1
(page
351)

Long point IDs/Mixed case support: Best practices.

4.2
(page
355)

Long point IDs/Mixed case support: idt files.

4.1. Long Point IDs/Mixed Case Support: Best Practices

Point IDs and alarm IDs, which now support a maximum of 256 characters and can include mixed
case, can be more descriptive, precise, more usable and readable than point IDs with the previous 32-
character length limit.

Because of these benefits, in many instances point IDs that exceed 32 characters will be preferable to
the shorter point IDs. However, although in some instances if an extremely long point ID that is now
possible with the 256 character support is exactly what you need, careful planning will be required as
to when and where these new lengths will be used.
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Some details to consider when planning to create points with long IDs or rename existing points are
as follows.

• Screen/monitor display width.
• Workbench Tree View.
• Mixed case support.
• Viewers (clients) with lower than CIMPLICITY v9.0 installations.
• Renamed points and expressions.
• Third party products.
• Known other Proficy and  third party products'  limitations

Note:

• Long point names support the same special characters as short names.
• The increase in supported size is particularly helpful when dealing with features such as class

objects where the classes object name is included in the point ID.

Screen/Monitor Display Width

Balancing the point name length with other information that users need to access is a main
consideration when planning for long point names. Integral in the calculation are:

• The width of the screen that displays the information
• What other information needs to display
• Where other information needs to be positioned in the display.
• How urgent the other information is.

Examples

• Alarm Viewer

Fields can be increased/decreased in the Alarm Viewer. However, if the point name is very long and
the Alarm ID field is:

Too narrow The point ID can be cut off, making it unclear what monitored object is in an alarm
state.

Wide enough to display the
name

Information to the right of the Alarm ID may not have room to display

• Marquee

If a long point name is configured to scroll on a  fixed width Marquee screen, it can possibly take too
much time before the actual message to be delivered scrolls by. This, of course, is counter-productive
to the Marquee purpose.
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• CimEdit/CimView

On CimEdit screens, text objects can display the point ID. However, if the text object is referencing a
long point ID, it is usually preferable for the text object display text to be different from the point ID
and have fewer characters.

Workbench Tree View

When using long point IDs is the best choice, using the dot delimiter and selecting the Tree View in
the Workbench right-pane provides the most efficient way to view the entire point ID and associated
information (e.g. resource, Device ID, Point Type, description).

CIMPLICITY will:

• Assign each part of the point name that is to the right of a dot its own level.
• Group the parts of point names with parallel text into folder.

Example

1. The beginning parts of many point names that monitored machine heat were could be divided
into a hierarchy of levels that were  grouped together.

2. Even though the point names were not very long, the names facilitated organizing the
information.

3. The machines' point names were all configured as HEAT.SOUTH.Region.<Machine name>.

4. When Tree View was selected, the Point IDs were listed as follows.

1 Folder HEAT
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2 Folder SOUTH

3 Folder Region

4 Unique name e.g. 04_Machine6504

Mixed Case Support

Beginning in CIMPLICITY v9.0 point IDs support mixed case. You can take advantage of
mixed cases to help identify point ID sections that go together and make the point ID easier to
read for point IDs of any length.

Important:  CIMPLICITY does not differentiate among Upper case, mixed case or lower
case point IDs that have the exact same characters. For example TANK1, Tank1 and tank1 are
treated as the same point; they are not three different points.

Viewers (Clients) with Lower then CIMPLICITY v9.0 Installations

If you are using long point IDs on a server that has CIMPLICITY v10.0 installed, it is
recommended that you also upgrade CIMPLICITY to version 10.0 on connected Viewers
(clients).

Viewers that have not been upgraded to CIMPLICITY v9.0 at a minimum:

• Will not display the long point IDs.
• Will display point IDs that are 32 characters or less.
• Will not display mixed case.

Points that are mixed case in a CIMPLICITY v9x project on the Server are converted to all
upper-case on the Viewer.

If long point IDs are used, one of two results will occur on Viewers with lower than
CIMPLICITY v9.0. The result depends on how the point ID is being used.

Point ID
Location

Result

Embedded
Point IDs
(Applications
including:

• CimEdit
Screens

• CimView
Screens)

If long point IDs are embedded in a CimEdit screen (e.g. used in an Expression field) and the
CimEdit screen is copied to a Viewer that has lower than CIMPLICITY v9.0 installed, the long
entries will not be recognized as point IDs; CimEdit and/or CimView will have unpredictable
results.
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Point ID
Location

Result

Browsed
Point IDs
(Applications
including:

• Point
Browsers

• Point
Control
Panel

• Alarm
Viewers)

The point IDs that display will be the short names that CIMPLICITY has automatically generated.
The names are random characters and so will not be easily identifiable.

Renamed Points and Expressions

As with any point that is renamed, if a short ID point is renamed with a longer ID:

• Remember to rename the point anywhere that it is being used in CIMPLICITY (e.g.
derived point expression, CimEdit Expression fields or scripts)

• Make sure the feature using the longer name has been configured to deal with it.

Third Party Products

Consult the documentation for any  third party products/control that are receiving point ID data
from CIMPLICITY to see if there are any limits in the length of the names they use.

Known Other Proficy and Third Party Products' Limitations

Known applications that do not support the new point ID and/or alarm message lengths are as
follows.

Proficy Change Management

Proficy Change Management History Difference reports do not display long point IDs; they do
display the short internal point IDs.

Tip:   A group of  *.idt (page 355) files are available that enable you to find what long
point ID is associated with any listed short point ID.

Access Database and Database Logging

Microsoft Access (As-Is product) does not fully support the long point IDs or alarm messages
that were introduced in CIMPLICITY V9.0.

Consult Microsoft documentation for details about maximum character support.

4.2. Long Point IDs/Mixed Case Support: idt Files
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CIMPLICITY IDT Files Long Point ID/Short Point ID Associations

Whenever a user creates a  long point ID (over 32 characters), CIMPLICITY automatically generates
a corresponding short point ID that it uses for internal processes.

There may be times when you need to review the long point ID and short point ID associations.

You will be able to find these associations in  *.idt map files.

Available *.idt map files include the following.

Feature Map Files

Actions act_name_map.idt

Alarms alm_name_map.idt

Events evt_name_map.idt

Points pt_name_map.idt

Point Map File (pt_name_map.idt)

The procedure to display map .idt files is the same for any feature. Most likely, the most commonly
used file will be pt_name_map.idt.

1
(page
356)

Display a project's main directory in a Command window.

2
(page
357)

Enter commands to open the pt_name_map.idt file.

3
(page
358)

Review the mapped point list in the pt_name_map.idt file.

Display a project's main directory in a Command window.

1. Open the project whose points you want to review.
2. Click Tools>Command Prompt on the Workbench menu bar.

A command window opens displaying the project's directory.

1. Enter cd master.

The path is now the project's main directory.
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Enter commands to open the pt_name_map.idt file.

Do the following.

A Enter idtpop pt_name_map

Press Enter.

The short to long name map for points is processed.

B Enter Notepad pt_name_map.idt

Press Enter.

Result:  Notepad (or another named text editor) opens with a list of the project's short point IDs
mapped to their corresponding long point IDs.

Entries include

0 Point short name



Project Setup | 7 - Points | 358

1 Point long name.

Review the mapped point list in the pt_name_map.idt file.

The mapped list displays the point IDs as follows.

Column Description Example

A Left Automatically generated internal short point
ID.

D46D146C1A4F4BA1977A52F21DC7D8E1

Right Long point ID associated with automatically
generated  internal short point ID.

LEVEL_RESERVOIR_SOUTH60_REGION1710_29875

B Left Internal short point ID with same characters
as user created short point ID.

HEAT.SOUTH.REGION.01_MACHINE6501

Right User created short point ID associated with
the internal short point ID.

HEAT.SOUTH.REGION.01_MACHINE6501



Chapter 8. Point Attributes

About Point Attributes

CIMPLICITY provides you with different types of point attributes that help you evaluate different
perspectives of a point's status.

The types of available point attributes are:

• User defined
•  Create a new Point attribute set.
• Quality
• Runtime
• Configuration

Attributes can be used in expressions in:

• Event Editor
• CimEdit for CimView
• Point Control Panel opened from a CimView screen
• Custom applications making point requests
• BCE scripts

These attributes can be referenced in many CIMPLICITY applications in the same fashion as a
configured point ID.

The general syntax for referencing a point attribute is:

<point ID>.<point attribute>

Syntax Description

< point ID > A normally configured point ID.

< point attribute > One of the point attributes described in this chapter when you click one of the four buttons above.

Note:

• You can also use the CIMPLICITY Point browser to select an attribute that is available for a
selected point and apply it to the application in which you are working. You can open the Select
a Point Browser from any expression field.

• Point attributes do not apply to system points (page 413) .
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User Defined Point Attributes

User Defined Point Attributes

1. Create several user defined fields, (attribute definitions) within a set, then

2. Associate the attribute set with a point. (The same attribute set can be associated with more than
one point.), then

3. Associate your user-defined fields with that point in expressions in:
• Event Editor,
• CimEdit for CimView,
• Point Control Panel opened from a CimView screen,
• Custom applications making point requests, and
• BCE scripts.

Example

The processes for a machine point called MACH_TEMP are different depending on whether or
not a man is online. You:

4. Create an attribute set call PROC.

5. Include an attribute field called MOL (man-on-line).

6. Associate the attribute set PROC with the machine's MACH_TEMP point.

7. Create a CimView screen object that displays the value of the MOL field.

During runtime, the CimView screen will alert users whether or not a man is online for the point
MACH_TEMP provided your application has set the attribute.

User Flag Attributes

User Flag Attributes

CIMPLICITY provided user flag attributes enable any point to access its entire 16 through 32 bits of
a 64 bit user set at once. The exact access depends on the selected attribute.

• USER_FLAGS
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• EXTENDED_USER_FLAGS_LOW

• EXTENDED_USER_FLAGS_HIGH

USER_FLAGS

A CIMPLICITY provided attribute,  USER_FLAGS , enables any point to access its entire 16-bit
user set at once. This capability does not require additional configuration.

Associated Point Type Device or Virtual

Access Read only

Value Type UINT

Expression Syntax PointID.USER_FLAGS

Note:  The value of  USER_FLAGS  can be logged.

EXTENDED_USER_FLAGS_LOW

A CIMPLICITY provided attribute, EXTENDED_USER_FLAGS_LOW, enables any point to access the
lowest 32 bits in a 64 bit user set at once. This capability does not require additional configuration.

Associated Point Type Device or Virtual

Access Read only

Value Type UINT

Expression Syntax PointID.EXTENDED_USER_FLAGS_LOW

Note:  The value of EXTENDED_USER_FLAGS_LOW can be logged.

EXTENDED_USER_FLAGS_HIGH

A CIMPLICITY provided attribute, EXTENDED_USER_FLAGS_HIGH, enables any point to access the
highest 32 bits in a 64 bit user set at once. This capability does not require additional configuration.

Associated Point Type Device or Virtual

Access Read only

Value Type UINT

Expression Syntax PointID.EXTENDED_USER_FLAGS_HIGH

Note:  The value of EXTENDED_USER_FLAGS_HIGH can be logged.
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View a Project's Existing Point Attribute Sets

1. Expand the Points folder in the left pane of the Workbench.
2. Select Attribute Sets.

The Workbench right pane displays the list of Point attribute sets in the right pane.

Create a New Point Attribute Set

Create a New Point Attribute Set

Steps to create a new point attribute set include:

Step 1
(page
362)

Open the New Attribute Set Dialog box.

Step 2
(page
364)

Name a new attribute set.

Step 3
(page
365)

Add fields to the new attribute set.

Step 4
(page
367)

Associate the attribute set with one or more points.

Step 5
(page
368)

Use an attribute set, for example, in a CimView screens.

Step 1. Open a New Attribute Set dialog box

CIMPLICITY provides several methods to open a New Attribute Set dialog box.

• Workbench
• Point Properties dialog box's Advanced General tab

Workbench

1. Select Project>Points>Attribute Sets in the Workbench left pane.

2. Do one of the following:
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A Click File>New on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Attribute Sets. a. Right-click Attribute Sets.
b. Select New on the Popup menu.

D a. In the Workbench right pane.
a. Right-click any attribute set.
b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

Result: A New Attribute Set dialog box opens when you use any method.

Point Properties dialog box's Advanced General tab

3. Right-click Attribute Sets.

4. Select New on the Popup menu.

5. Right-click any attribute set.

6. Select New on the Popup menu.

7. Select the General tab in the Point Properties dialog box for the point you are configuring.
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8. Click Advanced to put the General tab in advanced mode.

9. Click the Popup Menu button to the right of the Attribute Set field; select New on the Popup
menu.

A New Attribute Set dialog box opens when you use any method.

Step 2. Name a New Attribute Set

1. Enter the name of the new attribute set in the Set Name field.

The name can:

• Be up through 32 characters long.
• Have alphanumeric characters and underscores only
• Alphabetic characters can be in any position.
• Digits can be in any position other than the first position.
• Underscores can be in any position.

2. Click OK.

The system verifies that the attribute set name does not already exist, and that no invalid characters
have been used.
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If the attribute set name you entered is valid, an Attribute Set dialog box for the new attribute set
opens.

Step 3. Add Fields to the new Attribute Set

A
(page
365)

Open the Attribute Field dialog box.

B
(page
366)

Define an Attribute field.

C
(page
366)

Re-display the Attribute Set dialog box.

1. Open the Attribute Field dialog box.

Click Add in the Attribute Set dialog box.

Result: A blank Attribute Field dialog box opens.
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1. Define an Attribute field.

Options in the Attribute Field dialog box are as follows.

Field Description

Field name The name can:

• Be up to 16 characters long.
• Have alphanumeric characters and underscores only:
• Alphabetic characters can be in any position.
• Digits can be in any position other than the first position.
• Underscores can be in any position.

Start Bit position at which the attribute should start. You can choose from 0 through 63.

Size Size of the attribute field. The allowable size depends on the position at which you started the field.

Important:  The Start position + the Size cannot exceed 64.

Example If you enter 32 in the Start field, the maximum field size is 32.

Save on
shutdown

Checked Attribute values will be preserved across project restarts.

Writeable
device flag

Checked Data will be sent to the associated devcom when the attribute field is set.

Read only Checked Restricts the field to read-only when it is displayed on a CimView screen.

Restrict
write by role

Checked Allows only the roles that have been granted Modify attribute privileges in the Roles
Properties dialog box to perform a setpoint on this attribute field.

1. Re-display the Attribute Set dialog box.

Click OK to close the Attribute Field dialog box.

The Attribute Field dialog box closes and the Attribute Sets dialog box displays the Field Name with
its Field Start and Size information.
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Note: Continue to add attributes until you have listed all the attributes that should be associated with
a selected point.

Step 4. Associate the Attribute Set with One or More Points

1. Open the Properties dialog box for the point with which you want to associate the point set.

2. Select the General tab.

3. Do any of the following to enter an attribute set name in the Attribute set field.

A Type the Attribute Set name that you want to associate with the point in the Attribute set field.

B Click the Browse button to open the Select an Attribute Set browser.

C Click the Popup Menu button; select Browse on the Popup menu to open the Select an Attribute Set browser.

D Click the Popup Menu button; select a recently opened attribute set on the Popup menu.
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The point now has an associated attribute set. Each field in the set can be used to associate additional
information with the point.

Step 5. Use an Attribute Set Field

1. Open an application that displays point values, e.g. CimEdit/CimView.

2. Enter in a field (or list) a <Point ID>.<Attribute field>

Where

<Point ID> is the selected point ID.

<Attribute Field> is a field in the attribute set that is assigned to the point.

Example

• A Point ID is named LEVELT301.
• An attribute set that was assigned to LEVELT301 is named LEVEL_HT.
• A field in the attribute set is LEVEL_HT_TNK3.

In order to display the status of the LEVEL_HT_TNK3 field, a CimEdit designer does the
following.

a. Opens a Properties dialog box for an object on the CimEdit screen.
b. Selects an Expression field to which the point attribute will be assigned.
c. Selects the point's attribute field in a Select a Point browser (Tree View).

Result:

a. The selected attribute displays in the Expression field, as follows.

LEVELT301.LEVEL_HT_TNK3
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a. During runtime, the object will reflect the field value and will adhere to the field
characteristics that were specified in the Attribute Field dialog box.

Open an Existing Attribute Set Dialog Box

CIMPLICITY provides several methods to open an Attribute Set dialog box for an existing attribute
set.

• Workbench
• Point Properties dialog box's Advanced General tab

Workbench

1. Select Project>Points>Attribute Sets in the Workbench left pane.

2. Select an attribute set in the Workbench right pane.

3. Do one of the following.
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A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:
a. Right-click Attribute Sets.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click an attribute set. a. Right-click an attribute set.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

Result: The Attribute Set dialog box opens with the selected attribute set.

Point Properties dialog box's Advanced General tab

4. Right-click Attribute Sets.

5. Select Properties on the Popup menu.

6. Right-click an attribute set.

7. Select Properties on the Popup menu.

8. Select the General tab in the Point Properties dialog box for the point you are configuring..

9. Click Advanced to put the General tab in advanced mode.

10. Select the point attribute set  in the Attribute set field that will be modified.

11. Click the Popup Menu button; select Edit on the Popup menu.
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The Attribute Set dialog box opens with the selected attribute set.

Quality Attributes

Quality Attributes

CIMPLICITY provides attributes that enable a user to assess the quality of a point in order to
evaluate the quality of the data it sends or receives.

The quality attributes are:

• QUALITY

• QUALITY.MANUAL_MODE

• QUALITY.ALARMED

• QUALITY.ALARMS_ENABLED

• QUALITY.DISABLE_WRITE
• QUALITY.IS_AVAILABLE

• QUALITY.IS_IN_RANGE

• QUALITY.LAST_UPD_MAN
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• QUALITY.STALE_DATA

QUALITY (Attribute)

QUALITY is not configuration data, as with value attributes, but is used to dynamically change the
behavior of a point, or dynamically reflect runtime information about the point.

QUALITY is the sum of all its current binary values in decimal format.

Associated Point Type Device

Access Read Only

Value Type UINT

Expression Syntax PointID.QUALITY

QUALITY  can also be configured to display the state of each of its individual indicators.

Following are the CIMPLICITY read-only indicators located at each of the 16 bit  positions.

Indicator Bit Position

MANUAL_MODE 0x01

LAST_UPD_MAN 0x02

IS_AVAILABLE 0x04

IS_IN_RANGE 0x08

STALE_DATA 0x10

ALARMS_ENABLED 0x20

DISABLE_WRITE 0x40

ALARMED 0x80

Note:

• The 0x0100 bit position indicates if the alarm is in the ACK state.

• The 0x0200 bit position indicates if the Devcom can specify alarm states for the point.

• The 0x0400 bit position indicates if the point is not configured.
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QUALITY.MANUAL_MODE (Attribute)

QUALITY.MANUAL_MODE  can be used as an attribute that references the  QUALITY 
indicator called  MANUAL_MODE .

QUALITY.MANUAL_MODE  enables a user to take a device point that may or may not be
currently available and put it in manual mode. The user can then set the point's value. This is
particularly useful if a point is attached to equipment that is known to be malfunctioning and, as
a result, creates a problem in other areas of the system. This indicator enables a user to separate
the point from that equipment and set the point to a known good value that preserves the system's
integrity.

Note:  When a read-only device point is put in manual mode, the read-only feature is ignored.
As a result, if Allow set point for read only manual mode  points is checked (enabled) in the Point
Setup (page 346) dialog box that is accessed (page 342) through the Project Properties dialog box,
administrators who are performing system diagnostics can change its value for testing purposes.

Example

A temperature sensor that reports temperatures, which are acted upon by CIMPLICITY applications
to initiate temperature control actions, fails. To continue the high temperature setting, a user
with Modify attributes privilege places the point that reflects the errant sensor in manual
override mode. The user then sets a value that causes the application to cease the unnecessary
temperature control procedures. This allows users who are knowledgeable of their CIMPLICITY
application implementation to make emergency, temporary adjustments to their system's operation.
Consequently the application does not have to anticipate and provide for handling of all possible
failures in its implementation.

Associated Point
Type

Device

Access Write–for users who have Modify attributes privileges. These privileges are enabled in the Roles
Properties dialog box.

Value Type Boolean

Expression
Syntax

PointID.QUALITY.MANUAL_MODE

Description Enables a user to place a point in manual mode. The user can then manually set the point's value.

1 The point is in manual mode.

0 The point is actively connected to a device.

QUALITY.ALARMED (Attribute)

Associated Point Type Device or Virtual for system wide use
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Access Read only

Value Type Boolean

Expression Syntax PointID.QUALITY.ALARMED

Description Reflects whether a point is
currently in an alarm state including
exceeding range limits.

1 The point is in an alarm state.

0 The point is not in an alarm state.

QUALITY.ALARMS_ENABLED (Attribute)

Associated Point
Type

Device or Virtual.

Access Write

Value Type Boolean

Expression
Syntax

PointID.QUALITY.ALARMS_ENABLED

Description Enables a user to control the generation of alarms other than range limit alarms and to see if
someone else disabled them.

1 The alarm is enabled.

0 The alarm is disabled.

Example If someone disabled an alarm in the Point Control Panel, 
QUALITY.ALARMS_ENABLED  should reflect that by becoming 0.

QUALITY.DISABLE_WRITE (Attribute)

Associated Point Type Device or Virtual

Access Write–for users
who have Modify
attributes privileges.
These privileges are
enabled in the Roles
Properties dialog
box. See the "Role
Configuration" chapter
in this manual.

Value Type Boolean

Expression Syntax PointID.QUALITY.DISABLE_WRITE
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Description Enables a user to
inhibit writes via Point
Management to a
point.

1 Writing is disabled.

0 Writing is enabled.

QUALITY.IS_AVAILABLE (Attribute)

Associated Point Type Device or Virtual

Access Read only

Value Type Boolean

Expression Syntax PointID.QUALITY.IS_AVAILABLE

Description Displays whether or not the point is available.

1 The point is available.

0 The point is not available.

QUALITY.IS_IN_RANGE (Attribute)

Associated Point Type Device or Virtual

Access Read only

Value Type Boolean

Expression Syntax PointID.QUALITY.IS_IN_RANGE

Description Reflects if a point exceeds the range limits that are defined for it.

1 The point is in range.

0 The point exceeds the range limits.

Important:  When a point goes unavailable, ALARMED and the IS_IN_RANGE attributes keep the
value they had when that point was last available. This might not reflect the point's actual value while
it is unavailable.

Example

1. An available device point that is out of range becomes unavailable.

2. The unavailable device point is:
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3. Placed in Manual Mode

4. Set so its value is in range

5.  The point's IS_IN_RANGE attribute will equal 1.

6. The unavailable device point is taken out of Manual Mode

7. The point's IS_IN_RANGE attribute continues to equal 1.,

Because the point is unavailable, the Point Manager does not know that the point value is now
in range; as a result, the Point Manager has no reason to change the IS_IN_RANGE attribute
value.

QUALITY.LAST_UPD_MAN (Attribute))

Associated Point Type Device or Virtual

Access Read Only

Value Type Boolean

Expression Syntax PointID.LAST_UPD_MAN

Description Displays whether or not a value came from a manual override.

Returned Values 1 The value came from a manual override.

0 The value came from a device.

QUALITY.STALE_DATA (Attribute)

Associated Point Type Device or Virtual

Access Read only Configured on the General
tab of the Port Properties dialog box.

Value Type Boolean

Expression Syntax PointID.STALE_DATA

Description When Enable stale data is checked
in the Port Properties dialog box, the
point will remain available in most
circumstances that would have made
it unavailable. However, this attribute
will report that the point value is stale.
It is the last known good value and
may or may not have changed. Note:
Some devices may report some
points as stale even without enabling
this attribute.
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Returned Values 1 The point value is stale.

0 The point is not known to be stale.

Runtime Attributes

Runtime Attributes

CIMPLICITY provides you with an attribute that enables you to view the date and time a point's
value is updated.

The runtime attributes are:

• $RAW_VALUE
• TIMESTAMP

$RAW_VALUE

Associated Point Type All

Value Type Length of normal point

Access Same as associated point.

CIMPLICITY Field
Name

Raw Value

Description Device points only Provides the raw value of a point when using point enumeration or EU
conversion.

Important:  System (page 413) points do not have a raw value.

TIMESTAMP

Associated Point Type Device

Access Read only

Value Type System generated

Expression Syntax PointID.TIMESTAMP

Description Displays the time in the server's local time.

Default Display MM/DD/YY HHHH:MM:SS:TTT A Note: TTT = milliseconds; A = AM or PM
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Configuration Attributes

Configuration Attributes

Following is a list of configuration attributes.

A
(page
378)

C
(page
378)

D
(page
378)

E
(page
378)

F
(page
379)

H
(page
379)

I
(page
379)

L
(page
379)

M
(page
379)

P
(page
379)

R
(page
380)

S
(page
380)

T
(page
380)

V
(page
380)

W
(page
380)

A

ACCESS_FLAG ALARM_HIGH_N

ACK_TOUT (Obsolete) ALARM_LOW

ADDR ALARM_LOW_N

ADDR_OFFSET ALARM_STATE

ALARM_CRITERIA ANALOG_DEADBAND

ALARM_DELAY (Obsolete) ANALOG_DEADBAND_N

ALARM_HIGH

C

CALCULATION_TYPE

CLR_TOUT (Obsolete)

CONV_TYPE

D

DEADBAND DISPLAY_LIM_HIGH

DEADBAND_N DISPLAY_LIM_HIGH_N

DEL_OPT (Obsolete) DISPLAY_LIM_LOW

DESCRIPTION DISPLAY_LIM_LOW_N

DEVIATION_PTID DP_FLAG

DEVICE_ID

E

EU_LABEL
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EU_EXPRESSION

EU_REV_EXP

EXTRA

F

FLAGS

FORMAT_WID

FORMAT_PREC

FR_ID

H

HI_ACK_TOUT HIH_ACK_TOUT

HI_ALARM_DELAY HIHI_ALARM_DELAY

HI_ALARM_OFF_DELAY HIHI_ALARM_OFF_DELAY

HI_CLR_TOUT HIHI_CLR_TOUT

HI_DEL_OPT HIHI_DEL_OPT

HI_REP_TOUT HIHI_REP_TOUT

I

INIT_VALUE

L

LEVEL LOCAL

LO_ACK_TOUT LOLO_ACK_TOUT

LO_ALARM_DELAY LOLO_ALARM_DELAY

LO_ALARM_OFF_DELAY LOLO_ALARM_OFF_DELAY

LO_CLR_TOUT LOLO_CLR_TOUT

LO_DEL_OPT LOLO_DEL_OPT

LO_REP_TOUT LOLO_REP_TOUT

M

MEASUREMENT_UNIT_ID

P

POINT_ID POINT_SET_TIME
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PROCESS_ID POINT_SET_INTERVAL

PTMGMT_PROCESS_ID POINT_STATE

R

RATE_TIME_INTERVAL RANGE_LOW_N

RANGE_HIGH REP_TOUT (Obsolete)

RANGE_HIGH_N RESET_POINT_ID

RANGE_LOW ROLLOVER_VALUE

S

SCAN_POINT SETPOINT_LOW

SCAN_RATE SETPOINT_LOW_N

SETPOINT_HIGH SETPT_CHECK_PTID

SETPOINT_HIGH_N

T

• TRIGGER_POINT
• TRIGGER_TYPE
• TRIGGER_VALUE

V

VARIANCE_VALUE

W

WARNING_HIGH

WARNING_HIGH_N

WARNING_LOW

WARNING_LOW_N

ACCESS_FLAG

Associated Point Type All

Value Type 1 character

Access Read only
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CIMPLICITY Field Name Access

Description Device read/write access.

Returned values 0 Read only

2  Read/Write

ACK_TOUT

ACK_TOUT is OBSOLETE starting with CIMPLICITY v8.1.

Current attributes are as follows.

• HI_ACK_TOUT
• HIHI_ACK_TOUT
• LO_ACK_TOUT
• LOLO_ACK_TOUT

ADDR

Associated Point Type Device

Value Type 256 characters

Access Read only

CIMPLICITY Field Name Address

Description Actual address of the point within the device.

ADDR_OFFSET

Associated Point Type Device

Value Type Integer

Access Read only

CIMPLICITY Field Name Address Offset

Description offset in memory from the first bit of the Point address.

ALARM_CRITERIA

Associated Point Type All

Value Type Integer
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Access Read only

CIMPLICITY Field Name Alarm Criteria

Description Method to be used for evaluating alarm conditions.

Returned Values 1 Absolute

2 Deviation

4 Rate of Change

16 On Update

ALARM_DELAY

ALARM_DELAY is OBSOLETE starting with CIMPLICITY v8.1.

Current Attributes are as follows.

• HI_ALARM_DELAY
• HIHI_ALARM_DELAY
• LO_ALARM_DELAY
• LOLO_ALARM_DELAY

ALARM_HIGH and ALARM_HIGH_N

ALARM_HIGH

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Alarm High

Description High alarm limit

Note: If the value in the Hi-2 field is

0 ALARM_HIGH is 0.

Empty ALARM_HIGH is Empty.

ALARM_HIGH_N

Associated Point Type All

Value Type REAL

Access Read only
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CIMPLICITY Field Name Alarm High_N

Description High alarm limit Note: If the value in the Hi-2 field is

0 ALARM_HIGH_N is 0.

Empty ALARM_HIGH_N is ***..

ALARM_LOW and ALARM_LOW_N

ALARM_LOW

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Alarm Low

Description Low alarm limit Note: If the value in the Low-2 field is

0 ALARM_LOW is 0.

Empty ALARM_LOW is Empty.

ALARM_LOW_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Alarm Low

Description Low alarm limit Note: If the value in the Low-2 field is

0 ALARM_LOW_N is 0.

Empty ALARM_LOW_N is ***.

ALARM_STATE

Associated Point Type All

Value Type 2 bytes

Access Read only

CIMPLICITY Field Name Enable Alarm

Description Enable/Disable alarm.

Returned Values 0 Disable
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1 Enable

ANALOG_DEADBAND and ANALOG_DEADBAND_N

ANALOG_DEADBAND

Associated
Point Type

Device

Value Type 10 characters

Access Read only

CIMPLICITY
Field Name

Analog Deadband

Description Used to filter changes in raw value of point. The raw value must change at least this much to update
the value of the point. Note: If the value in the Analog Deadband field is

0 ANALOG_DEADBAND is 0.

Empty ANALOG_DEADBAND is Empty.

ANALOG_DEADBAND_N

Associated
Point Type

Device

Value Type REAL

Access Read only

CIMPLICITY
Field Name

Analog Deadband

Description Used to filter changes in raw value of point. The raw value must change at least this much to update
the value of the point. Note: If the value in the Analog Deadband field is

0 ANALOG_DEADBAND_N is 0.

Empty ANALOG_DEABAND_N is 0.

CALCULATION_TYPE

Associated Point Type Derived (Virtual)

Value Type 1 character

Access Read only

CIMPLICITY Field Name Calc Types

Description Method for determining the derived point value.
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Returned Values 0 Equation

1 Delta Accumulator

2 Value Accumulator

3 Average

4 Maximum

5 Minimum

7 Transition High Accumulator

8 Equation with Override

9 Timer/Counter

10 Histogram

CLR_TOUT

CLR_TOUT is OBSOLETE starting with CIMPLICITY v8.1.

Current attributes are as follows.

• HI_CLR_TOUT
• HIHI_CLR_TOUT
• LO_CLR_TOUT
• LOLO_CLR_TOUT

CONV_TYPE

Associated Point Type Device

Value Type 2 bytes

Access Read only

CIMPLICITY Field Name Conversion Type

Description Point EU conversion type.

Returned Values 0 None

1 Linear conversion

2 Custom conversion

DEADBAND and DEADBAND_N
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DEADBAND

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Alarm Deadband

Description Tolerance around alarm limits. Note: If the value in the Alarm Deadband field is

0 DEADBAND is 0.

Empty DEADBAND is Empty.

DEADBAND_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Alarm Deadband

Description Tolerance around alarm limits. Note: If the value in the Alarm Deadband field is

0 DEADBAND_N is 0.

Empty DEADBAND_N is 0.

DEL_OPT

DEL_OPT is OBSOLETE starting with CIMPLICITY v8.1.

Current attributes are as follows.

• HI_DEL_OPT
• HIHI_DEL_OPT
• LO_DEL_OPT
• LOLO_DEL_OPT

DESCRIPTION

Associated Point Type All

Value Type 40 characters

Access Read only
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CIMPLICITY Field Name Description

Description Description of point

DEVIATION_PTID

Associated Point
Type

All

Value Type 256 characters

Access Read only

CIMPLICITY Field
Name

Deviation Point

Description Point that current point will be compared to when checking for deviation alarm. Must be a
configured Point ID.

DEVICE_ID

Associated Point Type Device

Value Type 256 characters

Access Read only

CIMPLICITY Field Name Device ID

Description Device where the point data originates. Must be a configured Device ID.

DISPLAY_LIM_HIGH and DISPLAY_LIM_HIGH_N

DISPLAY_LIM_HIGH

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Disp. Limit (hi)

Description Largest value to display in CimView screens. Note: If the value in the Disp. Limit (hi) field is

0 DISPLAY_LIM_HIGH is 0.

Empty DISPLAY_LIM_HIGH is Empty.

DISPLAY_LIM_HIGH_N
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Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Disp. Limit (hi)

Description Largest value to display in CimView screens. Note: If the value in the Disp. Limit (hi) field is

0 DISPLAY_LIM_HIGH_N is 0.

Empty DISPLAY_LIM_HIGH_N is 0.

DISPLAY_LIM_LOW and DISPLAY_LIM_LOW_N

DISPLAY_LIM_LOW

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field
Name

Disp. Limit (low)

Description Smallest value to display in CimView screens. Note: If the value in the Disp. Limit (low) field
is

0 DISPLAY_LIM_LOW is 0.

Empty DISPLAY_LIM_LOW is Empty.

DISPLAY_LIM_LOW_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field
Name

Disp. Limit (low)

Description Smallest value to display in CimView screens. Note: If the value in the Disp. Limit (low) field
is

0 DISPLAY_LIM_LOW_N is 0.

Empty DISPLAY_LIM_LOW_N is 0.

DP_FLAG
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Associated Point Type Derived (Virtual)/Global (Virtual)

Value Type 1 character

Access Read only

CIMPLICITY Field Name Startup Condition

Description Source for the initial value of the point when the software is started or reset.

Returned Values 0 Not Applicable 

1 Init

2 Saved

3 Saved or Init

EU_LABEL

Associated Point Type All

Value Type 8 characters

Access Read only

CIMPLICITY Field Name Eng. Units

Description Units that the data represents.

EU_EXPRESSION

Associated Point
Type

Device

Value Type 300 characters

Access Read only

CIMPLICITY Field
Name

Eng. Conversion Expression

Description Arithmetic expression used to convert raw data to engineering units value. See Equation
Operations for the list of valid operators.

EU_REV_EXP

Associated Point
Type

Device

Value Type 300 characters

Access Read only
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CIMPLICITY
Field Name

Reverse Engineering Expression

Description Arithmetic expression used to convert engineering units value to raw data for setpoints. See
Equation Operations for the list of valid operators.

EXTRA

Associated Point
Type

All

Value Type Signed double integer (DINT)

Access Read only

CIMPLICITY Field
Name

Extra info

Description Provides an extra field that can be used to return additional point information in a CIMPLICITY
application.

FLAGS

Associated Point Type Device

Value Type 1 character

Access Read only

CIMPLICITY Field Name Poll After Set/ Delay Load

Bit 0= Poll After Set

Bit 1= Delay Load

Description Determines if polling should be done after a setpoint.

Returned Values 0 Do not poll (default)

1 Scan Immediately

2 Delay Load

3 Scan Immediately and Delay Load

FORMAT_WID

Associated Point Type All

Value Type 2 Bytes

Access Read only

CIMPLICITY Field Name Display Width



Project Setup | 8 - Point Attributes | 391

Description Number of spaces for display of point value in CimView.

FORMAT_PREC

Associated Point Type All

Value Type 2 Bytes

Access Read only

CIMPLICITY Field Name Display Precision

Description Precision of the display of point value in

FR_ID

Associated Point Type All

Value Type 256 characters

Access Read only

CIMPLICITY Field Name Resource ID

Description Resource ID for this point. Must be a configured Resource ID.

HI_ACK_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Acknowledge Timeout

Description Time in minutes before the point's Hi alarm is automatically acknowledged.

Returned Values -1 Acknowledge the Hi alarm immediately.

0 No auto acknowledge.

>0 Minutes to wait for the Hi alarm to be automatically acknowledged.

HI_ALARM_DELAY

Associated Point
Type

All

Value Type Integer
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Access Read only

CIMPLICITY Field
Name

Delay Alarms

Description Determine if the generation of point alarms that are in the Hi state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box.

Returned Values 0 Hi point alarms are not delayed

n Hi point alarms are delayed by n time units.

HI_ALARM_OFF_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Alarm off delay

Description Determine if removing point alarms that are in the Hi state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box.

Returned Values 0 Moving Hi point alarms to Normal state is not delayed.

n Moving Hi point alarms to Normal state is delayed by n time units.

HI_CLR_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Reset Timeout

Description Time in minutes before this point's Hi alarm is automatically reset.

Returned Values 1 Reset the Hi alarm immediately.

0 No automatic reset.

>0 Minutes before the Hi alarm is automatically reset.
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HI_DEL_OPT

Associated Point Type All

Value Type 2 characters

Access Read only

CIMPLICITY Field Name Deletion Requirements

Description Hi alarm delete options.

Returned Values AR Acknowledge and Reset Hi alarms.

A Acknowledge Hi alarms.

R Reset Hi alarms.

HI_REP_TOUT

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY
Field Name

Repeat Timeout

Description Time in minutes before the point's Hi alarm is automatically re-sent to alarm line printers. The Hi
alarm will be re-sent only if it is still active.

Returned Values 0 Never

>0 Minutes before automatic re-send

HIHI_ACK_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Acknowledge Timeout

Description Time in minutes before the point's HiHi alarm is automatically acknowledged.

Returned Values -1 Acknowledge the HiHi alarm immediately.

0 No auto acknowledge.

>0 Minutes to wait for the HiHi alarm to be automatically acknowledged.
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HIHI_ALARM_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Delay Alarms

Description Determine if the generation of point alarms that are in the HiHi state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box

Returned Values 0 HiHi point alarms are not delayed

n HiHi point alarms are delayed by n time units.

HIHI_ALARM_OFF_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Alarm off delay

Description Determine if removing point alarms that are in the HiHi state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box.

Returned Values 0 Moving HiHi point alarms to Normal state is not delayed.

n Moving HiHi point alarms to Normal state is delayed by n time units.

HIHI_CLR_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Reset Timeout



Project Setup | 8 - Point Attributes | 395

Description Time in minutes before this point's HiHi alarm is automatically reset.

Returned Values 1 Reset the HiHi alarm immediately.

0 No automatic reset.

>0 Minutes before the HiHi alarm is automatically reset.

HIHI_DEL_OPT

Associated Point Type All

Value Type 2 characters

Access Read only

CIMPLICITY Field Name Deletion Requirements

Description HiHi alarm delete options.

Returned Values AR Acknowledge and Reset HiHi alarms.

A Acknowledge HiHi alarms.

R Reset HiHi alarms.

HIHI_REP_TOUT

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY
Field Name

Repeat Timeout

Description Time in minutes before the point's HiHi alarm is automatically re-sent to alarm line printers. The HiHi
alarm will be re-sent only if it is still active.

Returned Values 0 Never

>0 Minutes before automatic re-send

INIT_VALUE

Associated
Point Type

Derived (Virtual)/Global (Virtual)

Value Type 256 characters

Access Read only
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CIMPLICITY
Field Name

Initial Value

Description Value for point at initialization before any data is generated by its component point(s). Use if 
PT_TYPE  is G, or  PT_TYPE  is D and  CALC_TYPE  is ACC, MIN, or MAX.

LEVEL

Associated Point Type All point types

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Level

Description Role security level value that was entered for the selected point in its Point Properties dialog
box.

LO_ACK_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Acknowledge Timeout

Description Time in minutes before the point's Lo alarm is automatically acknowledged.

Returned Values -1 Acknowledge the Lo alarm immediately.

0 No auto acknowledge.

>0 Minutes to wait for the Lo alarm to be automatically acknowledged.

LO_ALARM_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Delay Alarms
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Description Determine if the generation of point alarms that are in the Lo state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box

Returned Values 0 Lo point alarms are not delayed

n Lo point alarms are delayed by n time units.

LO_ALARM_OFF_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Alarm off delay

Description Determine if removing point alarms that are in the Lo state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box.

Returned Values 0 Moving Lo point alarms to Normal state is not delayed.

n Moving Lo point alarms to Normal state is delayed by n time units.

LO_CLR_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Reset Timeout

Description Time in minutes before this point's Lo alarm is automatically reset.

Returned Values 1 Reset Lo alarm immediately.

0 No automatic reset

>0 Minutes before the Lo alarm is automatically reset.

LO_DEL_OPT

Associated Point Type All
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Value Type 2 characters

Access Read only

CIMPLICITY Field Name Deletion Requirements

Description Lo alarm delete options.

Returned Values AR Acknowledge and Reset Lo alarms.

A Acknowledge Lo alarms.

R Reset Lo alarms.

LO_REP_TOUT

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY
Field Name

Repeat Timeout

Description Time in minutes before the point's Lo alarm is automatically re-sent to alarm line printers. The Lo
alarm will be re-sent only if it is still active.

Returned Values 0 Never

>0 Minutes before automatic re-send

LOCAL

Associated Point Type Derived (Virtual)/Global (Virtual)

Value Type Boolean

Access Read only

CIMPLICITY Field Name Local Value

Description Determines if value is reported to Point Manager.

Returned Values 0 Report value

1 Do not report value

LOLO_ACK_TOUT

Associated Point Type All

Value Type Integer
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Access Read only

CIMPLICITY Field Name Acknowledge Timeout

Description Time in minutes before the point's LoLo alarm is automatically acknowledged.

Returned Values -1 Acknowledge the LoLo alarm immediately.

0 No auto acknowledge.

>0 Minutes to wait for the LoLo alarm to be automatically acknowledged.

LOLO_ALARM_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Delay Alarms

Description Determine if the generation of point alarms that are in the LoLo state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box

Returned Values 0 LoLo point alarms are not delayed

n LoLo point alarms are delayed by n time units.

LOLO_ALARM_OFF_DELAY

Associated Point
Type

All

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Alarm off delay

Description Determine if removing point alarms that are in the LoLo state should be delayed.

Note:  The time unit is selected on the Alarm Options tab in the Point Properties dialog box
and Alarm Definition dialog box.

Returned Values 0 Moving LoLo point alarms to Normal state is not delayed.

n Moving LoLo point alarms to Normal state is delayed by n time units.
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LOLO_CLR_TOUT

Associated Point Type All

Value Type Integer

Access Read only

CIMPLICITY Field Name Reset Timeout

Description Time in minutes before this point's LoLo alarm is automatically reset.

Returned Values 1 Reset  LoLo alarm immediately.

0 No automatic reset

>0 Minutes before the  LoLo alarm is automatically reset.

LOLO_DEL_OPT

Associated Point Type All

Value Type 2 characters

Access Read only

CIMPLICITY Field Name Deletion Requirements

Description LoLo alarm delete options.

Returned Values AR Acknowledge and Reset LoLo alarms.

A Acknowledge LoLo alarms.

R Reset LoLo alarms.

LOLO_REP_TOUT

Associated
Point Type

All

Value Type Integer

Access Read only

CIMPLICITY
Field Name

Repeat Timeout

Description Time in minutes before the point's LoLo alarm is automatically re-sent to alarm line printers. The
LoLo alarm will be re-sent only if it is still active.

Returned
Values

0 Never
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>0 Minutes before automatic re-send

MEASUREMENT_UNIT_ID

Associated Point Type All

Value Type 256 characters

Access Read only

CIMPLICITY Field Name Measurement unit ID

Description The base measurement unit ID configured for the point.

POINT_ID

Description Returns the ID of the point (e.g. R1.POINT_ID would return R1)

PROCESS_ID

Associated Point
Type

Derived (Virtual)/Global (Virtual)

Value Type 256 characters

Access Read only

CIMPLICITY
Field Name

Virtual Proc ID

Description The Derived Point process that will calculate the value of this point. Must be a valid  PTDP_RP 
Process ID. Format is: <node_id>  _PTDP_RP

PTMGMT_PROCESS_ID

Associated Point
Type

Derived (Virtual)/Global (Virtual)

Value Type 256 characters

Access Read only

CIMPLICITY
Field Name

Point Manager

Description The Point Management process that will manage this point. Must be a valid PTM_RP Process ID.
Format is: <node_id> _  PTM  <n>  _RP
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POINT_SET_TIME

Associated
Point Type

Derived (Virtual)/Global (Virtual)

Value Type 8 characters

Access Read only

CIMPLICITY
Field Name

Start Time

Description For Timer/Counter points, start time used by Derived Point Processor to update the Point Manager with
information on the number of events, cumulative duration and time of the last HIGH event occurrence.

POINT_SET_INTERVAL

Associated Point Type Derived (Virtual)/Global (Virtual)

Value Type 8 characters

Access Read only

CIMPLICITY Field
Name

Interval

Description The frequency at which the Derived Point Processor updates the Point Manager with
information.

POINT_STATE

Associated Point Type Device

Value Type Boolean

Access Read only

CIMPLICITY Field Name Enabled

Description Determines if the point is enabled or disabled.

Returned Values 0 Disabled

1 Enabled

RATE_TIME_INTERVAL

Associated
Point Type

All
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Value Type Integer

Access Read only

CIMPLICITY
Field Name

Interval

Description The time interval for Rate of Change alarms.

Note:  Rate of Change and the time unit are selected on the Alarm tab in the Point Properties
dialog box and Alarm Definition dialog box Alarm Type field.

Returned
Values

n Rate of change is n time units. Note: 5 seconds is the minimum rate of change.

RANGE_HIGH and RANGE_HIGH_N

RANGE_HIGH

Associated Point
Type

All

Value Type 10 characters

Access Read only

CIMPLICITY Field
Name

Range high

Description Maximum value allowed for the converted (or base) value of a point. Note: If the value in the
Range high field is

0 RANGE_HIGH is 0.

Empty RANGE_HIGH is Empty.

RANGE_HIGH_N

Associated Point
Type

All

Value Type REAL

Access Read only

CIMPLICITY Field
Name

Range high

Description Maximum value allowed for the converted (or base) value of a point. Note: If the value in the
Range high field is

0 RANGE_HIGH_N is 0.

Empty RANGE_HIGH_N is 0.
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RANGE_LOW and RANGE_LOW_N

RANGE_LOW

Associated Point
Type

All

Value Type 10 characters

Access Read only

CIMPLICITY Field
Name

Range low

Description Minimum value allowed for the converted (or base) value of a point. Note: If the value in the
Range low field is

0 RANGE_LOW is 0.

Empty RANGE_LOW is Empty.

RANGE_LOW_N

Associated Point
Type

All

Value Type REAL

Access Read only

CIMPLICITY Field
Name

Range low

Description Minimum value allowed for the converted (or base) value of a point. Note: If the value in the
Range low field is

0 RANGE_LOW_N is 0.

Empty RANGE_LOW_N is 0.

REP_TOUT

REP_TOUT is OBSOLETE starting with CIMPLICITY v8.1.

Current attributes are as follows.

• HI_REP_TOUT
• HIHI_REP_TOUT
• LO_REP_TOUT
• LOLO_REP_TOUT
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RESET_POINT_ID

Associated Point Type Derived (Virtual)/Global (Virtual)

Value Type 256 characters

Access Read only

CIMPLICITY Field Name Reset Point

Description Point that will cause this derived point to reset. Must be a configured Point ID.

ROLLOVER_VALUE

Associated Point
Type

Derived (Virtual)

Value Type Integer

Access Read only

CIMPLICITY Field
Name

Rollover

Description For Delta Accumulator virtual points, the value of a point at which it rolls over to a zero value
when incremented by one unit.

SCAN_POINT

Associated Point Type Device

Value Type 2 bytes

Access Read only

CIMPLICITY Field
Name

Update Criteria

Description Value determining when point data is passed to the CIMPLICITY point database after the
device is read.

Returned Values 0 Unsolicited

1 On Change

2 On Scan

4 On Demand On Scan

5 On Demand On Change

6 Unsolicited On Change

7 Poll Once On Change
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8 On Demand Unsolicited

9 On Demand Poll Once

10 On Demand Unsolicited On Change

11 On Demand Poll Once On Change

SCAN_RATE

Associated Point Type Device

Value Type 2 bytes

Access Read only

CIMPLICITY Field Name Scan Rate

Description Frequency of point sampling. This is a multiple of the base scan rate set for the system.

SETPOINT_HIGH and SETPOINT_HIGH_N

SETPOINT_HIGH

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Setpoint high

Description Maximum value a point is allowed to be set. Note: If the value in the Setpoint high field is

0 SETPOINT_HIGH is 0.

Empty SETPOINT_HIGH is Empty.

SETPOINT_HIGH_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Setpoint high

Description Maximum value a point is allowed to be set. Note: If the value in the Setpoint high field is

0 SETPOINT_HIGH_N is 0.

Empty SETPOINT_HIGH_N is 0.



Project Setup | 8 - Point Attributes | 407

SETPOINT_LOW and SETPOINT_LOW_N

SETPOINT_LOW

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Setpoint low

Description Minimum value a point is allowed to be set. Note: If the value in the Setpoint low field is

0 SETPOINT_LOW is 0.

Empty SETPOINT_LOW is Empty.

SETPOINT_LOW_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Setpoint low

Description Minimum value a point is allowed to be set. Note: If the value in the Setpoint low field is

0 SETPOINT_LOW_N is 0.

Empty SETPOINT_LOW_N is 0.

SETPT_CHECK_PTID

Associated
Point Type

All

Value Type 256 characters

Access Read only

CIMPLICITY
Field Name

Safety Point

Description Point ID of an analog or digital point to be checked when a setpoint request is made for this point. If
the point evaluates to zero (0), the setpoint is denied. Must be a configured Point ID. Also serves as an
index for the Delta Accumulator array.

TRIGGER_POINT
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Associated
Point Type

Device/Derived (Virtual)

Value Type 256 characters

Access Read only

CIMPLICITY
Field Name

Trigger

Description The point serving as the trigger for this point. Use differs if device or derived point. Must be a configured
Point ID. For device points the trigger point must be on the same device as the points it triggers. For
derived points, the trigger point must be on the same project as the points it triggers.

TRIGGER_TYPE

Associated Point Type Device

Value Type 2 bytes

Access Read only

CIMPLICITY Field Name Relation

Description Determines how the trigger is evaluated.

Returned Values 0 No Trigger

1 On Change

2 Equal

3 Less Than

4 Greater Than

5 Less Than or Equal

6 Greater Than or Equal

TRIGGER_VALUE

Associated Point Type Device

Value Type 16 characters

Access Read only

CIMPLICITY Field Name Value

Description Value the trigger is compared with to determine if the  TRIGGER_TYPE  condition is
met.

VARIANCE_VALUE
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Associated Point Type Derived (Virtual)

Value Type Integer

Access Read only

CIMPLICITY Field Name Variance value

Description Delta accumulator variance value.

WARNING_HIGH and WARNING_HIGH_N

WARNING_HIGH

Associated Point Type All

Value Type 10 characters

Access Read only

CIMPLICITY Field Name Warning High

Description High warning limit Note: If the value in the Warning High field is

0 WARNING_HIGH is 0.

Empty WARNING_HIGH is Empty.

WARNING_HIGH_N

Associated Point Type All

Value Type Real

Access Read only

CIMPLICITY Field Name Warning High

Description High warning limit Note: If the value in the Warning High field is

0 WARNING_HIGH_N is 0.

Empty WARNING_HIGH_N is 0.

WARNING_LOW and WARNING_LOW_N

WARNING_LOW

Associated Point Type All

Value Type 10 characters

Access Read only
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CIMPLICITY Field Name Warning Low

Description High warning limit Note: If the value in the Warning Low field is

0 WARNING_LOW is 0.

Empty WARNING_LOW is Empty.

WARNING_LOW_N

Associated Point Type All

Value Type REAL

Access Read only

CIMPLICITY Field Name Warning Low

Description High warning limit Note: If the value in the Warning Low field is

0 WARNING_LOW_N is 0.

Empty WARNING_LOW_N is 0.

Apply Attributes (CimView Example)

Apply Attributes (CimView Example)

You have a device point called, for example, S90_550.

You want to review the point's values and the time that the values are read on a CimView screen.

The following steps enable you to easily configure the point attribute.

Step 1
(page
410)

Configure the point value display for CimView.

Step 2
(page
411)

Configure the timestamp display for CimView.

Step 3
(page
412)

View the point's values and timestamps in CimView.

Step 1. Configure the Point Value Display for CimView

1. Click the Text button in CimEdit.
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2. Place the cursor on the screen where you want the text object to appear.

The Properties - Object dialog box opens.

3. Select the Text tab.

4. Enter Point Value in the String field.

5. Open the Select a Point browser as follows:

a. Click the Popup Menu button  to the right of the Expression field.
b. Select Browse Point ID… from the popup menu.

The Select a Point browser opens.

6. Select S90_550 from the list of points.

7. Click OK to close the browser.

S90_550 appears in the Expression field.

8. Click OK to close the Properties - Object dialog box.

The text Point Value appears on the CimEdit screen.

Step 2. Configure the Timestamp Display for CimView

1. Click the Text button in CimEdit.

2. Place the cursor on the screen where you want the text object to appear.

The Properties - Object dialog box opens.

3. Select the Text tab.

4. Enter Point Time in the String field.

5. Open the Select a Point browser as follows:

a. Click the Browser button  to the right of the Expression field.
b. Select Browse Point ID… from the popup menu.

The Select a Point browser opens.

6. Select S90_550.TIMESTAMP as follows:
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a. Expand S90_550 in the list of points.
b. Select TIMESTAMP in the list that appears.

7. Click OK to close the browser.

S90_550.TIMESTAMP appears in the Expression field.

8. Click OK to close the Properties - Object dialog box.

The text Point Time appears under Point Value on the CimEdit screen.

Step 3. View the Point's Values and Timestamps in CimView

Click the Test Screen button  on the CimEdit toolbar.

Result: The Point value displays; the time the value was read displays below.

Point Attribute Security

Most point attributes are read-only. If users attempt to perform setpoint actions against the read-only
points, an error message displays.

Some quality point attributes are writable if the role has been granted the privilege in the Roles
Properties dialog box. If any roles without the privilege attempt to perform setpoint actions against
the point attribute, an error message displays.



Chapter 9. System Points

About System Points

CIMPLICITY provides you with several system points that you can use any where in your project
including:

• Event Manager
• CimEdit
• CimView
• Point Control Panel

Each system point, which is Read only, is automatically updated by CIMPLICITY. The default
update time is every 60 seconds. To see the value of any one, all you have to do is select it for
display.

System point categories include the following points.

$ALARM
(page
413)

$CLASS
(page
413)

$LOCAL
(page
413)

$PROJECT
(page
414)

$ROLE
(page
414)

$USER
(page
414)

$ALARM

• $ALARM.ACKED
• $ALARM.ACTIVE
• $ALARM.TOTAL
• $ALARM.UNACKED

$CLASS

• $CLASS_<Alarm class name>.ALARMS
• $CLASS_<Alarm class name>.UNACKED
• $CLASS_<Alarm class name>.UNRESET

$LOCAL

• $LOCAL.BIG_COUNTER
• $LOCAL.DATE.MONTH
• $LOCAL.COMPUTER
• $LOCAL.DATE.SECOND
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• $LOCAL.COUNTER
• $LOCAL.DATE.SECONDOFDAY
• $LOCAL.DATE.AMPM
• $LOCAL.DATE.WEEK
• $LOCAL.DATE.DAY
• $LOCAL.DATE.YEAR
• $LOCAL.DATE.DAYOFWEEK
• $LOCAL.DATETIME
• $LOCAL.DATE.DAYOFYEAR
• $LOCAL.DATETIME_INTERVAL
• $LOCAL.DATE.HOUR
• $LOCAL.DATETIME_VARUPDATE
• $LOCAL.DATE.HOUR12
• $LOCAL.DGR_STATE
• $LOCAL.DATE.MINUTE
• $LOCAL.WINUSER

$PROJECT

$PROJECT $PROJECT.DATE.MONTH

$PROJECT.AVAILABLE $PROJECT.DATE.SECOND

$PROJECT.COMPUTER $PROJECT.DATE.SECONDOFDAY

$PROJECT.DATE.AMPM $PROJECT.DATE.WEEK

$PROJECT.DATE.DAY $PROJECT.DATE.YEAR

$PROJECT.DATE.DAYOFWEEK $PROJECT.DATETIME

$PROJECT.DATE.DAYOFYEAR $PROJECTDEVICES

$PROJECT.DATE.HOUR $PROJECT.LOGGEDIN

$PROJECT.DATE.HOUR12 $PROJECT.USERS

$PROJECT.DATE.MINUTE

$ROLE

• $ROLE
• $ROLE.LEVEL

$USER

• $USER
• $USER.ALARMS
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$ALARM.ACKED

Point Type Server Point

Data Type UDINT

Access Read only

Description Total Alarms acknowledged

Update Automatic by CIMPLICITY

$ALARM.ACTIVE

Point Type Server Point

Data Type UDINT

Access Read only

Description Total active alarm count

Update Automatic by CIMPLICITY

$ALARM.TOTAL

Point Type Server Point

Data Type UDINT

Access Read only

Description Total alarm count

Update Automatic by CIMPLICITY

$ALARM.UNACKED

Point Type Server Point

Data Type UDINT

Access Read only
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Description Total alarms unacknowledged

Update Automatic by CIMPLICITY

$CLASS_<Alarm class name>.ALARMS

Point Type Server Point

Data Type UDINT

Access Read only

Description Alarm count by selected class

Update Automatic by CIMPLICITY

$CLASS_<Alarm class name>.UNACKED

Point Type Server Point

Data Type UDINT

Access Read only

Description Unacknowledged alarm count by selected class

Update Automatic by CIMPLICITY

$CLASS_<Alarm class name>.UNRESET

Point Type Server Point

Data Type UDINT

Access Read only

Description Not cleared (reset) alarm count by selected class

Update Automatic by CIMPLICITY
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$LOCAL Points

About $LOCAL Points

A project does not have to be running to display $LOCAL point values; a running Viewer only is
required.

• $LOCAL Points: List.
• $LOCAL Points:Example viewing values in the Point Control Panel.

Note:   $LOCAL point values will display when only the Viewer is running:

• On CimView screens or other CIMPLICITY applications that display point values.
• From projects that are running on remote computers; the values will be local values.

$LOCAL Points: List

• $LOCAL.BIG_COUNTER
• $LOCAL.DATE.MONTH
• $LOCAL.COMPUTER
• $LOCAL.DATE.SECOND
• $LOCAL.COUNTER
• $LOCAL.DATE.SECONDOFDAY
• $LOCAL.DATE.AMPM
• $LOCAL.DATE.WEEK
• $LOCAL.DATE.DAY
• $LOCAL.DATE.YEAR
• $LOCAL.DATE.DAYOFWEEK
• $LOCAL.DATETIME
• $LOCAL.DATE.DAYOFYEAR
• $LOCAL.DATETIME_INTERVAL
• $LOCAL.DATE.HOUR
• $LOCAL.DATETIME_VARUPDATE
• $LOCAL.DATE.HOUR12
• $LOCAL.DGR_STATE
• $LOCAL.DATE.MINUTE
• $LOCAL.WINUSER

$LOCAL Points: Example Viewing Values in the Point Control Panel

1. Open the Point Control Panel.
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A Select CIMPLICITY Project dialog box opens.

2. Do one of the following.

Viewer is not running Click Start as Viewer.

Viewer is running Click Cancel.

The Point Control Panel opens.

Note: Although it is not necessary, a project can also be started.

3. Click the Add Points button  .

The Select a Point browser opens.

4. Do the following.

A Select $LOCAL, which is available as a project in the Project field.

Important:  $LOCAL is available to select $LOCAL points only. It is not a real CIMPLICITY project.

B Click Browse. The $LOCAL points are listed.
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C Select one or more $LOCAL points.

The $LOCAL points that are added to the Point Control Panel display the current values.

$LOCAL.BIG_COUNTER

Point Type Local Point

Data Type UQINT

Access Read only

Description Counts forward indefinitely (Int. 125 msec)

Update Automatic by CIMPLICITY

$LOCAL.COMPUTER

Point Type Local Point

Data Type STRING (15)

Access Read only

Description Local computer name

Update Automatic by CIMPLICITY

$LOCAL.COUNTER

Point Type Local Point



Project Setup | 9 - System Points | 420

Data Type USINT

Access Read only

Description Counts from 0 to 31 (125 millisecond intervals).

Update Automatic by CIMPLICITY

$LOCAL.DATE.AMPM

Point Type Local Point

Data Type BOOL

Access Read only

Description 0=AM; 1=PM

Update Automatic by CIMPLICITY

$LOCAL.DATE.DAY

Point Type Local Point

Data Type USINT

Access Read only

Description Current day in the month (1-31)

Update Automatic by CIMPLICITY

$LOCAL.DATE.DAYOFWEEK

Point Type Local Point

Data Type USINT

Access Read only

Description Current day in the week (1-7); 1=Sunday

Update Automatic by CIMPLICITY

$LOCAL.DATE.DAYOFYEAR

Point Type Local Point

Data Type UINT
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Access Read only

Description Current day in the year (1-366)

Update Automatic by CIMPLICITY

$LOCAL.DATE.HOUR

Point Type Local Point

Data Type USINT

Access Read only

Description Current hour in the day (0-23)

Update Automatic by CIMPLICITY

$LOCAL.DATE.HOUR12

Point Type Local Point

Data Type USINT

Access Read only

Description Current hour in the day (1-12)

Update Automatic by CIMPLICITY

$LOCAL.DATE.MINUTE

Point Type Local Point

Data Type USINT

Access Read only

Description Minutes past the hour (0-59)

Update Automatic by CIMPLICITY

$LOCAL.DATE.MONTH

Point Type Local Point

Data Type USINT

Access Read only
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Description Current month of the year (1-12); 1=January

Update Automatic by CIMPLICITY

$LOCAL.DATE.SECOND

Point Type Local Point

Data Type USINT

Access Read only

Description Second past the minute (0-59)

Update Automatic by CIMPLICITY

$LOCAL.DATE.SECONDOFDAY

Point Type Local Point

Data Type UDINT

Access Read only

Description Second past midnight (0-86399)

Update Automatic by CIMPLICITY

$LOCAL.DATE.WEEK

Point Type Local Point

Data Type USINT

Access Read only

Description Current week in the year (1-52)

Update Automatic by CIMPLICITY

$LOCAL.DATE.YEAR

Point Type Local Point

Data Type UINT

Access Read only

Description Current year (1970-2039)
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Update Automatic by CIMPLICITY

$LOCAL.DATETIME

Point Type Local Point

Data Type UDINT

Access Read only

Description Local date and time in seconds from 1/1/1970

Update Automatic by CIMPLICITY

$LOCAL.DATETIME_INTERVAL

Point Type Local Point

Data Type UDINT

Access Read/Write

Description Update interval or $LOCAL.DATETIME_VARUPDATE in 10 millisecond units.

Note:  $LOCAL.DATETIME_INTERVAL controls how often the system updates
$LOCAL.DATETIME_VARUPDATE (page 423).

Example If a user sets $LOCAL.DATETIME_INTERVAL to 200, $LOCAL.DATETIME_VARUPDATE will
be updated every 2 seconds.

Default 100 (when the Viewer starts)

Update Automatic by CIMPLICITY

$LOCAL.DATETIME_VARUPDATE

Point Type Local Point

Data Type UQINT

Access Read only

Description Local date and time in 100 nanoseconds seconds from 1/1/1970

Update Automatic by CIMPLICITY

$LOCAL.DGR_STATE

Point Type Local Point

Data Type USINT
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Access Read only

Description DGR State, as follows.

0 Live Mode

1 Stopped

2 Paused

3 Playing

4 Buffering

5 Loading

Update Automatic by CIMPLICITY

$LOCAL.WINUSER

Point Type Local Point

Data Type STRING (20)

Access Read only

Description Local Windows user name

Update Automatic by CIMPLICITY

$PROJECT

Point Type Server Point

Data Type STRING (20)

Access Read only

Description Project name

Update Automatic by CIMPLICITY

$PROJECT.AVAILABLE

Point Type Local Point

Data Type BOOL

Access Read only

Description Project availability



Project Setup | 9 - System Points | 425

0=Not Available

1=Available

Update Automatic by CIMPLICITY

$PROJECT.COMPUTER

Point Type Server Point

Data Type STRING (15)

Access Read only

Description Project computer name

Update Automatic by CIMPLICITY

$PROJECT.DATE.AMPM

Point Type Server Point

Data Type BOOL

Access Read only

Description 0=AM; 1=PM

Update Automatic by CIMPLICITY

$PROJECT.DATE.DAY

Point Type Server Point

Data Type USINT

Access Read only

Description Current day in the month (1-31)

Update Automatic by CIMPLICITY

$PROJECT.DATE.DAYOFWEEK
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Point Type Server Point

Data Type USINT

Access Read only

Description Current day in the week (1-7); 1=Sunday

Update Automatic by CIMPLICITY

$PROJECT.DATE.DAYOFYEAR

Point Type Server Point

Data Type UIND

Access Read only

Description Current day in the year (1-366)

Update Automatic by CIMPLICITY

$PROJECT.DATE.HOUR

Point Type Server Point

Data Type USINT

Access Read only

Description Current hour in the day (0-23)

Update Automatic by CIMPLICITY

$PROJECT.DATE.HOUR12

Point Type Server Point

Data Type USINT

Access Read only

Description Current hour in the day (1-12)

Update Automatic by CIMPLICITY



Project Setup | 9 - System Points | 427

$PROJECT.DATE.MINUTE

Point Type Server Point

Data Type USINT

Access Read only

Description Minutes past the hour (0-59)

Update Automatic by CIMPLICITY

$PROJECT.DATE.MONTH

Point Type Server Point

Data Type USINT

Access Read only

Description Current month (1-12); 1=January

Update Automatic by CIMPLICITY

$PROJECT.DATE.SECOND

Point Type Server Point

Data Type USINT

Access Read only

Description Second past the minute (0-59)

Update Automatic by CIMPLICITY

$PROJECT.DATE.SECONDOFDAY

Point Type Server Point

Data Type UDINT

Access Read only
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Description Second past midnight (0-86399)

Update Automatic by CIMPLICITY

$PROJECT.DATE.WEEK

Point Type Server Point

Data Type USINT

Access Read only

Description Current week in the year (1-52)

Update Automatic by CIMPLICITY

$PROJECT.DATE.YEAR

Point Type Server Point

Data Type UINT

Access Read only

Description Current year (1970-2039)

Update Automatic by CIMPLICITY

$PROJECT.DATETIME

Point Type Server Point

Data Type UDINT

Access Read only

Description Server date and time in seconds from 1/1/1970

Update Automatic by CIMPLICITY

$PROJECT.DEVICES

Point Type Server Point
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Data Type UDINT

Access Read only

Description Number of devices online

Update Automatic by CIMPLICITY

$PROJECT.LOGGEDIN

Point Type Local Point

Data Type BOOL

Access Read/Write

Description Login status

0 Logged out || !$PROJECT.AVAILABLE

1 Logged in && $PROJECT.AVAILABLE

Update Automatic by CIMPLICITY

$PROJECT.USERS

Point Type Server Point

Data Type UDINT

Access Read only

Description Number of users

Update Automatic by CIMPLICITY

$ROLE

Point Type Server Point

Data Type String (16)

Access Read only

Description User role identification

Update Automatic by CIMPLICITY
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$ROLE.LEVEL

Point Type Server Point

Data Type DINT

Access Read only

Description Role's security level.

Update Automatic by CIMPLICITY

$USER

Point Type Server Point

Data Type String (32)

Access Read only

Description User identification.

Update Automatic by CIMPLICITY

$USER.ALARMS

Point Type Local Point

Data Type UDINT

Access Read only

Description Alarm count by user

Update Automatic by CIMPLICITY



Chapter 10. Point Cross Reference

About Point Cross Reference

The same point may be used in several different parts of your project, in several different ways.
Therefore, when you modify its properties, it is important to know how the modification will affect
instances where it occurs in the project.

The Point Cross Reference window in CIMPLICITY provides you with a quick way to find where
and how a point is being used in your project's subsystems, including:

• Database Logger
• Event Manager
• Point Configuration
• Screens
• Scripts

Step 1
(page
431)

Open the Point Cross Reference window.

Step 2
(page
433)

View Points in the Point Cross Reference window.

Step 3
(page
438)

Work with a Point in Point Cross Reference.

Step 4
(page
441)

Print a Point Cross Reference report.

Step 5
(page
442)

Maintain a current point Cross Reference database.

Step 6
(page
444)

Open a different CIMPLICITY project.

Step 1. Open the Point Cross Reference Window

1. Select Project>Points>Cross Reference in the Workbench left pane.
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2. Select Cross Reference in the Workbench right pane.

3. Do one of the following.

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Cross Reference. a. Right-click Cross Reference.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click Cross Reference. a. Right-click Cross Reference.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

4. Right-click Cross Reference.

5. Select Properties on the Popup menu.

6. Right-click Cross Reference.

7. Select Properties on the Popup menu.

8. If the PtXRef database has:
• Been built and all of its subsystems are up-to-date, the Point Cross Reference window

opens, displaying the list of points in the PtXRef database.
• Not been built an Update PtXRef Database dialog box opens.
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9. Click No to open the Point Cross Reference window without updating the database, or click Yes
to rebuild the database.
The Point Cross Reference rebuilds the database. A Building PtXRef Database... dialog box

displays the progress. 

10. Click Finish.

Step 2. View Points in the Point Cross Reference Window

Step 2. View Points in the Point Cross Reference Window

The Point Cross Reference window layout provides you with a clear way to view current information
about the points in your PtXRef database.

Options include:
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Option
2.1 (page
434)

Review Point Cross Reference right pane views.

Option
2.2 (page
435)

Review Point Cross Reference point list.

Option
2.3 (page
436)

Specify the Point Cross Reference view.

Option
2.4 (page
437)

Change the Point Cross Reference subsystem display.

Option
2.5 (page
437)

Refresh the Point Cross Reference screen.

Option 2.1. Review Point Cross Reference Right Pane Views

• Right pane view overview.
• Right pane view toolbar.

Right Pane View Overview

You have the option to work with either two or three panes in the Point Cross Reference window.

1 Tree View
(page
438)

A tree displays:

• Where the point displays in the areas included in the PtXRef database.
• In what context the point is used.

From this display you can open a configuration window that is related to the instance you select

2 Text View
(page
440)

A full text description displays:
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• Where the point displays in the areas included in the PtXRef database.
• In what context the point is used.

3 Full View Both Tree and text view.

Note:  A list of points (page 435) displays in the left pane for all views.

Right Pane View Toolbar

1 Point Displays the selected point.

2 Search Finds a point whose name is manually entered in the Point field.

3 Print Prints the data displayed in the right pane.

Option 2.2. Review Point Cross Reference Point List

The left pane displays a list of points in the project.

You can view (page 436) :

• All points
• Only used points

Information listed in the left pane of the Point Cross Reference window includes the:

Type Point Type–Whether the point is valid or invalid.

1 Invalid
point type

Is still being used in the system.
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However, it has been deleted from the point database that you view in the Point
Configuration window. As a result, in reality, it does not exist.

2 Valid
point type

Is being used in the system and is in the point database.

Count Number of times the point occurs in the PtXRef database

Point ID Point ID

Description Description that was entered on the General (page 164) tab in the Point Properties dialog box.

To re-sort the lists in the left pane of the Point Cross Reference window:

Click the title bar on top of the list that you want as the primary sort.

Result: The list you select will be sorted in ascending order. Information on the other two lists will
stay with the associated items in the primary sort.

Option 2.3. Specify the Point Cross Reference View

1. Do one of the following..

Method 1

Click the View Options button– –on the Point Cross Reference toolbar.

Method 2

2. Click View on the Point Cross Reference menu bar.

3. Select Options.

The Views tab of the Options dialog box appears.

The options on the view tab are as follows.
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Option Description

Sort on When checked sorts by the checked option:

Point
Type

Whether the point is valid (included in the Points database) or invalid (appears in the
system but is not included in the Points database that appears in the Point Configuration
window).

Ref
Count

Numeric order based on how many times the point appears in the PtXRef database

Point
ID

Alphabetical order

Show
only used
points

When checked, the left pane displays only the points that are currently being used in your project

Enable
Tree /Text
View

CIMPLICITY displays either or both views, whatever is checked.

Option 2.4. Change the Point Cross Reference Subsystem Display

1. Click View on the Point Cross Reference menu bar.

2. Select Options.

The Options dialog box opens.

3. Select the Subsystems tab.

4. Check the check box to the left of each subsystem you want to include.

Option 2.5. Refresh the Point Cross Reference Screen

1. Click PtXRef on the Point Cross Reference menu bar.
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2. Select Refresh.

Step 3. Work with a Point in Point Cross Reference

Step 3. Work with a Point in Point Cross Reference

When you select a point in the left pane of the Point Cross Reference window you can:

• View where it is located in the PtXRef database and look at the display in the right pane to see
how it is being used.

• Make modifications to that point by selecting an item in the right pane.

Important:

The maximum:

• Fully qualified point name length that Point Cross Reference can work with is 289 characters.
• Display length is 512 characters.

Option
3.1 (page
438)

Work in the Point Cross Reference Tree View.

Option
3.2 (page
440)

Work in the Point Cross Reference Text View.

Option 3.1. Work in the Point Cross Reference Tree View

• Point ID display.
• Open the Point Properties dialog box.
• Modify a point or an instance where the point is being used

Point ID display

Once you have selected which views (Tree and/or text) in which you want information displayed in
the Point Cross Reference dialog box, you can easily review that information by simply selecting the
appropriate Point ID.
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1 Selected point

2 Subsystems:

• Database Logger
• Event Manager
• Points
• Screens
• Scripts

3 Point use.

4 Expanded tree. (It can also be contracted.)

Open the Point Properties dialog box

1. Select the point in the left pane of the Point Cross Reference window.

2. Do one of the following.

Method 1

a. Right click the object that represents the point instance you want to review in the right pane
of the Point Cross Reference window.

b. Select Open from the popup menu.

Result: A properties window that applies to the point instance you selected displays.

Method 2

a. Click View on the Point Cross Reference menu bar.
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b. Select Properties.

Result: The Point Properties dialog box for the selected point opens.

Method 3

Press Alt+Enter on the keyboard.

Result: The Point Properties dialog box for the selected point opens.

Modify a point or an instance where the point is being used

3. Select the point you want to modify in the left pane of the Point Cross Reference window.

4. Go to the tree view pane.

5. Right-click the instance you want to modify.

6. Select Open from the popup menu.

The related window that contains the information you want to modify opens, as follows:

Selected Instance Related Window or Dialog Box that Opens

Database Logger Database Logger configuration window.

Event Manager CIMPLICITY Event Manager window.

Points Project Name Point - Configuration window.

Point name Point's Point Properties dialog box.

Screens Blank CimEdit screen.

Screen name Point's CimEdit screen with open Point View - Screen window.

Scripts Blank CIMPLICITY Program Editor window.

Script name CIMPLICITY Program Editor with script that contains the point.

Note:  If the object you select has no properties, that selection will not be available when you
click the right mouse button.

Option 3.2. Work in the Point Cross Reference Text View

In Text view, scroll through the list in the right pane of the open Point Cross Reference window to
view the information. Depending on where the point is being used, you will see:
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Points Resource ID, Elements, Description.

Screens Screens using the point.

Database Logger Tables using the point.

BCE Scripts Scripts using the point.

Event Manager Events using the point

Step 4. Print a Point Cross Reference Report

1. Do one of the following.

Method 1

a. Click Project on the Point Cross Reference menu bar.
b. Select Print.

Note: The Print Setup option provides you with further configuration choices, including setting
print up on a network.

Method 2
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Click the Print button  on the Point Cross Reference toolbar.

The Print dialog box appears when you use either method.

2. Specify the print target and pages.

Step 5. Maintain a Current Point Cross Reference
Database

• Build selected subsystems.
• Rebuild all subsystems.

Build selected subsystems

1. Do one of the following.

Method 1

Click the Build button  on the Point Cross Reference tool bar.

Method 2

a. Click PtXRef on the Point Cross Reference menu bar.
b. Select Build.

The Build PtXRef Database dialog box appears.

2. Do one of the following.
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Option 1

Check All subsystems.

Point Cross Reference builds all the subsystems it monitors.

• Database Logger
• Event Manager
• Points
• Screens
• Scripts

Option 2

a. Check Selected subsystems.
b. Check the subsystems (listed above) that you want to include in the database.

Point Cross Reference begins to add and rebuild the selected subsystems.

3. Click Finish when the rebuild is complete.

Result: The Point Cross Reference window displays the rebuilt database.

Rebuild all subsystems

4. Do one of the following.

Method 1

a. Click PtXRef on the Point Cross Reference menu bar.
b. Select Rebuild all.

Method 2

Press F7 on the keyboard.
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Point Cross Reference begins to rebuild all the subsystems.

5. Click Finish the rebuild is complete.

The Point Cross Reference window displays the rebuilt database.

Step 6. Open a Different CIMPLICITY Project

Do one of the following.

Method 1

1. Click the Open button  on the Point Cross Reference toolbar.

An Open dialog box appears.

2. Select the project you want to open.

3. Build the PtXRef database, if it does not exist.

Method 2

4. Click Project on the Point Cross Reference menu bar.

5. Select Open.

An Open dialog box appears.

6. Select the CIMPLICITY project you want to open.

7. Build the PtXRef database, if it does not exist.

Note:  You can find and open a CIMPLICITY project from the last databases you opened
listed, which are on the Project drop down menu.



Chapter 11. Measurement Units

About Measurement Units

As a system engineer, you can use the Measurement Units feature to convert an entire project from
one unit of measurement to another (for example Fahrenheit to Centigrade)...all at once. In fact,
you can convert the measurement units for part of the project, a special area in the project, or the
entire project, whatever is required at the time. The scope of the conversion depends solely on the
measurement unit that will be converted and the points assigned to it.

One of the obvious advantages of this straightforward feature is that it can save you valuable time.
For example

• When a project for an international company needs to be configured to operate in several
countries that adhere to different measurement systems, you can use Measurement Units to
quickly convert the entire project, to as many different measurement units, as necessary.

• When a project has several points that need to be converted and that have the same equivalents,
you can use Measurement Units to specify the conversion in one place, at one time, for all the
involved points.

Measurement Units conversion complements CIMPLICITY's other conversion feature, Engineering
Unit (EU) conversion. Each serves a particular need. Both offer a wide range of conversion options.

EU conversion provides an exact way to specify a conversion for an individual point. (The EU
conversion feature is in the Conversion tab of the Point Properties dialog box.)

Measurement Units provides an efficient way to specify a conversion for a specific unit of
measurement.

For example, a PLC is hooked up to five different thermometers, each of which uniquely expresses
temperature in counts. The system engineer configures each thermometer as a point and uses the EU
conversion to create each point's unique conversion equation. Each equation converts the counts to
Fahrenheit.

If the same PLC configuration needs to be used in a country that measures temperature in Centigrade,
every Fahrenheit measurement must be converted. In this situation, the system engineer uses the
Measurement Units feature. The engineer specifies only one configuration in one window, the
Measurement Units window, to convert all five points from Fahrenheit to Centigrade. In addition,
this one configuration will convert any other points in the project to which Fahrenheit is assigned.

To setup for a project wide conversion, you need to:

• Configure measurement systems and units.
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• Specify an active measurement system for the project to use during runtime.
• Follow a few guidelines.

When the setup is completed and the configuration is updated, the project data automatically displays
the correct units and labels for the specified measurement system.

Measurement Systems and Units Configuration

Measurement Systems and Units Configuration

Use the Measurement Units Configuration window to configure the main elements in the
measurement systems and units functionality.

To create your conversion equivalents, you will:

1
(page
447)

Start Measurement Units.

2
(page
448)

Toggle dynamic configuration.

3
(page
449)

Add a new measurement system (if the one you want does not exist).

4
(page
450)

Copy a measurement system, by defining a set of base units and their corresponding labels in the
Measurement Units Configuration window.

5
(page
451)

Rename a measurement system.

6
(page
451)

Delete a measurement system.

7
(page
452)

Create a base measurement unit entry.

8
(page
453)

Edit base measurement unit properties, if necessary.

9
(page
453)

Define an equivalent unit for each base measurement unit, by specifying the label, display format and
conversion equations to be used for each.
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10
(page
455)

Copy a measurement unit.

11
(page
456)

Rename a measurement unit.

12
(page
456)

Delete a measurement unit.

13
(page
457)

Specify the active measurement system.

14
(page
460)

Close the Measurement Unit window.

Review Properties Configuration

Review configuration for:

• Unit properties.

• System properties.

1. Start Measurement Units

1. Select Project>Advanced>Measurement Units in the Workbench left pane.

2. Select Measurement Units in the Workbench right pane.

3. Do one of the following.
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A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Measurement Units. a. Right-click Measurement Units.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click Measurement Units. a. Right-click Measurement Units.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

4. Right-click Measurement Units.

5. Select Properties on the Popup menu.

6. Right-click Measurement Units.

7. Select Properties on the Popup menu.

2. Toggle Dynamic Configuration

Measurement Units supports dynamic configuration if the project is running.

Do one of the following to toggle dynamic configuration on/off.
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1 Click Tools>Dynamic on the Measurement Unit window menu bar.

2 Click the Dynamic Configuration button on the Measurement Unit window toolbar.

Result: Dynamic Configuration is turned on if it was off; off if it was on.

3. Add a New Measurement System

3. Add a New Measurement System

1. Click File>New System on the Measurement Unit window menu bar.

The New Measurement System dialog box opens.

2. Enter the name of your measurement system in the System ID field.

3. Click OK.

The Measurement System Properties dialog box opens.

Measurement System Properties Defined

Use the Measurement System Properties dialog box to define the display label for the measurement
system. You can also use this dialog box to make the measurement system the active system when
the project starts.
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To make the measurement system the active system when the project starts:

1. Enter an optional description in the Description field.

2. Enter an optional display label in the Display label field.

3.  Check the Use at runtime check box if you want this measurement system to be the active
system when the project starts.

4. Click Enter.

The tab for the new measurement system is added in the right pane.

If Unit IDs exist in the left pane, you will see default values in the Equivalent Unit ID,
Forward Equation, Reverse Equation, Justification and Type fields.

4. Copy a Measurement System

1. Move the cursor to the tab of the measurement system you want to copy.

2. Click the right mouse button.

3. Select Copy... from the pop-up menu.

The Copy Measurement System dialog box opens.
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4. Enter the name of the new measurement system in the Destination field.

5. Click OK.

A new measurement system tab will be created with the name you specified.

If there are existing Unit IDs in the left pane, you will see default values in the Equivalent Unit ID,
Forward Equation, Reverse Equation, Justification and Type fields for the new measurement
system.

5. Rename a Measurement System

1. Move the cursor to the tab of the measurement system you want to rename.

2. Click the right mouse button.

3. Select Rename… from the pop-up menu.

The Rename Measurement System dialog box opens.

4. Enter the new name of the measurement system in the Destination field.

5. Click OK

The measurement system tab will change to the name you specify.

6. Delete a Measurement System

1. Select the measurement system that will be deleted in the Measurement Unit window right pane.

2. Select Edit>System>Delete on the Measurement Unit window menu bar.
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A message box opens to confirm deletion of the selected system.

3. Click OK.

The system is deleted.

7. Create a Base Measurement Unit

7. Create a Base Measurement Unit

1. Do one of the following to start:
• Click File>New Unit on the Measurement Unit window menu bar.
• Press Ctrl+N on the keyboard.
• In the left pane, click the right mouse button; select New… on the Popup menu.

The New Measurement Unit dialog box opens.

2. Enter the name of your base unit in the Unit ID field and click OK.

The Measurement Unit Properties dialog box opens.

Measurement Unit Properties Defined

Use the Measurement Unit Properties dialog box to enter the display label for the measurement unit.

1. Enter an optional description in the Description field.
2. Enter an optional display label in the Display label field. This display label is automatically

selected when a user selects the Unit ID for a point in Point Configuration.
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3. Click Enter.

The new base Unit ID is added to the end of the list in the left pane. Equivalent entries are also made
in each system you currently have in the right pane.

If you currently have measurement systems defined in the right pane, default values for the new base
unit are automatically entered in the Equivalent Unit ID, Forward Equation, Reverse Equation,
Justification and Type fields for all the measurement systems.

8. Edit Base Measurement Unit Properties

1. Position your mouse over what you want to change.

2. Click twice.

You can now type in your changes.

If you prefer, you can open the Measurement Units Properties dialog box and edit the
description and display label for a base unit. Do one of the following:

• Select Unit Properties from the Edit menu.
• Press Ctrl+P on the keyboard.
• In the left pane, select the base unit, click the right mouse button and select Properties…

from the pop-up menu.

9. Define an Equivalent Unit

1. Double-click Measurement Units in the left pane of the Workbench.

The Measurement Unit–Configuration window opens.

2. Do one or the following:

Option 1

a. Select Edit on the menu bar.
b. Select Unit Equivalence.

Option 2

Press Ctrl+E on the keyboard.

The Unit on System dialog box opens.
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Note:  When you use %P as the conversion equation in a measurement unit equivalence, the
display format fields such as Width, Precision, Type and Justification will be used instead because a
%P requires no conversion.

You can edit any of the following fields in the right pane or in the dialog box:

Field Description

Equivalent
Unit ID

Enter the Unit ID you want to use when the measurement system is active. The Unit ID may or may not
match any other Unit IDs in the configuration.

Forward
Equation

Enter the equation to be used by Point Management to convert the base value to its equivalent in this
measurement system. For example, if point XYZ's base value is in inches and you want to display it
in centimeters, use the forward expression %P*2.54001. If the point's base value is the same as its
converted value, just put %P in the field.

Reverse
Equation

Enter the equation to be used by Point Management to convert the equivalent in this measurement
system to its base value. For example, if point XYZ's base value is in inches and its equivalent value
is in centimeters, use the reverse expression %P/2.54001. If the point's base value is the same as its
converted value, just put %P in the field.

Justification This field is used to align the display of point value. By default, the project uses the justification you
specify when you configure a point. Select the justification you want to use when displaying the point's
value on CimView screens when this measurement system is active, as long as the Configured option is
selected for the CimView object display properties. You can select one of the following:

Left Left justifies the value display.

Right Right justifies the value display.

Zero Zero fills the value display.

Width This field represents the number of spaces you want to dedicate to the display of the point value. By
default, the project uses the display width you specify when you configure a point. If you want to use a
different display width for all points that use this Unit ID, enter it in this field.

Precision This field represents the number of digits to be displayed to the right of the decimal point. By default, the
project uses the precision you specify when you configure a point. If you want to use a different precision
for all points that use this Unit ID, enter it in this field.
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Field Description

Type This field determines the format type used when the point value is displayed. By default, the project uses
the display type you specify when you configure a point. If you want to use a different display for all points
that use this Unit ID, enter it in this field. Use the drop-down list button to select one of the following:

Fixed All points that use the Unit ID are displayed in fixed format using the Width and Precision
information you specify. If you do not specify the Precision, the default is 6. For example, if
you specify a Width of 7 and Precision of 3, the point display uses 7 places and there are 3
places after the decimal point. In this case, 10 displays as 10.000.

Scientific All points that use the Unit ID are displayed in scientific format using the Width and Precision
information you specify. If you do not specify the precision, the default is 6.

Compact All points that use the Unit ID are displayed in Fixed or Scientific format based on Precision,
which determines the exponent to start displaying in Scientific format. For example, if you
specify a Precision of 5, the value 100,000 displays as 1e+005 and 10,000 displays as 10000.
The Compact type also truncates trailing zeros to the right of the decimal point. For example,
10.0 displays as 10 and 10.10 displays as 10.1.

10. Copy a Measurement Unit

1. Select the measurement unit you want to copy.

2. Do one of the following.
• Click Edit>Copy Unit on the Measurement Unit window menu bar.
• Click the right mouse button; select Copy on the Popup menu.
• Press Ctrl+C on the keyboard.

The Copy Measurement Unit dialog box opens.

3. Enter the name of the new measurement unit in the Destination field.

4. Click OK.

The Measurement Unit Properties dialog box opens.

5. Fill in the description label for the new measurement unit.
• Details for using the Measurement Unit Properties dialog box.

6. Click OK.

A new measurement unit will be created with the name you specified.
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Equivalent measurement units are also created for each measurement system in the right pane.

11. Rename a Measurement Unit

1. Click the measurement unit in the left pane that you want to rename.

2. Click the right mouse button.

3. Select Rename… from the pop-up menu.

The Rename Measurement Unit dialog box opens.

4. Enter the new name of the measurement unit in the Destination field.

5. Click OK

The measurement unit name in the left pane will change to the name you specify.

12. Delete a Measurement Unit

1. Click the measurement unit in the left pane that you want to delete.

2. Select Edit on the Measurement Unit menu bar.

3. Select Delete Unit.

A Measurement Unit Configuration dialog prompt appears if you chose to be prompted.

4. Click Yes.

The measurement unit is deleted.
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13. Specify the Active Measurement System

The active measurement system is the measurement system used at runtime. You can select the
system in either of two dialog boxes.

Specify the Active Measurement System in the:

• Project Properties Dialog box.
• Measurement System Properties dialog box.

Project Properties dialog box

1. Click Project>Properties on the Workbench menu bar.

2. Select the Settings tab.

3. Select Measurement Units.

4. Click Settings.

The Activate Measurement System dialog box opens displaying either of the following.

If: Then:

A system was specified in the Measurement System
Properties dialog box.

The system displays in the Active Measurement
System field.

No system has been selected.  <None> displays in the Active Measurement
System field.

5. (Optional) Click the drop-down list button to the right of the Active Measurement System field
and select a new active measurement system.

6. Click Apply.

7. Click OK.
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Result: If you select:

• A measurement
system

• The Use at runtime check box in the Measurement Systems Properties dialog box
is checked.

• The check boxes for all other measurement systems are cleared.

• <None> Only the base conversions are used.

Measurement System Properties dialog box

8. Expand the Advanced folder in the Workbench left pane.

9. Double-click Measurement Units.

The Measurement Unit–Configuration Window Opens.

10. Click Edit>System>Properties on the Measurement Unit–Configuration Window menu bar.

The Measurement System Properties dialog box opens.

• The system that displays in the Display label field reflects the tab that is enabled in the
Measurement Unit - Configuration window right pane.

• If the Use at runtime checkbox is checked, the system:
• Will be used during runtime.
• Also displays in the Activate Measurement System dialog box.
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11. Do any of the following.

Leave the settings unchanged. Click Cancel.

(If not selected for runtime) enable runtime use for the system. a. Check Use at runtime.
b. Click Apply.
c. Click OK.

(If selected for runtime) disnable runtime use for the system. a. Clear Use at runtime.
b. Click Apply.
c. Click OK.

Result

If the Use at runtime
checkbox is:

The system:

Checked and and the changes applied • Will be used during runtime.
• Also displays in an updated Activate Measurement System dialog

box.

Cleared and the changes applied • Uses only the base conversions.
• Displays <None> in the Activate Measurement System dialog

box.

12. Check Use at runtime.

13. Click Apply.

14. Click OK.

15. Clear Use at runtime.



Project Setup | 11 - Measurement Units | 460

16. Click Apply.

17. Click OK.

14. Close the Measurement Unit Window

Do one of the following.

• Click File>Exit on the Measurement Unit window menu bar.
• Click the Windows Exit button  on the Measurement Unit window top right corner.
• Click Alt+F+X on the keyboard.

Result: The Measurement Unit window closes when you use any method.

Measurement Unit Guidelines

Measurement Unit Guidelines

Because of the dynamic nature of the Measurement Units conversion, make sure that your project
configuration adheres to these guidelines before you activate your first Measurement Units
conversion. After that, use these guidelines to configure new points, objects and functions.

The main thing to keep in mind is that CIMPLICITY makes its conversion by finding points that
have a specified base measurement unit and converting them to an equivalent measurement unit.
Therefore any constant value that is not associated with a base measurement unit will not get
converted.

Understanding these concepts is crucial for correctly displaying animations in CimView. In addition,
understanding that background Basic Control Engine functions executed by the Event Manager
always adhere to the base measurement, will help you avoid unnecessary and incorrect script editing.

For more detail, read:

• Floating Point Numbers vs. Integers.
• Derived Points.
• CimEdit Management of Animated Objects.
• CimView Scripts.
• Event Manager and Basic Control Engine.
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Floating Point Numbers vs. Integers

• Overview
• Guidelines
• Example

Overview

The active measurement system always uses floating-point numbers for values of points that have
conversion to that system. When you use Measurement Units conversion, internal calculations
respond to whether you define a point as an integer or a floating point.

The key to deciding whether to define a point as an integer or floating point is to determine how
much precision that point requires. A floating point gives you the highest degree of precision.

Here is a brief description of the process.

You define a point as an integer type and assign it a base measurement unit. At runtime the active
measurement system causes that base measurement unit to convert to its equivalent unit.

When you set the point's value (a setpoint), the point's value is reverse converted from the active
measurement unit into the base measurement unit. If the point is:

• An integer, in order to fit the reverse converted value into the integer specification, the
conversion process rounds off the floating value that was the result of the reverse conversion to
the nearest integer.

• A floating point, it will be able to hold the floating value that was the result of the reverse
conversion.

When the point is displayed, the value is forward converted from the base measurement unit into the
active measurement unit. If the point is:

• An integer, the forward conversion will use the rounded value in its calculations. The displayed
value will reflect that rounding.

• A floating point will hold the floating value that was the result of the reverse conversion. The
displayed value will equal the value at which you set the point.

In many cases, the rounding effect is totally acceptable. When it is not, use floating-point types.

Guidelines

For points that need to have the highest level of precision and use Measurement Units conversion,
use the floating point type instead of the integer point type.
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Example

Point XYZ is a point with a base unit ID of inches that requires the highest level of precision. Its
initial value is 10 inches.

You use Metric as the active measurement system. As a result, XYZ's value displays as centimeters.

You want to perform a setpoint on XYZ.

Don't

Define XYZ as an integer.

If you then perform a setpoint on XYZ and set it to 26.924 cm.:

• 26.924 cm. is reverse converted to 10.60 inches.
• Because XYZ is an integer, 10.60 is rounded up to 11 inches.
• 11 inches is forward converted to 27.94 cm.
• The point value displays as 27.94 cm.

Do

Define XYZ as a floating-point type.

When you then perform a setpoint on XYZ and set it to 26.924 cm., the internal conversion is able to
store 10.6 inches. As a result, the point, which is the same value it was set to, displays as 26.924 cm.

Derived Points

• Overview
• Guidelines
• Example

Overview

By default, when a derived point expression uses a device point, it uses the raw (unconverted) value
of the device point.

When a derived point value is calculated:

1. Constants are assumed to be in the base units for the point.

2. The base units for all points in the expression are used.
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3. The result is then converted to the current active measurement system units for the derived
point.

Guidelines

Assign a base Unit ID for a derived point that is consistent with the base Unit IDs of the points
in its expression and use constants that are consistent with the base Unit ID for the derived
point.

If you are using Measurement Units and want your derived points to be calculated correctly,
you need to use the Engineering Units (EU) value for device points in your derived point
expressions. You can do this in one of two ways:

• Set the PTMDP_DO_EU_CONV global parameter to one (1) to automatically use the EU
value of device points in all derived point expressions.

• Use the EU_CONV function for every device point you use in a derived point expression
to convert the device points to their EU values.

Example

SOURCE is a device point with a Base Unit ID of inches.

DEST is a derived point with an expression: SOURCE+10.0 (inches).

The value of SOURCE is 1 inch.

You will use Measurement Units conversion to convert the project from inches to centimeters.

Don't

• Assign DEST a measurement unit of centimeters in the Point Properties box Conversion
tab, which is different from SOURCE's assigned measurement unit, inches.

• Leave DEST's measurement unit (in the Conversion tab) blank.

In either case you are creating an inconsistent condition which may produce confusing results
after conversion.

Do

Assign DEST a base measurement unit of inches in the Point Properties box Conversion tab.

The expression, SOURCE+10.0, will be calculated as 1 inch +10 (inches) = 11 inches

Because DEST has a base measurement unit of inches, it will be included in the Measurement
Unit conversion and will display as 27.94 centimeters.

CimEdit Management of Animated Objects
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Overview

You can configure animation for any object in CimEdit, to be viewed through CimView. However,
because CimView is a display process, it is crucial that it reflects the active measurement system.

Animation capabilities in CimEdit include:

• Color animation
• Movement
• Rotation/fill
• Scaling
• Angle animation (Applicable to Arc, Chord, and Pie objects)
• Transparency animation

Objects configured for each of these capabilities will take expressions, including minimum and
maximum values. However, when you need to do a conversion, it is important to take into account
how CimView deals with an expression's minimum/maximum values and their related high/low
values.

When CimView processes an object's animation expression, it first looks for minimum and
maximum values specified within the object properties. If it finds them, it uses them. Because these
values are attached to the object, not a point with a measurement unit, CimView uses the values as
entered independent of the measurement unit.

Second, if the minimum and maximum fields in the object's Properties dialog box are blank and the
animation expression is a single Point ID, CimView looks for Display low and Display high values
configured in the View tab of the Point Configuration Properties box. If the Display low and Display
high fields:

• Are blank, CimView defaults to a constant minimum of 0 and maximum of 100, independent of
the measurement unit.

• Contain values, CimView uses those values. Because they are correctly associated with the
point's measurement unit, the values will be converted to the active measurement unit at
runtime.

Guidelines

If you want to guarantee that your animation will properly adjust to measurement system changes
at runtime, make sure that for every animation expression using a single point ID in your CimView
screens, the:

• Minimum and Maximum fields in CimEdit are blank so the point display limits are used.
• Display low and Display high fields are filled, in the View tab of the Point Properties dialog

box.
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Example

Using the U.S. Customary system as the active measurement system, you want to move an object
from a lowest value (0 inches) on the left of the screen to a highest value (100 inches) on the right of
the screen, as the point's value changes.

You then change the active measurement system from U.S. Customary to Metric. As a result, the
measurement units are converted from inches to centimeters

Don't

Specify 0 (inches) as the expression minimum value and 100 (inches) as the expression maximum
value in the object's configuration window.

If the point in the animation expression has a base value of 8 inches (displayed as 20.32 cm.), it will
cause CimView to incorrectly place the animated object within the 0-100 limits because it thinks the
0-100 limits are centimeters. Because the range is incorrect, CimView will display the value too far
to the right. (The range should be 0-254 cm.)

Do

Leave the object's fields blank and enter 0 in the point's Display low, 100 in its Display high field in
Point Configuration.

If the point in the animation expression has a value of 8 inches (displayed as 20.32 cm.), CimView
will properly place the animated object within the limits, because they are converted to centimeters.
(0-100 is now 0-254.)

CimView Scripts

• Overview
• Guidelines

Overview

CimView uses Basic scripts, which can, among many other things, use the runtime value of a point.

When you use point values within scripts, the values correspond to the active measurement system.
Therefore, if you compare or manipulate values with other values that are constant, you will most
likely run into trouble if you switch active measurement systems. This is because your constant
numbers will stay the same, but the point values will most likely change due to unit equivalence.
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Guidelines

You have to take into consideration that the point values will vary depending on the active
measurement system. Therefore, make sure that values in the script are all static; conversely, that
there are no absolute values in the script.

Event Manager and Basic Control Engine

• Overview
• Guidelines
• Example

Overview

The Event Manager, which is a background process, sees point values in the point's base
measurement unit. Because it is a background process, the users will never see the values it is
working with. They only see the action, for example, an alarm going off, that has been triggered by
the event.

This means, for example, that if you need an alarm to go off when the water in a tank reaches a
certain level, the alarm will go off when the water reaches that level, no matter what measurement
system is being used.

Of course, you can also associate Events with internal functions, such as timing. These functions are
unaffected by any conversion.

Guidelines

When you specify point values in the Event Editor, enter them for the base measurement unit. The
actions you specify will occur when the point value for the event, such as Point Equals, is reached.

Don't change anything in the Event Manager configuration if you are changing the active
measurement system.

Example

You have a point called  WaterLevel  and you have an action that gets triggered when the level
reaches 100 inches. Your base unit is inches and the project is converted to centimeters.

Do

Don't do anything.
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When you use the Metric system as the active measurement system, the event will not get triggered
until the level hits 254 centimeters, which is equivalent to 100 inches. The Event Manager internally
sees the value as 100 inches and triggers the event properly.



Chapter 12. Import/Export Configuration

About Import/Export Configuration

You can use the Import/Export Utility to:

• Write existing CIMPLICITY point data in to a file.
• Create and modify CIMPLICITY point data using third party software.
• Import point data into CIMPLICITY software to update the database.
• Update the configuration of multiple points at a time.
• Delete CIMPLICITY point data from CIMPLICITY software.

You can use the same point information to configure more than one system. For example, you can
use a spreadsheet to create and modify point data, then import the data into both the CIMPLICITY
database and Logicmaster 90 software.

The following is a quick overview of how Import/Export passes data between the CIMPLICITY
point database and third party applications.

In addition to reading and writing information in the CIMPLICITY point database and CSV files,
Import/Export uses information in the Import/Export configuration files to determine default field
data, and writes informational, warning, and error messages to a log file.

Import/Export Data File Format

Import/Export Data File Format

The file and record formats used by the Import/Export Utility give you the ability to transfer
configuration data between the CIMPLICITY point database and third-party software.
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Import/Export reads and writes text files that use the .csv(Comma Separated Value) format.
Each record in a .csv file begins on a new line and continues until the next new line character is
encountered. Each field in a record is separated by a comma. You can process CIMPLICITY point
configuration data in any third-party application that can read or write files in .csv format.

The .csv files used by Import/Export consist of a number of records. These records use the SNF
(Shared Name File) format. In an SNF file, the first record, called the Field Names record, lists of the
names of all the variables contained in each subsequent record.

In addition, the SNF format used by Import/Export has the following conventions:

• For import, if a field is empty, and the point already exists, the current value of the field is
preserved.

• For import, if a field is empty, the point is a new point and a default is defined in  ie_deflds.cfg ,
the default is entered in the field in the database.

• Comment lines are indicated by two-pound signs at the beginning of the line.
• The field names must be from the list of supported fields and are case insensitive. Any invalid

fields will be identified as an error and ignored.

Important:  You can change a point from a null to a non-null value. However, once a point has a
non-null value you cannot change it to a null value. If you try to change a non-null value to null and
do a clie import you will see that fields that were supposed to change retain the previous non-null
values.

Sample Data File

An example of a .csv file in SNF format follows. This file modifies the alarm limits of a subset of
device points. These points are assumed to already be configured in the CIMPLICITY database.

** FIELD NAMES is a physical record consisting of a single line. It is shown here as multiple lines
for readability within the documentation.

Edit .csv Files in Notepad
This topic describes guidelines for using Notepad to edit a CSV file.
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If you want to enter a field to be blank (have no value), use  " "  (a double-quote, followed by any
number of spaces, followed by a double-quote) for the field entry.

Using double-quotes  is extremely important, particularly if you are changing a field that has an
existing value.

If you enclose the space in quotes, CLIE will recognize that the field value should be changed to no
value.

If you do not enclose the space in quotes, CLIE will interpret the empty space as "Do not change the
original value." As a result, the next time you import the file, the original value will remain.

If you want initial blanks at the start of the field, enclose the field (including the blanks) in double-
quotes. For example:

   ,"     Initial blanks",...

Important: If you do not enclose the field (including blanks)  in double-quotes, the initial blanks
will not appear.

You must enclose between double-quotes any fields that contain a comma as part of the data. For
example:

   ,"Comma, example",...

You must enter two double-quotes if you want a double quote to be part of a data string. For example

   ,"Quotes ""example"" ",...

Edit .csv Files in Excel
This topic describes how to use Excel to edit a CSV file.

If you want to enter a blank character field, use  " "  (a double-quote, followed by any number of
spaces, followed by a double-quote) for the field entry.

Using double-quotes  is extremely important, particularly if you are changing a field that has an
existing value.

If you enclose the space in quotes, CLIE will recognize that the field value should be changed to no
value.

If you do not enclose the space in quotes, CLIE will interpret the empty space as "Do not change the
original value." As a result, the next time you import the file, the original value will remain.

Initial blanks at the start of a field are ignored. If you want initial blanks, you must edit the file with
Notepad and enclose the field in double-quotes. For example:
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   ,"     Initial blanks",...

Important: If you do not enclose the field (including blanks)  in double-quotes, the initial blanks
will not appear.

A field that contains a comma does not need to be enclosed in double quotes. For example:

You do not need to enter two double quotes if you want a double quote to be a part of a data string.
For example:

Example: Import Export Data File Format

This example describes the procedure for correctly changing a value to no value in a .csv file when
the file is used with the import/export utility.

1. Enter alarm limit values for a point in the Point Properties dialog box.

2. Export the file at a command prompt using the import/export utility.

projectname\master>clie export export1.csv

Where

projectname\master> is the path to the project master directory.

clie export is the export command.

export1.csv is the example name of the export file.

3. Open export1.csv in Notepad or Excel.
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The values you entered on the Alarm tab in the Point Properties dialog box display in the
export1.csv file.

4. Change:
• 100 to 250
• 50 to " "

5. Save the file.

6. Import the file.

projectname\master>clie import export1.csv

Where

projectname\master is the path to the project master directory.

clie import is the import command.

export1.csv is the example name of the .csv file.

7. Open the Point Properties dialog box.
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The values have changed based on your entries (250 and " ").

The changes are also retained in the .csv file when you open it in Notepad or Excel.

Note:  If you had not used double-quotes:

• 100 would change to 250
• 50 would remain 50.

The value in the .csv file would also revert to 50.

Import/Export Configuration Files

Import/Export Configuration Files

There are two configuration files in your project data directory that are read by Import/Export when
it starts up.

They are:
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• ie_deflds.cfg contains import field defaults.

• ie_formats.cfg contains export field formats.

You may modify these configuration files through any text editor, independent of Import/Export.

Import Field Defaults (ie_deflds.cfg)

Import Field Defaults (ie_deflds.cfg)

The  ie_deflds.cfg  file in your project's Data directory:

• Contains information about default values that Import/Export will assign to point configuration
fields when importing data for new points. This file is a CSV file that uses the SNF format.

• Defines default values for selected fields based on point of origin and point type. You may
configure default information for analog, digital and text point types for both device and virtual
(derived) points.

Important:  Do not change information in the PT_ID, PT_ORIGIN, or PT_TYPE fields of
records in this file.

When you import data into the CIMPLICITY point configuration, any fields in an import record that
do not contain data, and that correspond to default fields in  ie_deflds.cfg , will have their values set
to the default values contained in  ie_deflds.cfg .

Example

If a new digital device point is being imported, and The Access field in the import file is left blank,
the import function will substitute the default Access value used for  IE_DEV_DIGITAL .

An initial version of  ie_deflds.cfg  is included in your software distribution.

Initial Version of ie_deflds.cfg

## Shared Name File
## CIMPLICITY IMPORT/EXPORT -- Default Points Configuration
##
PT_ID, PT_ORIGIN, PT_TYPE, ACCESS, ADDR_TYPE, ALM_CRITERIA,
ALM_ROUTE_OPER, ALM_ROUTE_SYSMGR, ALM_ROUTE_USER, ALM_TYPE,
ANALOG_DEADBAND, CALC_TYPE, CONV_TYPE, ELEMENTS, JUSTIFICATION,
LOCAL, POLL_AFTER_SET, PT_ENABLED, RESET_ALLOWED, SAMPLE_INTV,
SAMPLE_INTV_UNIT, SCAN_RATE, UPDATE_CRITERIA, VARIANCE_VAL, VARS
##
IE_DEV_ANALOG,D,INT,R,FQ,ABS,0,0,0,,0,,NO,1,LEFT,,0,1,0,0,SEC,1,OC,,1
##
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IE_DEV_DIGITAL,D,BOOL,R,FQ,,0,0,0,AL,,,,1,LEFT,,0,1,0,0,SEC,1,OC,,1
##
IE_DEV_TEXT,D,STRING,R,FQ,,0,0,0,,,,,1,LEFT,,0,1,0,0,SEC,1,OC,,1
##
IE_VIRT_ANALOG,G,INT,RW,,ABS,0,0,0,,,EQU,,1,LEFT,0,,1,0,0,SEC,,,0,1
##
IE_VIRT_DIGITAL,G,BOOL,RW,,,0,0,0,AL,,EQU,,1,LEFT,0,,1,0,0,SEC,,,0,1
##
IE_VIRT_TEXT,G,STRING,RW,,,0,0,0,,,EQU,,1,LEFT,0,,1,0,0,SEC,,,0,1
##

Change Information in ie_deflds.cfg

Default values are particularly useful if you frequently import points with similar data. This data can
be put in  ie_deflds.cfg  rather than putting it in every import file.

You can modify the fields in  ie_deflds.cfg  with a text editor.

You may change the values for any fields in the data records of  ie_deflds.cfg , except the PT_ID,
PT_ORIGIN and PT_TYPE fields.

You may add new default fields to this file.

todo:   To add a new field:

1. Type a comma at the end of the Field Name list, and add the field name.
2. Type a comma at the end of each data record in the file, and add the field value. If the field is

empty, just type a comma.

Export Field Formats (ie_formats.cfg)

Export Field Formats (ie_formats.cfg)

The  ie_formats.cfg  file in your project data directory defines the Field Names records you will be
using to generate export files. This file is a .csv file that uses the SNF format. The first field in each
record is the name of the format, and the remaining fields are the field names to be exported when
that format is specified.

The default file contains two formats: Full Set and Logicmaster Export.

• The Full Set format contains all fields supported by Import/Export.
• The Logicmaster Export format contains the four fields of interest to the Logicmaster 90

(LM90).
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Select one of the formats in this file when you export data. If you do not select a format, an internal
format is used

Note:  The internal format contains all the fields in the Full Set plus additional unsupported
fields.

An initial version of  ie_formats.cfg  is included in your software distribution.

Initial Version of ie_formats.cfg

##
## CIMPLICITY IMPORT/EXPORT -- Export Format Configuration
##
Full Set, PT_ID, ACCESS, ACK_TIMEOUT, ADDR, ADDR_OFFSET, ADDR_TYPE,
ALM_CLASS, ALM_CRITERIA, ALM_DEADBAND, ALM_DELAY, ALM_HIGH_1,
ALM_HIGH_2, ALM_HLP_FILE, ALM_LOW_1, ALM_LOW_2, ALM_MSG,
ALM_ROUTE_OPER, ALM_ROUTE_SYSMGR, ALM_ROUTE_USER, ALM_STR,
ALM_TYPE, ANALOG_DEADBAND, CALC_TYPE, CONV_LIM_HIGH, CONV_LIM_LOW,
CONV_TYPE, DELETE_REQ, DESC, DEVIATION_PT, DEVICE_ID, DISP_LIM_HIGH,
DISP_LIM_LOW, DISP_WIDTH, ELEMENTS, ENG_UNITS, EQUATION, FW_CONV_EQ,
GR_SCREEN, INIT_VAL, JUSTIFICATION, LOCAL, MAX_STACKED,
MEASUREMENT_UNIT_ID, POLL_AFTER_SET, PRECISION, PROC_ID,
PTMGMT_PROC_ID, PT_ENABLED, PT_ORIGIN, PT_SET_INTERVAL, PT_SET_TIME,
PT_TYPE, RANGE_HIGH, RANGE_LOW, RAW_LIM_HIGH, RAW_LIM_LOW,
REP_TIMEOUT, RESET_ALLOWED, RESET_COND, RESET_PT, RESET_TIMEOUT,
RESOURCE_ID, REV_CONV_EQ, ROLLOVER_VAL, SAFETY_PT, SAMPLE_INTV,
SAMPLE_INTV_UNIT, SCAN_RATE, SETPOINT_HIGH, SETPOINT_LOW, TRIG_PT,
TRIG_REL, TRIG_VAL, UPDATE_CRITERIA, VARIANCE_VAL, VARS
##
Logicmaster Export, PT_ID, ADDR, DESC, PT_TYPE
##

Change Information in ie_formats.cfg

You can modify a current format or add additional export formats to  ie_formats.cfg  with a text
editor.

todo:   To add a new default format to the file:

1. Add a new line to the file.

2. Enter the name of the new format, followed by a comma. Make sure that the format name is
unique.

3. Enter the list of field names that you want to export. Use a comma to separate the names.
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You can modify an existing format by either adding or deleting field names from its definition
record.

Do not modify the Full Set or Logicmaster Export definitions.

Import/Export Log File

Import/Export Log File

Any errors or warnings incurred by Import/Export will be logged to a file in the directory pointed to
by the logical LOG_PATH, which is typically your project's  log  subdirectory.

After importing or exporting data, check the Import/Export Log file for errors. Since it is an ASCII
file, you can use any available text editor to read it. The messages are self-explanatory, but if you
need further information, be sure to check the Status Log file.

Import/Export Log File Name

The name of the log file is based on the current PRCNAM. The PRCNAM environment variable
must be set. If you do not set the environment variable, you will get an error message and the utility
will exit.

The file will be named  IE< prcnam >.log , where  < prcnam >  is the value assigned to PRCNAM.
Only one user at a time may run with the same  prcnam , so each  prcnam  has its own log file.
Each time a new session of Import/Export begins, the log file ( IE< prcnam >.log  or the default 
IElog.log ) is closed and a new one is started. The log file is in the directory specified by the logical, 
LOG_PATH .

Import/Export Log File Format

Every message written to the log file is time stamped and includes the type of message (error,
warning or informational). The date is shown in the first message of the file and the time appears on
each message.

For example, you may see messages that look like the following:

08:30:14 INFO:    Starting application Mar 11 1994.
08:38:15 Warning: Length of point `GEF_DEMO_REAL_REAL_LONG_NAME' with
 prefix xxxxxxxx is too long - truncated
10:29:53 ERROR:   No DEVICE_ID specified for device Point `DEMO_COS'
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In the above example:

• The Info message tells you when the application (in this case, import) started.
• The Warning message tells you that the pref ix that you are adding to the beginning of each

Point ID will cause the identified Point ID to be truncated.

Note: Point IDs may have up to 256 characters

Example

GEF_DEMO_REAL_REAL_LONG_NAME  will be truncated to 
XXXXXXXX_GEF_DEMO_REAL_REAL_LONG .

• The error message tells you that you do not have a Device ID for a given point. This is
categorized as an error, because this point data will not be imported unless you add a Device ID.

Configuration Data Imported

Configuration Data Imported

Through a PLC programming application or third party software package, you can create a SNF
format file containing point configuration data. Since only a subset of CIMPLICITY point fields may
be contained in the file, you may also need to modify the  ie_deflds.cfg  file to specify default values
for additional fields.

Once you have configured the  ie_deflds.cfg  file and created the SNF format import file, you are
ready to use Import/Export to import your configuration data into the CIMPLICITY point database.
When you import the data, you can also specify filter criteria to be applied to points in the file.

The import function will process each record in the input file. If it finds an invalid data field, it
discards the record and reports the error to a log file, and then continues processing with the next
record in the file.

Any data that exceeds the maximum length of the field it is being imported into is truncated. This
truncation is reported as a warning and does not keep the record from being imported, unless the
resulting truncated data is invalid.

Import Procedure

1. Log in and start up a command shell in the project where you want to import data.
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2. At the system prompt, invoke the following command:

$ clie import <file> [-D <device_id>] [-R <resource_id>]      [-Pa <prefix>] [-y]

Where

< file >  is a required argument, and is the full path of import file to be read. The file may be
in any directory, but the project's Data subdirectory is recommended. You should always use
the .csv extension with this filename.

Important:  Option names are case sensitive and must be entered as defined.

For CIMPLICITY versions 6.0 and higher

If imported points contain references to other points, it may be necessary to run the import
procedure more than once.

The optional arguments for the import command are:

Argument Description

-D <
device_id >

A valid Device ID in the CIMPLICITY database. For each device point in the import file that
does not have a Device ID, add the Device ID indicated by this argument. If no Device IDs are
specified in the import file, this option will set all device points in the import file to the specified
Device ID. This option will not override Device IDs already present in the import file. Those IDs
will remain unchanged.

R
<resource_id>

A valid Resource ID in the CIMPLICITY database. For each Point ID in the import file that does
not have a Resource ID, add the Resource ID indicated by this argument. If no Resource IDs are
specified in the import file, this option will set all points in the import file to the specified Resource
ID. This option will not override Resource IDs already present in the import file. Those IDs will
remain unchanged.

Pa <prefix> Add prefix_ to the start of each Point ID in the input file.

y Perform the import in dynamic mode if the project is running. Allows you to import point
information without restarting the project.

Example

clie import myfile.csv -R RESOURCE1

imports the point data from  MYFILE.CSV  and use RESOURCE1 as the Resource ID for any
records that do not have a Resource ID defined.

Dynamic Mode Imports
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Dynamic mode import lets you import point information without shutting down and restarting a
project. To perform an import in dynamic mode you must use the command line option  –y  as
described in the following example:

clie import myfile.csv -y

The CIMPLICITY Login dialog box will ask you to log into the project if you have not done so.

If you attempt a dynamic import while the project is not running, the import will continue in static
mode and display the following warning message:

Project must be running to use dynamic configuration.

Additional Roles {<filename>.rol} file Imported

1. Create a second file called  < filename >.rol  where  <filename>  is the same as the CSV file.

2. Add one line in  < filename >.rol  for each point that you are routing to roles other than
SYSMGR, USER, or OPER. The format of the line will be the Point ID followed by a list of
roles. Separate each field with a comma.

3. Run the Import utility as usual. The utility will automatically search for a  .rol  file whose name
matches that of the CSV file, and process the additional role information.

The following is an example of an .ROL file:

##  Point Role File Ver. 1.1
##  File created by:  GE Intelligent Platforms, Inc. --
 CIMPLICITY  Ver.  8.1
##  File created at:  15:33:35  on 6/21/95
##
TEST_ANALOG,DOER,FIXER
TEST_DIGITAL,FIXER

Configuration Data Exported

Configuration Data Exported

When exporting data, you must first determine which points to export and what file to export them
to. You can also specify filter criteria from which a list of points is created.
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You can define formats in  ie_formats.cfg  and identify which fields to export to a file. Therefore, it
is not necessary to export all the possible fields in every file.

The list of points is automatically exported to the file you specify. You can then edit the file with a
spreadsheet program, simple text editor, etc. After modifying the data, you can use the Import/Export
Utility to import the data back into the CIMPLICITY point database.

Export Configuration Data

todo:  To export configuration data:

1. Log in and start a command shell in the project from which you want to export data.

2. At the system prompt, invoke the following command:

$ clie export < file > [-Pr] [-Ef < format >]   [-Sp< point_id >] [-Sd < device_id >] [-So <
origin_id >]   [-St < type >] [-Sr < resource_id >]

Where

< file >  is a required argument, and is the full path of export file to be written. The file may be
in any directory, but the project's  Data  subdirectory is recommended. You should always use
the .csv extension with this filename.

Important:  Option names are case sensitive and must be entered as defined.

The optional arguments for the export command are:

Argument Description

-Pr Remove all prefixes from Point IDs (up to and including the underscore), before exporting.

-Ef < format > The type of file format to use. Specify one of the formats, found in the project's  ie_formats.cfg 
format configuration file. Default formats in the file are:  "Full Set"   all supported fields will
be exported  "   Logicmaster Export   "   only 4 fields will be exported. If no format name is
specified, the internal format is used. This format includes all of the fields in the  Full Set , plus
additional unsupported fields.

-Sp <
point_id >

A full or partial Point ID. Export data for Point IDs that begin with the string you specify. Note:
Wildcards are required for partial point name matches..

-Sd <
device_id >

A full or partial Device ID. You can use the * and ? wildcard characters (page 482) when
specifying a partial Device ID. Export data for Point IDs whose Device IDs match the string you
specify.

-So <
origin_id >

Export data for Point IDs whose Origin IDs match the string you specify. Specify one of the
following:  D  - device point  G  - global virtual point  R  - derived virtual point

-St < type > A full or partial Point Type in the CIMPLICITY database. You can use the * and ? wildcard
characters (page 482) when specifying a partial Point Type. Export data for Point IDs whose
Point Types match the string you specify.
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Argument Description

Sr   < resource_id >   A full or partial Resource ID. You can use the * and ? wildcard characters
(page 482) when specifying a partial Resource ID. Export data for Point IDs whose Resource
IDs match the string you specify.

Two export files will be generated by the Export utility:  < filename >   .csv  and  < filename >  
.rol . The .ROL file will contain information on additional roles configured for alarm routing.
If there are no roles other than SYSMGR, USER and OPER, the file will still be generated, but
will contain no information.

Example

clie export myfile.csv -Pr -Ef "My Set"

exports the data fields defined by "My Set" in  ie_formats.cfg  to  MYFILE.CSV  and 
MYFILE.ROL , and strips off any prefixes on the Point IDs.

Wildcard Characters Specified for Export

You can use the following wildcards.

Wildcard Description

* Search for any number of characters at this point in the string. For example, if you want to display a list
of resources that start with M and end with X, enter M*X in the Resource ID field.

? Search for any character in this place in the string. For example, if you want to display the list of
resources whose names are three characters long, and whose first character is M and third character is
X, enter M?X in the Resource ID field.

Note:  There are no implied wildcards. If you do not include or terminate your search string with
an asterisk, only those items that match your request exactly will be returned.

Important:  Wildcards do not work with the  -sp  option.

Configuration Data Deleted

Configuration Data Deleted

You can use the CLIE utility to delete point information from the CIMPLICITY database.

todo:  To delete CIMPLICITY point data:
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1. Start a command shell in the project from which you want to export data.

2. At the system prompt, invoke the following command:

$ clie delete < point_id > [/NOCONFIRM]

Where

< point_id >  is the Point ID you want to delete. You can use the wildcard characters  ?  and  * 
to delete sets of Point IDs.

The optional argument for the delete command is:

Argument Decription

/NOCONFIRM Deletes the requested points without prompting you to confirm the deletion.

If you choose to confirm the deletion, you are prompted like this:

> clie delete D?I*
Starting Import/Export - logging to LOG_PATH:IC169.log
Do you want to DELETE <DRIVE_CONVEY1>
(Y)es (N)o (A)ll
y
Do you want to DELETE <DRIVE_CONVEY2>
n
Number of points Deleted  =  1
Successful completion - Review LOG_PATH:IC169.log log file for
 messages.
>

Wildcard Characters Specified for Delete

You can use the wildcards as follows:

Wildcard Description

* Search for any number of characters at this point in the string. For example, if you want to delete all
points that start with M and end with X, enter M*X in the <point_id> field.

? Search for any character in this place in the string. For example, if you want to delete all points whose
names are three characters long and whose first character is M and third character is X, enter M?X in
the <point_id> field.

Note:  There are no implied wildcards. If you do not include or terminate your Point ID string
with an asterisk, only those Point Ids that match your request exactly will be deleted.



Project Setup | 12 - Import/Export Configuration | 484

Wild cards do not work with the  -sp  option.

Import/Export Field Names

Import/Export Field Names

The field names used by the Import/Export Utility correspond to a set of fields in the CIMPLICITY
point and alarm configuration files. Each field has certain requirements that must be met for
information in that field to successfully be imported into the CIMPLICITY point database.

The next two sections give you detailed information about the field names used by Import/Export.

Import/Export Required Fields

The PT_ID field is required in every file. This should preferably be the first field in the record.

Here is some more detailed information about the field:

Maximum Field Length 256 characters

CIMPLICITY Field Name Point ID

Description Unique name for a point

Import/Export Optional Fields

Note about Field List

Any of the fields listed in this section may be specified in a data file for Import/Export. None are
absolutely required, but, when specifying new points to be imported into the CIMPLICITY database,
certain fields may be required.

Points are device points, derived points, or global points.

Note:  Some of the optional fields are specific to points of a particular origin. The Point Origin
column identifies the type of point defined by the record. The point types are:

• All
• Device
• Global (virtual)
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• Derived (virtual)

All field names and enumerated data are case insensitive.

ACCESS

Point Type Device

Maximum Field Length 2 characters

CIMPLICITY Field Name Access

Description Device read/write access.

Values Valid values are:

R Read only

W Read/Write

ACCESS_FILTER

Point Type All

Maximum Field Length Byte

CIMPLICITY Field Name Enterprise Point

Description Indicates whether the Enterprise Server has access to the point.

Values Valid values are:

E Enterprise Server can access

B or blank Enterprise Server cannot access

ACK_TIMEOUT

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Acknowledge Timeout

Description Time in minutes before the point's alarm is automatically acknowledged.

Values Valid values are:

-1 No auto acknowledge

 0 Acknowledge immediately

>0 Minutes to wait for automatic acknowledge
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ADDR

Point Type Device

Maximum Field
Length

256 characters

CIMPLICITY
Field Name

Memory Type or Address

Description Actual address of the point within the device. For devices with memory types, this field contains the
memory type. Otherwise, the actual point address is used.

ADDR_OFFSET

Point Type Device

Maximum Field
Length

Integer

CIMPLICITY Field
Name

Address Offset

Description Offset in memory from the first bit of the Point address. For Analog, APPL, and Text point types,
this field must be zero.

ADDR_TYPE

Point Type Device

Maximum Field Length 2 characters

CIMPLICITY Field Name Address Type

Description For MMS Ethernet devices only. The type of address.

Values Valid values are:

VN Variable Name

FQ Fully qualified

LG Logical

UC Unconstrained

AI Array Index

SI String Index

ALM_CLASS

Point Type All
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Maximum Field
Length

5 characters

CIMPLICITY Field
Name

Alarm Class

Description The Alarm Class ID to be used for the point's alarms. The Alarm Class ID must already be defined
in the CIMPLICITY database.

ALM_CRITERIA

Point Type All

Maximum Field Length 3 characters

CIMPLICITY Field Name Alarm Criteria

Description Method to be used for evaluating alarm conditions.

Values Valid values are:

ABS Absolute

DEV Deviation

ROC Rate of Change

ONU On Update

ALM_DEADBAND

Point Type All

Maximum Field Length Integer

CIMPLICITY Field
Name

Alarm Deadband

Description Tolerance around alarm limits. The range is determined by the PT_TYPE defined for the
point.

ALM_DELAY

Point Type All

Maximum Field Length Integer

CIMPLICITY Field
Name

Delay Alarms

Description Determine if the generation of alarms by the point should be delayed.

Values Valid values are:

0 Alarms are not delayed.
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1 Alarms are delayed by the length of time specified by SAMPLE_INTV and
SAMPLE_INTV_UNIT.

ALM_ENABLE

Point Type Device

Maximum Field Length Boolean

CIMPLICITY Field Name Enable alarm

Description Determines if a point alarm is enabled or disabled.

Values Valid values are:

0 Disabled

1 Enabled

ALM_HIGH_1

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Warning High

Description High warning limit

ALM_HIGH_2

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm High

Description High alarm limit

ALM_HLP_FILE

Point Type All

Maximum Field
Length

67 characters

CIMPLICITY Field
Name

Help File

Description Name of the help text file. ".HLP" will be added to the name. Help files are located in 
%SITE_ROOT%\am_help
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ALM_LOW_1

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Warning Low

Description Low warning limit

ALM_LOW_2

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm Low

Description Low alarm limit

ALM_MSG

Point Type All

Maximum Field
Length

80 characters

CIMPLICITY Field
Name

Alarm message

Description Text displayed when the alarm is set. See Alarm Message Variables for the list of variable
information that can be used in the text.

ALM_OFF_DELAY

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm off delay

Description Determine if removing point alarms in the ALARM state should be delayed.

ALM_OFF_DELAY_HI

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm off delay hi

Description Determine if removing point alarms in the HI state should be delayed.
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ALM_OFF_DELAY_HIHI

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm off delay hihi

Description Determine if removing point alarms in the HIHI state should be delayed.

ALM_OFF_DELAY_LO

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm off delay lo

Description Determine if removing point alarms in the LO state should be delayed.

ALM_OFF_DELAY_LOLO

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm off delay lolo

Description Determine if removing point alarms in the LOLO state should be delayed.

ALM_ROUTE_OPER

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Alarm Routing: OPER

Description Determines if alarm information is
sent to users with OPER role.

Values Valid values are:

0 Do not sent alarm to OPER role.

1 OPER role can display the alarm.

ALM_ROUTE_SYSMGR

Point Type All

Maximum Field Length Boolean
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CIMPLICITY Field Name Alarm Routing: SYSMGR

Description Determines if alarm information is sent to users with SYSMGR role. Valid values are:

Values Valid values are:

0 Do not sent alarm to SYSMGR role.

1 SYSMGR role can display the alarm.

ALM_ROUTE_USER

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Alarm Routing: USER

Description Determines if alarm information is
sent to users with USER role.

Values Valid values are:

0 Do not sent alarm to USER role

1 USER role can display the alarm.

ALM_SEVERITY

Point Type All

Maximum
Field Length

Integer

CIMPLICITY
Field Name

Severity

Description A number from 1 through 1000. The higher the number the more severe the alarm is considered.
CIMPLICITY treats more severe alarms with a higher priority.

ALM_STR

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Alarm String Index

Description Alarm string index to be applied for alarms. Must be a valid index.

ALM_TYPE

Point Type All

Maximum Field Length 2 characters
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CIMPLICITY Field Name Alarm Type

Description Determines
which log is
written to.

Values Valid values are:

AL Alarm Log

EV Event Log

ALM_UPDATE_VALUE

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Alarm Update: USER

Description Determines if alarm values
should be updated.

Values Valid values are:

0 Do not update alarm values

1 Update alarm values.

ANALOG_DEADBAND

Point Type Device

Maximum Field
Length

Integer

CIMPLICITY Field
Name

Analog Deadband

Description Used to filter changes in raw value of point. The raw value must change at least this much to
update the value of the point.

BFR_COUNT

Point Type All

Maximum Field
Length

Integer

CIMPLICITY
Field Name

Point Buffering Max Count

Description The maximum number of point values to buffer for Trending. If left zero, then the number of values is
not used as a limiting factor when buffering data.
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BFR_DUR

Point Type All

Maximum Field
Length

Integer

CIMPLICITY
Field Name

Point Buffering Max Duration

Description The longest time between the first value and last value buffered for Trending. If left zero, then
duration is not used as a limiting factor when buffering data.

BFR_EVENT_PT_ID

BFR_EVENT_PT_ID is reserved for future use.

BFR_EVENT_TYPE

BFR_EVENT_TYPE is reserved for future use.

BFR_EVENT_UNITS

BFR_EVENT_UNITS is reserved for future use.

BFR_GATE_COND

BFR_GATE_COND is reserved for future use.

BFR_SYNC_TIME

BFR_SYNC_TIME is reserved for future use.

CALC_TYPE

Point Type Derived (virtual)

Maximum Field Length 3 characters

CIMPLICITY Field Name Calc Types

Description Method for determining the derived point value.

Values Valid values are:

EQU Equation

DAC Delta Accumulator
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VAC Value Accumulator

AVG Average

MAX Maxim

MIN Minimumum

T_C Timer/Counter

HST Histogram

T_H Transition High Accumulator

EWO Equation with Override

CHANGEAPPROVAL

Point Type All points

Maximum Field
Length

5 characters.

CIMPLICITY Field
Name

Change approval

Description Selected  change approval specifications will be exported with the point and set for the point
when it is imported.

Values Valid values are:

P Perform

PV Perform and verify

L Log only

NONE None

PU Perform and unsigned writes

PVU Perform, verify and unsigned writes

LU Log only and unsigned writes

NONEU None and unsigned writes

CONV_LIM_HIGH

Point Type Device

Maximum Field Length Integer

CIMPLICITY Field Name Converted Value (second)

Description Second converted value used for linear conversion.
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CONV_LIM_LOW

Point Type Device

Maximum Field Length Integer

CIMPLICITY Field Name Converted Value (first)

Description First converted value used for linear conversion.

CONV_TYPE

Point Type Device

Maximum Field Length 2 characters

CIMPLICITY Field Name Conversion Type

Description Point EU conversion type.

Values Valid values are:

NO None

LC Linear conversion

CS Custom conversion

DELAY_LOAD

Point Type Device

Maximum Field Length Boolean

CIMPLICITY Field Name Delay Load

Description Indicates if a
device point is a
delay load point:

Values Valid values are:

0 No

1 Yes

DELETE_REQ

Point Type All

Maximum Field Length 2 characters

CIMPLICITY Field Name Deletion Requirement

Description Determines when alarm occurrence should be deleted.
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Values Valid values are:

A Acknowledge only

R Reset only

AR Acknowledge and Reset

DESC

Point Type All

Maximum Field Length 40 characters

CIMPLICITY Field Name Description

Description Description of point

DEVIATION_PT

Point Type All

Maximum Field
Length

256 characters

CIMPLICITY Field
Name

Deviation Point

Description Point that current point will be compared to when checking for deviation alarm. Must be a
configured Point ID.

DEVICE_ID

Point Type Device

Maximum Field Length 256 characters

CIMPLICITY Field Name Device ID

Description Device where the point data originates. Must be a configured Device ID.

DISP_LIM_HIGH

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Disp. Limit (hi)

Description Largest value to display in CimView screens.

DISP_LIM_LOW
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Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Disp. Limit (low)

Description Smallest value to display in CimView screens.

DISP_TYPE

Point Type All / Real Data type Only

Maximum Field Length CHAR

CIMPLICITY Field Name Display Type

Description Determines if the value displayed is Fixed, Scientific or compact.

Values Valid values are:

f fixed

g Compact

e Scientific.

DISP_WIDTH

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Display Width

Description Number of spaces for display of point value in CimView.

ELEMENTS

Point Type All

Maximum Field
Length

Integer

CIMPLICITY Field
Name

Elements

Description Number of discrete elements in the point's data array. This is determined by the point's
configured data type.

ENG_UNITS

Point Type All

Maximum Field Length 8 characters
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CIMPLICITY Field Name Eng. Units

Description Units that the data represents.

ENUM_ID

Point Type Integer

Maximum Field Length Valid pre-existing point enumeration identifier

CIMPLICITY Field Name Point Enumeration

Description Identifies an already existing point enumeration set to be associated with integer type points.

EQUATION

Point Type Derived (virtual)

Maximum
Field Length

300 characters

CIMPLICITY
Field Name

Equation

Description Specifies how the value is calculated.

Values If CALC_TYPE is:

DAC, VAC, AVG,
MAX, or MIN

Make sure the field contains the source Point ID.

EQU Enter a mathematical formula, the result of which is the value of this point. See
Equation Operations for the list of valid operators.

EXTRA

Point Type Any

Maximum Field Length DINT

CIMPLICITY Field Name Extra Info

Description Specifies the DINT value for a point's Extra Info field.

FW_CONV_EQ

Point Type Device

Maximum Field
Length

72 characters

CIMPLICITY Field
Name

Eng. Conversion Expression
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Description Arithmetic expression used to convert raw data to engineering units value. See Equation
Operations for the list of valid operators.

GR_SCREEN

Point Type All

Maximum Field
Length

16 characters

CIMPLICITY Field
Name

Graphic Screen

Description CimView screen to display when the Get Screen Hot Key is pressed for this point on the Point
List or Alarm Page.

INIT_VAL

Point Type Derived (virtual)/Global (virtual)

Maximum
Field Length

Number

CIMPLICITY
Field Name

Initial Value

Description Value for point at initialization before any data is generated by its component point(s). Use if PT_TYPE
is G, or PT_TYPE is D and CALC_TYPE is ACC, MIN, or MAX.

JUSTIFICATION

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Justification

Description Determines if the value displayed is
justified and/or padded with zeros.

Valid values are:

0 Left justified

1 Right justified

2 Right justified with leading zeros.

LEVEL

Point Type All

Maximum Field Length DINT
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CIMPLICITY Field Name Level

Description Role's security level.

LOCAL

Point Type Derived (virtual)/Global (virtual)

Maximum Field Length Boolean

CIMPLICITY Field Name Local Value

Description Determines if value is reported
to Point Manager.

Valid values are:

0 Report value

1 Do not report value

LOG_ACK

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Local Value

Description Determines if value is reported to Point Manager.

Values Valid values are:

0 Logging when an alarm is acknowledged is not set.

1 Logging when an alarm is acknowledged is set.

LOG_DATA

Point Type Device

Maximum Field Length Boolean

CIMPLICITY Field Name Log data

Description Indicates if a
point is being
logged.

Values Valid values are:

0 No

1 Yes
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LOG_DATA_HISTORIAN

Point Type Device or Virtual

Maximum Field Length Boolean

CIMPLICITY Field Name LOG_DATA_HISTORIAN

Description Indicates if a
point is being
logged to
Historian

Values Valid values are:

0 No

1 Yes

LOG_DEL

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Local Value

Description Determines if value is reported to Point Manager. Valid values are:

0 Logging when an alarm is deleted is not set.

1 Logging when an alarm is deleted is set.

LOG_GEN

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Local Value

Description Determines if value is reported to Point Manager. Valid values are:

0 Logging when an alarm is generated is not set.

1 Logging when an alarm is generated is set.

LOG_RESET

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Local Value
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Description Determines if value is reported to Point Manager. Valid values are:

0 Logging when an alarm is reset is not set.

1 Logging when an alarm is reset is set.

MAX_STACKED

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Max Number Stacked

Description Maximum number of alarm occurrences tracked. Valid values are:

0 Alarm is not stacked.

1 to 19 Number of alarms stacked.

MEASUREMENT_UNIT_ID

Point Type All

Maximum Field Length 256 characters

CIMPLICITY Field Name Measurement Unit ID

Description The base measurement unit ID configured for the point.

MISC_FLAGS

Point Type All

Maximum
Field Length

Integer

CIMPLICITY
Field Name

MISC_FLAGS

Description An 8 bit flag in which:

Bit Is:

0 Used internally if Point is a $Local point.

1 Used solely for internal use.

2 Set at configuration. Point general properties when Invert check box is check/uncheck. Note: The
Invert checkbox is on the Point Properties dialog box>General tab.

3 Used only with Proficy SOA; Bit 3 configuration requires CIMPLICITY v8.1 and higher.

Other bits are reserved for future use.
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POLL_AFTER_SET

Point Type Device

Maximum Field Length Boolean

CIMPLICITY Field Name Poll After Set

Description Determines if polling should be done after a setpoint.

Values Valid values are:

0 Do not poll (default)

1 Scan immediately

Important:  Some device communication interfaces support asynchronous polling by default.

These devices include:

• AB Ethernet
• Mitsubishi TCP/IP
• Sharp
• Triplex

For these interfaces, if the device response to a poll request is received during the poll after set
processing, the response on the poll after set can be processed first.

• Do the following if either condition occurs.
• This behavior is observed and is a problem for the application
• Normal polling delivers the data to the application in a time frame sufficient to meet the

application needs.

Clear the Poll after Set checkbox (page 191) on the Device tab of the Point Properties dialog box.

• If a poll after set is required, the asynchronous polling can be disabled on the port.

Note:  Disabling asynchronous polling on a port may significantly alter the data collection
performance.

To disable the asynchronous polling, define the global parameter <PORT>_SYNC_ONLY .

Synchronous polling is disabled by default.

PRECISION

Point Type All
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Maximum Field Length Integer

CIMPLICITY Field Name Precision

Description Number of decimal places in display.

PROC_ID

Point Type Derived (virtual)/Global (virtual)

Maximum Field
Length

14 characters

CIMPLICITY
Field Name

Virtual Proc ID

Description The Derived Point process that will calculate the value of this point. Must be a valid PTDP_RP
Process ID. Format is: <node_id> _PTDP_RP

PTMGMT_PROC_ID

Point Type Derived (virtual)/Global (virtual)

Maximum Field
Length

14 characters

CIMPLICITY
Field Name

Point Manager

Description The Point Management process that will manage this point. Must be a valid PTM_RP Process ID.
Format is:  < node_id >_PTM< n >_RP

PT_ENABLED

Point Type Device

Maximum Field Length Boolean

CIMPLICITY Field Name Enabled

Description Determines if the point is enabled or disabled.

Values Valid values are:

0 Disabled

1 Enabled

PT_ORIGIN

Point Type All

Maximum Field Length 1 character
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CIMPLICITY Field Name No field defined

Description Code indicating the origin of this point.

Values Valid values are:

D Device Point

R Derived Virtual Point

G Global Virtual Point

I Device Internal Point

A Device Always Poll Point

PT_SET_INTERVAL

Point Type Device

Maximum Field
Length

Time. The format is HH:MM:SS for the interval Where:

HH Hour

MM Minutes

SS Seconds

CIMPLICITY Field
Name

Interval

Description The interval at which the Timer/Counter point will be updated while the Expression value
remains HIGH.

PT_SET_TIME

Point Type Derived (virtual)

Maximum Field Length Time. The format is HH:MM:SS for the base start time, Where:

HH Hour

MM Minutes

SS Seconds

CIMPLICITY Field Name Set Time

Description Base start time for the Timer/Counter point interval.

PT_TYPE

Point Type All

Maximum Field Length 16 characters



Project Setup | 12 - Import/Export Configuration | 506

CIMPLICITY Field Name Type

Description Identifies type and length of point data. Must be a configured point type.

RANGE_HIGH

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Range Limit (hi)

Description The maximum value allowed for this point.

RANGE_LOW

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Range Limit (low)

Description The minimum value allowed for this point.

RAW_LIM_HIGH

Point Type Device

Maximum Field Length Integer

CIMPLICITY Field Name Raw Value (second)

Description Second raw value used for linear conversion.

RAW_LIM_LOW

Point Type Device

Maximum Field Length Integer

CIMPLICITY Field Name Raw Value (first)

Description First raw value used for linear conversion.

REP_TIMEOUT

Point Type All

Maximum Field
Length

Integer
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CIMPLICITY
Field Name

Repeat Timeout

Description Time in minutes before the point's alarm is automatically re-sent to alarm line printers. The alarm
will be re-sent only if it is still active.

Values Valid values are:

-1 No automatic re-send

 0 Minutes before automatic re-send.

RESET_ALLOWED

Point Type All

Maximum Field Length Boolean

CIMPLICITY Field Name Reset Allowed

Description Determines if a user can reset
the point's alarm.

Valid values are:

0 User cannot reset the alarm

1 User can reset the alarm

RESET_COND

Point Type Derived (virtual)/Global (virtual)

Maximum Field Length 2 characters

CIMPLICITY Field Name Reset/Startup Cond

Description Search sequence for source of initial value.

Values Valid values are:

UN Unavailable

IN Use INIT_VAL

SA Use saved value

SI Saved and init

RESET_PT

Point Type Derived (virtual)

Maximum Field Length 256 characters

CIMPLICITY Field Name Reset Point
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Description Point that will cause this derived point to reset. Must be a configured Point ID.

RESET_TIMEOUT

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Reset Timeout

Description Time in minutes before this point's alarm is automatically reset.

Values Valid values are:

-1 No automatic reset

 0 Reset automatically

>0 Minutes before automatic reset

RESOURCE_ID

Point Type All

Maximum Field Length 16 characters

CIMPLICITY Field Name Resource ID

Description Resource ID for this point. Must be a configured Resource ID.

REV_CONV_EQ

Point Type Device

Maximum Field
Length

72 characters

CIMPLICITY
Field Name

Reverse Engineering Expression

Description Arithmetic expression used to convert engineering units value to raw data for setpoints. See
Equation Operations for the list of valid operators.

ROLLOVER_VAL

Point Type Derived (virtual)

Maximum Field
Length

Integer

CIMPLICITY Field
Name

Rollover
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Description For Delta Accumulator virtual points, the value of a point at which it rolls over to a zero value
when incremented by one unit.

SAFETY_PT

Point Type All

Maximum
Field Length

256 characters

CIMPLICITY
Field Name

Safety Point

Description Point ID of an analog or digital point to be checked when a setpoint request is made for this point. If the
point evaluates to zero (0), the setpoint is denied. Must be a configured Point ID.

SAMPLE_INTV

Point Type All

Maximum Field Length Integer

CIMPLICITY Field
Name

Alarm Delay Interval (value)

Description SAMPLE_INTV depends on the alarm type, as follows.

Rate of
Change

The frequency with which the point will be sampled for Rate of Change
alarming.

Absolute The length of delay before the alarm is reported, if Delay Alarms is set to Y.

Note:  CLIE import generates an error and fails for points where the SAMPLE_INTV field
value is set to less than 5 and SAMPLE_INTV_UNIT is set to SEC.

This is the alarm delay time setting field, which was modified to accept a delay of less than 5
seconds. Error messages in the CLIE log files are as follows for each point that fails:

1. Error in Sample Interval for Point '<pointname>'
2. Error deriving field data in SNF record for point '<pointname>'.

SAMPLE_INTV_UNIT

Point Type All

Maximum Field Length 3 characters

CIMPLICITY Field Name Alarm Delay Interval (units)

Description The type of units for
SAMPLE_INTV.

Values Valid values are:
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SEC Seconds

MIN Minutes

HR Hours

SCAN_RATE

Point Type Device

Maximum Field Length Integer

CIMPLICITY Field Name Scan Rate

Description Frequency of point sampling. This is a multiple of the base scan rate set for the system.

SETPOINT_HIGH

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Setpoint Limit (hi)

Description The maximum value a point is allowed to be set.

SETPOINT_LOW

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Setpoint Limit (low)

Description The minimum value a point is allowed to be set.

TIME_OF_DAY

TIME_OF_DAY is reserved for future use.

TRIG_CK_PT

Point Type All

Maximum Field Length 256 characters

CIMPLICITY Field Name Availability Trigger

Description The point serving as the availability trigger for this point.

Values Valid values are:

If the Availability Trigger is: The point values is
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TRUE (non-zero) Available.

FALSE (zero) Unavailable.

TRIG_PT

Point Type Device/Derived (virtual)

Maximum Field Length 256 characters

CIMPLICITY Field Name Trigger

Description The point, which must be a configured pont ID, serving as the trigger for the selected point

Values The use differs if the point is a device or derived point, as follows.

For: The Trigger Point must be:

Device points On the same device as the points it triggers.

Derived points Processed by the same Derived Point Process as the points it triggers.

TRIG_REL

Point Type Device

Maximum Field Length 2 characters

CIMPLICITY Field Name Relation

Description Determines how the trigger is evaluated.

Values Valid values are:

NO No Trigger

OC On Change

EQ Equal

LT Less Than

GT Greater Than

LE Less Than or Equal

GE Greater Than or Equal

TRIG_VAL

Point Type Device

Maximum Field Length 16 characters

CIMPLICITY Field Name Value

Description Value the trigger is compared with to determine if the TRIG_REL condition is met.
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UAFSET

Point Type Any

Maximum Field Length Valid Attribute Set Identifier

CIMPLICITY Field Name Attribute Set

Description Must contain an existing Attribute Set Identifier

UPDATE_CRITERIA

Point Type Device

Maximum Field
Length

2 characters

CIMPLICITY Field
Name

Update Criteria

Description Value determining when point data is passed to the CIMPLICITY point database after the
device is read.

Values Valid values are:

UN Unsolicited

OC On Change

OS On Scan

DS On Demand On Scan

DC On Demand On Change

PO Poll Once

VARIANCE_VAL

Point Type Derived (virtual)

Maximum Field Length Number

CIMPLICITY Field Name Variance value

Description Accumulator variance value.

VARS

Point Type All

Maximum Field Length Integer

CIMPLICITY Field Name Vars
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Description Number of process variables represented by this point.

Logicmaster 90 Support

Logicmaster fields map to the following field names in the Shared Name File:

Logicmaster Field Field Name

reference † ADDR

nickname PT_ID

description DESC

length ELEMENTS

type ‡ PT_TYPE

† blockname = > add to ADDR string (for example: %Lxxxxx,block).

‡ timer and pid are not supported by CIMPLICITY software at this time.

Sample Logicmaster File

The following is an example of a Logicmaster file.



Chapter 13. Point Control Panel

About the Point Control Panel

The Point Control Panel provides you with a forum in which you can easily review and change point
values and status during runtime.

Information that displays during runtime includes selected point:

• Values
• Measurement units for the point. The unit can be the active measurement system (page 445) or

assigned to the point (page 177) .
• Value time stamp.
• Description that was entered on the general tab in the Point Properties or Object dialog box for

either a device (page 164) or virtual (page 196) point.
• Alarm state.

Open the Point Control Panel

1. Select Runtime>Point Control Panel in the Workbench left pane.

2. Select Point Control Panel in the Workbench right pane.

3. Do one of the following:



Project Setup | 13 - Point Control Panel | 515

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Point Control Panel. a. Right-click Point Control Panel.
b. Select Properties on the Popup menu.

D In the Workbench right pane:

Either Or

Double click Point Control Panel. a. Right-click Point Control Panel.
b. Select Properties on the Popup menu.

E Press Alt+Enter on the keyboard.

4. Right-click Point Control Panel.

5. Select Properties on the Popup menu.

6. Right-click Point Control Panel.

7. Select Properties on the Popup menu.

8. Continue, based on whether or not projects are running.

9. Proceed according to the status of running projects as follows:

One project is running:

An empty Point Control Panel opens with the running project as the connected project.

More than one project is running

A Select project to connect dialog box opens. 
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a. Select the project to connect.
b. Click Connect.

No project is running:

A Select CIMPLICITYÒ Project dialog box opens.

a. Select the project to start.
b. Click either:
• Start
• Start as Viewer

An empty Point Control Panel opens connected to the selected project in any situation.

When you add points, the default selection will be from the connected project.

You can also add points from additional projects to which you have access.

Note:  The role assigned to your user ID must have authorization in order for you to display the
Point Control Panel's right-click Popup menu.
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Point Control Panel Files

Point Control Panel Files

When you display and manipulate points in the Point Control Panel, you are creating a file that can
be saved as a .PPL file and printed as a document. This functionality can save you time by providing
you with the ability to create a list of points just once, save the list and reuse it without having to take
the time to find and select the points again.

Displayed data includes:

The Point Control Panel provides you with the following features to deal with Point Control Panel
files.

1
(page
517)

Open a Point Control Panel file.

2
(page
520)

Save a Point Control Panel file.

3
(page
521)

Install a shortcut of a Point Control Panel document.

4
(page
522)

Print a Point Control Panel document.

5
(page
524)

Exit the Point Control Panel.

1. Open a Point Control Panel File

1. Open a Point Control Panel File

1.1
(page
518)

Display a new Point Control Panel File.

1.2
(page
518)

Open an existing Point Control Panel file.
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1.1. Display a New Point Control Panel File

If you are working in the Point Control Panel and want to display a newPoint Control Panel file, you
can by using any of several methods.

Method 1

1. Click File on the Point Control Panel menu bar.

2. Select New.

Method 2

Double-click the New button  on the Point Control Panel toolbar.

Method 3

Press Ctrl+N on the keyboard.

A new Point Control Panel appears when you use any method.

1.2. Open an Existing Point Control Panel File

You can quickly open a recently used Point Control Panel file (.PPL) or find and open any other file.

You can:

• Quickly open a recently used Point Control Panel file.
• Open any existing Point Control Panel file.

Quickly open a recently used Point Control Panel File
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1. Click File on the Point Control Panel menu bar.

2. Select any of the files listed on the File menu.

Result: The file displays in the Point Control Panel with the configuration you saved.

Open any Existing Point Control Panel File

3. Open the Open dialog box.

Method 1

a. Click File on the Point Control Panel menu bar.
b. Select Open.

Method 2

Double-click the Open button  on the Point Control Panel toolbar.

Method 3

Press Ctrl+O on the keyboard.

The Open dialog box opens when you use any method.
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4. Find and select the .PPL file you want.

The file displays in the Point Control Panel with the configuration you saved.

2. Save a Point Control Panel File

When you display a configuration that you think you will use again, you can save it using any of
several methods.

You can:

• Save a Point Control Panel file.
• Save a copy of a Point Control Panel file.

Save a Point Control Panel File

1. Do one of the following:

Method 1

a. Click File on the Point Control Panel menu bar.
b. Select Save.
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Method 2

Double-click the Save button  on the Point Control Panel toolbar.

Method 3

Press Ctrl+S on the keyboard.

If the file has been saved previously the saved version is updated.

If the file is being saved for the first time, the Save As dialog box opens.

2. Enter a name for the file in the folder where you keep Point Control Panel files for the project.

3. Click Save.

Result: A new Point Control Panel file is saved for future use.

Note:  By default, Point Control Panel documents are placed in the main CIMPLICITY
directory, but you can select another directory.

Save a copy of a Point Control Panel file

4. Click File on the Point Control Panel menu bar.

5. Select Save As…

The Save As dialog box opens.

6. Enter a name for the file in the folder where you keep Point Control Panel files for the project.

7. Click Save.

3. Install a Shortcut of a Point Control Panel File

1. Save (page 520) the Point Control Panel file.

2. Click File on the Point Control Panel menu bar.

3. Select Install.
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A Create Shortcut dialog box opens.

4. Select the folder in which the shortcut should appear, e.g., Desktop.

5. Click OK.

The shortcut is created where you specified, e.g. .

Note:  If you open the shortcut when the project is not running a Select CIMPLICITYÒ Project
dialog box opens to let you easily start the project.

4. Print a Point Control Panel Document

4. Print a Point Control Panel Document

4.1
(page
523)

Preview a Point Control Panel printed document.

4.2
(page
523)

Customize the print setup for the Point Control Panel.
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4.3
(page
524)

Print a Point Control Panel document.

4.1. Preview a Point Control Panel Printed Document

1. Do one of the following to open the Point Control Panel Print Preview window.

Method 1

a. Click File on the Point Control Panel menu bar.
b. Select Print Preview.

Method 2

Press Alt+F+V on the keyboard.

The Point Control Panel Print Preview window opens when you use either method.

2. Review the print preview using the Point Control Panel tools:

To Action

Zoom in • Left-click the mouse
• Click Zoom in on the toolbar.

Zoom out • Left-click the mouse
• Click Zoom out on the toolbar.

Note:  The screen size cycles as follows:

• Increases in size for  two left-mouse clicks/decreases in size for one click.
• Increases in size for two button clicks/decreases in size for two button clicks.

When the cycle starts with the first click, it  goes to the next size up or down based on the
current size.

Go to the previous
page

Click Prev Page on the toolbar

Go to the next page Click Next Page on the toolbar

Display one page Click One Page. This button is active when two pages are displaying.

Display two pages Click Two Page. This button is active when one page is displaying.

Print Click Print.

4.2. Customize the Print Setup for the Point Control Panel

The Point Control Panel provides you with the ability to assign a printer other than the Windows
default printer or to change the printer specifications.
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Method 1

1. Click File on the Point control Panel menu bar.

2. Select Print Setup.

Method 2

Press Alt+F+R on the keyboard.

The Print Setup dialog box opens when you use either method. Options for the print setup depend on
the printer that is being used.

Note:  You can also change the printer specifications before you print the document.

4.3. Print a Point Control Panel Document

Do one of the following.

Method 1

1. Click File on the Point Control Panel menu bar.

2. Select Print.

Method 2

Click Print in the Point Control Panel Print Preview window.

Method 3

Press Crtl+P on the keyboard.

5. Exit the Point Control Panel

1. Do one of the following:
• Click File>Exit on the Point Control Panel menu bar.
• Press Alt+F+X on the keyboard.
• Click the Window Close button .

If you made unsaved changes, a Point Control Panel message box appears asking you if you
want to save them.

2. Click one of the following.
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Yes Save the changes

No Discard the changes

Cancel Return to the Point Control Panel.

Point Procedures in the Point Control Panel

Point Procedures in the Point Control Panel

There are some procedures that you can perform in the Point Control Panel that apply to any points,
including points in manual mode and points with alarms.

You can:

1
(page
525)

Add points to the Point Control Panel.

2
(page
531)

Change Font Colors in the Point Control Panel.

3
(page
532)

Edit a Point through the Point Control Panel.

4
(page
534)

Delete a Point from the Point Control Panel.

Note:  An Invalid Point icon  will appear to the left of the Point ID if the point is not valid.
This can happen, for example, if you add a point to a Point Control Panel file, save the file, close it,
then delete the point from the project when you are working in the Workbench. The next time you
open the Point Control Panel file an Invalid Point icon will appear next to that Point ID.

1. Add Points to the Point Control Panel

1. Add Points to the Point Control Panel

There are several ways you can add points the Point Control Panel.

Tip:  A quick way to add points is to open (page 518) an existing file that contains some or all
of the points and class objects you want to work with.

You can add selected or all points in a project:
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1.1
(page
526)

Add points using the Select a Point Browser.

1.2
(page
528)

Add points directly from the Workbench.

1.3
(page
529)

Add class object points to the Point Control Panel.

1.4
(page
530)

Add points from another Point Control Panel file.

Note:

• The Point Control Panel displays the time in the local time zone of the Viewer.
• If you are not logged into CIMPLICITY a CIMPLICITY® Login dialog box will display when

you try to add points to the Point Control Panel.

Once you fill in your User ID and Password, if your role has access to the Point Control Panel, you
will be able to add points.

1.1. Add Points Using the Select a Point Browser

1. Do one of the following:

Method 1

a. Click Edit on the Point Control Panel menu bar.
b. Select Add Points.

Method 2

Click the Add Point  button on the Point Control Panel toolbar.

Method 3

Press Ctrl+A on the keyboard.
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Method 4

a. Right-click a point that displays in the Point Control Panel.
b. Select Add Points… from the popup menu.

The Select a Point Browser displays when you use any method. If more than one project is
running, the  that the project that was selected for connection when the Point Control Panel was
opened displays in the Project field.

You can do any of the following to change the project selected for point browsing.

• Select any running project in the drop-down list that grants you privileges to browse.
• Enter any of the following.
• Project name
• Server name
• IP address
• Cluster name
• Cluster IP address

Important: If cabling redundancy is configured on a server and you attempt to connect by
cluster name or IP address, the connection will fail.

2. Select the Point IDs you want to display for the selected running project.

3. Click OK.

The points appear in the Point Control Panel displaying their runtime values, units and timestamp. If
a point is in an alarm condition, its text displays in the color associated with the alarm level.



Project Setup | 13 - Point Control Panel | 528

1.2. Add Points Directly from the Workbench

You can

• Copy and paste Point ID's, or
• Drag Point ID's

into the Point Control Panel from the Workbench.

1. Position a Point Control Panel window near the Workbench.:

2. Click the Points icon in the Workbench left pane.

3. Select the points you want in the right pane of the Workbench.

4. Do one of the following.
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A Drag points from the Workbench into the Point Control Panel.

Workbench Point Control Panel

B Seciect Edit>Copy on the menu bar. Select Edit>Paste on the menu bar.

C Press Ctrl+C on the keyboard Press Ctrl+V on the keyboard.

The points display their runtime values, units and timestamp in the Point Control Panel. If a point is
in an alarm condition, its text displays in the color associated with the alarm level.

Tip:  You can drag the points from the Point Control Panel to a CimEdit Screen. They become
text objects in CimEdit.

1.3. Add Class Object Points to the Point Control Panel

You can add selected class object points to the Point Control Panel by using any of the methods
available for adding one or more single points.

You can also quickly add all of the points associated with selected class objects to the Point Control
Panel.

Method 1. Use the Object browser

1. Do one of the following

• Click the Object button  on the Point Control Panel toolbar or
• Select Edit>Add Objects on the Point Control Panel menu bar

The Object browser opens.

2. Select an one or more class objects.

3. Click OK.

Method 2. Add an object from the Workbench

4. Place the Workbench next to the Point Control Panel.

5. Select the Object icon in the Workbench left pane.

6. Select one or more objects in the right pane.

7. Drag or copy the objects the same way you add points (page 528) directly from the
Workbench into the Point Control Panel.

All of the points associated with the selected class objects display in the Point Control Panel.
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1.4. Add Points from another Point Control Panel File

1. Select the Point ID or Point IDs in a Point Control Panel file that you want to paste into another.

2. Do one of the following.

Method 1

a. Click Edit on the Point Control Panel menu bar.
b. Select Copy.

Method 2

Press Ctrl+C on the keyboard.

3. Open the Point Control Panel file into which the Point IDs will be copied.

4. Do one of the following.

Method 1

a. Click Edit on the Point Control Panel menu bar.
b. Select Paste.

Method 2

Press Ctrl+V on the keyboard.

The Point IDs appear in the second Point Control Panel.
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2. Change Font Colors in the Point Control Panel

You can maximize a user's ability to quickly distinguish points that are in different states by setting
the foreground and background colors for the state.

The states you can set are:

• Normal
• Warning
• Alarm
• Wait for response

1. Click Font on the Point Control Panel's menu bar.

2. Select Colors.

3. The Font Color dialog box opens.

4. Select the Foreground (Text) and/or Background color from the drop down field menus for any
of the four states.

5. Click either:

OK Save your changes.

Cancel Discard the changes.

The Point Control Panel re-displays, reflecting your changes.
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3. Edit a Point through the Point Control Panel

You can open a read/write Point Properties box for any point in the Point Control Panel.

Important:  CIMPLICITY dynamically updates any changes you make in the Point Properties
dialog box even if you have not enabled dynamic configuration.

1. Select a point in the Point Control Panel.

Example

A point that is in a high alarm state is selected.

2. Do one of the following.

• Click the Edit Point button  on the Point Control Panel toolbar.
• Select Edit>Edit Point on the Point Control Panel menu bar.
• Right-click a point; select Edit point from the Popup (page 516) menu.

The selected point's Point Properties dialog box  opens.

3. Make any changes, the same as you would if you opened the Properties dialog box by double-
clicking a point ID in the Workbench.

Example
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The high alarm state values are changed in the point's Point Properties dialog box.

A Alarm limit values when first opened.

B Alarm limit values changed.

Note: If you click Apply at any time, CIMPLICITY will dynamically update the system with
your changes.

4. Click one of the following when you are ready to close the dialog box.

OK Saves any unapplied changes and has CIMPLICITY dynamically update the system.

Cancel Discard any unapplied changes.

The Point Properties dialog box closes in the Point Control Panel. The system is updated if you
clicked OK or Apply.

Example

OK was clicked. The selected point is no longer in alarm state.
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Tip:  You can confirm that the changes were applied by opening the point's Point Properties
dialog box in the Workbench.

Note:  The Edit Point feature is enabled if you have access to the project's configuration data
(e.g. either running on node or via a mapped drive from off node; an off-node Viewer does not have
the required access) and the required CIMPLICITY privileges. Your role must have the dynamic
configuration privilege enabled, and the privilege to configure points enabled, if configuration
security (page 85) is set for the project.

4. Delete a Point from the Point Control Panel

You can easily remove points from the Point Control Panel. If you save the file, the points will not
appear when you re-open it.

Important:  Deleting points from the Point Control Panel does NOT delete the points from your
project.

1. Do one of the following:

Method 1

a. Click Edit on the Point Control Panel menu bar.
b. Select Delete

Method 2

Click the Delete Point  button on the Point Control Panel toolbar.

Method 3

Press Delete on the keyboard.

Method 4

a. Right-click a point that displays in the Point Control Panel.
b. elect Delete from the Popup (page 516) menu.

A Point Control Panel dialog box appears asking you to confirm deletion.

2. Click either
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Yes Delete the points

No Cancel deletion

The points will be removed or not according to your specifications.

Note:  If you do not save the Point Control Panel file after you delete the points, they will
reappear the next time you open the file.

Manual Mode Points in the Point Control Panel

Manual Mode Points in the Point Control Panel

In the Point Control Panel you can easily make use of the CIMPLICITY manual mode feature.

Manual mode enables a user to take a device point that may or may not be currently available and
put it in manual mode. The user can then set the point's value. This is particularly useful if a point is
attached to equipment that is known to be malfunctioning and, consequently, creates a problem in
other areas of the system.

The Point Control Panel enables you to:

1
(page
536)

Add manual mode points to the Point Control Panel.

2
(page
537)

Enable and disable manual mode points.

Note:  A user must have a role in which Modify Attributes is checked in the Roles dialog box in
order to work with manual mode points.

Example

A temperature sensor that reports temperatures, which are acted upon by CIMPLICITY applications
to initiate temperature control actions, fails. To continue the high temperature setting, a user
with Modify Manual Mode privilege places the point that reflects the errant sensor in manual
override mode. The user then sets a value that causes the application to cease the unnecessary
temperature control procedures. This allows users who are knowledgeable of their CIMPLICITY
application implementation to make emergency, temporary adjustments to their system's operation.
Consequently, the application does not have to anticipate and provide for handling of all possible
failures in its implementation.

When the temperature sensor is fixed, the user disables manual mode. Point data collection resumes.
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1. Add Manual Mode Points to the Point Control Panel

1. Do either:
• Click Edit>Add Manual Mode Points on the Point Control Panel menu bar.

• Press Alt+E+M on the keyboard.

An Add Manual mode Points dialog box opens.

2. Select the project in which the Point Control Panel should find manual mode points.

If you have access to that project, the Point Control Panel looks for manual mode points and
provides a message stating how many it found.

3. Click OK.

the Point Control Panel displays all of the manual mode points that are in the selected project.
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A Manual Mode icon  displays to the left of each of the point ID's.

2. Enable/Disable Manual Mode Points

If your role has Modify Attributes privileges, you can enable or disable manual mode for a point,
when necessary.

• Enable manual mode.
• Disable manual mode.

Enable manual mode

By Enabling Manual Mode, a user can separate the point from that equipment and set the point to a
known good value that preserves the system's integrity. When the required corrections are made, the
user can then bring the point back online by disabling manual mode.

1. Select a point ID that needs to be put in manual mode.

2. Do one of the following.

A Click Edit>Enable Manual Mode on the Point Control Panel menu bar.

B Click the Enable Manual Mode button on the Point Control Panel toolbar.

An icon  displays to the left of the Point ID, indicating that the point is in manual mode.

3. Double click the Point ID.

The Point Control Panel's Point Properties dialog box opens.

4. Select the Detail (page 539) tab.

5. Enter a new value for the point in the Set Value field.
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Result: The point will continue to function in the CIMPLICITY project using the set value.

Disable manual mode:

6. Select a point that is in manual mode.

7. Do one of the following.

A Click Edit>Disable Manual Mode on the Point Control Panel menu bar.

B Click the Disable Manual Mode button on the Point Control Panel toolbar.

PCP Point Properties Dialog Box

PCP Point Properties Dialog Box

The Point Control Panel provides you with tremendous flexibility in displaying a point's properties.

In addition to the point's Point Properties dialog box, a Point Control Panel (PCP) Point Properties
dialog box provides you with a quick read-only summary of point properties and enables you to
change runtime point and alarm values.

 
(page
538)

Open the PCP Point Properties dialog box.

 
(page
539)

Tabs in the PCP Point Properties dialog box.

Open the PCP Point Properties dialog box

1. Select a point in the Point Control Panel.
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2. Do one of the following.

• Double-click the selected point.

• Click the Edit Point Properties button  on the Point Control Panel toolbar.
• Click Edit>Properties on the Point Control Panel menu bar.
• Right-click the point; select Properties on the Popup menu.

The PCP Point Properties dialog box opens when you use any method.

Tabs in the PCP Point Properties dialog box

Tabs in the PCP Point Properties dialog box may include one or more of the following.

Tab Available Description

1
(page
539)

Detail For every point. Quick read-only summary of the point's properties Setpoint access, if
the point allows set points.

2
(page
540)

Alarm If alarm limits are configured
(except for On Update limits).

Change the alarm limits for a selected point. This tab is available only if
alarm limits (except On Update limits) are configured for the point.

3
(page
542)

Array If the point is an array point. View and set the values of elements in an array, if the array point
allows set points.

1. Detail Tab in the PCP Point Properties Dialog Box

The Detail tab in the Point Control Panel's Point Properties dialog box enables you to:

• Review summary details about a point.

Read-only details about the point provide a quick overview of the point's properties. The property
specifications were entered in the point's detailed Point Properties dialog box.

• Change a point's value.

Enter a value in the Set value field.



Project Setup | 13 - Point Control Panel | 540

Note:  A user must have a role for which the  setpoint privilege is checked in the Roles dialog
box in order to set points.

2. Alarm Tab in the PCP Point Properties Dialog Box

If an alarm has been configured for a point that is selected in the Point Control Panel, an Alarm tab
will be included in the point's PCP Point Properties dialog box. This tab enables you to change the
alarm limits during runtime.

The contents of the Alarm tab depend on whether you are viewing an Analog or Boolean point type.

• Alarm tab for Boolean points.

• Alarm tab for Integers.

Note:

• Points with On Update alarms do not have an Alarm tab in the PCP Point Properties dialog box.

• You can restore a selected point's alarm limits by clicking the Restore Alarm Limits button 
on the Point Control Panel toolbar.

Alarm Tab for Boolean Points

Features that can be edited on the PCP Point Properties Alarm tab for a Boolean are as follows.
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Feature Use to:

Alarm
Enabled

Check Enable alarming for a point that is already in an Alarm state–the alarm is generated.

Clear Disable an alarm when the point is in an Alarm state–the state is reset to Normal.

Note: If you disable alarming, a Disabled Alarm icon  displays next to the point in the Point Control
Panel window.

Current Change the alarm value to either 1 or 0. Note: If you change the value for the alarm, an Alarm Limit
Changed icon  displays next to the point in the Point Control Panel window.

Alarm Tab for Integers

Features that can be edited on the PCP Point Properties Alarm tab for an integer are as follows.
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Feature Description

Alarm
Enabled

Check Enable alarming for a point that is already in an Alarm state–the alarm is generated.

Clear Disable an alarm when the point is in an Alarm state–the state is reset to Normal.

Note: If you disable alarming, a Disabled Alarm icon  displays next to the point in the Point Control
Panel window.

Current Change alarm limits. Note: If you change alarm limits, an Alarm Limit Changed icon  displays next
to the point in the Point Control Panel window.

Restore
Alarm Limits

Click if you want to restore the limits to their original values.

3. Array Tab in the PCP Point Properties Dialog Box

1. Double-click an element in the array.

The element displays in a writable box.

2. Change the element's value.

3. Press Enter on the keyboard.

The new value displays in the Set Value column. The Current  Value is different from the Set
Value.
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4. Click  Apply.

The Current Value is now the same as the Set Value.

5. Click OK to close the PCP Point Properties dialog box.

The Point Control Panel updates to reflect your changes.

Note:  You can open the array's detailed Point Properties dialog box to make other modifications.

Alarm Procedures in the Point Control Panel

Alarm Procedures in the Point Control Panel

You can work with alarms in the Point Control Panel in the following ways.
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You can:

1
(page
544)

Disable/enable an alarm in the Point Control Panel.

2
(page
545)

Modify/restore alarm limits in the Point Control Panel.

3
(page
545)

Add points with disabled or modified alarms to the Point Control Panel.

1. Disable/Enable an Alarm in the Point Control Panel

• Disable an alarm.
• Enable an alarm.

Disable an alarm

1. Select a point in the Point Control Panel.

2. Do one of the following.

• Click the Disable Alarm button  on the Point Control Panel toolbar.
• Click Edit>Disable Alarm on the Point Control Panel menu bar.
• Clear the Alarm enabled checkbox on the PCP Point Properties dialog box Alarm tab.
• Right-click the point; select Disable Alarm on the Popup menu.

Result: The point's alarms are disabled and a Disabled Alarm icon  displays to the left of  the
Point ID.

Enable an alarm

3. Select a point in the Point Control Panel.

4. Do one of the following.

• Click the Enable Alarm button  on the Point Control Panel toolbar.
• Click Edit>Enable Alarm on the Point Control Panel menu bar.
• Check the Alarm enabled checkbox on the PCP Point Properties dialog box Alarm tab.
• Right-click the point; select Enable Alarm on the Popup menu.

The point's alarms are enabled. The Disabled Alarm icon next to the Point ID disappears.
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2. Modify/Restore Alarm Limits in the Point Control Panel

• Modify alarm limits.
• Restore alarm limits

Modify alarm limits

Modify alarm limits on the Alarm tab (page 540) in the PCP Point Properties dialog box.

Restore alarm limits

1. Select a point that has modified alarm limits.

Note: A Modified Alarm icon  displays to the left of the point ID.

2. Do one of the following.

• Click the Restore Alarm Limits button  on the Point Control Panel toolbar.
• Click Edit>Restore Alarm Limits on the Point Control Panel menu bar.
• (Integers) Click the Restore Alarm Limits (page 541) button on the PCP Point Properties

dialog box Alarm tab.
• Right-click the point; select Restore Alarm Limits on the Popup menu.

The alarm limits (page 279) that were entered in the full Point Properties dialog box are restored. The
Modified Alarm icon disappears.

3. Add Points with Disabled or Modified Alarms to the Point Control
Panel

1. Click Edit>Add Modified Alarms... on the Point Control Panel menu bar.
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An Add Disabled/Modified Alarms dialog box opens.

2. Select options as follows.

Option Description

Project Running project that will be searched for selected disabled and/or modified alarms.

Disabled Alarms Check to add points with disabled alarms

Modified Alarm Check to add points with modified alarms.

3. Click OK.

If you have access to that project, the Point Control Panel looks for points with disabled or
modified alarms and provides a message stating how many it found.

4. Click OK.

The Point Control Panel displays all of points with modified and/or disabled alarms that are in the
selected project.

Icons to the left of the point ID identify modified and disabled alarms.
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Alarm is modified.

Alarm is disabled.



Chapter 14. Browsers

About Browsers

Certain input fields on your configuration window and dialog boxes have a Browse button to the
right of them. When you click this button, you invoke a Browser for that particular entity.

Each browser enables you to search through a complete or filtered list of  entities and select the one
you want for your configuration. Browse buttons that open Browsers include:

Button Opens a Browser for:

Alarm classes .

Classes,

Class objects.

Devices.

General.

Historian tags.

Measurement units.

Points.

Point enumerations.

Resources.

Roles.

String Index.

Note:  If the Auto Browse option in a Browser is enabled, the display list initially displays all of
the entities available for the Browser.

You can tailor the display list to your needs by entering specifications in the available fields.
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Browser Use

All of the browsers provide a similar user interface.

The exact details for each browser depend on the items being browsed.

A using browser features overview is as follows.

rect 303, 83, 324, 100  (page 554)
rect -1, 28, 20, 45  (page 554)
rect 333, 2, 354, 19  (page 554)
rect 301, 58, 322, 75  (page 553)
rect 166, 316, 187, 333  (page 553)
rect 179, 249, 200, 266  (page 553)
rect 302, 108, 323, 128  (page 553)
rect 8, 97, 29, 114  (page 551)
rect 148, 55, 169, 72  (page 551)
rect 73, 28, 94, 45  (page 550)
rect 3, 398, 24, 415  (page 553)
rect 180, 399, 201, 416  (page 551)

1
(page
550)

Select the browser view.
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2
(page
551)

(In select instances) Select a CIMPLICITY project or Historian connection.

3
(page
551)

Browse filter fields.

4
(page
553)

Populate the browser.

5
(page
553)

Sort  the Browser List./ Change the column display width.

6
(page
553)

Exit a Browser without selecting an item.

X
(page
554)

Exit a Browser without selecting an item.

1 Select the browser view.

Each browser provides the same view options.

Click View on the browser menu bar.

View options are:

Option Description

Hierarchical Displays a Tree View.
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Option Description

Flat Displays a flat list.

Field
Chooser

Opens a Field Chooser dialog box. The fields correspond to the fields for the selected browser's item.

Auto
Browse

The following occurs when Auto Browse is checked or clear.

Checked All of the items currently in the database display when you open that Browser.

Clear No items display when you open the browser. You must enter filter information and click
Browse to display a list of items.

2 (In select instances) Select a CIMPLICITY project or Historian connection.

If the browser requires a project or an Historian connectionposition: static; (Select a tag browser) to
be selected a drop down list will be available to make that selection.

Note:  The following will occur when the browser opens if Auto Browse is checked.

The project or Historian connection are: Result

Selected and available All of the items currently in the database display

Not selected Nothing displays.

Unavailable An error message reports the issue.

3 Browse filter fields/Select maximum record limit.

Filter Fields
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Fields and the Browse button in the Browser enable you to quickly find a specific item or subset of
items.

The exact fields that are available on each browser are based on what is being browsed.

1. Enter a full or partial item name in one or more of the fields.

You can use the * and ? wild cards, as follows.

Wildcards: All browsers, except the Select a Tag browser

Wild card Searches for any:

* Number of characters at this point in the string. Example To display the list of points that:
• Start with M.
• End with X.

Enter M*X in the Point ID field.

? Character in this place in the string. Example To display the list of points whose:
• Names are three characters long.
• First character is M.
• Third character is X.

Enter M?X in the Point ID field.

Note:  Some filter fields may also let you access other Browsers to select an item for filter
purposes. These Browsers have the same functionality as the current Browser.

Wildcards: Select a Tag Browser (Historian Tag)

Wildcard usage for A Select a Tag browser, which connects to a selected Historian server, is as
follows.

Filter
Field

Use *
and ?

Comment

Tag Name Yes

Description Yes

Engineering
Unit

No Browsing not case sensitive

Data Type No A Select Data Type browser is available by clicking the field's Browse button.

Interface
Name

No Browsing Is not case sensitive; a Select an Interface Name  browser is available by
clicking the field's Browse button.

Source
Address

Yes

2. Click Browse.
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A list that is filtered according to your specifications displays.

Note:  There are no implied wild cards. If you do not include or terminate your search string with
an asterisk, only those items that match your request exactly will be returned.

Max. Record Limit

The number of records that will be listed in the browser will be limited to the number entered in the
Max. Record Limit field.

If there are more records that fulfill the criteria than the maximum limit, the records retrieved are    

If additional records are required, the limit can be increased and the browse repeated.

Default limit: 1000 records.

4 Populate the browser.

Click Browse after the filter criteria have been selected.

The browser is populated with items that fulfill the criteria.

5 Sort  the Browser List./ Change the column display width/ Note number of records retrieved.

List Sort

The list is initially sorted alphanumerically in ascending order by the fixed display attribute. You can
do additional sorting as follows.

• Click one of the field identifier buttons at the top of the list to re-sort the list by the field you
select or

• Double-click one of the field identifier buttons to re-sort the list in descending order.

Column Width

The browsers provide the standard column width resizing capability.

6 Select an Item in the Browser

One or more items can be selected in the browser, based on the target destination.

Do either of the following.

• Double-click the item.
• Select the item; click OK.

The Browser closes, and the selected item is put in the associated field.
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Note:  Use the following keys when more than one item can be selected.

Key Selects

Shift Continuous items.

Ctrl items that are separated in the list.

X Exit a Browser without selecting an item.

Do any of the following at any time  to exit the Browser without selecting an item.

• Click File>Exit  on the Browser menu bar.
• Click Cancel.

• Click the Microsoft Close button .

Field Chooser Dialog Box

1 (page
554)position: static;

Open the Field Chooser dialog box.

2 (page
555)position: static;

Select Fields for the Workbench right pane.

1. Open the Field Chooser dialog box

1. Click an application (icon) in the left pane.

Fields that correspond to the selected application display in the right pane.

2. Use any of the following methods to open the Field Chooser dialog box.
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A Click the Field Chooser button on the Workbench toolbar.

B Click View>Field Chooser on the Workbench menu bar.

C a. Click the right mouse button in the right pane.
b. Select Field Chooser on the Popup menu.

The Field Chooser dialog box opens when you use any of these methods.

a. Select Fields for the Workbench Right Pane

The names and number of fields that display in the Field Chooser dialog box depend on what
application was selected before the dialog box was opened.

Use the Field Chooser dialog box to select the fields that will display for the selected
application, as follows.

Feature Fields action.

A Available Field Do not display in the Workbench.

B Display Fields Display in the Workbench right pane.

C Buttons to add or remove fields for display.

Add Select a field in the Available Field box.



Project Setup | 14 - Browsers | 556

Feature Fields action.

Adds the field to the Display Fields.

Remove Select a field in the Display Fields box.

Sends field back to the Available Field box.

D Buttons to position the field in the Workbench.

Move Up (With each click) selected field is moved one column to the left one column.

Move Down (With each click) selected field is moved one column to the right one column.

Click OK.

3. Click the right mouse button in the right pane.

4. Select Field Chooser on the Popup menu.
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